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Contacting Infor

If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and
create a support incident.

The latest documentation is available from docs.infor.com or from the Infor Support Portal. To access
documentation on the Infor Support Portal, select Search > Browse Documentation. We recommend
that you check this portal periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Chapter 1: General Financials Information

About Accounts
An account tracks the money spent or earned by business activities.

Business activities could be any of the following:

• Paying Bills
• Receiving Payments
• Generating Payroll Checks
• Purchasing Supplies
• Paying Rent

The system uses default accounts for specific types of transactions. Account numbers to use for
transactions are often automatically assigned from code and parameters forms.

Customer order and purchase order lines use account numbers defined on the Product Codes form.
An item is assigned a product code, and each product code has account numbers associated with it.
When an item is sold, it is entered on a customer order line item. When the voucher is entered, the
system credits the inventory account (taken from the product code) with the proper amount.

Account Number Setup

The account number is the central location for domestic currency amounts. The account number spans
the system. Use the Chart of Accounts form to maintains all amounts for all parts of the system.
Accounts must be set up for each of the following account types:

• Assets
• Liabilities
• Owner's Equity
• Revenue
• Expenses

You can also set up accounts for the following account types:

• Allocation
• Statistical: You can only use Statistical Accounts within Financial Statements, the Chart of

Accounts form and the Chart of Accounts Budget and Plan form, where they are maintained.
• Analytical: This account type is available only if you have selected the Analytical Ledger option

on the General Parameters form.
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For each account, you can also determine whether unit codes will be used. The Unit Code tabs display
valid unit codes. There are also utilities to help you add, copy, and remove ranges of unit codes.

We recommend that you set up all accounts to be the same number of digits. For example, if you will
have accounts up to 999999, then all accounts should have 6 digits. This makes it easier to run utilities
with account ranges. If your account numbers are different lengths, for example, 600 to 999 and 100000
to 999999, and you enter the range 600 to 999999 in a utility, it will not process all accounts.  You must
run the utility for the range 600 - 999 and again for 100000 - 999999.

Note:  Accounts can be deleted; however, you cannot delete accounts with data posted to them. You
also cannot delete accounts that are referenced on any parameters form (for example, Purchasing
Parameters or Accounts Payable Parameters), or any account record if it has any associated Unit
Codes (1 through 4).

Control Accounts

On the Chart of Accounts form, select the Control Account check box to identify the current account
as a control account. For more information about how control accounts are used, see About Control
Accounts on page 12.

Currency Translation Methods

The currency translation method that is defined for each account is used to calculate exchange rates
at different points in time; for example, at the time of a transaction posting, the end of an accounting
period, or the average exchange rate within a period. They can only be updated for financial entities
that report to other financial entities.

Note:  To comply with FASB 52 or GAAP standards, you must set the currency translation method to
Average for revenue and expense accounts and End for asset and liability accounts.

About Control Accounts
A control account is a general ledger account with a balance that reflects the total balances of related
subsidiary ledger accounts.

For example, many companies specify control accounts for these areas:

• Accounts Payable
• Accounts Receivable
• Inventory
• WIP
• Vouchers Payable
• Taxes
• Bank Accounts
• Service Order Labor, Miscellaneous and Deposit Accounts
• Service Contract Accounts
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Control accounts are defined on the Chart of Accounts form and are generally only used on setup
and parameter forms.

Control accounts require some basic security. Users should not be able to manually post transaction
amounts to a control account, which might cause the control account to become out of balance. If you
select Secure Control Accounts on the General Parameters form, control account numbers are not
available on drop-down lists on transaction forms like Purchase Orders or Job Material Transactions,
and the account numbers also cannot be manually entered on transaction forms.

However, a user who is assigned the group authorization Allow JE to Ctrl Acct (Allow Journal Entries
to Control Accounts) can specify a control account for a manual journal entry in the General journal or
a user-defined journal in the Journal Entries, Import Journal Entries, or Journal Builder forms. This
allows the correction of Distribution journal entries that were incorrectly assigned to control accounts.

About Cancellation Posting for Single-Entry Accounting
For businesses that use single-entry accounting, cancellation posting allows for cancellation or reversal
adjustment transactions using a negative entry on the same side, debit or credit, as the original entry.
A negative sign (-) is displayed to identify the adjustment. Cancellation posting is available for accounts
payable adjustments and accounts receivable credit memos.

Setup and Application

You enable cancellation posting functionality by selecting a setting on the General Parameters form.
You can then apply this functionality to individual adjustment entries on theInvoices, Debit and Credit
Memos and A/P Vouchers and Adjustments forms.

When you apply cancellation posting to a transaction record, these indications are visible on subsequent
posted transactions, journal entries, and ledger reports for the transaction:

• On related forms and reports, a negative sign (-) is displayed with the adjustment amount.
• On these forms, a display-only Cancellation check box is selected:
• A/P Posted Transactions Detail
• A/R Posted Transactions Detail
• G/L Posted Transactions
• Journal Entries
• On these reports, an X is displayed next to the transaction:
• A/P Voucher Posting Report
• Invoice Transaction Report
• Journal Transaction Report

Processing Rules

These processing rules exist for cancellation posting:

• Accounts Payable:
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On the A/P Vouchers and Adjustments form, a cancellation posting adjustment references the
original voucher number and reverses the entire amount of the original voucher. Partial adjustments
cannot be made. Also, amounts and discount and due dates from the original voucher cannot be
changed.

Posted vouchers can be canceled only one time. Posted vouchers referenced by posted adjustments
or payments cannot be canceled.

• Accounts Receivable:

On the Invoices, Debit and Credit Memos form, a cancellation posting credit memo references the
original invoice number and reverses the entire amount of the original invoice. Partial credit memos
cannot be made. Also, amounts from the original invoice cannot be changed. The due date follows
existing rules based on credit terms.

Posted invoices can be canceled only one time. Posted invoices referenced by posted credit memos,
debit memos, or payments cannot be canceled.

• Journal Entries and G/L Posted Transactions:

On the Journal Entries and G/L Posted Transactions forms, negative-signed debit and credit amounts
are displayed for cancellation adjustments in the AP Dist journal and for cancellation credit memos in
the AR Dist journal. Debit amount totals are tallied using the sum of positive and negative-signed debits.
Credit amount totals are tallied using the sum of positive and negative-signed credits. All other entries
are displayed using traditional double-entry accounting notation.

The application of cancellation posting does not alter transaction entry. It affects only the display of the
debit and credit amounts and totals, as shown in this example:

Single-Entry Cancellation
Posting Credit Memo for
Original Invoice

Double-Entry Credit Memo for
Original Invoice

Original A/R Invoice

Dr  Accounts Receivable - 119

Cr Revenue - 100

Cr VAT -19

Dr Revenue 100

Dr VAT 19

Cr  Accounts Receivable 119

Dr Accounts Receivable 119

Cr  Revenue 100

Cr VAT 19

Reporting

Reports related to voucher adjustments and credit memos display transactions using negative-signed
debit and credit amounts. This applies to reporting that occurs during the transaction-to-journal-to-ledger
cycle. Again, debit amount totals are tallied using the sum of positive and negative-signed debits. Credit
amount totals are tallied using the sum of positive and negative-signed credits.

Certain reporting rules apply when the Separate Debit and Credit Totals option is also applied to
reports.
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A/R A/P Offset Overview
This feature allows you to have a batch of selected AR invoices and AP vouchers offset each other.
This can be done only if you have a customer that is also a vendor.

The functionality involves these forms:

• Accounts Payable Parameters
• Vendors
• AR/AP Payment Offset
• A/R Payments
• A/R Payment Distributions
• A/P Payments
• A/P Payment Distributions

Offsetting A/R Invoices and A/P Vouchers
To offset A/R Invoices and A/P vouchers:

1 Create an offset account on the Accounts Payable Parameters form.

2 Link a customer to a vendor with the Customer field on the Vendors form.

3 Create offsetting payments for A/R and A/P on the A/R A/P Payment Offset form.

a Select either the vendor or the customer. Only vendors and customers with a corresponding
customer or vendor appear in the drop down lists. The grid populates with outstanding invoices
and vouchers.

b Select a combination of vouchers and invoices that have equal amounts. For example, select
an invoice for $1,000 and two vouchers; one for $400 and one for $600. If you don't have
amounts that exactly balance, click the offset amount either for the voucher or the invoice and
provide the new number.

c Click Create Offsets. A message is displayed that tells you that A/P and A/R payment
distributions were created. You can now post these payments using the A/R Payment Posting
and A/P Check Printing/Posting forms. The grid on the A/R A/P Payment Offset form does
not refresh with current data until you post.

4 View payments as offset with the Offset check box on these forms: A/R Payments, A/R Payment
Distributions, A/P Payments, and A/P Payment Distributions.

Note: Offset payment distributions cannot be deleted using the A/R Payment Distributions or
A/P Payment Distributions form; however, these distributions are deleted when payments are
posted or if you manually delete the payments using the A/R Payments or A/P Payments form.
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Creating and Maintaining Budgets and Plans
Budgets are estimates of anticipated receivables and payables for a specific time frame. They are
usually based on historical facts, including past sales and growth trends. The budget amounts are used
by General Ledger reports, financial statements, and the Chart of Accounts Report. Budgets are also
displayed when viewing posted General Ledger (G/L) transactions to allow a comparison between a
period's actual transaction amount and the budgeted amount.

The Chart of Accounts Budget and Plan form is a worksheet that you use to create budgets and
plans for each individual account, accounting period, and fiscal year. This form maintains information
for budgets, plans, and actual change amounts. Actual change values are used only to define statistical
accounts.

The Chart of Accounts Budget and Plan form allows you to store budgets for multiple fiscal years.
Each time a new fiscal year is added to the accounting periods or a new Chart of Accounts is added,
you must manually add corresponding budget, plan, and actual records. You can either click New to
add them one at a time or use the Copy Balances to Budgets form to copy ranges of Unit Codes and
account ranges to and from fiscal years. These amounts are useful for comparing actual financial
activity against budgeted or planned activity.

Budget amounts and plan amounts are handled the same way. The plan amounts simply allow for a
second budget or planning figure. A common practice is to use the plan amounts to maintain last year's
sales figures.

If you are using a second Analytical Ledger in addition to the General Ledger, see About Analytical
Accounting on page 233 to learn how budgets and plans are affected.

To enter amounts manually for a new fiscal year:

1 Select Actions > New.

2 Select the account.

3 Select the fiscal year, if necessary.

4 In the Budgeted Change field, enter the amount.

5 In the Planned Change field, enter the amount.

6 Click Actions > Save.

You can use the Planned Change amounts in this form to contain last year's account balances.

To create a base value for budgeted amounts that increment each preceding accounting period by a
specific percentage:

1 Select Actions > Budget Growth Auto-Set.

The system displays the Chart of Accounts Budget and Plan Growth form.

2 Enter the base amount and the desired percentage increase per accounting period.

This process updates each accounting period for that year.

3 To save the entries, click OK.

To create a base value for planned amounts for all currently defined accounting periods that increment
each preceding accounting period by a specific percentage:

1 Select Actions > Plan Growth Auto-Set.
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The system displays the Chart of Accounts Budget and Plan Growth form.

2 Enter the base amount value and the desired percentage increase rate of change per accounting
period.

This process updates each accounting period for that year.

3 To save the entries, click OK.

About Statistical Accounts
Statistical accounts are used to track non-financial, that is, non-monetary, amounts over a period of
time.

You can use the information from statistical accounts to compare non-financial data to related financial
data - for example, compare Shipping Expenses to Quantity Shipped in each shipping department - in
order to control costs or measure productivity.

You can also use statistical accounts to track periodic changes in non-financial data, and to allocate
and distribute expenses based on that variable data.

Note:  You can only use statistical accounts within the Chart of Accounts form and the Chart of
Accounts Budget and Plan form, where they are maintained.

Creating Statistical Accounts
Statistical accounts are used to track non-financial, that is, non-monetary, amounts over a period of
time.

For more information, see About Statistical Accounts on page 17.

To set up statistical accounts.

1 Create an account on the Chart of Accounts form where the Account Type is set to
Statistical. Set the appropriate unit codes to be accessible. For example, if you want to record
statistical information about departments, and Unit Code 1 reports department information, then
set Unit Code 1 to Accessible for the account.

2 On the Chart of Accounts - Budget and Plan form, specify statistical information related to the
unit code in the statistical account. Use the Actual Change to record the amount of change during
the current period.

3 After you have set up your statistical accounts and entered information on the Chart of Accounts
- Budget and Plan form, use this information to create ratios, compare financial values to
non-financial values, or allocate and distribute expenses based on that variable data. For more
information, see Example: Allocating Expenses with Variable Percentages based on YTD Amounts
from Statistical Accounts on page 280.
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Consolidation Overview
You can consolidate your financial data from several sites for timely reporting and online queries.

Entities

In a multi-site environment, you can specify a hierarchy of financial entities that operating sites report
to. A financial entity is a level of business operation for which there is:

• A complete set of financial statements,
• Its own domestic currency code, which must be shared by sites that report to it, and its own currency

rates, which may or may not be shared by reporting sites/entities.
• Its own account template, chart of accounts, and accounting periods, which must be shared by

reporting sites. (Reporting entities do not have to share these characteristics.)

Each entity allows no business activity aside from period, chart and currency maintenance, and the
reporting of its consolidated ledger and budgets. Entity users should all belong to the default authorization
group Entity Forms, which limits them to using only entity-level forms. They should also be licensed
for the "Entity" module.

If the Ledger Detail category is replicated to the entity from the sites, you may be able to view detail
down to the level of the originating transaction. (This assumes that any other categories required for
the transaction-level detail are also being replicated. Having this level of G/L and other transaction
detail replicated to the entity generally does not make sense from a performance standpoint.) Otherwise,
you will need to access the specific site in order to view the transaction detail.

For more information about replicating categories, see the Multi-Site Planning Guide.

Sites Reporting to an Entity

The majority of operations at sites reporting to an entity remain the same as at a non-reporting site,
including the financials. If a site reports to an entity, the site's Chart of Accounts is now owned by the
entity and copied from it. In the local copy of the Chart of Accounts, you can delete records to use a
subset of the accounts. The site must use the domestic currency of its entity, but it may use its own
rates. Consolidation utilities must be run at the reporting sites to copy the posted ledger transactions
and budgets into the entities all the way up the hierarchy.

A site is not required to report to an entity, in which case its financials are not consolidated.

Setup of Entities and the Reporting Structure

When you create system databases or add sites and entities to a database, you must specify a site
type. When you create a site that will be used as a financial entity, specify a site type of entity.

Operational data such as entry or selection of customers and vendors is not necessary for entities.

Defining the Hierarchy

To define or change the hierarchy of your sites and entities, several tools are available:
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• Change Reports to Entity: Use this utility at the reporting site/entity to specify the next-level entity
to which this site/entity reports.

• Multi-Site Chart Copy: Use this utility at the entity to copy the Chart of Accounts to the reporting
sites/entities.

• Ledger Consolidation: Use this utility at the reporting site/entity to consolidate all previously
unconsolidated records for the site, all the way up the financial reporting hierarchy.

Note:  Additional steps are required in order to initially set up a financial hierarchy.

For more information, see Setting Up a Consolidation Reporting Structure on page 272.

We suggest that you contact Infor Consulting Services to help with your implementation.

It is not necessary to have a balanced financial hierarchy.

Changes to Your Reporting Structure

Over time, sites come and go and the hierarchy of entities may change. As these changes occur, the
historical consolidated financial data will not change, and an historical time-phased site/entity structure
will be maintained. This allows prior period reporting and drill-downs to yield identical results, even
after the structure has changed. On the date of a reporting structure change, a large transaction is
posted to close out all accounts for all selected subordinate sites, computing the account balance of
each account. Half of this transaction is immediately consolidated to the existing structure, effectively
zeroing the balances from the books. After the hierarchy is changed, the other half of the transaction
is consolidated to the new structure, creating opening balances for all the accounts. At the site level,
this has no effect, since a debit and credit for the same amount is posted to the same account on the
same date.

Be aware of the following when changing the reporting hierarchy:

• Financial statement reporting at entities only shows data for transactions that occurred during the
time period that the hierarchy was in place.

• When you change an entity's Reports To mapping, there is no historical audit trail of how it was
formerly set up.

• Transactions are consolidated to the current structure only, regardless of effective date of the
hierarchy change or the ledger transaction date.

Note:  Sites can only report to entities that have matching reporting parameters. This includes the
same chart template, domestic currency and financial periods, as well as every Chart of Accounts
already defined at the entity.

Currency

Average exchange rates are calculated based on exchange rates established by sites (set up by site
or mid-level entity that the site reports to in a shared currency environment). During ledger consolidation,
when posting revenue and expense accounts, exchange rates set up at the site level (set up by site
or mid-level entity that the site reports to in a shared currency environment) are used to calculate
average exchange rate for the period and are used to translate site amounts in site's currency to
corporate currency. Exchange rates must be set up at the site (or mid-level entity that the site reports
to in a shared currency environment) for Ledger Consolidation to correctly post amounts in corporate
currency.

When dealing with multiple currencies in a consolidated environment:
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• The base (domestic) currency must be the same at all sites reporting to an entity. However, you
may set up the sites so they can maintain their own currency exchange rates - or you may want
to maintain the rates only at the entity.

For more information, see the section on replicating shared currency in Default Replication
Categories.

• In each entity's Chart of Accounts, the currency translation method and the exchange rate type
are specified for each account.

• The currency table of the entity is the one used for translation during the consolidation. (Sites use
the domestic currency of their entity, so there is no currency translation at this level.)

To comply with FASB52 or GAAP standards, on the Chart of Accounts form, you must make sure
the currency translation methods are set to Average for revenue and expense accounts, End for asset
and liability accounts, and Spot for Owner's Equity accounts. You can exclude Owner's Equity accounts
from being revalued by setting the Account Class in the Chart of Accounts form to Equity -
Non-Monetary.

Note:  This adjustment is necessary only when the ledger is consolidated in a multi-site setup where
a subordinate entity's domestic currency is different from its parent entity's domestic currency, different
account types are posted with different translation methods, and the exchange rates varies.

See FASB52 Overview on page 238.

Combined vs. Consolidated Reporting

Financial statements can either show combined data from a group of sites, or consolidated data from
an entity and its reporting sites.

If you want to create sample financial statements before changing a hierarchical structure, to see what
the combined data from multiple sites will look like, you can mimic the new structure by using multi-site
group IDs and combined financial statements.

Even after you have set up a consolidated environment, you may still run combined financial statements
for a group of sites.

When you run consolidated financial reports from the entity, all sites that report to the entity must have
run the Ledger Consolidation utility. When the financial statement is run, no currency translation is
required, because the data at the entity level is already translated into the entity's currency and Chart
of Accounts. Also, since no multi-site group IDs are specified, it looks only at the information in the
entity. Therefore, consolidated financial reports run much faster than combined financial reports.

About Ledger Consolidation

You can consolidate the ledger at the end of the year. When you select the Year End check box, the
system posts CTA adjustment transactions to the ledger for the revenue and expense accounts.

The following checks are made:

• The hierarchy is valid
• The accounts map correctly
• The unit codes map correctly
• The currencies convert properly
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The system uses the currency rate tables that are defined by each financial entity where the consolidation
entries are being written. The translation is performed directly on data from the originating site's
transaction.

Period totals are created, using the definitions at each entity additionally segregated by hierarchy.

As this utility runs, it creates a report of any exceptions, undoing only the affected ledger record and
continuing with the remaining processing.

Before actually posting the transactions, you can run in Verify mode by not selecting the Consolidate
check box.

Note:  Before running this utility, you must specify a valid account in the CTA Account field on the
General Parameters form at the corporate entity level; otherwise, an error message displays.

If you are reconsolidating, use the Set Ledger Consolidated Flag utility to reset the Ledger
Consolidated field. Then delete the data in the ledger and pertot database tables for the corporate
and lower entities, but not for sites. If you do not take these steps before rerunning Ledger
Consolidation, the entity ledger will be out of balance.

Unit Code Mapping

Each unit code is copied to the Reports To entity verbatim if that account in the Reports To entity has
the unit code enabled.

Budget Consolidation

Use the Budget Consolidation utility at the reporting site/entity to consolidate all previously
unconsolidated site budgets and plans through the cutoff date. All entities in the hierarchy that are
senior to the current site must be replicating G/L or Ledger Consolidation data with the current site.
Each budget and plan for each account is consolidated all the way up the hierarchy; the budget and
plan at the current site remains unchanged. For higher level entities, the newly created budgets and
plans are stored using that entity's chart of accounts, base currency, and financial periods.

If a site or entity enters and leaves a hierarchy in the course of a single year, the original budget/plan
will be replaced with the later one.
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Chapter 2: Accounts Payable (A/P)

Accounts Payable Setup
To set up your Accounts Payable system:

1 Define A/P account numbers in the Chart of Accounts form.

The account numbers are needed for all vouchers, adjustments, and payments in Accounts Payable.
The Chart of Accounts must contain all Accounts Payable-related account numbers before
transaction distributions and posting can occur.

2 Define standard accounts for vouchers payable, duty, freight, and so on, using the Purchasing
Parameters form.

3 Set up inventory adjustment and variance accounts using the Product Codes form.

The system uses the inventory adjustment account number for PO receiving transactions. The
variance accounts are the accounts to which you want to assign variance expenses for a group of
items identified by a product code.

4 In the Accounts Payable Parameters form:

• Specify vendor prefixes.

The vendor prefix is used for alphanumeric numbering of vendors. The prefix is automatically
added to the beginning of default vendor numbers for new vendors. If the user overrides the
default value, the prefix is not applied.

• Set up aging parameters, used as the default day range and titles on the AP Aging Report.

Negative numbers represent days until due (the voucher will be due in the future). Positive
numbers represent days past due. The Aging Report can be based on invoice date, due date,
or discount date.

• Set up default accounts for system-generated distributions.
• Specify whether external expense reports are processed by the A/P system.

5 Set up a bank code for each vendor using the Bank Reconciliations form.

Bank codes are defined for each bank your company does business with. Each bank code requires
a general ledger account number. Several bank codes may use the same general ledger cash
account.

6 Set up shipping codes using the Ship Via Codes form.

Ship via codes are required for vendors and are used to reference a method of shipment on an
order.

7 Set up billing terms codes using the Billing Terms form.
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The Billing Terms Code displays on the Vendors or Multi-Site Vendors form and identifies the
default billing terms. The default value can be overridden on the order. Billing terms calculate the
due date, discount date and discount percent (if applicable) when the user provides the invoice
date.

8 Set up payment hold reason codes in the Payment Hold Reasons form.

These codes explain reasons why vendor payment may be held.

Accounts Payable Steps
Accounts Payable (A/P) is the process you use to pay vendors for services and goods contracted for
and delivered. Accounts Payable is closely linked to the purchasing function, where you create and
receive purchase orders, purchase requisitions, blanket purchase orders, and line releases.

The following events are the basic steps for Accounts Payable. See the linked help topics for more
information.

1 Entering a Vendor Record

2 Creating A/P Vouchers or Adjustments on page 95

3 Distributing A/P Vouchers and Adjustments on page 103

4 Creating Recurring Vouchers on page 92

5 Generating Recurring Vouchers on page 106

6 Distributing Recurring Vouchers on page 102

7 Authorizing Vouchers on page 91

8 Printing and Posting Vouchers on page 107

9 Distributing Vendor Payments Manually on page 69

10 Generating Automatic Payments on page 71

11 Using Quick Payment Application on page 86

12 Printing and Posting Checks on page 77

13 Creating Manual Checks on page 68

14 Using Vendor Payment Hold

15 Logging Vendor Communications

16 Posting to the A/P Ledger Distribution Journal on page 73

17 Deleting A/P Posted Payments on page 24

18 Voiding Posted Checks on page 89

19 Activating/Deactivating Posted Transactions

20 Accounts Payable Year End Procedure

21 Purging Voucher History on page 108
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Creating a Debit Memo in A/P
Debit memos for A/P transactions that originated in purchasing must be made in purchasing. So, if you
currently have a voucher in A/P Posted Transactions, follow these steps:

1 Open the Purchase Order Receiving form.

2 Find the PO number.

3 To add the PO line item, click Add. The system displays the Add Receiving Line form.

4 Select the DR Return check box.

5 Enter a positive quantity in the Receive Qty field.

6 Leave the Reject Qty field at 0 (zero).

7 Select a Reason Code.

8 To add the line item, click Add and then click OK. The system returns you to the Purchase Order
Receiving form.

9 Select the line item you added and then, to receive it, click Receive.

These journal entries are created:

• Inventory (Credit)
• Voucher/Payment (Debit)

10 Open the Generate AP Transactions form. The transaction is an adjustment.

11 Select the correct voucher number to create the debit memo. The adjustment is then posted to
A/P Vouchers and Adjustments.

12 Click Generate.

13 Open the A/P Vouchers and Adjustments form and post the negative adjustment to the A/P
Ledger Distribution Journal.

These journal entries are created:

• Voucher/Payment (Credit)
• A/P (Debit)

14 The debit will show as an adjustment on the A/P Posted Transactions Detail form. You can then
match the Vouchers Payable Report to the General Ledger Vouchers Payable Account.

Caution:  Never enter a negative voucher on the A/P Vouchers and Adjustments form to create
a debit memo for Accounts Payable. A debit memo can be tied by the system back to a voucher,
but a voucher cannot be tied back to another voucher (regardless if one is negative).

Deleting A/P Posted Transactions
To void and delete A/P payments that have been posted, use the Delete A/P Posted Transactions
utility. This utility deletes all fully paid vouchers for the selected vendors.

1 Open the Delete A/P Posted Transactions utility form.

2 Specify this information:
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• Through Date: The current system date displays by default, but you can change it to the last
date that a voucher's invoice date can be deleted. If a voucher has a due date that falls after
this date, it will not be deleted, regardless of whether the voucher has been paid.

• Starting Vendor and Ending Vendor: Select the range of vendors whose transactions you
want to delete. To delete transactions for all vendors, leave both these fields blank.

• Purge Non A/P Payments: To delete all non-A/P payments for the selected vendors, select
this check box.

• Preview/Commit:
• To view the results of running the utility without saving the results in the database, select

Preview.
• To save the results in the database, select Commit.

3 Click Process.

Electronic Funds Transfer (EFT)

Setting up Electronic Funds Transfer (EFT) Payments
Electronic funds transfer (EFT) is a common way to process automatic transfer of funds from a company's
bank account to its vendors or employees. SyteLine supports various output file formats for submission
to third-party EFT transmission systems.

Note: Be aware that check numbers are limited to 7 digits for vendor/employee payments with an EFT
Payment Type where the EFT Format set to ALLEFT. You can manually set the check number on the
A/P Payments form.

1 In the Chart of Accounts form, set up any new G/L accounts and unit codes that you will use for
automatic A/P payments.

2 On the General Parameters form, specify your company's Bank Authority Party ID, if your
company does business in countries that require it.

3 On the Countries form, you should already have set up country codes that map to ISO country
codes. You must also set up the Bank Transit Number Mask in this form for each country where
you will transmit electronic banking data. See the help for this field for some examples of the
masking format.

4 On the Bank Reconcilations form, specify information about the banks that you will use for EFT
transactions. This includes your company's bank as well as vendor and employee banks.

• Create a bank code and specify the appropriate information to describe the banks where your
company has accounts. This can include your company’s IBAN number and the currency in
which the bank deals, your company’s BIC number or Bank Authority Party ID, as appropriate.

Your company might have accounts at banks in different regions or in different currencies, to
simplify dealing with vendors and employees in those regions or currencies.

• Create a bank code and specify information to describe each of the banks where your vendors
and employees have accounts. Specify the currency in which each bank deals.
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For vendor’s banks, also specify the appropriate EFT information, which can include the IBAN
number, BIC number or Bank Authority Party ID, as appropriate.

• If your vendors use an Optical Character Recognition (OCR) number in banking, select the
appropriate settings in the OCR Reference Control fields.

5 On the Bank Addresses form, specify at least the bank number and the branch code for each
bank.

6 On the A/P EFT Posting form, specify the format.

7 Use the Bank File Format and Bank Code Bank File Format forms to set up the EFT parameters
for this information:

• EFT format: ALLEFT, BBMEFT, ABAFILE, NACHA PPD, NACHA CCD, SEPA, CPA, CNAB,
or ZENGIN File (JBA).

• Bank code to use for EFT transactions
• Logical folder where the EFT output files will be stored
• User name and user number, which is needed only for the ABAFILE format
• Destination ID and Origination ID, which are needed only for the NACHA and CPA formats
• Company ID, which is needed only for the NACHA format
• Whether to use the default account. This is needed only for the CPA format.
• Registration number, which is needed only for the CNAB format

After EFT processing has begun, this tab also shows the last date an EFT file was created, and
the name (number) of that file.

8 In the Remittance Advice area to the right of the EFT parameters, indicate whether you want to
print remittance advice after posting EFT transactions.

9 On the Vendors or Multi-Site Vendors form, set up EFT information for the individual vendors.

This information includes the Bank Code for your company's bank account that you will use for
automatic payments; the Payment Type, and the Vendor Bank code that describes the vendor's
bank account that will receive payments from your bank account.

If the vendor's default payment type is EFT, specify this information, depending on the EFT format
that you use:

• For ABAFILE, specify the bank account, the bank's EFT (sort) number, and the account name.
• For ALLEFT and BBMEFT, specify the bank account and the bank's EFT (sort) number.
• For CNAB, specify the transit reference, EFT (sort) number, and the account name.
• For CPA, specify the bank account, the transit reference, EFT (sort) number, and the account

name.
• For NACHA PPD and NACHA CCD, specify the bank name, transit reference, and bank

account.
• For SEPA, specify the international bank account number (IBAN).

For vendors in countries where this is a requirement, specify the Bank Authority Party ID.

If a Remit To Vendor is set for the vendor, then EFT information must also be set up for the Remit
To Vendor.

10 On the Employees form, in the Direct Deposit section, specify appropriate banking information for
employees who can receive automatic payments. The information that you must supply depends
on the requirements of the banking authority.

For posting steps, see Posting Electronic Funds Transfer Transactions on page 27.
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Posting Electronic Funds Transfer Transactions
Note: Ensure that users who perform the Final Register and Post, or who print the Remittance Advice,
have permission to write to the output directory for the EFT files. If you run either process successfully,
and no file is created, check the permissions on the directory.

To post electronic funds transfer (EFT) transactions and to create the EFT output file:

1 Before posting,select the A/P EFT Posting Report option on the A/P EFT Posting  form.

This option produces a list of the EFT payments that will be posted. The grid at the bottom of the
form also displays the list of items that will be posted. Review these lists.

2 After printing the report, to begin the posting process, select the Final Register and Post option.

This step also creates the EFT payments output file, using information from fields on the Bank
File Format form. The system:

• Writes the file in the format specified by the EFT Format field.
• Writes payment records to this file, which has an incrementally numbered filename (continuing

from the number in the Last EFT File field).
• Places the file in the logical folder specified in the Logical Folder field.

Note: Click the Files button on the A/P EFT Posting form to view or download the output file
from the logical folder.

• Creates the EFT Output File Report. This report logs all output EFT records.

3 Optionally, select the Print Remittance Advice option and then click Process to print remittance
advice,

Note:  If the EFT option for Remittance Advice is selected on the Accounts Payable Parameters
form, you must also select Print Remittance Advice.

To have the remittance advice statement processed for print, fax, or email on a vendor-by-vendor basis,
also select the Use Profile check box.

When you post an EFT payment and distribution, a Bank Reconciliations record stores the payment.
The system marks the record as Not Voided.

EFT Output Files
This topic describes EFT output filenames. See the format topics for more information.

About EFT Output Filenames

If the EFT format is ALLEFT or BBMEFT, the filename is incremented each time the post process is
run, so the file is never overwritten.

If the EFT format is ABAFILE, CNAB, CPA,  NACHA or SEPA, the filename format is EFT + day +
month + year + hour + minutes + seconds + the file extension (.aba, .dat, .txt or .xml), so the file is
never overwritten.
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Format

The format of the EFT output file depends on the value of the EFT Format field on the Accounts
Payable Parameters form. See these topics for information about the file formats:

• ABAFILE Format on page 28
• ALLEFT Format on page 31
• BBMEFT Format on page 31
• CNAB Format on page 32
• CPA Format on page 40
• NACHA Format on page 44
• SEPA Format on page 59

The Zengin (JBA) EFT file is also supported.

ABAFILE EFT Output Format
For full details of the ABAFILE format, contact the Australian Bankers Association. The following tables
show field size and justification.

ANZ,NAB, and WBC all use the standard ABA file format. These banks use transaction code 50 or 13
depending on if the payment is a debit or credit.

ABAFILE (ANZ, NAB, WBC)

Standard Record Type 0

Value or NotesLengthStarting
Position

Name

011Record Type 0

Must be blank-filled172Blank

01219Reel Sequence Number

bank_addr_mst.bank_code

Must be an approved financial institution
abbreviation

321User Financial Institution

Must be blank-filled724Blank

apparms_mst.EFT_user_name

Must not be all blanks

2631User preferred name of user
supplying file

apparms_mst.EFT_user_number

Must be User Identification Number as-
signed by APCA and User Financial Institu-
tions. Must be numeric. Right justified. Zero
filled

657User Identification Number of
user supplying file

"VENDOR PMT"1263Description of file contents
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Value or NotesLengthStarting
Position

Name

Today()

The date when transactions are released
to all financial institutions

675Date to be processed

Must be blank-filled.4081Blank

Standard Record Type 1

Value or NotesLengthStarting
Position

Name

111Record Type 1

vendor_mst.EFT_bank_num

Format ###-###

72BSB Number

vendor_mst.account99Account number

blank118Indicator

13 or 50219Transaction Code

glbank_mst.check_amt1021Amount

parms_mst.company3231Title of Account

glbank_mst.ref_num+'-
'+glbank_mst.check_num

1863Reference

bank_addr_mst.bank_number

Format ###-###

781BSB Number

bank_hdr_mst.branch_code988AccountNumber

parms_mst.company1697Name of Remitter

000000008113Amount of withholding Tax

ABAFILE (HSBC, Bankwest)

These banks use the records above, but in addition to those standard records, they request one last
record of Type 1 (Transaction Code = 13) that totals all the payments into one credit record with the
format shown here:

Value or NotesLengthStarting
Position

Name

111Record Type 1

bank_addr_mst.bank_number

Format ###-###

72BSB Number

Infor SyteLine Financials User Guide | 29

 

Accounts Payable (A/P)



Value or NotesLengthStarting
Position

Name

bank_hdr_mst.branch_code99Account number

blank118Indicator

13219Transaction Code

dbl_NegativeAmtTotal1021Amount

parms_mst.company3231Title of Account

"Creditor Payments"1863Reference

bank_addr_mst.bank_number

Format ###-###

781BSB Number

bank_hdr_mst.branch_code988AccountNumber

parms_mst.company1697Name of Remitter

000000008113Amount of withholding Tax

ABAFILE (CBA)

This bank uses the standard formats shows above, but it requires two records for each transaction
(Transaction Code = 50 followed by this one with Transaction Code = 13):

Value or NotesLengthStarting
Position

Name

111Record Type 1

bank_addr_mst.bank_number

Format ###-###

72BSB Number

bank_hdr_mst.branch_code99Account number

blank118Indicator

13219Transaction Code

DomCheckAmt1021Amount

parms_mst.company3231Title of Account

"Payment"1863Reference

bank_addr_mst.bank_number

Format ###-###

781BSB Number

bank_hdr_mst.branch_code988AccountNumber

parms_mst.company1697Name of Remitter

000000008113Amount of withholding Tax
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ALLEFT EFT Output Format
This table shows the ALLEFT EFT output format:

FormatDescriptionDatabase Table and Column

99-99-99Vendor bank sort codevendor_mst.EFT_bank_num

99999999EFT bank account numbervendor_mst.account

9Always set to zeroN/A

string of length 18vendor name, or vendor
account name. This is refer-
ence information.

first 18 characters of vendor_mst.ac-
count_name if not null; else first 18
characters of vendaddr_mst.name

decimal, length 8, padded
on left with blanks, always 2
digits after the decimal point
(maximum 99999.99)

Payment amountSum of all appmtd_mst.dom_amt_paid
if the vendor's currency code = cur-
rparms_mst.curr_code for a payment;
else sum of all
apppmtd_mst.for_amt_paid for a pay-
ment

string of length 7, padded on
left with blanks

Check numberappmt_mst.check-num

Note:  There are no spaces except as specified and each EFT output file line corresponds to one
payment record.

If the payment amount is greater than 99999.99, then ?????.?? is written to the output file, and a line
displaying the error is written to an error file (generated in the same directory as the output file).

11-22-33100200320Bicycle Parts Comp   10.00      1 
11-22-33100200320Bicycle Parts Comp   20.00      2 

BBMEFT EFT Output Format
This table shows the output format:

FormatDescriptionDatabase Table and Column

99-99-99Vendor bank sort codevendor_mst.EFT_bank_num

','SeparatorN/A

string, length 18vendor name, or vendor ac-
count name. This is refer-
ence information.

first 18 characters of vendor_mst.ac-
count_name if not null; else first 18
characters of vendaddr_mst.name

','SeparatorN/A
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FormatDescriptionDatabase Table and Column

string of length 10, leading
spaces converted to zeros
and decimal point re-
moved

Payment amountSum of all appmtd_mst.dom_amt_paid
if the vendor's currency code = cur-
rparm_msts.curr_code for a payment;
else sum of all
apppmtd_mst.for_amt_paid for a pay-
ment

'EFT'Always set to 'EFT'N/A

integer, field as long as
required for number

check numberappmt_mst.check-num

integerAlways set to '99'N/A

'/'SeparatorN/A

Note:  There are no spaces except as specified and each EFT output file line corresponds to one
payment record. Use '/' to delimit the end of each record.

11-22-33,Bicycle Parts Comp,10020032,0000001500,EFT7,99/ 
11-22-33,Bicycle Parts Comp,01234568,0000002000,EFT82,99/ 

CNAB EFT Output Format
The Header and Footer records are the outer "envelope" of the transaction. The Batch Header and
Batch Footer records act as an inner envelope.

Each record ends with a carriage control (line break) character.

Header Record

Field or NotesFormatLengthPosi-
tion

Field Description

bank_addr_mst.bank_number

This is the bank that will receive the
file.

Numeric31Bank code in
Compensation
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Field or NotesFormatLengthPosi-
tion

Field Description

Sequential number to uniquely identify
a lot of service. Created and managed
responsible for generating the magnet-
ic data in the file. Fill with '0001 'for the
first batch file. For the others: use the
batch number plus 1. The number must
not be duplicated within the file. If the
File Header record is complete, use
'0000. If the file trailer record is com-
plete, use '9999 '.

Numeric44Batch service

'0'Numeric18Record type

BlanksAlphanumeric99Use Unique
FEBRA-
BAN/CNAB

1 - for CPF  2 - for CNPJ.Numeric118Type of Company
Registration

apparms_mst.registration_number>Numeric1419Company registra-
tion number

Fill with "0009999990126    ", where
999999 is the number of the Covenant
for payment, right-aligned with leading
zeros, followed by "0126" for payment
and other positions with blanks
(spaces).

Alphanumeric2033Code of the
Covenant in the
database

bank_addr_mst.branch_codeNumeric553Agency Sponsor
of Account

Code adopted by the Bank responsible
for the current account, to verify authen-
ticity of the Code of the Agency.

Alphanumeric158Check digit of the
Agency

bank_hdr_mst.bank_acct_noNumeric1259Current account
number

Code adopted by the responsible bank
account to verify the authenticity of
Current  Account Number. For banks
that make use of two positions for the
Check Digit Number Current Account,
fill this field with the 1st position of this
digit.

Example:Number Current Account =
45981-36

In this case Account Check Digit = 3

Alphanumeric171Digit account
Checker
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Field or NotesFormatLengthPosi-
tion

Field Description

BlankAlphanumeric172Check digit of
AG/Account

parms_mst.companyAlphanumeric3073Name of company

bank_hdr_mst.nameAlphanumeric30>103Name of bank

BlanksAlphanumeric10133Use Unique
FEBRA-
BAN/CNAB

1Numeric1143Shipping/Return
Code

GetCurrentDate()Numeric8144File generation
date

GetCurrentTime()Numeric6152File generation
time

apparms_mst.EFT_fileNumeric6158File sequence
number

083Numeric3164No version of the
file layout

Zeros or blanksNumeric5167File Recording
density

Text of remarks intended for the exclu-
sive use of the Bank.

Alphanumeric20172To Use Reserved
seat

Text of remarks intended for the exclu-
sive use of the Company.

Alphanumeric20192Company re-
served

Text of remarks intended for the sole
use of FEBRABAN. Fill with blanks.

Alphanumeric29212Use Unique
FEBRABAN/CN-
ABe

Batch Header Record

Field or NotesFormatLengthPosi-
tion

Field Description

bank_addr_mst.bank_numberNumeric31Bank code in
Compensation
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Field or NotesFormatLengthPosi-
tion

Field Description

Sequential number to uniquely identify
a lot of service. Created and managed
responsible for generating the magnet-
ic data in the file. Fill with '0001 'for the
first batch file. For the others: use the
batch number plus 1. The number must
not be duplicated within the file. If the
File Header record is complete, use
'0000. If the file trailer record is com-
plete, use '9999 '.

Numeric44Batch service

1Numeric18Record type

CAlphanumeric19Type of operation

20Numeric210Service type

03Numeric212Release form

042Numeric314Version number
of lot Layout

BlanksAlphanumeric117Use Unique
FEBRA-
BAN/CNAB

2Numeric118Type of Company
Registration

apparms_mst.registration_numberNumeric1419Registration num-
ber of company

 Alphanumeric2033Code of the
Covenant in the
database (subdi-
vided below)

apparms_mst.ach_origin_id 933No payment of
the Covenant

0126 442 

Blanks 546 

  251 

bank_addr_mst_mst.branch_codeNumeric553Agency Sponsor
account
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Field or NotesFormatLengthPosi-
tion

Field Description

Code adopted by the responsible bank
account to verify the authenticity of
Current Account Number. For banks
that make use of two positions for the
Check Digit Number Current Account,
fill this field with the 1st position of this
digit.

Example:

Number C / C = 45981-36

In this case Account Check Digit = 3

Alphanumeric158Digit account
Checker

bank_hdr_mst.bank_acct_noNumeric1259Current account
number

same as aboveAlphanumeric171Digit account
Checker

 Alphanumeric172Check digit of
Ag/Account

parms_mst.companyAlphanumeric3073Name of company

 Alphanumeric40103Message 1

 Alphanumeric30143Street name

 Numeric5173Local number

 Alphanumeric15178Home, Apartment,
Room, Etc

 Alphanumeric20193City name

 Numeric5213CEP

 Alphanumeric3218Add-on of the
CEP

 Alphanumeric2221Abbreviation of
the State

 Alphanumeric8223Use Unique
FEBRA-
BAN/CNAB

 Alphanumeric10231Code of Occur-
rences for return
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Segment A

Field or NotesFormatLengthPosi-
tion

Field Description

bank_addr_mst.bank_numberNumeric31Bank code in
Compensation

(From Batch Header record) 0001+Numeric44Batch service

3Numeric18Record type

00001+Numeric59No record in the
batch Sequence

AAlphanumeric114Thread registry
Detail

0Numeric115Entry type

00Numeric216Code instruction
for movement

IF(appmt_mst.for_check_amt < 5000,
700, 018)

Numeric318Code Coordinat-
ing Board

vendor_mst.EFT_bank_numNumeric321Payee Bank code

First 5 chars of vendor_mst.transitNumeric524Agency Sponsor
of the payee's Ac-
count

Code adopted by the Bank responsible
for the current account, to verify authen-
ticity of the Code of the Agency.

Alphanumeric129Check digit of the
Agency

vendor_mst.accountNumeric1230Current account
number

Code adopted by the responsible bank
account to verify the authenticity of
Current Account Number. For banks
that make use of two positions for the
Check Digit Number Current Account,
fill this field with the 1st position of this
digit.

Example:

Number C / C = 45981-36

In this case Account Check Digit = 3

Alphanumeric142Digit account
Checker

Infor SyteLine Financials User Guide | 37

 

Accounts Payable (A/P)



Field or NotesFormatLengthPosi-
tion

Field Description

Code adopted by the Bank responsible
for the current account, to verify authen-
ticity of the pair Branch Code / Account
Number Current. For banks that make
use of two positions for the Check
Digit Number Current Account, fill this
field with the 2nd position of this digit.

Example:

Number C / C = 45981-36

Alphanumeric143Check digit of
AG/Account

Name OR VadRName = vendad-
dr_mst.name

Alphanumeric3044Payee name

ppmt_mst.check_num (74-79)

 + 

(From Batch Header record) 0001+
(80-85)

+

apparms_mst.EFT_file (86-93)

Alphanumeric2074Document Num-
ber Assigned for
Company

appmt_mst.check_dateNumeric894Date of payment

vendor_mst.curr_codeAlphanumeric3102Currency type

if Currency type = BRL (000)Numeric10105Currency amount

appmt_mst.for_check_amtNumeric13120Payment amount

 Alphanumeric20135Document Num-
ber Assigned by
the Bank

00000000Numeric8155Actual date of
Payment Effectua-
tion

0000000000000Numeric13163Actual value of
the identifiable
Pay

 Alphanumeric40178Other information.
Salaries of
servers by SIAPE

07Alphanumeric2218Supplement Ser-
vice Type

 Alphanumeric5220TED's purpose
code
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Field or NotesFormatLengthPosi-
tion

Field Description

 Alphanumeric2225Add-on pay pur-
pose.

 Alphanumeric3227Use Unique
FEBRA-
BAN/CNAB

0Numeric1230Notice to the Pay-
ee

 Alphanumeric10231Codes of Occur-
rences p/return

Batch Footer

Field or NotesFormatLengthPositionField Description

bank_ad-
dr_mst.bank_num-
ber

Numericwidth="40">3width="56">1Bank code in Compensation

0001+Numeric44Batch service

5Numeric18Record type

BlanksAlphanumeric99Use Unique FEBRA-
BAN/CNAB

Add Record types
(1,3,5)

Numeric618Amount of batch Records

SUM()Numeric1624Sum of the values

SUM()Numeric1342Sum of amount of Coins

 Numeric660Debit Notice number

BlanksAlphanumeric16566Use Unique FEBRA-
BAN/CNAB

 Alphanumeric10231Return codes of occurrences
for

Footer

Field or NotesFormatLengthPositionField Description

bank_ad-
dr_mst.bank_num-
ber

Numeric31Bank code in Compensation

9999Numeric44Batch Service
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Field or NotesFormatLengthPositionField Description

9Numeric18record type

BlanksAlphanumeric99Use Unigue FEBRABAN/CNAB

SUM()Numeric618Amount of lots in File

SUM()Numericv624Amount of file records

000000Numeric630Number of Accounts for Concili-
ation (Lots)

BlanksAlphanumeric20536Use Exclusivo FEBRA-
BAN/CNAB

CPA EFT Output Format
The Header and Trailer records are the outer "envelope" of the transaction. The Detail records act as
an inner envelope combining similar entries.

Each record ends with a carriage control (line break) character.

Header Record

Field or NotesFormatLengthPosi-
tion

Field Description

bank_hdr_bank_file_fmt_mst.a
ch_origin_id

This is the number assigned by the
bank for EFT accounts.

Alphanumeric1011-20Originator's ID

bank_file_fmt_mst.last_file

The file creation number must incre-
ment by one from one file to the next.

Numeric421-24File Creation No.

GETCurrentDate(CYYDDD)

C=0 YY=10 for 2010 DDD=Year Day

Numeric625-30Creation Date

bank_hdr_bank_file_fmt_mst.a
ch_dest_id

This is the bank's institution ID.

Numeric531-35Destination Data
Centre

BlankAlphanumeric2036-55Reserved Cus-
tomer-Direct
Clearer Communi-
cation area

vendor_mst.curr_codeAlphanumeric356-58Currency Code
Identifier
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Field or NotesFormatLengthPosi-
tion

Field Description

BlankAlphanumeric140659-
1464

Filler

Detail Record

Field or NotesFormatLengthPosi-
tion

Field Description

C = Credit Payment

D = Debit Payment

Alpha11Logical Record
Type ID

Count()

Increment by 1 from field 02 in the
Header record

Numeric92Logical Record
Count

bank_hdr_bank_file_fmt_mst.a
ch_origin_id

This is the number assigned by the
bank for EFT accounts.

Alphanumeric1011Origination Con-
trol Data

bank_file_fmt_mst.last_file

Must be the same as the field in the
Header record

Numeric421File Create Num-
ber

450

CPA transaction code

Numeric325CPA Code

appmt_mst.for_check_amt

Amount of EFT transaction, format
$$$$$$$$cc No commas or decimal
points. Right justified

Numeric1028Amount

0 (no change in turn of century)>Numeric138Due Date Centry

GetYear()>Numeric>239Due Date Year

GetDay()Numeric341Due Date Day

vendor_mst.EFT_bank_num

Institution ID

Numeric444Financial Institu-
tion Number

vendor_mst.transit

Branch or transit number.

Numeric548Financial Institu-
tion Branch Num-
ber

vendor_mst.account

Field must be left justified, do not zero
fill. Enter significant digits only

Alphanumeric1253Account Number
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Field or NotesFormatLengthPosi-
tion

Field Description

0000000000000000000000Numeric2265Item Trace Num-
ber

000Numeric387Stored Trans
Type

bank_hdr_bank_file_fmt_mst.u
ser_name

Your company's name for participant's
statements.  This appears on most
bank statements. Do not enter zeros
in the field.

Alphanumeric1590Short Name

Name OR VadRName = vendad-
dr_mst.name

Vendor or Remit To Vendor Name

Alphanumeric30105Transaction Pay-
ee/ Payor name

Alphanumeric30135Name 

BlankAlphanumeric10165Eft Originator ID

appmt_mst.vend_num + "-" + a
ppmt_mst.check_num

Optional reference field

Alphanumeric19175Transaction Origi-
nation Xref

The element is formatted as

(a) (b) (c)

9 999 99999

where (a) = constant zero

(b) = bank number (bank_ad-
dr_mst.bank_number)

(c) = branch or transit number (bank_
addr_mst.branch_code)

If Use Default Account is not selected
on the Bank Code Bank File Format
form, this value contains bank_ad-
dr_mst.bank_number + bank_ad-
dr_mst.branch_code. If Use Default
Account is selected, this value contains
all zeros.

Numeric9194Transaction Re-
turn Financial Insti-
tution

bank_hdr_mst.bank_acct_no

If Use Default Account is not selected
on the Accounts Payable Parameters
form, this field is required; if not then
leave blank

Alphanumeric22203Transaction return
Account
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Field or NotesFormatLengthPosi-
tion

Field Description

BlankAlphanumeric15215Originator's
Sundry Info

BlankAlphanumeric22230Stored Trace
Number

BlankAlphanumeric2252Settlement Code

00000000000Numeric11254Invalid Data Ele-
ment

Trailer Record

Field or NotesFormatLengthPosi-
tion

Field Description

ZAlpha11Record Type

Count()

Increment by 1 from previous record
sequence number

Numeric92Record Se-
quence/Count

bank_hdr_bank_file_fmt_mst.a
ch_origin_id

Must be the same as in the Header
record

Numeric1011EFT Originator

bank_file_fmt_mst.last_file

Must be the same as in the Header
record.

Numeric421File Create Num-
ber

00000000000000

Amount of debit payment transactions
(type D). Right-justify with leading ze-
ros. Format $$$$$$$$$$$$cc

Numeric1425Value of debits

00000000

Total number of debit payment transac-
tions (Type D). Right-justify with lead-
ing zeros.

Numeric839Number of debits

Sum()

Amount of credit payment transactions
(Type C). Righ- justify with leading ze-
ros. Format $$$$$$$$$$$$cc

Numeric1447Value of credits
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Field or NotesFormatLengthPosi-
tion

Field Description

Sum()

Total number of debit payment transac-
tions (Type C). Right-justify with lead-
ing zeros.

Numeric861Number of credits

0Numeric1469Total Value of Er-
ror Corrections 'E'

0Numeric883Total Number of
Error Corrections
"E"

0Numeric1491Total Value of Er-
ror Corrections
"F"

0Numeric8105Total Number of
Error Corrections
"F"

NACHA EFT Output Format
The NACHA file format is composed of 94-character records.

The File Header and File Control records are the outer "envelope" of the transaction. The Batch Header
and Batch Control records act as an inner envelope combining similar entries.

Note: ACH File output format is used for payments from a US company with a domestic currency of
USD to a US vendor. If the company domestic currency does not equal USD, then an IAT record is
included in the EFT output for NACHA format.

Records can be formatted using the file structures described in these topics:

• NACHA ACH File Output Format on page 44
• NACHA IAT File Output Format on page 50

NACHA ACH File Output Format
ACH records are used when NACHA payments are sent domestically within the United States.
Note: ACH File output format is used for payments from a US company with a domestic currency of
USD to a US vendor. If the company domestic currency does not equal USD, then an IAT record is
included in the EFT output for NACHA format.

See NACHA IAT File Output Format on page 50.

Each record ends with a carriage control (line break) character.
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File Header Record

This record includes your company name and company number. It also designates the immediate
destination of the entries in the file.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 1. This identifies the file
header record.

 11Record Type
Code

Value is 01. The lower the number, the
higher the processing priority. Current-
ly, only 01 is used.

 22Priority Code

Not used.Blank14Filler

bank_hdr_bank_file_fmt_mst.a
ch_dest_id - Bank's transit routing
number

Fill with zeros to
the left

95Destination ID

bank_hdr_bank_file_fmt_mst.a
ch_co_id - Company number. The
use of an IRS federal tax ID number is
recommended. The company ID is
displayed in the output with leading
zeros.

Left-justified1014Company ID

dbo.getsitedate - Date the input file
was created.

YYMMDD624Creation Date

dbo.getsitedate - Time of day the input
file was created.

HHMM430Creation Time

Initial value is A. This is a code to dis-
tinguish between multiple input files. If
more than one file is delivered, they
must have different file IDs.

Uppercase A-Z
Numeric 0-9

134File ID

Value is 094 - Number of bytes per
record.

 335Record Size

Value is 10. 238Blocking Factor

Value is 1. 140Format Code

bank_hdr_mst.name - Name of
bank. Form field is 60 characters, but
is truncated here to 23.

Left-justified2341Destination Name

parms_mst.company - Name of your
company. Form field is 60 characters,
but is truncated here to 23.

Left-justified2364Company Name

Not used.Blanks887Filler
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Note:  There is a space between the File Header Company Name and the Batch Header Record Code.

Batch Header Record

This record contains the effective entry (transaction) date, which is the date the deposits will be settled.
The record also identifies your company and contains an entry description for debits and credits in this
batch.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 5. This identifies the batch
header record.

 11Record Type
Code

This value identifies the type of entries
in the batch:

• 200 identifies the type of entries in
the batch as mixed debits and
credits.

• 220 indicates that only credits are
contained in this batch.

• 225 indicates that only debits are
contained in this batch.

 32Service Class
Code

parms_mst.company - Form field is
60 characters, but is truncated here to
16.

Left-justified, al-
phanumeric

165Company Name

Not used.Blanks2021Filler

bank_hdr_bank_file_fmt_mst.a
ch_co_id - Company number. Value
is the same as Company in the file
header record, unless multiple compa-
nies or divisions are sent in one trans-
mission. The company ID is displayed
in the output with leading zeros.

Left-justified, al-
phanumeric

1041Company ID

Value is PPD. This identifies the entries
in the class. The standard entry class
used here is Prearranged Payments
and Deposit entries.

Alphabetic351Entry Class

Value is Vouchers. This is a description
of the transaction that may be printed
on the receiver's bank statement.

Left-justified, al-
phanumeric

1054Entry Description

dbo.getsitedate. This is the current
date, which is used to identify the
transactions. It may be printed on the
receiver's bank statement.

MMDDYY664Company Descrip-
tive Date
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Field or NotesFormatLengthPosi-
tion

Field Description

dbo.getsitedate. This is the current
date, which is used to post the transac-
tions.

YYMMDD670Effective Entry
(Transaction)
Date

Not used.Blanks376Filler

Value is 1. This identifies the bank as
a depository financial institution bound
by the rules of the ACH.

 179Originator Status
Code

bank_hdr_bank_file_fmt_mst.a
ch_orig_id - The transit routing
number of the originating financial insti-
tution.

Fill with zeros to
left

880Originating ID

Initial value is 1. Number batches se-
quentially.

Fill with zeros to
left

788Batch Sequence
Number

PPD Detail Record

This record contains the information needed to post a deposit to an account, such as the receiver's
name, account number, and payment amount.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 6. This identifies a detail entry
record.

 11Record Type
Code

Identifies the account type at the receiv-
ing financial institution as a deposit
destined for a checking account.

Numeric22Transaction Code

vendor_mst.transit - Transit
routing number of the receiver's finan-
cial institution.

Fill with zeros to
left

84Detail Transit

The ninth digit of the receiving financial
institution's transit routing number,
calculated by SyteLine.

Numeric112Check Digit

vendor_mst.account - Receiver's
bank account number.

Left-justified, al-
phanumeric

1713Account Number

DerDomAmtApplied * 100 - Transac-
tion amount in dollars with two decimal
places

Fill with zeros to
left (no decimal
point)

1030Amount

vendor_mst.vend_num - This vendor
number may be printed on the receiv-
er's bank statement.

Left-justified, al-
phanumeric

1540Vendor ID
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Field or NotesFormatLengthPosi-
tion

Field Description

vendaddr_mst.name - Form field is
60 characters, but is truncated here to
22.

Left-justified, al-
phanumeric

2255Vendor Name

Not used.Blanks277Filler

Value is 0 - Indicates no addenda
records for this transaction.

Numeric179Addenda

bank_hdr_bank_file_fmt_mst.a
ch_orig_id - This value is the origi-
nation ID of the receiver's bank.

Fill with zeros to
left

880Detail Orig ID

Initial value is 1. This value increments
for every payment record.

Fill with zeros to
left

788Detail Sequence

Note:  The optional Entry Detail Addenda record is not included with SyteLine A/P EFT files. There
are line breaks (carriage return characters) between each detail record.

Batch Control Total

This record appears at the end of each batch. It holds totals for the batch.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 8. This identifies a batch con-
trol total record.

 11Record Type
Code

This value identifies the type of entries
in the batch:

• 200 identifies the type of entries in
the batch as mixed debits and
credits.

• 220 indicates that only credits are
contained in this batch.

• 225 indicates that only debits are
contained in this batch.

Numeric32Service Class

Total number of detail records pro-
cessed in the batch.

Numeric. Fill with
zeros to left

65Entry Count

Value is calculated by SyteLine.Numeric1011Entry Hash

Dollar total of debit entries in the batch.Numeric. Fill with
zeros to left

1221Total Debit
Amount

Sum of DerDomAmtApplied for each
payment *100. This is the dollar total
of credit entries in the batch.

Numeric. Fill with
zeros to left

1233Total Credit
Amount
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Field or NotesFormatLengthPosi-
tion

Field Description

bank_hdr_bank_file_fmt_mst.a
ch_co_id - This should match the
Company ID used in the batch header.
The company ID is displayed in the
output with leading zeros.

 1045Company ID

Not used.Blanks2555Filler

bank_hdr_bank_file_fmt_mst.a
ch_orig_id - This should be the
originating bank's routing number.

Numeric. Fill with
zeros to left

880Origination ID

Initial value is 1. This indicates the
number of the batch associated with
the control record.

Numeric. Fill with
zeros to left

788Sequence

File Control Records

This record provides a final check on the submitted data. It contains block and batch counts and totals
for each type of entry.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 9. This identifies a file control
record.

 11Record Type
Code

Initial value is 1. This is the total num-
ber of batch header records in the file.

Numeric. Fill with
zeros to left

62Batch Count

The system calculates the number of
detail records, plus all header and
control records, and divides by 10 to
get the block count. If there is a remain-
der, it adds 1 to the block count.

Numeric. Fill with
zeros to left

68Block Count

This is the total number of detail
records in the file.

Numeric. Fill with
zeros to left

814Entry Count

Value is calculated by SyteLine.Numeric. Fill with
zeros to left

1022Entry Hash

Dollar total of debit entries in the file.Numeric. Fill with
zeros to left

1232Total Debit

Sum of DerDomAmtApplied for every
payment * 100. This is the dollar total
of credit entries within the file.

Numeric. Fill with
zeros to left

1244Total Credit

Leave this reserved field blank.Blanks3956Reserved
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NACHA IAT File Output Format
NACHA IAT records are used when payments are sent to a foreign country.
Note: ACH File output format is used for payments from a US company with a domestic currency of
USD to a US vendor. If the company domestic currency does not equal USD, then an IAT record is
included in the EFT output for NACHA format.

See NACHA ACH File Output Format on page 44.

Each record ends with a carriage control (line break) character.

File Header Record

This record includes your company name and company number. It also designates the immediate
destination of the entries in the file.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 1. This identifies the file
header record.

 11Record Type
Code

Value is 01. The lower the number, the
higher the processing priority. Current-
ly, only 01 is used.

 22Priority Code

bank_hdr_bank_file_fmt_mst.a
ch_dest_id - Bank's transit routing
number There is a space between Pri-
ority Code and Destination ID.

Fill with zeros to
the left

104Destination ID

bank_hdr_bank_file_fmt_mst.a
ch_co_id - Company number. The
use of an IRS federal tax ID number is
recommended. The company ID is
displayed in the output with leading
zeros.

Left-justified1014Company ID

dbo.getsitedate - Date the input file
was created.

YYMMDD624Creation Date

dbo.getsitedate - Time of day the input
file was created.

HHMM430Creation Time

Initial value is A. This is a code to dis-
tinguish between multiple input files. If
more than one file is delivered, they
must have different file IDs.

Uppercase A-Z
Numeric 0-9

134File ID

Value is 094 - Number of bytes per
record.

 335Record Size

Value is 10. 238Blocking Factor

Value is 1. 140Format Code
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Field or NotesFormatLengthPosi-
tion

Field Description

bank_hdr_mst.name - Name of
bank. Form field is 60 characters, but
is truncated here to 23.

Left-justified2341Destination Name

parms_mst.company - Name of your
company. Form field is 60 characters,
but is truncated here to 23.

Left-justified2364Company Name

vbNewLine or vbCLf   Return

Note:  There is a space between the File Header Company Name and the Batch Header Record Code.

Batch Header Record  IAT

This record contains the effective entry (transaction) date, which is the date the deposits will be settled.
The record also identifies your company and contains an entry description for debits and credits in this
batch.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 5. This identifies the batch
header record.

There is a space between the Compa-
ny Name and the Batch Header Record
Type.

 11Record Type
Code

This value identifies the type of entries
in the batch:

• 200 identifies the type of entries in
the batch as mixed debits and
credits.

• 220 indicates that only credits are
contained in this batch.

• 225 indicates that only debits are
contained in this batch.

 32Service Class
Code

parms_mst.company - Form field is
60 characters, but is truncated here to
16.

Blanks165Company Name 

Value is FF. There is no foreign ex-
change conversion for entries transmit-
ted using this code.

 221Foreign Exchange
Indicator

Value is 3. Transaction does not use
foreign exchange.

 123Foreign Exchange
Reference Indica-
tor
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Field or NotesFormatLengthPosi-
tion

Field Description

 Space filled 24Foreign Exchange
Reference

vendaddr_mst.country. Use ISO
country codes.

 239ISO Destination
Country Code

If a person is not originating the batch,
this field must contain the IRS Taxpay-
er Identification number (TIN) of the
originators specified in the Originator
Name field.  NACHA rules do not indi-
cate whether an alpha or number pre-
fixing the TIN is acceptable.  NACHA
has recommended that third-party
senders initiating an IAT transaction
on behalf of another part use this field
for the third-party sender's TIN.

fill 0 to left1041Originator ID

Value is IAT.Alphabetic351Entry Class

Value is Vouchers. This is a description
of the transaction that may be printed
on the receiver's bank statement.

Left-justified, al-
phanumeric

1054Entry Description

USD 364ISO Orig Curr
Code

USD 367ISO Dest Curr
Code

dbo.getsitedateMMDDYY670Date

Leave blank.Blank 76Settlement Date

Value is 1. This identifies the bank as
a depository financial institution bound
by the rules of the ACH.

There are 3 spaces between the
Transaction Date and the Originator
Status.

 179Originator Status
Code

bank_hdr_bank_file_fmt_mst.a
ch_orig_id - The transit routing
number of the originating financial insti-
tution.

Fill with zeros to
left

880Originating ID

Initial value is 1. Number batches se-
quentially.

Fill with zeros to
left

788Batch Sequence
Number

vbNewLine or vbCLf   Return
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IAT Detail Record

This record contains the information needed to post a deposit to an account, such as the receiver's
name, account number, and payment amount.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 6. This identifies a detail entry
record.

 11Record Type
Code

Identifies the account type at the receiv-
ing financial institution as a deposit
destined for a checking account. If
DerDomAmtApplied > 0 then the value
is 22 or 32; otherwise it is 27 or 37,
depending on whether the vendor ac-
count is checking or savings.

Numeric22Transaction Code

vendor_mst.transit - Transit routing
number of the receiver's financial insti-
tution.

Fill with zeros to
left

84Detail Transit

The ninth digit of the receiving financial
institution's transit routing number,
calculated by SyteLine.

Numeric112Check Digit

7. This number represents the number
of addenda records associated with
each Entry Detail record.

 413Num Addenda
Records

 Blanks1317Filler

DerDomAmtApplied * 100 - Transac-
tion amount in dollars with two decimal
places

Fill with zeros to
left (no decimal
point)

1030Amount

vendor_mst.account - Receiver's bank
account number.

Left-justified3540Account Number

 Blanks275Filler

 Blanks177Filler

 Blanks178Filler

Value is 1 - Indicates that addenda
records exist for this transaction.

Numeric179Addenda

vendor_mst.transit + #.  First 8
digits is vendor transit number; the last
7 digits must be incremented by 1 for
each Detail record.

   Trace Number

vbNewLine or vbCLf   Detail Addenda
Record Indicator
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Note:  The optional Entry Detail Addenda record is not included with SyteLine A/P EFT files. There
are line breaks (carriage return characters) between each detail record.

First IAT Addenda Record

This record contains addenda.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 7. 11Record Type
Code

Value is 10. 22Addenda Code

Value is BUS. 34Transaction Code

DerDomAmtApplied * 100

No decimal.

Numeric. Fill with
zeros to left

187Foreign Payment
Amount

BlankSpace filled2225Foreign Trace
Number

vendaddr_mst.name 3547Receiving Compa-
ny Name

 Space filled682Reserved

This number is the same as the last
seven digits of the Trace Number.

Fill with zeros to
left

788Entry Detail

vbNewLine or vbCLf   Return

Second  IAT Addenda Record

This record contains addenda.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 7. 11Record Type
Code

Value is 11. 22Addenda Code

parms_mst.company

Field is 60 characters but will be trun-
cated to 35.

 354Originator Name

parms_mst.addr##1

This is the physical address of the
originator. A PO Box is not allowed.

 3539Street Address

  1474Reserved
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Field or NotesFormatLengthPosi-
tion

Field Description

  788EntryDetailSe-
qNumber

vbNewLine or vbCLf   Return

Third IAT Addenda Record

This record contains addenda.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 7. 11Record Type
Code

Value is 12. 22Addenda Code

parms_mst.city + * + parms_m
st.state + \

The originator's city and state/province.
Use an asterisk between the city and
state/province. Use a backslash as the
terminator.

 354Originator City
and State

parms_mst.country + * + parm
s_mst.zip + \

The originator's country and ZIP code.
Use an asterisk between the country
and ZIP. Use a backslash as the termi-
nator.

 3539Originator Coun-
try and Postal
Code

  1474Reserved

  788EntryDetailSe-
qNumber

vbNewLine or vbCLf   Return

Fourth IAT Addenda Record

This record contains addenda.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 7. 11Record Type
Code

Value is 13. 22Addenda Code

Infor SyteLine Financials User Guide | 55

 

Accounts Payable (A/P)



Field or NotesFormatLengthPosi-
tion

Field Description

bank_hdr_mst.name 354Originating Bank
Name

  239 

bank_hdr_bank_file_fmt_mst.a
ch_orig_id

 3441Originating Bank
ID

parms_mst.country 375Originating
Branch Country
Code

Blank 1078Reserved

  788EntryDetailSe-
qNumber

vbNewLine or vbCLf   Return

Fifth IAT Addenda Record

This record contains addenda.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 7. 11Record Type
Code

Value is 14. 22Addenda Code

vendor_mst.bank_name 354Receiving Bank
Name

vendor.transit_reference

If US is specified for the Receiving
Branch Country Code, this defaults to
01.

 239Receiving Num-
ber Qualifier

vendor_mst.transit 3441Receiving Bank
Routing Number

vendaddr_mst.country 375Receiving Branch
Country Code

Blank 1078Reserved

  788EntryDetailSe-
qNumber

vbNewLine or vbCLf   Return
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Sixth  IAT Addenda Record

This record contains addenda.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 7. 11Record Type
Code

Value is 15. 22Addenda Code

vendor_mst.vend_num 154Receiver's ID
Number

vendaddr_mst.addr##1(vadRAdd
r_1 or VadAddr_1)

 3519Receiver's Street
Address

 Space

filled

3454Reserved

  788EntryDetailSe-
qNumber

vbNewLine or vbCLf   Return

Seventh IAT Addenda Record

This record contains addenda.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 7. 11Record Type
Code

Value is 16. 22Addenda Code

vendaddr_mst.city + * + vend
addr_mst.state + \

The receiver's city and state/province.
Use an asterisk between the city and
state/province. Use a backslash as the
terminator.

 354Receiver City and
State

vendaddr_mst.country + * + v
endaddr_mst.zip + \

The receiver's country and ZIP code.
Use an asterisk between the country
and ZIP. Use a backslash as the termi-
nator.

 3539Receiver Country
and Postal Code

  1474Reserved
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Field or NotesFormatLengthPosi-
tion

Field Description

  788EntryDetailSe-
qNumber

vbNewLine or vbCLf   Return

Batch Control Record

This record appears at the end of each batch. It holds totals for the batch.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 8. This identifies a batch con-
trol total record.

 11Record Type
Code

This value identifies the type of entries
in the batch:

• 200 identifies the type of entries in
the batch as mixed debits and
credits.

• 220 indicates that only credits are
contained in this batch.

• 225 indicates that only debits are
contained in this batch.

Numeric32Service Class

Total number of detail records pro-
cessed in the batch.

Numeric. Fill with
zeros to left

65Entry Count

Value is calculated by SyteLine .Numeric1011Entry Hash

Sum of all negative DerDomAmtAp-
plied for each payment *100.

Numeric. Fill with
zeros to left

1221Total Debit
Amount

Sum of all positive DerDomAmtApplied
for each payment *100. This is the
dollar total of credit entries in the batch.

Numeric. Fill with
zeros to left

1233Total Credit
Amount

bank_hdr_bank_file_fmt_mst.a
ch_co_id - This should match the
Company ID used in the batch header.
The company ID is displayed in the
output with leading zeros.

 1045Company ID

Not used.Blanks2555Filler

bank_hdr_bank_file_fmt_mst.a
ch_orig_id - This should be the
originating bank's routing number.

Numeric. Fill with
zeros to left

880Origination ID
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Field or NotesFormatLengthPosi-
tion

Field Description

Initial value is 1. This indicates the
number of the batch associated with
the control record.

Numeric. Fill with
zeros to left

788Sequence

vbNewLine or vbCLf   Return

File Control Record

This record provides a final check on the submitted data. It contains block and batch counts and totals
for each type of entry.

Field or NotesFormatLengthPosi-
tion

Field Description

Value is 9. This identifies a file control
record.

 11Record Type
Code

Initial value is 1. This is the total num-
ber of batch header records in the file.

Numeric. Fill with
zeros to left

62Batch Count

The system calculates the number of
detail records, plus all header and
control records, and divides by 10 to
get the block count. If there is a remain-
der, it adds 1 to the block count.

Numeric. Fill with
zeros to left

68Block Count

This is the total number of detail and
addenda records in the file.

Numeric. Fill with
zeros to left

814Entry Count

Value is calculated by SyteLine.Numeric. Fill with
zeros to left

1022Entry Hash

Sum of negative DerDomAmtApplied
for every payment * 100Dollar total of
debit entries in the file.

Numeric. Fill with
zeros to left

1232Total Debit

Sum of positive DerDomAmtApplied
for every payment * 100. This is the
dollar total of credit entries within the
file.

Numeric. Fill with
zeros to left

1244Total Credit

Leave this reserved field blank.Blanks3956Reserved

vbNewLine or vbCLf   Return

SEPA EFT Output Format
With SEPA, citizens and companies can make and receive payments in euros, within all EU member
states.
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The SEPA output file is formatted as an XML file that includes the following structure. Only the elements
set by SyteLine are shown here.

Group Header

NotesMappingXML TagMessage Item

Point-to-point reference as-
signed by the instructing party
and sent to the next party in the
chain in order to unambiguously
identify the message. The in-
structing party must ensure that
this is unique per instructed
party for an agreed-upon period.

appmt_mst.vend_num + "/
" + appmt_mst.check_num

<MsgId>Message Iden-
tification

Date/time the payment transac-
tion was created.

appmt_mst.CreateDateTim
e

<CreDtTm>Creation Date-
Time

 1<NbOfTxs>Number of
Transactions

Total of all individual amounts
included in this message, irre-
spective of currencies.

Sum of all appmt.for_check_amt
included in that payment

<CtrlSum>Control Sum

The party that is initiating the
payment. This can be either the
debtor or a party initiating pay-
ment on behalf of the debtor.

 <InitgPty>Initiating Party

Name is limited to 70 charactersparms_mst.company<Nm>  Name

  <Id>  ID

  <OrgId> Organization
Identification

An 8- or 11-character ISO code
assigned by SWIFT and used
to identify a financial institution
in financial transactions.

bank_hdr_mst.BIC<BICorBIE>BIC

Payment Information

There can be multiple Payment Information sections following the Group Header section.
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Payment MethodPayment Information Identifi-
cation

XML TagMessage Item

Assigned by the initiating party.
Unambiguously reference the
overall content of the payment
information component. The ID
is only relevant between the ini-
tiating party and the receiving
party. It can be included in relat-
ed messages, such as Payment
Status Report of Bank-to-Cus-
tomer Account Reporting mes-
sages, that are sent back by the
initiating party's agent to the ini-
tiating party.

BATCH<PmtInfId>Payment Infor-
mation Identifi-
cation

Only TRF is allowed.TRF<PmtMtd>Payment
Method

Specifies that multiple entries
per transaction are possible.

TRUE<BtchBookg>Batch Booking

Use only at Payment Informa-
tion level and not at Credit
Transfer Transaction Informa-
tion level. When Instruction Pri-
ority is used, Payment Type In-
formation must be present at
Payment Information level.

 <PmtTpInf>Payment Type
Identification

Usage is recommended. <SvcLvl>  Service Level

Only SEPA is allowed.SEPA<Cd>  Code

YYYY-MM-DDappmt_mst.check_date (iso)<ReqdExct-
nDt>

Requested Ex-
ecution Date

  <Dbtr>:Debtor

Mandatory (AT-02 Name of the
Originator). Limited to 70 char-
acters.

parms_mst.company<Nm> Name

The account of the debtor to
which a debit entry will be made
as a result of the transaction. In
SEPA credit transfers, only
IBAN should be used.

 <DbtrAcct>Debtor Ac-
count

  <Id>   ID
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Payment MethodPayment Information Identifi-
cation

XML TagMessage Item

The account number (only the
IBAN) of the Originator to be
debited for the Credit Transfer
Instruction. IBAN is the interna-
tional bank account number, an
expanded version of the Basic
Bank Account Number (BBAN)
used internationally to uniquely
identify the account of a cus-
tomer at a financial institution.

bank_hdr_mst.IBAN<IBAN>  IBAN

The financial institution servicing
an account for the debtor. Only
BIC is allowed for the identifier.

 <DbtrAgt>Debtor Agent

  <FinInstnId>  Financial In-
stitution Identi-
fication

 bank_hdr_mst.BIC<BIC>    BIC

Multiple sections are are al-
lowed here (see below).

 <CdtTrfTxInf>Credit Trans-
fer Transac-
tion Informa-
tion

Credit Transfer Transaction Information

There can be multiple transaction sections within the Payment Information section.

NotesMappingXML TagMessage Item

  <PmtId>payment identi-
fication
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NotesMappingXML TagMessage Item

(AT-41 Originator's Reference
to the Credit Transfer) Provides
an end-to-end identifier
throughout the processing, inter-
bank and settlement chain. It is
assigned by the Initiating Party
and is carried from message to
message throughout the inter-
bank payment chain, up to the
creditor. It can form the basis
for a creditor who wants to inves-
tigate the payment transaction.
It can be included in related
messages sent back by the initi-
ating party's agent to the initiat-
ing party.

Example: 1235678/3245623/12-
30-2015

appmt_mst.vendor+"/" +
appmt_mst.check_num + "
/" + appmt_mst.check_da
te

<EndToEn-
dId>

End-to-End
Identification

Contains either <EqvtAmt> (do-
mestic currency) or <InstdAmt>
(foreign currency)

 <Amt>Amount

Example:

<EqvtAmt>
  <Amt 
Ccy="GBP">300.00</Amt>

  <CcyOfTrf>GBP</Ccy
OfTrf>
</EqvAmt>

where

• <Amt Ccy> shows the
bank's currency code
(bank_hdr_mst.curr_code)
and the amount
(appmt_mst.for_check_amt)

• <CcyOfTrf> is the vendor's
currency code used in the
transfer (ven-
dor_mst.curr_code)

<EqvtAmt>Equivalent
Amount
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NotesMappingXML TagMessage Item

AT-04 Amount of the Credit
Transfer in Euro

Example:

<InstdAmt 
Ccy="EUR">535.25</In
stdAmt>

where Ccy (currency) must be
"EUR". The amount
(appmt_mst.dom_check_amt)
must be 0.01 or more and
999999999.99 or less. The
fractional part has a maximum
of two digits.

<InstdAmt> Instructed
Amount

  <CdtrAgt>Creditor Agent

  <FinInstnId> Financial Insti-
tution Identifi-
cation

  <BIC>  Vendor BIC

  <Cdtr>Creditor

Mandatory (AT-21 Name of the
Beneficiary).Limited to 70 char-
acters.

Name OR VadRName = vendad-
dr_mst.name

<Nm> Name

(AT-22 Address of the Beneficia-
ry)

 <PstlAdr> Postal Ad-
dress

  <AdrTp>  Address
Type

 VadRAddr_1 or VadAddr_1
(vendaddr_mst.addr##1)

<AdrLine>  Address Line

 VadRAddr_2 or VadAddr_2 (ve
ndaddr_mst.addr##2)

<AdrLine>  Address Line

 VadRZip or VadZip (vendaddr
_mst.zip)

<PstCd>  Postal Code

 VadRCity or VadCity (vendadd
r_mst.city)

<TwnNm>  Town Name
(city)

state/province/region or other
subentity

VadRState or VadState (venda
ddr_mst.state)

<CtrySubD-
vsn>

  Country Sub-
division

Two digit ISO country codeVadRCountry or VadCountry (v
endaddr_mst.country)

<Ctry>  Country
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NotesMappingXML TagMessage Item

 VadRAddr_1 or VadAddr_1 (ve
ndaddr.addr##1)

<AdrLine>  Address Line

 VadRAddr_2 or VadAddr_2 (ve
ndaddr.addr##2)

<AdrLine>  Address Line

Account of the creditor to which
a credit entry will be made as a
result of the transaction. In the
case of SEPA credit transfers,
only IBAN should be used.

 <CdtrAcct> Creditor Ac-
count

  <Id>  ID

 vendor_mst.IBAN<IBAN>   IBAN

  <RmtInf> 

Lists the vendor invoice number,
remittance advice or “Open
Payment.”

appmtd.inv_num<Usrtrd> 

Generating DAS2 Declaration Forms
To generate DAS2 declaration forms for applicable vendors:

1 Open theFiscal Reporting System Form Printing Reportform.

2 Specify this information:

Display Report Header
To display report headers on the report, select this check box. Report headers display on the first
page of the report and list the parameters by which you generated the report.

Current Year/Previous Year
Select whether to print the report for the current or previous fiscal year.

Fiscal Reporting System
Select DAS2 for the starting and ending reporting systems.

Vendor
Specify the starting and ending vendors for which to run the report.

3 To preview the report before printing, click Preview. Previews are processed as background tasks.

4 To print the report, click Print.
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DAS2 Declaration Form - Report Content
This topic describes the derived fields on the DAS2 Declaration Form, which is generated from the
Fiscal Reporting System Form Printing Report form.
• NP: Nom and Prenom (Last name and First name)

The value in the Contact field on the Vendors form is split based on the placement of the first " "
(space) character. Everything before the space is considered the first name and placed in the
Prenom field. Everything after the space is considered the last name and placed in the Nom field.

• No and Voie (Street number and Street name)

The value in the Address [1] field on the Vendors form is split based on the placement of the first
" " (space) character. Everything before the space is considered the street number and placed in
the No field. Everything after the space is considered the street name and placed in the Voie field.

• Nat (Payment type),4 - Montant (Amount), Nat (Payment type), and 5 - Montant (Amount)

The payment types and amounts for boxes 4 and 5 come from invoices where the Fiscal Reporting
System Type values of H, C, CO, R, JP, DA, DI, or AR have been specified. The transactions are
summed by type.

• 6 - Avantages en nature (Fringe benefits), V (Amount), and N (Code for the amount)

Box 6 shows the summed amount for all payments where theFiscal Reporting System Type
values of N - A, N -L, N - N, N - T, or N - V have been specified.

• 7 - Indemnitès et remboursements (Reimbursements),I (Amount), and M (Code for the amount)

Box 7 shows the summed amount for all payments where theFiscal Reporting System Type
values of M - F, M - P, or M - R are specified.

• 8 - TVA nette sur droits d'auteur (VAT on copyrights)

Box 8 shows the sum of the tax amount on payments where the Fiscal Reporting System Type
value of DI (box 4 or 5 amount type) is specified.

• 9 - Retenue à la source (domicile hors de France) (Withholding tax (place of residence outside
of France)), M (Amount), and O (Code for the amount)

Box 9 shows the sum of the tax amount on payments where the Fiscal Reporting System Type
value of O - R or O - D is specified.

Paying for Purchases with a Credit Card
When you use a credit card to pay for a purchase from a vendor, you need to show the purchase under
the Purchase Vendor. You also need to remit the payment to the Credit Card Vendor.

To set up a credit card for this purpose, create a bank code for the credit card on the Bank
Reconciliations form. On this form, the Cash Account for the credit card's bank code should be some
type of clearing account. To activate the new bank code, add a bank reconciliation transaction Type
for "Check."

After you create the new bank code for the credit card, you can then do the following:
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1 Receive and create a voucher for the purchase order as you would for a regular purchase.

2 Create a payment using the credit card's bank code for the vendors and vouchers.

3 Print and post the checks.

4 Add a manual voucher to the Credit Card vendor for the total amount. Use the same clearing
account used by the credit card bank code for the distribution on this manual voucher. This way,
the vendor's purchases YTD remain intact, and the payment is actually remitted to the Credit Card
vendor.

Using A/P Tax Reports
This topic describes using A/P tax reports.

Use this information with these reports:

• Tax Payable Report
• Tax Vouchered (Parametric) Report
• Goods and Services Taxes (GST) Tax Credit Report
• Provincial Sales Taxes (PST) Tax Credit Report

Report Output

The tax reports list detailed information from the tax records for a range of tax periods. The records
are grouped and subtotaled by tax code, and the records are sorted by distribution date within the
group. A negative value identifies a reduction adjustment made to a voucher.

Caution:  The tax records are extracted from voucher history. If you purge this information before
printing this report, any tax records prior to the report's date range are lost and do not appear on the
report. The history information does not include postings you performed manually from the G/L journal
to the tax G/L accounts.

Also, if you generated tax  account distributions from Purchasing before posting them in A/P, and then
adjusted the distributions manually, the history information does not include the adjustments. Therefore,
the report does not reflect these secondary changes to the account balance.

Verifying the Report

Compare the contents of the report to the tax account balances for the period reported from the G/L.
If you find discrepancies, first verify that the A/P module does not contain unposted vouchers posted
from Purchasing.

Then, make sure the A/P Distribution journal has been posted to the ledger. You may have additional
discrepancies if you adjusted the tax account balances manually with journal entries, or adjusted the
A/P Voucher G/L tax account distribution records manually. Only these discrepancies are acceptable.
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A/P Voucher Information

In Purchasing, the tax records are created at the same time as the A/P voucher is generated. The
system does not alter these records, regardless of changes to the transaction in A/P or G/L.

If you enter vouchers or adjustments directly in A/P (not from Purchasing), the tax records are created,
based on the values in the special tax fields in the G/L distributions. When you post the manual vouchers,
the tax records are created.

On the GST and PST reports, The GST or PST Taxable column shows only the value of goods that
apply to the tax code being reported. The value in the Voucher Total column includes all lines, charges,
freight, and taxes on the document.

Because of the method by which the voucher history is maintained on the GST and PST reports, when
you make adjustments to pre-vouchered amounts, the records are stored under the same voucher
number, and the original voucher total is updated. In this situation, independent tax records are
maintained under the separate Taxable, but the Voucher Total shows the same amount. Therefore,
because the column would double count, the Voucher Total column does not contain a subtotal.

The GST or PST Taxable column is less accurate for vouchers than for invoices, because the vendor
calculates the tax with the tax basis as estimated from the tax codes stored with the PO.

A/P Payments

Creating a Manual Check
1 On the A/P Payments form, select Actions > New.

2 Specify information in these fields:

• Vendor: Select the number of the vendor you are entering the manual check for.
• Payment Type: To create a manual check, select Manual Check.
• Reapplication: If the manual check payment is for a reapplication, select this check box.
• Check Number: Enter the check number for the manual check you are issuing.
• Check Seq: Enter the check sequence number, or accept the default of the next incremental

number. The system uses this number to keep the distributions in numerical order.
• Check Date: Enter the check date, or accept the default of today's date.
• Bank Code: This field displays the vendor's default bank code, but you can change it to the

code of the bank from which the payment is being made (if applicable).
• Notes: (Optional) Enter notes about the payment.
• Reference: Enter the description that is to appear in the journals for this transaction, or accept

the default, which is the APP followed by the vendor number.
• Payment Amount: Enter the amount of the check.

3 To save the payment, select Actions > Save.

4 Select Distributions.
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5 Select Actions > New, and distribute the payment. See Distributing Vendor Payments Manually
on page 69 for more information.

6 Print and post the check.

Creating a Standard Draft
1 On the A/P Payments form, select Actions > New.

2 Specify information in these fields:

• Vendor: Select the number of the vendor you are entering the standard draft for.
• Payment Type: Select Standard Draft.
• Check Seq: Accept the sequence number that displays. The system uses this number to keep

the distributions in numerical order.
• Check Date: Enter the draft date, or accept the default, which is today's date.
• Draft Due: The default payment due date displays, but you can change it to a different date

on which the draft is to be due.
• Bank Code: The vendor's default bank code displays, but you can change it to the code of

the bank from which the payment is being made (if applicable).
• Notes: (Optional) Enter notes about the payment.
• Reference: Enter a description which is to appear in the journals for this transaction, or accept

the default, which is APP followed by the vendor number.

3 To save the payment, select Actions > Save.

4 Select Distributions.

5 To distribute the payment, select Actions > New.

6 On the General tab, in the Type field, select one of these options:

• Voucher: Applies the payment to a particular voucher. Enter the voucher number in the
Vch/Seq field.

• Open: Applies the payment to the vendor, not to a specific voucher.

7 Finish distributing the payment. See Distributing Vendor Payments Manually on page 69 for more
information.

8 Print and post the draft.

Distributing Vendor Payments Manually
To distribute vendor payments manually:

1 On the A/P Payment Distributions form, select Actions > New.

2 In the Vendor field, select the vendor from the list of those with payments on file.

The payment header information displays in the upper part of the form, and you cannot change it.

3 On the General tab, fill in the required data:

• Type: Select the distribution type: Voucher, Non A/P, Commission or Open.
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Note: When adding multiple AP payment distributions, you can specify only one Open type
distribution per site for each Open type payment.

• Vch/Seq: If you are adding a voucher distribution, enter the number of the voucher referenced
from the distribution. If you are entering any other type of distribution, enter its sequence
number. The sequence number is used only to keep the distributions in numerical order.

• Site: If the distribution type is Non A/P, Commission, or Open, select the site where the
transaction resides. If the distribution type is Voucher, the site that contains the posted
transaction against which the payment distribution is being applied displays for reference.

• Invoice: If the distribution type is Non A/P, Commission, or Open, enter the number of the
invoice you are applying the distribution against. For a Commission distribution type, you must
enter an order entry invoice number with a commission type of Distribution; the sum of the
commissions for that invoice and vendor displays in the Amount Paid field on the Accounts
tab.

• PO: If the distribution type is Non A/P, Commission, or Open, enter the PO number to which
you want to record the payment.

• 1099 Reportable: If the payment distribution is 1099 taxable and should be included on the
vendor's 1099 form, this check box should be selected. If the payment is not 1099 taxable,
clear the check box.

4 Select the Accounts tab, and then fill in data in the following fields:

• Amount Paid: Enter the amount to apply to this payment.
• Disc Taken: If the payment type is Voucher, enter the amount to be discounted from this

payment.
• [Tax Adjustment (1)]: If the payment type is Voucher, this field displays any Tax System 1

adjustment for discounts. You can change this amount.
• [Tax Adjustment (2)]: If the payment type is Voucher and a second tax system is defined,

this field displays any Tax System 2 adjustment for discounts. You can change this amount.
• Disc Account: If the payment type is:

• Voucher, this field displays the discount account number from the Accounts Payable
Parameters form. If the discount amount is not zero, you can select a different account
for the discount amount, if applicable.

• Non A/P, select the number of the General Ledger account that is to receive the distribution
amount. This account offsets the cash account.

• Commission, this field displays the number of the General Ledger commission paid account
from the Accounts Payable Parameters form, but you can select a different account to
apply the payment to.

• Open, this field displays the number of the General Ledger deposit account from the
Accounts Payable Parameters form, but you can select a different account to apply the
payment to.

5 To save the distribution, select Actions > Save.

Note:  Distributions of type Non-A/P or Commission are not permitted for payments where the Payment
Type is Standard Draft.
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Generating Automatic Payments
To automatically generate A/P payments and distributions:

1 Open the A/P Payment Generation form.

2 Specify information in these fields:

• Multi-Site Group ID: To generate payments for a different multi-site group, select that group's
ID.

• Payment Date: Enter the date to print on all the checks or drafts, or accept the default, which
is today's date.

• Payment Type: Select the check box of each payment type you want to generate payment for:
Standard Check, Manual Check, Wire, Standard Draft, Incoming Draft, or EFT.

• Aging Basis: Select the method to age the payments: Invoice, Due Date, or Disc Date.
• Include Commissions Due: To process commissions for the commissions-due records of

outside salespersons whose reference numbers are also valid vendor numbers, select this
check box. The system summarizes the total commission-due amount into the check total for
each vendor. To exclude commissions, clear this check box.

• Delete Payment/Distributions: To have any existing payments be deleted before generating
the new payments, select this check box. To preserve the existing payments, clear this check
box.

• Starting and Ending Bank Code: Enter the range of bank codes for which to produce payments.
• Starting and Ending Vendor: Enter the range of vendors for which to produce payments.
• Starting and Ending Age Date: Enter the first and last aging dates of the transactions to consider

for payment. These dates also set the range for which payments and distributions can be
deleted using the Delete Payment/Distributions check box. If the Invoice Date or Due Date
falls within the date range specified in these fields, the voucher is selected for payment.

Note:  If you are generating standard checks and you have entered some existing payments, the
check generation process affects the existing payments. We recommend that you post the existing
payments before generating new payments.

3 To generate the payments, click Process.

Paying Finance Charges
To apply customer payments to finance charges using the A/R Payments form, do the following:

1 Fill in the fields of the form and enter the total amount of the payment in the Amount field, although
part of the money may be applied to other things than finance charges.

2 To save the A/R Payments record, select Actions > Save.

3 To open the A/R Payment Distributions form, click the Distributions button.

4 On the General tab, in the Type field, select Finance Charge.

5 In the Dist Amount field, enter the amount of the payment to be applied to finance charge.

You can create separate distribution records for the remainder of the payment.

6 To save the A/R Payment Distributions record, select Actions > Save.

7 Open the A/R Payment Posting form.
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8 To post all customers, accept the default values.

9 Click Process.

Posting A/P Wire Transactions
To post wire transactions, use the A/P Wire Posting form:

1 Select field values that filter the transactions to post. You can  specify a range of vendor numbers,
names and  pay dates, the type of payment, and the bank code.

2 Specify the sort method.

3 Before posting, select the A/P Wire Posting Report option. Click Process to print and review this
report, which lists the wire payments to be posted.

The grid at the bottom of the form also displays the list of items that will be posted.

4 After you review the report, select Final Register and Post and click Process.

5 Optionally, print the remittance advice:

• select Print Remittance Advice.
• To process the remittance advice output for print, fax, or email on a vendor-by-vendor basis,

select Use Profile.
• Click Process.

Note: If the Wire option for Remittance Advice is selected on the Accounts Payable Parameters
form, you must select Print Remittance Advice.

When you post a wire payment and distribution, a Bank Reconciliations record stores the payment.
The system marks the record as Not Voided.

Reversing a Posted Wire Payment
Note:  If the voucher for the wire payment is generated but not processed, delete the wire payment
record in the A/P Payments form instead of reversing it.

To reverse a wire payment:

1 Create a new wire payment on the A/P Wire Posting form and enter a negative value for the
payment.

2 Distribute the payment to the same wire number, bank code, vendor number, and voucher number.

3 Perform the wire posting.

During the posting process, the system marks the corresponding bank reconciliation as Voided.
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Posting A/P Cash Payments
If a vendor accepts cash payments, you can pay with cash and post the cash payment to the ledger:

1 Create a voucher for the vendor in the A/P Vouchers and Adjustments form.

2 Generate the distribution and post the voucher in the A/P Voucher Posting form.

3 Create a payment with a Payment Type of Cash and match the payment to the voucher with A/P
Quick Payment Application.

4 Use the A/P Check Printing/Posting form to post the payment:

• Specify the vendor number.
• Select Preliminary Check Register and click Process.
• Click OK to confirm the Preliminary Check Register report.
• Select Final Register and Post and click Process. (Skip the other steps.)
• Verify that the payment was posted and click OK.

Posting A/P Direct Debit Payments
Automatic direct debit A/P payments are generated when a new BankStatement BOD is received into
SyteLine from ION.

Note: This topic does not apply if certain country packs (for example, Sweden) are enabled. See the
appropriate SyteLine country guide for more information.

1 When an A/P Payment record is created and not yet posted, the A/P button on the Bank Statements
form is enabled for the record.

2 Select the record and click A/P to open the A/P Payments form and review the payment information.
The Payment Type should be set to Direct Debit.

3 Save any changes.

4 Create a voucher against the payment and handle it as you would handle any other A/P payment.

5 In the A/P Wire Posting form, specify the Vendor range and a Pay Type of Direct Debit.

6 Follow the steps in Posting A/P Wire Transactions on page 72.

After the payment is posted, the appropriate journals are updated.

Posting to the A/P Distribution Journal
The A/P Distribution Journal records purchase orders you have received and vouchered. Eventually,
you need to post this journal to the General Ledger.

Caution:  After transactions are posted to the journal, you can no longer update them. You can add
text to the line entries, but to adjust them you must use the A/P Vouchers and Adjustments form.
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You can view posted transactions in the A/P Distribution journal on the A/P Posted Transactions
Detail form. Use the grid pane to select the transaction you want to view. The Type field identifies the
type of transaction you are viewing: payment, voucher or adjustment.

To view summary information about the displayed transaction, select Summary. The system displays
the A/P Posted Transactions Summary form.

Reconciling Bank Statements for Accounts Payable
Prerequisites:

• Ensure that SyteLine is able to receive BankStatement BODs from ION. See the  Infor SyteLine
Integration Guide for Infor Local.ly.

• On the Accounts Payable Parameters form, set the EFT Format to the appropriate format (SEPA
for EU countries, or other formats as noted in the specific country guides). .

• On the Vendors or Multi-Site Vendors forms, set the Payment Type to EFT (or Wire Transfer
for certain countries) for vendors that can receive automatic A/P payments. Specify the banking
information for the vendor.

• In the Chart of Accounts form, set up an account for every vendor whose bank account uses a
currency other than your domestic currency. Transactions to/from this account will be in the currency
of the vendor bank account. This prevents currency exchange fluctuations from affecting automatic
payments.

• On the Bank Reconciliations form, set up information for the banks from which you will receive
statements. The currency, BIC and IBAN codes must match the information in the messages that
you receive from the banks. 

To view and reconcile a bank statement:

1 View and filter bank transactions.

Bank statement records are display-only. You cannot make changes on this form; however, you
can filter the records to view specific types of information.

a In the Bank Statement form, click the Filter-in-Place tool bar button to see the available bank
statement records.

Each bank statement record shows information relating to one customer or vendor bank
identifier code (BIC) or to one employee account used for payments.

b Select a record.

The bank statement record header can contain information such as this:

• The starting and ending balance for the account for the period
• The period starting and ending dates
• The currency that is used for all transactions in the statement

The statement line detail shows debit and credit transactions and amounts, listed with the
appropriate domain and family codes that describe the type of transaction. (Chinese transactions
show positive and negative numbers rather than debit and credit.)

The information is formatted dynamically. The grid column headings and content are set based
on the format that is used by a particular bank.

Infor SyteLine Financials User Guide | 74

 

Accounts Payable (A/P)



2 View and process automatic A/P payments.

Note: This information about automatic payments does not apply if certain country packs (for
example, Sweden) are enabled. See the appropriate SyteLine country guide for more information.

When a BankStatement BOD is received into SyteLine, automatic payments are generated for any
A/P transactions in the statement that have a domain code of PMNT and a domain family code of
IDDT or ICDT.

a On the Bank Statements form, select a transaction line with the domain family code IDDT or
ICDT.

b Click A/P to view the A/P payment transactions that were created for the current statement
record.

c Process the A/P payments and then post them on the A/P Wire Posting form.

3 Reconcile the bank statement:

a Manually reconcile the account statement records on the Bank Statement form with the
transactions on the Bank Reconciliations form for this account.

See Preparing a Bank Reconciliation on page 75.

b When the statement is completely reconciled, select the Process check box on the Bank
Statements form. You can then use the Bank Statement Purge utility to purge the processed
records.

Preparing a Bank Reconciliation
The system maintains a transaction history of all activity against the bank checking accounts your
company uses. You can view this information using the Bank Reconciliations form, and also prepare
bank reconciliations by tracking what has been recorded by the bank.

Summary bank reconciliation records are automatically created when you process entries on these
forms:

• A/R Payment Posting for payment types: Check, Wire, and Adjustment only
• A/R Adjustment Posting
• A/R Wire Posting
• Returned Checks

Checks that are printed through Payroll and Accounts Payable are automatically recorded, along with
checks that have been voided due to a reprint, enabling you to view and reconcile each check. To
reflect miscellaneous charges, you must either manually add them through the grid on this form, or
record them in the General Journal or a user-defined journal.

Note:  You cannot enter post-dated checks until they have been deposited.

One of these sources is shown in the Ref Type field for automated bank reconciliation records:

• A/P: The transaction is posted from A/P check or draft printing.
• A/R: The transaction is posted from A/R check, adjustment, wire, or draft posting.
• PR: The transaction is posted from payroll check printing.
• BAL: The transaction is created during the bank reconciliation compression process.
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To reconcile and then compress transactions:

1 To reflect deposits and miscellaneous charges that are not automatically added (see above), you
must either manually add them through the grid on the Bank Reconciliations form, or record them
in the General Journal or a user-defined journal.

2 When you receive a statement from the bank, for each reconciled transaction, select Reconciled
on the Bank Reconciliations form.

3 To process all transactions against the current General Ledger cash account, click Balance
Compute.

4 To delete transactions that have been reconciled, run the Bank Reconciliation - Compression
utility:

• (Optional) By default, the system compresses transactions through the current system date,
but you can enter a different date that is earlier than the date of the last check record you want
to compress. This sets the system to know what check number is next in the sequence.

• In the Bank Code field, select the bank code of the bank account you want to compress.
• If you want the system to automatically increment date ranges and re-run reports and utilities,

select the Increment Date check box.
• To compress the selected bank code's reconciliation transactions, select Process.

Note: 
• For A/R transactions, after a payment by check is received for an invoice, you must manually enter

the payment in the Bank Reconciliations form. You must enter and post customer checks
individually. When each payment is reconciled with the bank statement, the system credits the
VAT A/R Received account.

• For A/P transactions, after a processed check is reconciled with the bank, the system debits the
VAT A/P Paid account.

Preparing a Bank Reconciliation Using Transfer VAT
This topic describes how to reconcile invoice and voucher payments when the Transfer VAT option
is selected on the General tab of the Tax Systems form.

Transfer VAT enables VAT recognition upon bank reconciliation.

For more information on performing a bank reconciliation, see Preparing a Bank Reconciliation on
page 75.

To reconcile A/P checks with Transfer VAT selected:

1 Open the Bank Reconciliations form.

2 Select the appropriate Bank Code.

3 Specify these values in these fields:

• Type: Must be Check.
• Transaction: Enter the individual check number.
• Ref Type: Must be A/P.
• Ref Num: Select the appropriate vendor number.

4 After you are finished entering or updating transactions, click Balance Compute.
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5 When finished reconciling, select Actions > Save.

To reconcile A/R deposits with Transfer VAT selected:

1 Open the Bank Reconciliations form.
2 Select the appropriate Bank Code.
3 Specify these values in these fields:
• Type: Must be Deposits.
• Transaction: Enter the deposit number.
• Ref Type: Must be A/R.
• Ref Num: Select the appropriate customer number. For summary bank reconciliation entries, this

value is set to 0 by default.
• After you are finished entering or updating transactions, click Balance Compute.
• When finished reconciling, select Actions > Save.

Printing and Posting Checks

Caution:  The A/P Payment Generation utility resets most of the fields of the existing payment
records. To avoid this, always post your manual checks using the A/P Check Printing/Posting form
before running the A/P Payment Generation utility.

Caution:  You can void checks using the A/P Check Printing/Posting form only before you print the
final register. Once you print the final register and post the checks, you cannot void checks using this
form. For more information, see Voiding Posted Checks on page 89.

To print and post checks:

On the A/P Check Printing/Posting form, select the process to use:

• Preliminary Check Register: Sets up a preliminary check register. If no checks need to be printed,
a message to that effect displays. When you select this option, the system validates the check
information, prints the register, and then returns you to the A/P Check Printing/Posting form so
that you can continue with or exit from the process.
Note:  You must print the preliminary register before you can print the checks.

• Print A/P Checks: Prints the A/P checks from the preliminary register.
• Void Check(s): Activates the options in the To Void group box so that you can void checks and

then post them. Use this option if your checks printed incorrectly or were damaged. When you
choose this option, the To Void group box is updated with information about the checks that are
to be voided. When prompted, click OK to void the listed checks.

• Print A/P Check Stubs: (Optional) Reprints the APCheckLaserStubs, APCheckSTD006Stubs, or
APCheckANZStubs report for the checks in the collection, but leaves the check portion at the
bottom blank. This option can only be selected after a Print A/P Checks or Void Checks option
has been performed. Once the Final Register and Post has been performed, check stubs can no
longer be printed.
Note:  Check stubs print only for standard checks. Manual checks do not print checks; therefore,
they do not print check stubs.

• Final Register and Post: Prints a check register, posts the checks to the A/P Distribution Journal,
creates posted transactions, and updates the vendor records. General Ledger journal records are
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created for the payment records, and the posted transaction vouchers are created for the amount
paid and discount taken.

• Print Remittance Advice: If the Manual option for Remittance Advice is selected on the Accounts
Payable Parameters form, you must also select this option. To have the remittance advice statement
processed for print, fax, or email on a vendor-by-vendor basis, also select the Use Profile check
box. If you select this option but no manual checks exist in the check batch, the remittance advice
will be blank.

• Fill in the fields indicating the associated bank, check numbers, vendors, pay dates, and other
information for the process.

• Click Process.
Note: 
• If you exit from this form after printing or voiding checks but without running the Final Register

and Post option, the system will void any records that are not already voided, and then automatically
run the Final Register And Post option.

• Checks that you post from A/P contain the reference type A/P and a reference number corresponding
to the vendor number of the A/P check. During posting, multi-currency gains and losses are recorded
to the A/P ledger distribution journal (if applicable).

• If a discount is taken, the Discount field prints by itself on the line immediately following its
corresponding voucher information. This line will also print the side label Discount whenever the
line prints.

• When you print and post checks, three fields on the Vendors form are updated for the vendor:
• Last Paid Date: Date of the last posted payment for that vendor
• Discounts YTD: YTD amount of a discount taken for a voucher for a vendor
• Payments YTD: YTD payments made to the vendor in the current year

• It is possible to modify the system so that you can print checks in a language other than your
domestic language. To do so, you must modify the Source Code for the two stored procedures
that handle A/P Check Translation: WordNumSp() and WordNumISp(), which are included with all
SyteLine distributions.

• Check amounts print as both words and numeric amounts. Two lines are available to display the
amount in words. Check amounts are limited to print billions or less. If the currency code is MXN
or MXV, the check amount prints in Spanish, regardless of the specified language code, and billions
are represented as "thousands of millions."

•

Printing and Posting A/P Drafts

Caution:  The A/P Payment Generation utility resets most of the fields of the existing payment
records. To avoid this situation, always post your manual drafts using the A/P Draft Printing/Posting
form before running the A/P Payment Generation utility.

To print and post drafts:

1 Open the A/P Draft Printing/Posting form.

2 Enter information in these fields:

• Bank Code: Select the bank code for the drafts you want to post.
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• Starting Draft Number: Select the starting draft number.
• Sort by: Indicate how you want to sort the report.
• Display Distribution Detail: Indicate whether you want distribution information on the report
• Vendor: Select the first and last vendor numbers you want to include in the printing or posting.
• Due Date: Select the first and last due dates you want to include
• Starting Name/Ending Name: Enter the first and last name you want to include.

3 To print and review the report (before posting the drafts), select Print and then click Process.

Note:  If you are using preprinted forms, we suggest that you use a non-postscript printer driver;
otherwise, the drafts may not print with the correct alignment.

To ensure that the drafts are correctly aligned, select the Align Draft Form option to print an
alignment before actually printing the drafts.

After printing the drafts, you should immediately post them.

4 When you are ready to post the drafts, select Commit and then click Process.

Posting Remitted Drafts
To post remitted drafts and print a remittance statement:

1 Open the A/P Posting Draft Remittance form.

2 Enter the following information:

• Starting and Ending Vendor Number: Select the first and last vendor numbers whose draft
remittances you to post, or, to post draft remittances for all vendors, leave both fields blank.

• Starting and Ending Draft Number: Select the first and last draft numbers you want to include.
• Starting and Ending Due Date: Select the first and last due dates you want to include.
• Bank Code: Select the bank code for the draft remittances you want to post.
• Display Report Header: If you want to include report headers in the report, select this check

box.

The report header displays on the first page of the report, and lists the parameters by which you
generated the report.

3 To print and review the A/P Posting Draft Remittance Report, select Print and then click Process.
To have the remittance advice statement processed for print, fax, or email on a vendor-by-vendor
basis, also select the Use Profile check box.

4 When you are ready to post the draft remittances, select Commit and then click Process.

Example: Multi-Site AP Check Printing/Posting
In this example, three sites exist for Entity XYZ. Site A is designated as the centralized payment site
where all sites' vouchers are paid. If site A makes a $300 payment to a vendor to pay 3 vouchers, each
from a different site, the following journal entries must occur.
• Create vouchers to pay vendor - $100 from each site, as shown in this table:
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CreditDebit  

 $100PurchasesSite A transactions:

$100 A/P 

 $100PurchasesSite B transactions:

$100 A/P 

 $100PurchasesSite C transactions:

$100 A/P 

• Post Payment from corporate to vendor of $300 - $100 from each site, as shown in this table.

CreditDebit  

$300 CashSite A transactions:

 $100A/P 

 $100Inter-Site Liab (Site B) 

 $100Inter-Site Liab (Site C) 

$100 Inter-Site LiabSite B transactions:

 $100A/P 

$100 Inter-Site LiabSite C transactions:

 $100A/P 

Using A/P Quick Payment Application to Reapply Open
Payments
You can use the A/P Quick Payment Application form to reapply open payments in two ways:
• Option 1: Reapplying Open Payments
• Option 2: Reapplying Open Payments

Option 1: Reapplying Open Payments
1 Enter the payment you want to reapply, and select its Reapplication check box.

All the vendor's transactions display in the grid at the bottom of the form. Select the applicable
transaction(s). If an open type distribution already exists for a payment, it displays as Open (Dist)
to distinguish it from open transactions from A/P Posted Transactions.

Open payments from other sites (that is, sites other than the site of the payment) do not display in
the grid.
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Open payments do not display in the grid for any payment that does not have a check number or
draft number (Standard Checks and Standard Drafts). A check number or draft number is required
for these payment types to automatically reapply an open payment for them when you click Apply.

2 Select the vouchers to which you want to reapply the payment.

Transactions in the grid at the bottom of the form do not become available for selection until you
save the payment in the upper part of the form. After selecting items in the grid, you must then
click Apply to process them. Selecting a different payment without first selecting Apply will cancel
any changes you made in the grid.

3 Select Apply.

The system automatically generates payment distributions for the selected vouchers. If you selected
any open payments, they will first be applied to the selected vouchers and posted with the proper
journal entries. In this case, journal entries will have the reference of APPR (payment reapplication).
Otherwise, you must post the payment distributions as usual.

See Posting Payments on page 162.

Option 2: Reapplying Open Payments
1 Enter and save a payment. In the grid at the bottom of the form, both a voucher and an open

payment display.

2 To trigger the reapplication process, select the open payment and then click Apply.

Note:  If you select multiple vouchers and multiple open payments, the system automatically applies
the open payments by type and due date. You cannot update the voucher number.

3 Click Apply.

The same process occurs for the reapplication as described in Option 1 above. The system then
creates a payment distribution for any remaining items, and if an amount remains for the payment
in the upper part of the form, creates an open payment distribution for it.

Examples: A/P Quick Payment Application
Use these examples to understand the A/P Quick Payment Application.

Scenario #1

You enter a payment for $150, and then select three $50 vouchers in the grid to apply against that
payment.

The grid shows:

DiscountAmt to
Pay

Due
Date

Inv DateCheckPOSiteVouch-
er

Type

0.0050.006/155/15P00000101101Voucher
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DiscountAmt to
Pay

Due
Date

Inv DateCheckPOSiteVouch-
er

Type

0.0050.007/156/15P00000701150Voucher

0.0050.007/226/22P000001001156Voucher

Selecting Apply creates three distribution records, one for each voucher.

Scenario #2

You enter a payment for $100, and select no transactions in the grid. The payment date is 06/15/2002.
You save the payment, and then select Apply to apply it. A payment distribution for an open amount
of $100 is created. The grid shows:

Dis-
count

Amt to
Pay

Due
Date

Invoice
Date

CheckPOSiteVouch-
er

Type

0.00100.006/156/1501Open

Scenario #3

You enter a payment for $100, select a voucher with an amount less than $100 so that some of the
payment amount is left to apply. You save the payment. You then select a voucher for $60 and select
Apply. Two payment distributions are created, one with the type Voucher in the amount of $60, and
the other with the type Open in the amount of $40. Both the voucher and the open payment are shown
as selected in the grid.

Dis-
count

Amt to
Pay

Due
Date

Invoice
Date

CheckPOSiteVouch-
er

Type

0.0040.006/156/1501Open
(dist)

0.0060.006/155/15P00000101102Voucher

Scenario #4

You enter a payment for $0, and then select a voucher and an open payment.

Dis-
count

Amt to
Pay

Due
Date

Invoice
Date

CheckPOSiteVouch-
er

Type

0.0050.006/156/15P00000101Open

0.0050.006/155/15P00000101101Voucher

0.0050.007/226/22P000001001156Voucher

Selecting Apply automatically posts the open payment. The voucher number in A/P Posted Transactions
now says 101. The A/P account in the original A/P Posted Transactions record for the open payment
is 11600. The A/P account in the parameters is 20000. Journal entries created are:
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Exchange
Rate

Ref/CurrencyAmountAccountDate/Acct De-
scription

Journal Seq

1APPR50.00200006/1529

1.000USD50.00Accounts
Payable

1APPR50.00200006/1530

1.000USD50.00AP Deposit

Scenario #5

You enter a payment for $75, and then select multiple vouchers and an open payment.

You select two vouchers: voucher 101 with a due date of 06/15/2002 for $50, and voucher 150 with a
due date of 07/15/2002, for $75. You then select a $50 open payment with a due date of 06/15/2002.
Selecting Apply applies the open payment of $50 to voucher 101 and posts it. A/P Posted Transactions
will show the payment with a voucher number of 101. The new payment of $75 is applied to voucher
150, and a payment distribution is created. When the grid in A/P Quick Payment Application is refreshed,
it will look like this:

Dis-
count

Amt to
Pay

Due
Date

Invoice
Date

CheckPOSiteVouch-
er

Type

0.0075.007/156/15P00000701Voucher

No transaction line for voucher payment 101 displays in the grid, because voucher 101 becomes fully
paid after you select Apply.

Scenario #6

Reapplication of an open payment.

You enter an open payment for reapplication with an amount of $1000. The grid shows a voucher
selected for $1000. The system creates the payment distribution when you select Apply. The A/P
account in the original A/P Posted Transaction record for the open payment is 11600 (Deposit account).
When you apply the open payment, payment application occurs within the due date, so the system
automatically enters a discount for $50 in the Discount column. When the payments post through
payment posting, the posted journal entries are as follows:

Exchange
Rate

Ref/CurrencyAmountAccountDate/Acct De-
scription

Journal Seq

656APPR1,000.00116001/1855

1.000USD1,000.00AP Deposit

656APPR50.00121001/1856

1.000USD50.00Open A/P Ac-
count
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Exchange
Rate

Ref/CurrencyAmountAccountDate/Acct De-
scription

Journal Seq

656APPR1,000.00200001/1857

1.000USD1,000.00Accounts
Payable

656APPR50.00504001/1858

1.000USD50.00Purchase Dis-
count and Al-
lowance

Applying the open payment to the voucher within A/P Quick Payment Application would yield the journal
entries shown below. Note that the system creates an Open payment distribution for the remaining
$50 of the open payment that was not applied (due to the applied discount). This payment distribution
is then posted normally through payment posting.

Exchange
Rate

Ref/CurrencyAmountAccountDate/Acct De-
scription

Journal Seq

656APPR1,000.00200001/1855

1.000USD1,000.00Accounts
Payable

656APPR50.00504001/1856

1.000USD50.00Discount and
Allowance

656APPR950.00116001/1857

1.000USD950.00AP Deposit

Scenario #7

Reapplying an open payment to a voucher from another site.

You select a voucher from the OH site. The open payment was entered in the MI site, and is being
applied in the MI site. When you select Apply, the entries look like the following:

MI Site

Exchange
Rate

Ref/CurrencyAmountAccountDate/Acct De-
scription

Journal Seq

23APPR100.0011600* 1/1735

1.000USD100.00AP Deposit

23APPR100.0049010* 1/17

1.000USD100.00A/P Inter-Site
Asset
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OH Site

Exchange
Rate

Ref/CurrencyAmountAccountDate/Acct De-
scription

Journal Seq

23APPR100.00200001/1747

1.000USD100.00Accounts
Payable

23APPR100.00490301/17

1.000APPR100.00A/P Inter-Site
Liability

Scenario #8

Reapplying an open payment to a voucher with a different exchange rate.

You apply an open payment for $310 Canadian Dollars (CND, at an exchange rate of 1.55) to a voucher
with an exchange rate of 1.60. The following entries display in the journal when you select Apply:

Exchange
Rate

Ref/CurrencyAmountAccountDate/Acct De-
scription

Journal Seq

5651APPR200.0011600* 1/1466

1.550USD10.90Currency Loss

APX7.0350600* 1/1467

1.550CND10.90Currency Loss

APX7.0320000* 1/1468

1.550CND10.90Accounts
Payable

5651APPR200.00200001/1469

1.550CND310.00Accounts
Payable

Scenario #9

You enter a payment for $75 with a non-A/P distribution of $5. You open the A/P Quick Payment
Application form, and select the Open and Voucher records. The transactions now display as follows:

Dis-
count

Amt to
Pay

Due
Date

Invoice
Date

CheckPOSiteVouch-
er

Type

0.005.005/1501Non-AP

0.0020.005/15101Open

0.0090.006/155/1501100Voucher
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You first apply the $20 open payment to the voucher. The system then creates distributions for $5.00
for Non-A/P cash, and a $70.00 voucher. The Non-A/P cash should already exist in the distributions,
so the system will delete and recreate it.

Using A/P Quick Payment Application to Enter and Apply
Full and Partial Payments
You can use the A/P Quick Payment Application form to enter full and partial payments, and
automatically distribute them to open vouchers. You can also apply payments that were entered on
the A/P Payments form.

Note:  Transactions in the grid are not available for selection until you enter and save a payment in
the upper part of the form. After selecting the transactions, you must then click Apply to process them.
Selecting a different payment without first clicking Apply will cancel any changes you made in the grid.
Selecting Apply generates the appropriate payment distributions, and refreshes the grid display with
the current data.

1 Open the A/P Quick Payment Application form.

2 Select Actions > New.

3 Enter the payment data:

• Vendor: Enter the vendor who is to receive the payment.
• Type: This field displays the vendor's default payment type from the Vendors form, but you

can select a different one from among the following:
• Standard Check
• Manual Check
• Wire Payment
• Standard Draft
• Incoming Draft

• Number: The check, wire, or draft number displays, depending on the payment type:
• For a manual check, enter the check number.
• For an incoming draft, enter the draft number.
• For a wired payment, enter the wire number.

Note that for standard checks and drafts, the system automatically updates this field when the
check or draft is printed.

• Seq: Enter the sequence number for this payment.

The system uses this number only to keep the payments in numerical order.

• Date: Enter the check, draft or wire date, or accept the default, which is today's date.
• Bank Code: This field displays the vendor's default bank code, but you can change it to the

bank code of the bank account from which the vendor is to be paid.
• Payment Amount: Enter the check, wire, or draft amount for the current payment. The payment

amount displays in terms of the bank code's currency.

For standard checks and drafts, you cannot update this field. Instead, the system displays the
sum of all the payment distributions for the vendor. To change this amount, you must change
the distributions using the A/P Payment Distributions form.
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• Exchange Rate: If you are using multiple currencies, this form displays the exchange rate
between the domestic currency and the payment currency, but you can change it. For open
payments, you must book a gain/loss transaction if the exchange rate on the payment is
different than the exchange rate on the voucher or adjustment. The payment goes to A/P
Posted Transactions with the same exchange rate as the open payment. The system does
not revalue the voucher.

• A/P Notes: Enter a description of the payment (up to 40 characters).
• G/L Reference: Enter a description of the payment for reference. This description is posted to

the General Ledger as part of the transaction posting. The default reference is APP, followed
by the vendor number.

The reference code must begin with AP; otherwise, the void utility cannot function.

4 To save the payment, select Actions > Save.

The system creates the payment record and then displays all open vouchers and payments for
the vendor in the grid at the bottom of the form.

5 In the grid at the bottom of the form, do one of the following:

• Select the check box in the Select column for each voucher and payment (transaction line)
that you want to apply the payment to.

• To apply the action to all the displayed items, click Select All.

6 To change an item's payment amount, click the grid scroll bar to display the Amt To Pay column,
and then enter the amount to be applied.

7 (Optional) For vouchers, you can enter a discount amount in the Discount column.

8 To distribute the payment, click Apply.

The Applied and Remaining fields in the upper part of the form show the updated amounts. You
can then apply the payment when these amounts are equal.

Note:  If the payment is not standard check or a standard draft, and the applied amount is less than
the remaining amount, the difference creates a new open payment distribution. If the applied amount
is more that the remaining amount, an error message displays, and you will not be able to continue
until you correct this error.

Using A/P Quick Payment Application to Enter and Distribute
an Open Payment
To enter a payment and distribute it as open, use the A/P Quick Payment Application form. You can
also distribute open payments that have been entered using the A/P Payments form.

Caution:  Transactions in the grid at the bottom of the form do not become available for selection
until you save the payment in the upper part of the form. After selecting items in the grid, you must
then click Apply to process them. Selecting a different payment without first click Apply will cancel
any changes you made in the grid.

1 Open the A/P Quick Payment Application form.

2 Select Actions > New.
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3 Enter the payment data:

• Vendor: Enter or select the vendor who is to receive the payment.
• Type: This field displays the vendor's default payment type from the Vendors form, but you

can select a different one from the following options:
• Manual Check
• Wire Payment
• Incoming Draft
• EFT
Note:  Because you must enter a check number in the Number field to distribute an open
payment, do not select the Standard Check or Standard Draft option.

• Number: To distribute an open payment, enter the check number.

If the check number is blank, any open payments from A/P Posted Transactions do not
display in the grid at the bottom of the form.

• Seq: Enter the sequence number for this payment. This number is used only to keep the
payments in numerical order.

• Date: Enter the check, draft or wire date, or accept the default, which is today's date.
• Bank Code: This field displays the vendor's default bank code, but you can change it to the

bank code of the bank account from which the vendor is to be paid.
• Payment Amount: Enter the amount of this open payment. The payment amount cannot be

negative, or an error message displays when you click Apply.
• Exchange Rate: If you are using multiple currencies, this field displays the exchange rate

between the domestic currency and the payment currency, but you can change it.

For open payments, you must book a gain/loss transaction if the exchange rate on the payment
is different than the exchange rate on the voucher or adjustment. The payment goes to A/P
Posted Transactions with the same exchange rate as the open payment. The system does
not revalue the voucher.

• A/P Notes: Enter a description of the payment (up to 40 characters).
• G/L Reference: Enter a description of the payment for reference. It is then posted to the

General Ledger as part of the transaction posting. The default reference is APP, followed by
the vendor number.
Note:  The reference code must begin with AP. Otherwise, the void utility does not function.

4 To save the payment, select Actions > Save. The system creates the payment record, and then
displays all open vouchers and payments for the vendor in the grid at the bottom of the form, but
none are automatically selected.

5 Select the items you want to process, or, to distribute the entire payment amount as an open
payment, leave them all unselected.

6 Click Apply. The system creates the open payment distribution record and generates distributions
records for any vouchers that are selected in the grid. Any remainder of the payment amount is
applied as an Open type payment distribution.

Note:  Open type payment distributions display in the grid with a type of Open (Dist) to distinguish
them from open payments displayed from the A/P Posted Transactions form.
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Voiding Checks Before They Are Posted
Use the A/P Check Printing/Posting form to void checks before they are posted, that is, before you
print the final register.
Note:  If you exit from the A/P Check Printing/Posting form after printing or voiding checks but without
running the Final Register and Post option, the system will void any records that are not already
voided, and then automatically run the Final Register and Post option.

Voiding Posted Checks
After checks have been posted, use one of the methods listed here if you need to void them:
• Voiding Posted Checks Using the A/P Payments Form
• Voiding a Posted Check Using the Void A/P Posted Payments Utility

After voiding the checks, you can reprint them.

Voiding Posted Checks Using the A/P Payments Form
To void posted checks using the A/P Payments form:

1 Select Actions > New.

2 Enter data in the following fields:

• Vendor: Select the number of the vendor whose check you want to void.
• Bank Code: Enter a valid bank code for the bank against whom the original check was issued.
• Payment Type: Select Manual Check.
• Check Number: Enter the number of the check you want to void.
• Check Date: Enter the date of the manual check.
• Seq: Accept the default, which is the next incremental number. The system uses this number

only to keep the distributions in numerical order.
• Check Amt: Enter the negative value of the check you are voiding. For example, to void a

$250.00 check, specify -250.00.

3 In the G/L Reference field, enter the description for this transaction that is to appear in the journals.
The default is APP, followed by the vendor number.

4 Select Distributions.

5 Select Actions > New.

6 Distribute to the vouchers as negative amounts.

7 Print the final register and post the negative check.

Note:  The check number that defaults on the A/P Check Printing and Posting form during this
process is strictly for standard checks. You do not need to update this number when posting the
negative manual check.
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Voiding a Posted Check Using the Void A/P Posted Payments Utility
Note:  If the A/P payments are manual checks, are compressed, or are multi-site, you cannot void
them using this utility.

To void a payment using the Void A/P Posted Payments utility:

1 Enter data in the following fields:

• Bank Code: Select the bank code of the bank account associated with the payments you want
to void.

• Starting and Ending Check Num: Enter the range of check numbers you want to void.

For a single check, use the same starting and ending check number.

2 Select Process.

Voiding Unposted Drafts
You can use the A/P Draft Printing/Posting form to void drafts only if they have not yet been posted.

1 Choose the Void Drafts option. The To Void group box is updated with information about the drafts
that will be voided.

2 When prompted, click OK to void the listed drafts.

If you want to void a draft after it has been posted, you must use the Void Posted Draft Payments
form.

Voiding Posted Drafts
After posting drafts, you can void them, using the Void Posted Draft Payments form.

After voiding the drafts, you may reprint them.

Note:  If the A/P payments are standard drafts, are compressed, or are multi-site, you cannot void
them using this utility.

To void drafts using the Void Posted Draft Payments form:

1 Enter data in the following fields:

• Bank Code: Select the bank code of the drafts you want to void.
• Starting and Ending Draft Number: Enter the draft number range of the drafts you want to void.

2 Perform one of the following actions:

• To view the results of running the utility without saving the results in the database, select
Preview.

• To save the results in the database, select Commit.

3 Click Process.
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Vouchers

Activating Voucher Authorization
You can turn the Voucher Authorization feature on or off using the Purchasing Parameters form.
Once you activate voucher authorization, you can also set up voucher tolerance criteria to allow flexibility
in authorizing vouchers.

1 On the General tab, select the Voucher Authorization check box.

2 In the Voucher Tolerance Over field, enter the upper tolerance factor percentage.

3 In the Voucher Tolerance Under field, enter the lower tolerance factor percentage.

Note:  The tolerance factor cannot be greater than 100 percent or a negative number.

4 To save your selection, select Actions > Save.

You need special authorization to update purchasing parameters. See your system administrator for
assistance.

When you activate Voucher Authorization, you can update the Auth Status and Authorizer fields on
the A/P Vouchers and Adjustments form. The system determines the vouchers to post, depending
on the value in the Auth Status field.

The Auth Status field has three possible values: Authorized, Failed, and/or Matched. If the purchase
order's unit material cost equals the voucher's cost or is within the acceptable tolerance limit, the system
assigns the voucher a status of Matched; otherwise, the voucher is assigned a status of Failed. If the
vouchers can be posted, the system updates the Auth Status field to Authorized when you start the
Voucher Authorization utility.

Note:  PO Line/Release Unit Material Cost (not Unit Plan Cost) is compared to Generate A/P
Transactions Unit Cost.

When you create vouchers automatically from Purchasing, the system follows these rules:

• The Authorizer field default value comes from the purchase order's Buyer field.
• The system assigns all returns or adjustments an authorization status of Failed.
• Variances between expected freight, miscellaneous charges, etc., do not cause the system to set

the authorization status to Failed.

When you create vouchers manually from Accounts Payable, the system follows these rules:

• The system always assigns to vouchers an authorization status of Failed.
• Any time a voucher is updated, the system assigns it an authorization status of Failed.
• The Authorizer field is required if the Auth Status field is set to Authorized.

Authorizing Vouchers
You can control which vouchers to post. However, this process is optional.
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To authorize vouchers:

1 On the Purchasing Parameters form, activate voucher authorization.

See Activating Voucher Authorization on page 91.

2 Create vouchers.

See Creating Vouchers or Adjustments on page 95.

3 To select the vouchers to post, run the Voucher Authorization utility. This utility examines vouchers
and determines whether they can be posted. The default selection processes all vouchers and
adjustments. None of the selection criteria fields is required, but you can use them to limit the
number and type of vouchers the system processes.

4 Specify this information, as appropriate:

Starting and Ending Authorizer
Specify the range of authorizers. All vouchers authorized by people whose names fall alphabetically
between the starting and ending names are affected by this utility.

Starting and Ending Voucher
Specify the range of vouchers you are authorizing.

Starting and Ending Invoice Date
Specify the range of invoice dates for the vouchers you are authorizing.

Starting and Ending Vendor
Specify the range of vendors whose vouchers you are authorizing.

Authorization Status
Select the status of the vouchers you are authorizing: Failed and/or Matched.

5 Perform one of these actions:

• To view the results of running the activity or utility without saving the results in the database,
select Preview.

• To save the results in the database, select Commit.

6 Click Process.

Note:  The system does not post vouchers that have an authorization status of Failed.

7 Post the vouchers you selected in the Voucher Authorization utility.

If Voucher Authorization is not activated, follow your usual posting procedure to post vouchers.

Creating Recurring Vouchers
You can create recurring vouchers for payments you make to the same vendor every month. These
recurring payments include such things as rent, lease payments, and insurance bills. You should
generate recurring vouchers each month.

Caution:  Your company must develop procedures to prevent multiple generations for the same
month.
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1 Open the Recurring Vouchers form.

2 Select Actions > New.

3 Specify the required information listed below.

For more information, see the field descriptions for the relevant fields.

• Vendor
• Voucher
• Distribution Date
• A/P Acct
• Reference
• Invoice Date
• Due Date
• Disc Date

Note: This field displays the default terms from the vendor's terms code.

If you are using Advanced Terms, the European algorithm is used to calculate the due date, based
on all the elements of the terms. This algorithm is also used to recalculate the due date if any
element of the terms has changed or if the invoice date has changed.

4 (Optional) Enter information in the other fields.

5 Save the record.

6 To distribute the recurring voucher on page 102, click Distribution.

After you enter the recurring voucher and create a distribution for it (either manually or
system-generated), the distribution record remains on file. You do not need to distribute each month
unless the purchase amount changes. If this amount changes, you must update the distribution
record to reflect the new amount.

Examples of these two situations are rent and utility bills. Typically, the rent amount is the same
each month and so it is not necessary to distribute it each month. While a utility bill is recurring,
the currency amount usually is different each month, in which case it would be necessary to
redistribute it.

7 After vouchers are created and distribution is set up, you can generate recurring vouchers on page
106 at each payment cycle.

Creating Vouchers or Adjustments Automatically
There are two ways to automatically generate vouchers or adjustments:

• Configure the Auto Voucher feature for each vendor.
• Use the Generate A/P Transactions form, as described here.

To automatically create vouchers or adjustments using the Generate A/P Transactions form:

1 Open the Generate A/P Transactions form.

2 To display receipts for purchase order lines:

a Select the vendor whose invoice you are entering and then click Filter-In-Place.
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In the grid, vendor/currency combinations are displayed, so you can select one to work with.
This determines the purchase orders for which receipts will be vouchered and also filters the
other activities, such as PO Selection and Additional Material Selection.

b Do one of the following:

• To create a voucher for received purchase order lines, select the Voucher option.
• To create an adjustment to an existing voucher for returned items, select the Adjustment

option.

c If you selected the Adjustment option, in the Voucher field, select the existing voucher number.
d In the G/L Dist field, select a date or accept the default, which is the current date. The date is

the record date of the accounts payable transaction.
e To link the new voucher to a voucher pre-register, select the voucher pre-register number, and

then select OK.
f Select the Additional Material Selection tab.
g To voucher purchase order lines:

• Select the Generate from PO check box.
• Select the range of purchase orders you want to use.
• Select the lines/releases you want to use.

Note:  If the unit of measure of a purchase order line item was changed to something other
than the original unit of measure listed on the Items form, the Generate A/P Transactions
utility uses the original unit of measure to validate the data.

h To voucher GRN lines:

• Select the Generate from GRN check box.
• Select the range of GRNs appearing in the invoice.
• (Optional) Select the range of GRN line numbers appearing in the vendor's invoice.
• (Optional) Select the range of purchase order numbers appearing in the vendor's invoice.

i To voucher EDI invoices:

Selecting the Generate from EDI Invoices check box clears any values currently in the
Generate from PO and Generate from GRN fields of the Additional Material Selection tab
and disables those fields.

• Select the Generate from EDI Invoices check box. This field is disabled if the vendor is
not set up for EDI transactions or if there are any pending transactions currently on the
Material tab or the Taxes tab.

• Select an invoice.
• To include GRN lines, select the Received via GRN check box and select a GRN number

in the GRN field.
• Select Select Matching. Receipts for purchase order lines display in the browser on the

Material tab.

3 Edit the lines to reconcile receipts with the vendor's invoice.

When you edit receipt lines, the amount in the Total field on the Material tab is automatically
recalculated.

a Delete any purchase order receipt lines or GRN lines in the Material tab that are not referred
to in the vendor's invoice.
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b In the To Vch/Adj field, modify (as required) the number of units of each line item to include
in the voucher, or accept the default value of the quantity received minus any quantity previously
vouched for the purchase order line or GRN line.

c Modify (as required) the unit cost of each line, or accept the default value.

4 Create pending tax transaction lines for the received purchase orders.

The Taxes tab is enabled when the Active for Purchasing check box is selected on the Tax
Systems form for at least one tax system.

If the Taxes tab is disabled, you can enter tax amount(s) from the vendor's invoice, or other amounts
as required, in the Sales Tax field(s) on the header.

a Select the Taxes tab.
b Select Generate Tax. The activity calculates the sales tax for each pending voucher line on

the Material tab and creates a pending tax transaction line for each purchase order on which
tax is owed. The activity displays the total of the line amounts in the Sales Tax field(s) on the
Taxes tab and provides the option of copying the sum(s) to the header.

Note:  The label for the Sales Tax field is user-defined.

c To add a tax amount that was not created in the generation process, create a new tax
transaction line.

5 Enter payable amounts in the voucher header:

a In the Material field on the header, enter the amount displayed in the Total field on the Material
tab. Amounts in the two fields must be equal. The amount should be equal to what is specified
on the vendor's invoice.

b In the Freight and Misc Charges fields on the header, enter amounts from the vendor's invoice
or as required.

c If you have not already entered sales tax on the header, do so now. Sales Tax amount(s) on
the header must equal the total(s) on the Taxes tab.

d If you are creating a non-EDI voucher or adjustment, select the General tab and enter the
required information.

6 To generate the voucher or adjustment, click Generate.

The new voucher number appears in a message when processing is complete.

Creating Vouchers or Adjustments Manually
You can manually create a voucher for these tasks:

• To record an amount you owe to a vendor.
• To reduce the amount of a previously entered voucher.
• To reverse the full amount of a previously entered voucher, using single entry accounting. For this

task, do not follow the steps below.

See About Cancellation Posting for Single-Entry Accounting on page 13.

Note: You can also create vouchers or adjustments automatically. After you receive the purchase
order, use the Generate A/P Transactions utility to create the vouchers or adjustments, or configure
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your vendors to allow generation of vouchers immediately after receiving a shipment by using the Auto
Voucher field.

See Creating Vouchers or Adjustments Automatically on page 93.

To print a new voucher with adjusted amounts, you must first negate the original voucher entirely.
Using the PO Receiving form, perform a debit return for the same quantity originally vouchered. The
system generates an adjustment to offset the corresponding voucher, allowing you to begin again.
Then, receive the quantity back in. The new voucher can now be generated with the corrected domestic
currency amount.

1 Open theA/P Vouchers and Adjustments form.

2 SelectActions > New.

3 In the Vendor field, select the vendor for which you are entering the voucher or adjustment.

4 Specify this information:

Type
To add a voucher, select Voucher. To enter an adjustment, select Adjustment.

Voucher
If you are entering a Voucher transaction, specify a unique voucher number, or accept the default
of the next available voucher number. If you are entering an Adjustment transaction, select the
voucher number to be adjusted.

Invoice
Specify the vendor's invoice number.

Invoice Date
By default, this field displays today's date, but you can change it to the date on which the vendor
invoiced you for this transaction.

Distribution Date
By default, today's date displays, but you can change it to the date on which you want to distribute
these funds (for a voucher) or on which you want to apply the adjustment to this vendor's account.

PO
Select the vendor's purchase order number to apply the transaction against. When applicable, the
default value comes from the voucher.

Pre-Register
(Voucher transactions only) If you want to voucher material before it is received, specify a
pre-register number.

GRN
The goods receiving note number displays.

Posted from PO
This check box is automatically selected if the voucher was added as part of the posting process
from the Purchasing module. If you are manually adding a voucher through the A/P Vouchers
and Adjustments form, this check box is not available for selection.If this check box is selected,
you cannot delete the record. In addition, you can modify only some of the fields. Note that you
can still manually distribute the transaction to re-allocate the G/L account amounts.
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Auto Vouchered
This check box is selected if the order was automatically vouchered during PO receipt.

5 Specify the appropriate amounts in these fields:

Purch Amt
For a Voucher transaction, enter the total amount of the vendor invoice you are recording. Do not
include miscellaneous taxes, brokerage, duty, freight, insurance, and local freight in this amount.
For an Adjustment transaction, enter the amount by which to adjust the voucher and the vendor's
purchases YTD. A negative amount decreases the balance, while a positive amount increases it.

Freight
Specify the amount of freight payable for the transaction.

Duty
Specify the duty charges for the transaction.

Brokerage
Specify the brokerage charges for the transaction.

Insurance
Specify the insurance charges for the transaction.

Local Freight
Specify the local freight charges for the transaction.

Misc Charges
Specify the miscellaneous charges for the transaction.

Sales Tax

Specify the amount of tax for Tax System 1 payable on this transaction. This field is available only
if the Prompt for State Tax check box is selected on the Tax Parameters form.

Sales Tax 2

Specify the amount of tax for Tax System 2 payable on this transaction. This field is available only
if a second tax system is defined, and the Prompt for Tax System 2 check box is selected on
the Tax Parameters form.

Non-Disc Amt
Specify the domestic currency amount of the invoice amount that is not eligible for a discount.

Disc Amt
Specify the domestic currency amount of the discount that may be taken if the payment is made
on or before the discount date.

6 Specify this information:

Prox Code

If you selected the Advanced Terms field on the Billing Terms form, enter the appropriate Prox
Code. During the calculation of the due date, the "prox code" adjusts the date before the due days
are added on.
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Prox Day
If you specified a Prox Code value, enter the day of the month following the invoice date on which
the voucher becomes due.

Disc Pct
Specify the discount percentage to be given if payment is made by the discount date. This field
displays the default value from the Billing Terms record that is associated with the vendor's Terms
Code, but you can change it.

Disc Days
Specify the number of days after the invoice date that payment of the invoice qualifies for a discount.
This field displays the default value from the Billing Terms record that is associated with the
vendor's Terms Code, but you can change it. The system uses this value to calculate the discount
date.

Disc Date
Specify the date on which this voucher must be paid to qualify for a discount, or accept the default
date that is calculated. If the vendor does not offer a discount, you can clear this field.

Due Days
Specify the number of days after the invoice date that the invoice payment is due, or accept the
default that is displayed from the Billing Terms record that is associated with the vendor's Terms
Code.

Due Date
This field displays the date on which the invoice is due. The system calculates this date using the
Invoice Date and the Due Days or Prox Day value, but you can change it.

Fixed Rate
(For non-domestic currency transactions only) Select this check box only if you want to use a fixed
rate. Selecting this check box fixes the rate for the life of the document.
If you have set up multiple currencies for the vendor, then based on the selected currency, this
field uses the same value (selected or cleared) as on the Vendor Currency Codes form or
Currency Codes area on the Vendors form. You can update the value here if necessary, unless
the selected currency is the domestic currency.

Currency
(For non-domestic currency transactions only and only voucher transactions) If you have set up
multiple currencies for the vendor, if no distributions exist, and if Posted from PO is not selected,
you can specify a currency for the voucher.

Exchange Rate

(For non-domestic currency transactions only and only voucher transactions) For a non-domestic
currency transaction that has no receipts against it, you can enter an exchange rate if currency
exchange rate overrides are allowed for the selected currency code. The rate applies to the entire
order and can be changed until a receiving transaction is made against the order.

A/P Acct
(Voucher transactions only) By default, this field displays the General Ledger A/P account number
from the Accounts Payable Parameters form, but you can select a different account.
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(Unit Code 1-4)
(Voucher transactions only) For each unit code that you use, you can select the applicable code
for journal and reporting purposes.

Reference
The default value for this field is APRV (for Voucher transactions) or APA (for Adjustment
transactions) plus the voucher number, but you can specify a different reference to appear in the
journals for this transaction.

Builder PO Originating Site
The ID of the site where the Purchase Order Builder form was run to create this purchase order
is displayed.

Builder PO
If a Builder Purchase Order number is displayed in this field, the purchase order was created with
the Purchase Order Builder form. There may be purchase orders at different sites that are
included under this "umbrella" order. The ordered items may be included as part of a Master Buy
Agreement; if the quantities in the original PO are altered, the Master Buy Agreement may no
longer be applicable for this PO.

Builder Voucher Originating Site
The ID of the site where the Voucher Builder or Manual Voucher Builder forms were run to
create this voucher is displayed.

Builder Voucher
If a value is displayed in this field, this voucher was generated using the Voucher Builder or
Manual Voucher Builder forms.

Auth Status
Select the authorization status of the transaction. Options include Matched, Authorized or Failed.

(Authorizor)

Specify the name of the person authorizing the transaction. Note that you must enter a name if
the Auth Status field is set to Authorized.

Notes
Optionally, you can add notes about the transaction.

Fiscal Reporting System Type
If this voucher is for a DAS2 vendor, specify a type  to classify the transaction.

7 SelectActions > Save.

Creating Vouchers with the Manual Voucher Builder
The Manual Voucher Builder form allows you to quickly create a voucher in one or more sites for a
single vendor's invoice. On any site, you can specify the portion of the vendor invoice amounts to
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allocate. You can enter all or some subset of the vendor invoice amounts. You may use the originating
site as the To Site.

1 Set up Replication Rules for the Voucher Builder category. This is a one-time setup.

• From the Manual Voucher Builder site to the remote site(s) into which pending voucher
transactions will be created. This allows the setup of how the system will process pending
voucher transactions.

• From the remote site(s) into which pending voucher transactions will be created to the Manual
Voucher Builder site. This will replicate the necessary _all table data for validations performed
on the Manual Voucher Builder form.

2 Open the Manual Voucher Builder form.

3 Enter this information in the header:

• Vendor: Select the vendor for which you are entering the voucher. The vendor's name displays.
• Invoice: Enter the vendor's invoice number for tracking purposes.
• Invoice Date: By default, this field displays today's date, but you can change it to the date on

which the vendor invoiced you for this transaction.
• Distribution Date: By default, today's date displays, but you can change it to the date on which

you want to distribute these funds.
• Notes: (Optional) Enter any notes about the transaction.
• Generate Distribution: Select this check box to have the system automatically distribute the

voucher once you process it.
• Fixed Rate: (For non-domestic currency vendors only) Select this check box only if you want

to use a fixed rate. Selecting this check box fixes the rate for the life of the document.
• Currency: The currency rate displays.
• Exchange Rate: (For non-domestic currency vendors only) Enter the exchange rate.
• Purchase Amt: Enter the total amount of the vendor invoice you are recording.
• Freight: Enter the freight charges.
• Duty: Enter the duty charges.
• Brokerage: Enter the brokerage charges.
• Insurance: Enter the insurance charges.
• Local Freight: Enter the local freight charges.
• Misc Charges: Enter the miscellaneous charges.
• Sales Tax: Enter the amount of tax for Tax System 1.
• Sales Tax 2: Enter the amount of tax for Tax System 2.
• Invoice Amt: The invoice amount displays.

4 In the grid for each site, enter this information. Allocation totals display at the bottom of the form.

• To Site: Select the target site.
• Purchase Amt: Enter the purchase amount for the site.
• Freight: Enter the freight charges.
• Duty: Enter the duty charges.
• Brokerage: Enter the brokerage charges.
• Insurance: Enter the insurance charges.
• Local Freight: Enter the local freight charges.
• Misc Charges: Enter any miscellaneous charges.
• Sales Tax: Enter the sales tax.
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• Sales Tax 2: If this field is available, enter the sales tax for Tax System2.
• Invoice Amt: The invoice amount displays.

5 To generate the vouchers for each site, click Process.

If validation is successful, the system creates the pending voucher transactions in the site(s)
specified. It generates a new Builder Voucher number based on the originating sites Purchasing
Parameters and the last Builder Voucher number. The Builder Voucher Orig Site is set as the
site specified on the General Parameters form where you are creating the manual voucher.

If validation fails, the system handles the failure in one of the following ways:

• If the To Site is equal to the Manual Voucher Builder site, or if replication is transactional, from
the Manual Voucher Builder site to the remote site, then the system returns the error and does
not process the transactions.

• If the To Site is not equal to the Manual Voucher Builder site and replication is non-transactional,
the system handles the failure only at the remote site via the error-handling process that has
been defined for non-transactional replication.

The new Builder Voucher number is displayed in a message when processing is complete.

When you close the form, the system removes any unprocessed rows.

About Consolidated Vouchers
The Generate A/P Transactions activity supports consolidated vouchers. A consolidated voucher
covers multiple purchase orders referred to in a vendor's invoice. The voucher can also cover goods
receiving notes (GRNs) for shipments invoiced by a vendor.

A consolidated voucher has one Terms Code, though the purchase orders covered in the voucher may
have various codes. You can set the Terms Code for the voucher on the General tab. Otherwise, when
the activity creates material distribution lines, the Terms Code of the first purchase order is used as
the code for the voucher.

If any purchase order referred to in the vendor's invoice has a Fixed Rate, that rate determines what
purchase orders can be included in the voucher. Only purchase order lines with the same fixed exchange
rate can be included in the voucher. The activity selects such lines when it creates pending material
distribution lines. A voucher can include multiple variable-rate purchase orders.

A consolidated voucher has one Authorizer, though the purchase orders covered in the voucher may
be associated with more than one. You can specify the Authorizer to associate with the voucher on
the General tab. Otherwise, when the activity creates material distribution lines, the Buyer for the first
purchase order is used as the Authorizer for the voucher.

During generation of a voucher, the activity assigns any amounts entered in the Freight field and the
Misc Charges field to the first purchase order in the voucher.

Only purchase orders with the status Ordered and GRNs with the status Approved are considered
when the activity generates pending material transaction lines.

Landed costs must be vouched with the Generate Landed Cost Vouchers activity.
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If you are generating vouchers or adjustments for a vendor with a Vendor Category defined, the A/P
account number defaults from the Vendor Categories form. If you are using Advanced Terms, the
European algorithm is used to calculate the due date bucket for purchase orders and customer orders.

Distributing Recurring Vouchers
You can distribute the amount of each recurring voucher across multiple accounts in the General
Ledger. You can distribute these recurring vouchers either manually or automatically:

• To automatically create a voucher distribution in the Recurring Vouchers form, select the desired
voucher and then select Actions > Distribution Generation.

When you do this, the distribution uses the default purchases account from the Vendor record. If
there is not a default purchases account on the Vendor record, then it uses the default purchases
account from Accounts Payable Parameters.

• To manually create a voucher distribution, use the steps in this topic.

You only need to create the General Ledger (G/L) distributions once for each recurring voucher, unless
the payment amount changes.

After the recurring vouchers and their distributions are set up, then each time you run the A/P Recurring
Voucher Generation utility, it creates a recurring voucher and posts the voucher and its G/L distributions
to the A/P Vouchers and Adjustments form.

Note:  The system saves the recurring voucher's G/L distribution records until you delete the recurring
voucher.

To manually create a voucher distribution:

1 Open the Recurring Vouchers form.

2 Select the desired voucher.

3 To display the voucher in the Recurring Voucher Distribution form, click Distributions.

4 On the Recurring Voucher Distribution form:

a Select the vendor.
b To add a distribution, select Actions > New.
c Specify this required information:

Amount
Specify the amount for this distribution sequence number.

Account
Specify the account number for this distribution sequence number.

5 Continue adding distributions until the Distribution Total field equals theInvoice Amt field.

6 Optionally, to associate a distribution with a project on the Recurring Voucher Distribution form:

a In the Dist Seq field, accept the default of the next available sequence number.
b In the Project field, select the project number for the recurring voucher.
c Select the task number.
d Select the project cost code.
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7 You might have to enter tax information on the Recurring Voucher Distribution form, depending
on how the tax parameters were set up for this vendor. To add tax information:

a Select the tax system number to be used with this tax distribution.
b Select the tax code rate.
c Select the exempt tax code, if necessary.
d In the Tax Basis field, enter the taxable monetary amount on which the tax amount is based.

Distributing Vouchers and Adjustments
You can create distributions for vouchers and adjustments in either of these ways:

• To automatically distribute vouchers and adjustments, use the A/P Vouchers and Adjustments
form or the Voucher Adjustment Distribution form. Select the transaction you want to distribute
and then select Actions > Distribution Generation.

• To manually distribute vouchers and adjustments, use the steps in this topic.

You can also have the system distribute the amounts for you during the posting process.

To distribute vouchers and adjustments manually:

1 Open the Voucher Adjustment Distribution form.

2 To add a distribution, select Actions > New.

3 In the Vendor field, select the vendor whose voucher or adjustment you want to distribute.

4 In the Voucher field, select the transaction you want to distribute.

5 In the Dist Seq field, accept the default value of the next available sequence number.

This number is used to order the distributions for the selected transaction.

6 On the Allocation And Tax tab, in the Amount field, enter the distribution amount.

7 In the Account field, select the General Ledger account to post the transaction to.

8 If you must submit DIOT and IETU reports, specify or review this information on the Tax Parameters
tab:

Tax Reg Number Type
Specify the tax regulation number.

DIOT Transaction Type
Specify the DIOT transaction type.

Tax Reg Num Foreign
If selected, indicates that the vendor has a foreign tax regulation number.

Deduction Percent
Specify the percentage deducted from the voucher distribution.

Vendor Name
The vendor name is displayed.
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Tax Reg Num
The tax regulation number is displayed.

ISO Country Code
Select the ISO-defined country name.These fields are only displayed for users who are assigned
a Mexico Localization license.

9 Select Actions > Save.

10 Repeat steps 1-7 to continue distributing the transaction until the value in the Distribution Total
field on the Amounts tab equals that of the Invoice Amt field.

Generating Vouchers
Vouchers can be generated using the methods described here.
• Automatically, using the Generate A/P Transactions form
• Manually, using the A/P Vouchers and Adjustments form
• For multiple sites, using the Voucher Builder form

When you generate vouchers, remember this information:

• Before any transactions are created, the total distributed cost of the PO must equal the sum of all
vouchered line/releases. If they are not equal, the system displays an error message.

• If you are creating an adjustment rather than a voucher, you must select the number of the voucher
you are adjusting.

• When generating an adjustment, the A/P transaction record is filled with values from the A/P posted
transaction record. The transaction type is A, and the reference begins with APA.

• As each line/release is processed, the Unit Cost field of the purchase order is set to the vouchered
unit cost, and the purchase order detail costs are set to the vouchered detail costs.

• While transactions and distributions are set, messages display if the corresponding account number
has not been set up on the Accounts Payable Parameters form (the message is only a warning,
and processing continues).

• If the cost method is Actual or Standard, the system displays a message if the corresponding
account numbers are not set for the line item.

• The following A/P distribution transaction records are created when you generate vouchers:
• If any miscellaneous charges were entered, an A/P transaction distribution record is created,

using the Misc Charges account from the Accounts Payable Parameters form. The distribution
amount is set to the miscellaneous charges amount from the voucher.

• If sales tax was entered, an A/P transaction distribution record is created, using the Sales Tax
Exp account from the Accounts Payable Parameters form. The distribution amount is set to
the sales tax amount entered for the voucher. If the Active for Purchasing check box is
selected on the Tax Systems form, the system uses the A/P Tax account from the tax code.

• If a freight amount was entered, an A/P transaction distribution record is created, using the
Freight-In account from the Accounts Payable Parameters form. The distribution amount is
set to the freight amount entered for the voucher.

• If the cost method is None, an A/P distribution transaction record is created for the distributed
amount (total of the items), using either the product code's inventory account number (if the
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item has an associated product code) or the purchases account from the Accounts Payable
Parameters form. For all other cost methods, the Vouchers Payable account is used. The
distribution amount is set to the amount vouchered (the total cost of the items).

• Finally, an A/P transaction record is created for the total cost of the items (including freight,
miscellaneous charges, and sales tax), using the Accounts Payable account from the Accounts
Payable Parameters form.

• The distribution amount is set to the total of the miscellaneous charges, freight, sales tax, and
cost of the items. At that time, the system creates a voucher register record with a line item
for each line release being vouchered.

After the vouchers are posted in A/P, you can view the completed transactions using the
Journal Entries form, by selecting the A/P Dist journal option.

• The PO line/release quantity vouchered is set to the quantity received minus the quantity returned.
• The PO line/release quantity returned is set to zero.

When all transactions and distributions are created, the system displays a message indicating that the
process is complete.

Generating Landed Cost Vouchers
After you receive your purchase order, you can voucher your landed costs (duty, freight, brokerage,
insurance, and local freight).

1 Open the Generate Landed Cost Vouchers form.

2 Select the vendor number and any other pertinent information in the form's header.

3 Click the filter-in-place button to display in the Receipts tab a list of all receipts that meet your
criteria.

4 click Select All to select all displayed receipts, or use the Select check box to select one or more
individual receipts.

Optionally, to ensure that you are selecting the correct line items and view the selected line item's
details, you can click Detail to opens the appropriate purchase order line/release form.

If you select multiple records, they must all have the same exchange rate.

5 To allocate any landed costs you entered in the header across all selected PO receipt records,
click Cost Allocation.

This determines the ratio of each individual domestic landed cost to the total domestic landed cost
and then applies that ratio to the foreign translated amount. If the foreign translated amount column
sum is not equal to the total of the duty, freight, brokerage, insurance, and local freight amounts
in the header, the system generates a warning.

When you generate a landed cost voucher from a purchase order that has a fixed exchange rate
(the Fixed Rate field is selected on the Purchase Orders form Amounts tab), and the Landed
Cost currency is the same as the PO currency, the system uses the purchase order's exchange
rate instead of the current rate. If the Landed Cost currency is different from the PO currency, you
cannot specify a fixed rate. The currency rate is then set to the Buying Exchange Rate for the
vendor currency code (where the vendor currency code is either the currency of the Landed Cost
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vendor (for freight, duty, etc.) or, if a Landed Cost vendor is not specified, the PO vendor currency)
and where the Effective Date is the most recent date earlier than the transaction date

After you allocate costs, you can still change the landed cost on individual landed cost PO receipt
lines before you post.

6 Optionally, use the Taxes tab to generate and modify the tax distributions. Tax distributions should
be specified after all landed cost records have been selected.

Note: 
• The Taxes tab is enabled when the Active for Purchasing check box is selected on the Tax

Systems form for at least one tax system. If the Taxes tab is enabled, you can enter tax
amount(s) from the vendor's invoice, or other amounts as required, in the Sales Tax field(s)
on the header.

• The label for the Sales Tax field is user-defined.
• For area-based taxes, to calculate the sales tax for each selected voucher line on the Receipts

tab and create a pending tax transaction line, on the Taxes tab, click Generate Tax. The
activity displays the total of the line amounts in the Sales Tax field(s) on the Taxes tab and
provides the option of copying the sum(s) to the header.

To add a tax amount that was not created in the generation process, create a new tax
transaction line.

• Tax distributions for an item-based tax system, where no area-based system is defined, should
be entered manually. If you enter the tax distribution manually, do not click the Generate Tax
button.

7 To generate the voucher for the selected receipts, click Generate Voucher. When this process
complete, the system displays a message showing the number of vouchers created successfully.

After you generate the voucher, the system updates the actual landed cost amounts to the respective
POs in order by type.

When you run the Generate Landed Cost Vouchers activity for POs, variances are written to the
PO Distribution Journal:

• For non-inventory items, the variances are calculated between the vouchered amount and the
PO line item amount.

• For inventory items, the variances are calculated between the vouchered amount and received
amount.

Note:  After you generate landed cost vouchers, you cannot update them in A/P.

8 Post the landed cost vouchers just as you would post vouchers for material.

9 Optionally, run the Landed Cost Variance Report.

Generating Recurring Vouchers
To create the vouchers and distributions for the current payment cycle, use the A/P Recurring Voucher
Generation utility. Use the existing recurring vouchers and distributions as the templates to create the
current vouchers and distributions.

Note:  If you have not posted the previously created voucher, you cannot create a new voucher from
a recurring voucher for a vendor.
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To generate recurring vouchers:

1 Enter information in the following fields:

• Starting and Ending Vendor: Enter the range of vendors for which you want to generate vouchers
from their recurring vouchers.

• New Voucher Month: The current month number displays by default, but you can change it to
a different number of the month for which you want to generate recurring vouchers.

• New Voucher Year: The current year displays by default, but you can change it to a different
year for which you want to generate recurring vouchers.

• Distribution Date: The current system date displays by default, but you can change it to the
date you want to assign to the generated voucher.
Note:  If the date you enter is outside of the current period and you have not activated Enter
Out of Date Range authorization, the system stops processing the vouchers and displays an
error message.

2 Click Process.

You can view the generated vouchers using the A/P Vouchers and Adjustments form.

Printing and Posting Vouchers
To print and post vouchers:

1 If your company uses the Voucher Authorization feature, run the Voucher Authorization utility
before posting the approved transactions.

Note:  Running the Voucher Authorization utility is not required before posting transactions. The
posting process allows you to post vouchers with authorization statuses of Approved and/or Matched.

2 On the A/P Voucher Posting form, provide information in the following fields:

• Authorization Status: Select from the drop-down list the authorization status of the vouchers
you want to post.

• Sort By: Select from the drop-down list the order in which you want records to be created in
the posting table, and listed in the report and grid.

• Display Voucher Totals: If you want to include voucher totals in the report, select this check
box.

• Starting and Ending Vendor Number: Select the range of vendor numbers whose vouchers
you want to post or, to process vouchers for all vendors, leave both fields blank.

• Starting and Ending Voucher: Select the range of vouchers or, to process all vouchers, leave
both fields blank.

• Starting and Ending Due Date: Select the first and last due dates for vouchers you want to
include or, to process vouchers for all due dates, leave both fields blank.

• Starting and Ending Distribution Date: Enter the first and last distribution dates to include
or, to process vouchers for all distribution dates, leave both fields blank.

3 To print and review the A/P Voucher Posting report, select Print.
4 When you are ready to post the vouchers, select Commit and then click Process.
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You can view the posted vouchers using the A/P Posted Transactions Detail and A/P Posted
Transactions Summary forms.

Note:  If you use the External Financial Interface, additional processing may occur during voucher
posting. For more information, see "Setting Up an External Financial Interface on page 183."

Posting Vouchers - Detail
Posting does the following:

• Updates vendor records
• Creates posted transactions
• Updates the voucher register
• Updates the G/L journal

During posting, the system performs these steps:

• Adds the invoice amount to the Purchases YTD field on the Vendors or Multi-Site Vendors form
for each posted transaction. For a voucher, the Last Purchase Date field on the Vendors or
Multi-Site Vendors form is updated with the distribution date, provided that the distribution date
is after the Last Purchase Date.

• Creates a posted transaction record, using the transaction currency, for each voucher transaction,
and updates the corresponding posted transaction record for each adjustment transaction.

• Creates a voucher register record for each transaction that is not posted from PO. For each
transaction, one voucher register distribution record is created for the A/P account, and one is
created for each posted distribution record.

• Creates G/L journal entries for all A/P transactions, whether generated in PO or created in A/P.

Purging Voucher History
To delete records associated with posted transactions from voucher history and free up space in your
database, use the Purge Voucher History utility.

1 Open the Purge Voucher History form.

2 In the Ending Voucher field, select the last voucher you want to purge, or, to delete all vouchers,
leave this field blank.

3 In the Ending Invoice Date field, select the most recent date of the invoices you want to purge,
or, to delete invoices of any date, leave this field blank.

4 If you want to delete only the line items of the vouchers and not the header information, select the
Delete Line Items Only check box.

5 The system does not purge voucher headers associated with unposted A/P transactions or POs
with a status of Planned or Ordered. If you want the system to display an error message every
time it finds a voucher that cannot be purged, select the Show Unpurgable Vouchers check box.

6 To purge voucher history, click Process.

Note: 
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• To deactivate A/P posted transactions before purging, you must use the Activate/Deactivate
Posted Transactions - A/P utility.

• Also, purging the voucher history does not remove the voucher and payment from the A/P Posted
Transactions Detail form. To do that, you must run the Delete A/P Posted Transactions utility
before purging the vouchers.

Using Cancellation Posting for a Voucher Adjustment
You can cancel a posted voucher one time. The entire amount of the original voucher is canceled;
partial adjustments cannot be made.

1 Open the General Parameters form and make sure Enable Cancellation Posting is selected.

2 Open the A/P Vouchers and Adjustments form and click the filter-in-place button.

3 Select Actions > New.

4 Specify this information:

Vendor
Specify the vendor for which a voucher must be canceled.

Type
Specify Adjustment.

Cancellation
Select this check box.

Voucher
Specify the voucher to which to apply the cancellation. The list of posted vouchers to which you
can apply cancellation posting does not include those that are referenced by posted adjustments
or payments.

5 Complete the voucher and save the record.

Voucher Pre-Register Overview
The VAT (Value Added Tax) captures information about the value of intra-community sales and
purchases. Voucher Pre-Register allows the VAT to be recognized as soon as the supplier ships the
material.

The information on the Voucher Pre-Register form does not require a specific purchase order. Once
the voucher pre-register has been created, the system posts the pre-register and creates journal entries
using a new suspense account. When you are ready to voucher the material (after receiving it), you
can associate the voucher with one of the pre-registers. When you post the voucher, the system
changes the voucher pre-register to a status of Closed and creates the appropriate journal entries.

If the Recognize VAT check box is selected on the Accounts Payable Parameters form (Misc tab),
the pre-register date becomes the journal entry date, and the following journal entries occur:
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Planned to Posted

CreditDebitField

Material portion from pre-register.###Suspense Acct

 ###Freight

 ###Misc. Charges

There will be a debit for each Tax Distri-
bution.

###Tax 1

 ###Tax 2

### A/P Unmatched

If the Recognize VAT check box is not selected, the following journal entries occur:

CreditDebitField

Material + Tax portion from pre-reg-
ister.

###Suspense Acct

 ###Freight

 ###Misc. Charges

### A/P Unmatched

If a voucher is associated with a pre-register and the voucher is posted, the status of the pre-register
changes from Posted to Closed, and new journal entries are created to back out the original entries.
You can also manually change the pre-register status to Closed to create the offsetting journal entries.

If the Recognize VAT check box is selected on the Accounts Payable Parameters form, the voucher
date becomes the journal entry date, and the following journal entries occur:

Posted or Matched to Closed

CreditDebitField

### Suspense Acct

### Freight

### Misc. Charges

### Tax 1

### Tax 2

 ###A/P Unmatched

If the Recognize VAT check box is not selected, the following journal entries occur:
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CreditDebitField

### (Material + Tax) Suspense Acct

### Freight

### Misc. Charges

 ###A/P Unmatched

Pre-register can hold one of four different status types:

• Planned: If the pre-register status is Planned, the pre-register is in the process of being created,
or it has been created but is not yet posted.

• Posted: If the pre-register status is Posted, the pre-register has been posted. The only way to get
a status of Posted is to manually change the status from Planned to Posted. Journal entries are
created upon saving the status.

• Matched: If the pre-register status is Matched, the pre-register has been entered and saved either
on the Generate AP Transactions form or the A/P Vouchers and Adjustments form.

• Closed: If the pre-register status is Closed, the status of the pre-register number has been changed
manually to Closed or changed to Closed by the system. The system changes the status of a
voucher pre-register to Closed when a voucher is posted that has a pre-register number. When
the status is changed to Closed, journal entries are created to back out the original journal entries.
Once the status of the pre-register is Closed, it cannot be updated. The pre-register can be deleted
by clicking the Delete button on the toolbar or by using the Delete Voucher Pre-registers utility.

Deleting a Voucher Pre-register

The Delete Voucher Pre-Registers utility deletes all voucher pre-registers within a specified range.
The voucher pre-register must have a status of Closed before it can be deleted. All voucher pre-register
distributions for the range of voucher pre-registers are also deleted. Deleting voucher pre-registers
removes all information about the voucher pre-registers, and affects tax reporting.

Processing External Expense Reports
Expense reports can be sent as BODs to SyteLine from another application such as Infor Expense
Management.

SyteLine can process these BODs either through the Accounts Payable system or through the Payroll
system. This is determined by the setting of the Process External Expense Report in A/P field on
the Accounts Payable Parameters form:

• If Process External Expense Report in A/P is selected, the expenses are paid through a vendor
record that is linked to the employee record.

• If Process External Expense Report in A/P is not selected, the expenses are paid through payroll
payments to the employee.

Before you begin processing expense reports, you must set up employee information and certain codes
in SyteLine. If you are processing expenses through A/P, you must also perform these tasks:
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• Use the External Expense Types form to specify information that will be used to generate the
appropriate transactions and voucher distributions. A typical expense type might be something like
Airfare, Meals, or Hotel. In an Infor Expense Management expense report, this expense type is
tied to an Infor Expense Management project. The Infor Expense Management project has a prefix
(SRO_ for service orders, PRJ_ for projects, JOB_ for job orders, or any other prefix for
miscellaneous cost centers). For example, an expense type of Hotel might be tied to
SRO_SO0000000002/1, which transforms to a specific service order line in SyteLine.

The transaction type (prefix) determines how the fields on this form are used during SyteLine
processing of the specified expense type:

• For cost centers, that is, instances where the expense is not tied to an SyteLine order, the
Voucher Expense Account is used for A/P voucher distributions.

• For job orders, the Order Offset Account is used for A/P voucher distributions. That account
is also credited when a job material transaction is posted. The U/M field is needed for a material
transaction and generally is set to EA.

• For service orders, the Order Offset Account is used for A/P voucher distributions. The SRO
Misc Code is used for "miscellaneous"service transactions to obtain the Misc Code's account.
That account is credited when the service order transaction is posted.

• For project orders, the Cost Code on this form is set as the cost code for the A/P voucher
distribution. The cost code and the project are used to get the account data to use for that
distribution. When the A/P voucher is posted, a project transaction is created and posted for
the project order/task.

• Set up vendor records and associate them with each employee who will receive expense
reimbursement

For detailed steps, see the Infor SyteLine Integration Guide for Infor Expense Management.
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Chapter 3: Accounts Receivable (A/R)

Accounts Receivable Steps
Accounts Receivable (A/R) is the process you use to invoice customers for services you rendered or
goods you provided to them. You also use A/R to process customer payments and track discrepancies.
A/R is closely linked to Customer Service, where you enter orders and track customer interaction.

The basic steps for A/R are listed here. See the linked topics for more information.

1 Create an invoice, debit, or credit memo in A/R (Eliminate residual balances by generating debit
or credit memos).

Note:  You should create most invoices through Customer Service. Use A/R to enter only those
invoices, debit memos, and credit memos that do not result from the sale or return of inventory
items.

2 Distribute invoices on page 129.

3 Post invoices, debits, and credit memos on page 129.

4 Enter customer payments on page 135 (Enter customer payments using Quick Payments on page
154).

5 Distribute customer payments on page 137.

6 Post payments on page 162.

7 Run the A/R Aging Report on page 167.

8 Generate and post finance charges on page 146.

9 Rebalance customer balances.

10 Close the year for Accounts Receivable on page 119.

About A/R Posting
During posting, the system updates three types of records:

• Customer Master records
• Open Item records
• G/L Journal records

Following is a summary of the posting process:

• The system updates two fields of the Customers file for each transaction posted.
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• If the receipt date for the payment transaction is later than the last payment date in the Customers
file, the receipt date becomes the new last payment date.

• The system reduces the Customer Posted Balance amount by the payment amount and any
discount or allowance you give to the customer.

• The system creates an Open Item record for each transaction being posted.
• The system creates A/R Ledger Distribution Journal records.
• For each transaction, there is one journal record for the cash amount and one transaction for each

distribution record you enter.
• While posting payments, the system recalculates the Customer's Days Outstanding fields for

customers with an Open Item Balance Method. The values change if the payments being posted
fully pay an invoice.

• The system enters multi-currency gains and losses in the A/R journal (if applicable).
• When posting multiple checks, wires, and adjustments, a summary entry is created on the Bank

Reconciliations form. You can also post checks, wires, and adjustments individually to create
individual bank reconciliation entries.

About Credit for Returns
In some cases, you will need to issue credit for a return.

Determining How Much Credit to Issue

The decision about how much credit to issue is made when the customer is authorized to reject material
on the RMA Line Items form. Factors that enter into the calculation of the credit include:

• Quantity to Return: You enter the number of items for which return is authorized. If the material is
referenced to a customer order and line item, then the quantity returned cannot be greater than
the quantity invoiced. If the item is serial-tracked, then the quantity returned must be a whole
number.

• Unit Credit: You can enter the credit which you authorize for each unit returned. The default is the
cost associated with the item on the original customer order, if known, or the cost taken from current
pricing routines if the item is inventoried.

• Restocking Fee: Your company can elect to charge customers a small fee for the staff time it takes
you to process the returned material. This fee is often called a restocking fee, but you can call it
something else on your credit memos simply by changing the name in the Description field of the
RMA Parameters form. The system calculates the restocking fee based on the Restocking Fee
% stored on the RMA Parameters form to provide a Restocking Fee amount. This percent and
amount can be overwritten. Overwriting either one will cause the other to be recalculated.

Note: 
• If an RMA line item references a valid customer order and line, then an attempt is made to back

out the commission given on the original order by the RMA amount. In the calculation of the
commission to reverse, the restocking fee is not included.

• All invoicing (and crediting) must be done at the shipping site. All accounts receivable and inventory
transactions also occur at this site.
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Printing and Posting the Credit

To preview all RMA line items that are ready to be credited, run the RMA Status Report. RMA line
items appear on the RMA Status Report when:

• The Return check box is selected and the quantity returned is greater than the quantity credited
thus far, OR the Return check box is cleared and an amount remains to be credited.

• RMA line items have a status of Open or Filled. (RMA line items with a status of Closed or History
cannot be printed or posted.)

• The RMA associated with the RMA line item has a status of Open. (Items associated with headers
which have a status of Stopped, Closed, or History cannot be printed or posted.)

After reviewing the records pulled by the report, you might want to modify the range of RMA numbers
or of RMA dates, to eliminate records that should not be receiving credit memos at this time.

Then, to print RMA credit memos and to post the credits to Accounts Receivable, perform the RMA
Credit Memo activity.

The RMA credit memo is printed on the same special form as the standard invoice. The words RMA
CREDIT will print beneath the header information to differentiate the two documents.

• Form alignment: You can print a sample credit memo using Xs and 9s to represent data fields.
• Restocking Fee: The restocking fee will print on the RMA credit memo with the label defined by

you on the RMA Parameters form. If you do not charge your customers a fee to return merchandise,
do not enter any label in the Description field on the RMA Parameters form. That way, no label
prints on the credit memo.

• Multi-lingual credits: If the customer is flagged for multi-lingual invoices, the credit memo will
automatically be printed using the same language for labels.

• Non-domestic currency: The amount posted is always credited in the customer's currency, even
if the amount printed on the credit memo was translated to the domestic currency.

• Preprinted forms: Be sure to specify whether you use new Moore forms (the default) or the previously
available (old) Moore forms.

• Pre-numbered forms: If your company uses preprinted and pre-numbered forms, the maximum
number of lines allowed per credit memo is defined on the Accounts Receivable Parameters
form. The invoice headers are the same but the credit memo number changes. Also, the total
amount prints in words on the footer.

As part of the posting process, the status of all RMA line items that have been fully credited is
automatically changed to Closed. If all RMA line items associated with an RMA header have a status
of Closed, then the RMA header status is also changed to Closed.

The account numbers which will be debited and credited when you post credits are pulled as follows:

• If the item exists in theItems form, from the End User Type (if specified) or the Distribution Account
record

• If the item does not exist in the Items form, from the End User Type (if specified) or Accounts
Receivable Parameters (sales discount account and unit codes) form.

Adjustments Calculated by the System

When customers reject material for which they received a discount, or for which a sales representative
received commission, then the system adjusts those calculations where possible.
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Both the order level and line item level sales discounts (if any) given on the original customer order
will be backed out if:

• The original customer order and line are known.
• The item on all RMA line items matches the item on the associated customer order line items.
Note:  The amount of sales discount to back out is adjusted to reflect any differences in the unit price
on the original order and the unit credit on the RMA line.

The amount on which the sales commission is figured is adjusted by the amount of the credit (prior to
the application of the restocking fee) if:

• The RMA line item references a valid customer order (including History orders) and line.
• The RMA line item exists in the Items form and is the same as the item on the original customer

order.
• There were commissions associated with that particular item on the original customer order.

When you print an RMA credit memo, the document is assigned a number which prints in the Invoice
No space. However, the RMA credit appears in Accounts Receivable as an open credit, with an invoice
number of 0.

About Rebate Programs
SyteLine provides functionality for setting up and maintaining rebate programs to give your customers
incentives for buying. These rebate programs allow your customers to earn payment credits to use in
the future.

For more information about SyteLine rebate programs, refer to these topics:

• Promotion Pricing and Rebate Programs Overview
• Setting Up Promotion Pricing and Rebate Programs
• Maintaining Earned Rebates
• Processing Earned Rebates
• Closing Rebate Programs

Setting up A/R Direct Debits
With direct debit, you can automatically collect payments from a customer using an electronic funds
transfer (EFT) file.

After a direct debit A/R payment is posted, the DebitTransfer BOD is populated. The BOD is processed
by Infor Local.ly, which then uses the data to create an EFT file for bank collection. This file is sent to
the bank, informing the bank to move the funds from the customer's bank and account to your company's
bank and account. Your company's bank then initiates an EFT to the customer’s bank to have the funds
transferred by a bank-to-bank EFT. When you receive a bank statement from your company's bank,
you must manually enter direct debit deposits on the Bank Reconciliations form.
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The support for structured and unstructured fields that include reference information such as the invoice
number is dependent on the bank, or in case of bank-to-bank transfer, it is dependent on both banks.

Prerequisites

You must perform these tasks outside the application before you set up direct debit in the application:

• Obtain a signed mandate from the customer. The reference number on the mandate is entered
into the system and included in BODs and electronic messages.

• Obtain the IBAN numbers for your company and your customers.
• Obtain the BIC numbers for your company and your customers, if applicable.
• Obtain the Bank Authority Party IDs for your company and your customers, if applicable.

Direct Debit Setup

1 On the Chart of Accounts form, add any new accounts and unit codes for direct debit receivables.
This account is used when an A/R payment is posted whose type is direct debit. The account is
credited when the corresponding bank reconciliation deposit is entered.

2 On the General Parameters form, specify your company's Bank Authority Party ID, if your
company does business in countries that require it.

3 On the Countries form, you should already have set up country codes that map to ISO country
codes. You must also set up the Bank Transit Number Mask in this form for each country where
you will transmit electronic banking data. See the help for this field for some examples of the
masking format.

4 On the Accounts Receivable Parameters form, Electronic Banking section, specify the Direct
Debit Receivable Account to use as the default account for direct debits. This can be overridden
for End User Types or for specific customers.

5 Optionally, on the End User Types form, specify the direct debit receivables account information.
This account is used as the default Direct Debit Receivable Account for customers if either of these
statements is true:
• The customer does not have an end user type.
• The customer has an end user type, but the end user type does not have a Direct Debit

Receivable Account.

6 On the Customers or Multi-Site Customers form, specify the customer’s banking information.
The information that you must supply depends on the requirements of the banking authority. It can
include these fields:

Bank Code
Specify the bank code that describes your company’s bank account that you use to receive direct
debit A/R transactions from this customer.

Payment Type
Specify Direct Debit.

Customer Bank
Specify the bank code that describes the customer’s bank account that will be debited when the
A/R payment is sent to your bank account.

IBAN
Specify the customer’s international bank account number.
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BIC or Bank Authority Party ID
Specify the customer BIC or Bank Authority Party ID, as applicable.

Mandate Reference
Specify the reference number of the agreement with this customer to allow direct debit from this
account.

End User Type
Optionally, specify a user type to use the default Direct Debit Receivable account from the End
Users form instead of from the A/R Parameters form.

7 On the Bank Reconcilations form, specify information about the banks that you will use for EFT
transactions. This includes your company's bank as well as customer banks.
• Create a bank code and specify the appropriate information to describe the banks where your

company has accounts. This can include your company’s IBAN number and the currency in
which the bank deals, your company’s BIC number or Bank Authority Party ID, as appropriate.

Your company might have accounts at banks in different regions or in different currencies, to
simplify dealing with customers in those regions or currencies.

• Create a bank code and specify information to describe each of the banks where your customers
have accounts. Specify the currency in which each bank deals.

For customer’s banks, also specify the appropriate EFT information, which can include the
IBAN number, BIC number or Bank Authority Party ID, as appropriate.

• If your customers use an Optical Character Recognition (OCR) number in banking, select the
appropriate settings in the OCR Reference Control fields.

Chargebacks Overview
The chargebacks functionality allows you to approve or disapprove a non-full payment from customers
who may take a chargeback for reasons that include but are not limited to damage, lateness, or improper
packaging.

Use these forms with this functionality:

• Accounts Receivable Parameters
• Chargeback Types (and the associated Chargeback Types Query form)
• Chargebacks
• A/R Payment Distributions
• A/R Quick Payment Application

Clearing Offsetting Open Items in Accounts Receivable
In order to get open items off of the A/R Aging Report, they need to be applied to an invoice.
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If an invoice does not already exist that would be appropriate for applying the open items, then you
need to create an invoice for zero dollars, and do reapplications of the open debit item(s), open credit
item(s), or open payment(s) to that invoice.

If one or more of the items are open credits or debits, use this procedure.

1 Open the A/R Posted Transactions Detail form.

2 To reapply an open debit or credit to one invoice:

a Filter for both Customer and Open Credit.
b In the Invoice field, either enter or select the invoice to apply the open debit or credit.
c Click Save.

3 To reapply an open credit to multiple invoices:

a Determine the check/reference number of the credit memo you want to reapply.
b Add the customer number and check/reference number of your open credit.

Note:  The receipt date normally would not be changed. Credits are already against Accounts
Receivable and no journal entries will be created as a result of this reapplication.

c Click Save.
d Open the A/R Payment Distributions form.
e Add as many invoices as required to distribute the credit amount.
f Perform A/R Payment Posting to post the reapplication.
g If one of the items is an open payment transaction, then you will need to do the following:

• Determine the customer number and check number from A/R Posted Transaction Detail
form.

• Open the A/R Payments form.
• Enter Customer Number and Check Number. You should see RE-APPLICATION OF

OPEN PAYMENT beside the G/L Reference. If this does not appear, stop here and
re-examine the check number being entered.

• The date of the check should be changed to the current date. A journal entry will be created
as a result of the reapplication. The entry will debit the A/R Deposit Account and credit the
Accounts Receivable Account.

• Go to the A/R Payment Distributions form, enter the zero dollar invoice number as
required to distribute the Open payment.

• Perform A/R payment posting.

Closing the Year for Accounts Receivable
To close an accounts receivable (A/R) period or a year, use the A/R Period/Year End Procedure
utility. This utility clears the customer period-to-date information, or both the period-to-date (PTD) and
year-to-date (YTD) information. In addition, you can use it to clear the salesperson PTD or YTD
information. Finally, this utility also updates customer records to reflect the change of year.

To close a period or the year for A/R:

1 Open the A/R Period/Year End Procedure form.
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2 Enter the appropriate information in these fields:

• Customers, Salespersons, Both:
• To process only records for selected customers, select Customers.
• To process only records for selected salespersons, select Salespersons.
• To process both customer and salesperson records, select Both.

• Statement Cycles: Select the statement cycles you want to process. Options include: Weekly,
Monthly, Quarterly, or All.

• Zero PTD Only: If you want to start a new period and clear only the period-to-date information,
select this check box. If you want to clear all year-to-date information, clear this check box.

• Starting and Ending Customer: Enter the range of customers you want to process. To process
records for all customers, leave both these fields blank.

• Starting and Ending Salesperson: Enter the range of salespersons you want to process. To
process records for all salespersons, leave both these fields blank.

3 Click Process.

Deleting A/R Posted Transactions
To delete accounts receivable (A/R) transactions that have been posted:

1 Open the Delete A/R Posted Transactions utility form.

2 Specify this information:

• Through Date: Enter the date through which to delete A/R transactions, or accept the default,
which is the current system date.

• Statement Cycles: Enter the statement cycles for which you want to delete A/P transactions.
Options include Weekly, Monthly, Quarterly, or All.
Note:  With the exception of All, these options cause the utility to process only those records
for which the statement cycles match. For example, if you select Weekly, then only the records
with a statement cycle setting of Weekly are processed. Records tagged for Monthly or Quarterly
cycles do not get processed.

• Starting Customer and Ending Customer: Enter the range of customers for which you want
to delete A/R transactions. To delete A/R transactions for all customers, leave these fields
blank.

• Preview/Commit:
• To view the results of running the utility without saving the results in the database, select

Preview.
• To save the results in the database, select Commit.

3 Click Process.
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Using Chargebacks Functionality
A chargeback is the amount a customer deducts from a payment for reasons including but not limited
to damage, lateness, or improper packaging.

To use this functionality:

1 Establish Chargebacks and Chargebacks Deposit accounts on the Accounts Receivable
Parameters form.

2 Define chargeback types on the Chargeback Types form. The types are the reasons why a
customer might apply a chargeback.

3 Use the Chargebacks form to quickly enter chargeback data. You can specify the amount, choose
the type, see invoice, credit memo, and status information, and set that status to approve, pending,
or denied.

4 Choose one of these options:

• Record a payment on theA/R Payments form and on the A/R Payment Distributions form
and then, while still on the A/R Payment Distributions form, click the Distribute Chargebacks
button for the appropriate customer to populate the Chargeback Amount field with the amount
to be distributed, or

• Enter the payment amount on theA/R Quick Payment Application form and then click the
Apply button to apply any chargebacks from the Chargebacks form.

5 Use the A/R Payment Posting form to post like you would for any other payments or distributions.
For chargebacks that were approved on the Chargebacks form, the process on the A/R Payment
Posting form creates and posts credit memos tied to an invoice for each chargeback amount. If
the chargeback is approved after the payment is posted, a credit memo is created and posted.
The credit memo is tied to the chargeback manual invoice.

Using A/R Tax Reports
Use this information with these reports:

• Sales Tax Report
• Tax Receivable Report
• GST Invoiced Report (Canada)
• PST Invoiced Report (Canada)
Note: 

The iinvoice history information does not include postings you performed manually from the G/L journal
to the tax G/L accounts. Also, if you generated tax account distributions from Customer Order Entry
before posting them in A/R, and then adjusted the distributions manually, the history information does
not include the adjustments. Therefore, the report does not reflect these secondary changes to account
balances.
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Tax Records

In Customer Order Entry, the tax records are created when each invoice is printed and posted. The
system does not alter these records, regardless of changes to the transaction in A/R or G/L.

If you enter invoices, credit memos, or debit memos directly in A/R (not from Customer Order Entry),
the tax records are created based on the values in the special tax fields in the G/L distributions. When
you post the manual transactions, the tax records are created.

Verifying the Report

Compare the contents of the report to the tax account balances for the period reported from the G/L.
If you find discrepancies, first verify that A/R does not contain unposted invoices/credit memos from
Customer Order Entry.

Then, make sure the A/R Distribution journal has been posted to the ledger. You may have additional
discrepancies if you adjusted the GST account balances manually with journal entries, or adjusted the
A/R Invoice G/L GST Account Distribution records manually. Only these discrepancies are acceptable.

Invoice Batches

About Invoice Batches
You must have the JapanCountryPack license to use the invoice batch functionality.

These forms are used with the invoice batch functionality:

• Customers
• A/R Posted Transaction Detail
• Generate Invoice Batch
• Invoice Batches
• Invoice Batch Detail
• Invoice Batch Report

The invoice batch displays all invoices, credit memos, and debit memos that have not been printed on
any other invoice batch. You have the ability to verify all invoices, credit memos, and debit memos and
delete individual records from the invoice batch if desired. You can then print the invoice batch. Each
invoice batch is assigned a unique number. Invoice batches are generated based on a close date
entered on the Generate Invoice Batch form. The day of the close date is used to determine which
customers are included in the invoice batch by matching the day with the customer invoice batch cutoff
day assigned on the Customers form.

The Invoice Date and the Due/Paid Date fields on the A/R Posted Transaction Detail form are used
during the generation and print processing. For example, if the invoice date is set to 10/10/13 and
for some reason it is changed to 11/10/13, the invoice does not get picked up in the 10/20/13
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generation run unless the Override Invoice Batch Creation Rules field is checked on the Generate
Invoice Batch form.

For payments, the Due/Paid Date is used to determine when a payment was made. If this date is
changed, it affects the Former Invoice and Payment calculations on the Invoice Batch Detail form
and the Invoice Batch Report. If a payment Due/Paid Date is set to 05/12/13 and it is changed to
11/12/13, the payment shows in the November payments and not the May payments. If you do a
reprint of May, its values would be different because the payment would not show as being paid in
May.

Dummy Invoices

If you have upgraded from a prior version, you must create a dummy invoice batch so that old invoices,
credit memos, and debit memos do not show up on the first invoice batch sent out to your customers.
A dummy invoice batch should be created for each of the cutoff days that would be run during a normal
month. You should use the prior period close date, so that invoices, credit memos, and debit memos
for the current period are not included in the generation of the invoice batches. If an existing customer
has been in the system but was not part of the invoice batch process and is added to the invoice batch
process, you should generate a dummy invoice for that customer. This prevents older invoices, credit
memos, and debit memos from showing on the current period invoice batch.

Adding an Invoice Batch
1 On the Invoice Batches form, create a new record. The system automatically generates the invoice

batch number.

2 Provide a description.

3 Specify a close date in the Close Date field.

4 Save the record.

Deleting an Invoice Batch
On the Invoice Batches form, select a record and delete it.

You can only delete an invoice batch if it has not yet been printed. When you delete an invoice batch,
all A/R posted records assigned to the invoice batch are released.

Updating an Invoice Batch
On the Invoice Batches form, for an existing batch, you can only update the description.

To update the information within the batch, use the Invoice Batch Detail form.
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Generating an Invoice Batch
1 On the Generate Invoice Batch form, select the Close Date.

2 Provide a description for the invoice batch.

3 Optionally, select Exclude Invoices on Closing Date to exclude any records where the invoice
date is equal to the closing date.

4 Optionally, select Override Invoice Batch Creation Rules to override both the Close Date and
the Exclude Invoices on Closing Date fields. All records that are not assigned to another invoice
batch are added to this invoice batch.

5 Select a range of customers for which to create the invoice batch.

6 Click Process to create the batch.

About Invoice Batch Detail
Use the Invoice Batch Detail form to add, update, and delete Customer and A/R posted records from
an invoice batch. You can either open this form directly, or you can click the Invoice Batch Detail
button on the Invoice Batches form.

Before using this form you must already have created an invoice batch on the Invoice Batches form,
and you must have assigned an Invoice Batch Cutoff Day to a customer on the Customers form.

Adding a Customer to an Invoice Batch
1 On the Invoice Batch Detail form, select the invoice batch in the Invoice Batch field for which

you wish to add a customer. The choices here are all invoices that have not been placed on another
invoice batch.

2 Select a customer in the Customer field. If no customers are displayed in the Customer field, that
means either that no customers have the same close date that is assigned to the invoice batch or
all of the customers that do have that close date are already assigned to another batch.

3 Save the record. This information is shown on this form:

• Former Amount
• Payments
• Carry Over
• Invoiced This Period
• Charges
• Taxes
• Invoice Amount
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Adding an Invoice for a Customer to Invoice Batch Detail
1 After you add a customer, in the grid area of the Invoice Batch Detail form, click the Invoice field

to specify an invoice. Add as many as you like, each one in a different row.

2 Save the record. This connection between the invoice batch and the customer's transaction is seen
in the Invoice Batch field on theA/R Posted Transactions Detail form.

Updating or Deleting Invoice Batch Detail Records
On the Invoice Batch Detail form, only those records where the invoice batch has not been printed
can be updated or deleted.

You can select and delete individual invoice records in the grid or delete the invoice batch record from
this form.

Invoice, Credit or Debit Memo

About Multiple Due Dates for Invoices and Debit Memos
Creating multiple due date payment terms allows you to set up an invoice payment schedule for
customers.
Note:  The system does not support multiple due dates for billing terms when running the Infor SyteLine
Enterprise Financials Interface package.

Multiple due dates can be set up for the following:

• Invoices generated from customer orders and manually entered on the Invoices, Debit and Credit
Memos form.

• Debit memos generated from the Price Adjustment Invoice form and manually entered on
theInvoices, Debit and Credit Memos form.

The successful use of multiple due dates depends on creating billing terms with multiple due dates
and percentages, and selecting the appropriate billing terms for customers and customer orders.

Billing Terms Setup

To use multiple due dates, create a new terms code on the Billing Terms form. On this form, you
indicate that you want to use multiple due dates by selecting the Use Multiple Due Dates check box.
You can create more than one terms code that uses multiple due dates.

System-generated debit memos from the Price Adjustment Invoice form should have multiple due
dates if the terms code being used is a multiple due date terms code.
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You can use prox days and Advanced Terms in a multiple due date terms code. However, you cannot
create billing terms with Discount Days.

A multiple due dates terms code includes the following:

• Sequence: Sequence is used internally to track the sequence of the multiple due date record and
is assigned by the system. The first sequence starts with 10 and the next/subsequent sequences
at increments of 10. The due date calculation takes place normally, using the due days from billing
terms. You must enter more than one sequence.

• Due Days Offset: Number of days from the previous due date sequence of the billing terms. The
offset day in the first sequence is always equal to zero.

• Percent: The total of all sequence records for the multiple within a billing terms code must equal
100 percent.

Customers and Customer Orders

Once a new terms code is created, it is immediately available. The default billing terms code is set up
on the Customers form, but it can be changed on the Customer Orders, Price Adjustment Invoice,
or Invoices, Debit and Credit Memos forms.

You should not assign a multiple due date terms code to a customer and customer order where the
following options are used:

• Letter of Credit Required
• Consolidated Invoicing
• Payment Type is Draft

If these options are selected, the system displays an error message.

Invoicing

Once the customer order has been shipped, the system generates the invoice and calculates the
invoice payment schedule according to the settings in the terms code. Multiple due date records are
assigned to the invoice for as long as the invoice exists. If an invoice is deleted, the system deletes all
due date records for that invoice. If the terms code is modified, the system recalculates the due dates
and creates new due date records for the invoice.

On the Invoices, Debit, and Credit Memos form, you can adjust the amounts and due dates after the
invoice is created, but the total due amount must still equal the total invoice due amount. On the A/R
Posted Transaction Detail form, you can only update the due date.

Note:  If the customer uses revision and pay dates for invoices, the system adjusts the invoice due
dates to consider the revision and pay days. Revision and pay days are set up on the Customers form,
Revision/Pay tab.

To create invoices or debit memos with multiple due dates on the Invoices, Debit, and Credit Memos
form, use the Generate Distributions function to create the sequence of due dates and amounts.

The following examples show how multiple due dates are set up and invoiced. The second example
uses prox days and prox codes.
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EXAMPLE 1: There are four sequences defined. The invoice date is May 5. For Billing Terms, the due
days offset is 30 days. The following table shows how the system calculates the due date.

Final Due DatePercent     Due Days Offset
    

Sequence     

June 5 (May 5 plus 30 days)25010

July 5 (May 5 plus 60 days)253020

August 3 (May 5 plus 90 days)253030

September 1 (May 5 plus 120 days)253040

EXAMPLE 2 (Advanced Terms): There are three sequences defined. The invoice date is May 5. For
Billing Terms, the due days is 30, prox code is 2 (system sets the due date to the end of the month),
and prox days are 15 (day of the month). The following table shows an example of how you can divide
the billing and how the system calculates the amount to pay and the due date.

Final Due Date with
Prox Days Applied

Prox Code Ap-
plied

Invoice Due
Date

PercentDue Days
Offset

Se-
quence

July 15June 30June 430010

August 15July 30July 3303020

September 15August 31August 3403030

Viewing Due Date Records for an Invoice

You can view the list of due dates for an invoice by clicking Multiple Due Dates on the following forms:

• Invoices, Debit and Credit Memos
• A/R Posted Transaction Detail
• A/R Quick Payment Application

Applying Payments to Invoices

When you make payments using the A/R Payments form, if there is more than one due date amount
applied to the same invoice, the system creates one record per payment per invoice.

When you make payments using the A/R Quick Payment Application form, the system applies
payments to each due date in chronological order regardless of when they were received. The earliest
due date is always paid first.

EXAMPLE 3: For example, an invoice I101 has 3 due date records:

1 Due date = May 10 Due amount = $200
2 Due date = June 10 Due amount = $100
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3 Due date = July 10 Due amount = $100

A payment of $250 is applied to this invoice and one record of type Payment is create for $250 for
invoice I101. When the system needs to display the aging of the invoice that is not fully paid, it:

• Looks up all the records for invoice I101
• Takes the payment and credit memo
• Totals the amount
• Applies that amount to the earliest due date

In this example, take the payment record of $250 and apply that to the first due date record and then
the second due date record. The A/R Aging Report shows the following due records for invoice I101:

1 Due date = June 10 Due amount = 50
2 Due date = July 10 Due amount = 100.

Applying Debit Memos to Invoices

You can also create debit memos with multiple due dates, either manually or automatically. If the debit
memo is automatically generated, you can update it using the Invoices, Debit, and Credit Memos
form before posting. After it is posted, you can view it in the A/R Posted Transaction Detail form, just
like an invoice. When the debit memo is applied to an invoice, it is processed with the invoice for A/R
payment processing and aging for reports and customer statements.

There are three ways debit memos can be applied to invoices when either or both have multiple due
dates:

• For a debit memo with a single due date applied to an invoice with multiple due dates, the debit
memo is applied to the first due date.

• For a debit memo with multiple due dates applied to an invoice with multiple due dates, the total
debit memo is applied to the first due date record of the invoice.

• For a debit memo with multiple due dates applied to an invoice with a single due date, the total of
the debit memo due amount is applied to the first due date record of the invoice.

Canceling Drafts
To cancel previously printed drafts from the print invoice credit/debit memo transaction, use the A/R
Draft Cancellation form.

To restrict your report output, you can fill in the fields. To cancel all drafts, leave all fields blank.

1 In the Starting and Ending Customer fields, enter the customer ID range for the drafts to cancel.

2 In the Starting and Ending Draft Number fields, enter the draft number range for the drafts to
cancel.

3 Do one of the following:

• To preview the results before writing them to the system, select Preview.
• To write the changes to the system, select Commit.

4 Click Process.
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Distributing Invoices
You can distribute invoice amounts to multiple General Ledger (G/L) accounts, using any of these
methods:

• Automatic Distribution: On the Invoices, Debit and Credit Memos or Invoices, Debit and Credit
Memos G/L Distribution form, select the record for the invoice you want to distribute, and select
Actions > Generate Distributions. A message displays when the process is complete.
Note:  The default G/L accounts from the Accounts Receivable Parameters form and the
customer's tax code are used.

• Manual Distribution: Use the steps in this topic.
• Reapplication of an Open Credit: On the A/R Posted Transactions Detail form, locate the open

credit you want to reapply. Make a note of the customer, debit or credit transaction, check/reference
number, and invoice number associated with the transaction. Then follow the remaining steps in
Reapplying Open Payments on page 165.

The system posts only balanced entries to the G/L Journals. It posts one side to the A/R Account set
up for the invoice and the other side from the distributions entered on the Invoices, Debit and Credit
Memos form. Therefore, the amount distributed for any transaction must equal the total amount for
the invoice. If not, the system detects these errors when it posts the transactions, and cancels the
posting.

To manually distribute the invoice amounts:

1 On the Invoices, Debit and Credit Memos G/L Distribution form, select Actions > New.

2 Select the customer for which you are adding a distribution.

3 Select the number of the invoice you are distributing.

4 In the Dist Seq field, accept the default, which is the next available sequence number.

This number is used to order the distributions.

5 In the Tax System field, select the tax system for the distribution; or, for a non-tax distribution,
leave this field blank.

6 In the Dist Amount field, enter the amount of the distribution.

7 In the Account field, select the account to post the distribution to.

8 Select Actions > Save.

9 To continue adding distributions until the Total Remaining field is 0 (zero), repeat these steps as
necessary.

Posting Invoices, Debit Memos, and Credit Memos
To post invoices, debit memos, and credit memos:

1 Open the Invoice Posting form or the Multi-Site Invoice Posting form.

2 Indicate whether you want to post invoices, debit memos, and/or credit memos. You can select
more than one.
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3 Select how you want to sort and display the report data. By default, the system posts transactions
for all customers, but you can further refine your posting by selecting ranges of customers, invoices,
and dates. On the Multi-Site Invoice Posting form, you can also refine by builder invoice.

4 To print the report, click Process.

Note:  You must first print the posting report before you can post transactions. By default, the Print
option is automatically selected when you open this form.

5 After reviewing the report, select the Commit option.

6 To post the transactions, click Process.

7 When prompted to proceed, click OK.

If errors are detected in a transaction, the system displays a message indicating that not all transactions
were posted.

Note:  If you use the External Financial Interface, additional processing might occur during invoice,
debit memo or credit memo posting. For more information, see "Setting Up an External Financial
Interface on page 183."

What Happens During Invoice Posting
The updates that occur during invoice posting are described here.
• For each invoice, debit, or credit transaction posted, if the transaction is an invoice or a debit, the

system increases:
• the customer's posted balance by the sum of the total transaction amount
• the customer's sales YTD and sales PTD values by the amount of the transaction.

If the transaction is a credit, the system decreases the customer's posted balance, sales YTD,
and sales PTD in the same manner.

• The customer's Last Invoice Date field is updated with the invoice date for the transactions.
• New open items are created, one for each transaction that is posted.
• Entries are created in the General Ledger A/R Distribution (AR Dist) Journal.
• For each transaction, one journal record is created for the Accounts Receivable amount, and one

transaction is created for each distribution record entered.

Using Cancellation Posting for a Credit Memo
You can cancel a posted invoice one time. The entire amount of the original invoice is canceled; partial
credit memos cannot be made.

1 Open the General Parameters form and make sure Enable Cancellation Posting is selected.

2 Open theInvoice, Debits and Credit Memos form and click the filter-in-place button.

3 Select Actions > New.

4 Specify this information:
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Customer
Specify the customer for which an invoice must be canceled.

Type
Specify Credit Memo.

Cancellation
Select this check box.

Apply To Invoice
Specify the invoice to which to apply the cancellation. The list of posted invoices to which you can
apply cancellation posting does not include those that are referenced by a posted credit memo,
debit memo, or payment. Amounts from the original posted invoice are entered automatically and
cannot be changed.  

5 Complete the credit memo and save the record.

Eliminating Residual A/R Balances
Before you generate any financial statements, use the Residual A/R Balance Eliminations utility to
eliminate any residual A/R balance amounts that were created by exchange rate fluctuation and currency
rounding differences. Residual balances show up as open items in receivables. This utility eliminates
the residual balance amounts by generating debit memos or credit memos to offset the balance.

In addition to currency rounding differences, this utility can be used to eliminate any residual balances.
For example, if an invoice of 100.20 USD is issued and the amount paid is 100.00 USD, you can use
the utility to eliminate the .20 USD balance.

Note:  This utility only generates debit and credit memos for individual  customers and not for corporate
customers.

1 In the Residual A/R Balance Eliminations utility, specify the search criteria ranges for the residual
balances.

2 Select Preview and click Process.

3 The lower grid displays the results based on the criteria you selected:

• For open item customers, the utility searches their open accounts receivable records and
invoices net balance due. If the net amount is a positive balance, a Credit Memo will be created
for each of the invoices. If the net amount is a negative balance,  a Debit Memo will be created
for each of the invoices.

• For balance forward customers, the utility searches their open accounts receivable records
and net amount from their invoices. If the net amount is a positive balance, a Credit Memo will
be created as an open credit and the invoice number will be zero. If it is a negative balance,
a Debit Memo will be created and the invoice number will be zero. The words "Balance Forward"
display in the Invoice column on the lower grid. The Invoice Date in the grid will be blank.

4 Select Commit and click Process.

If the open invoice amounts are positive numbers, the utility generates Credit Memos; if the amounts
are negative numbers, the utility generates Debit Memos.
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Note: The Debit Memos and Credit Memos generated here are similar to those entered using the
Invoice, Debit and Credit Memos form except they will use the general ledger account number
defined in this utility. You can still run the Delete A/R Posted Transactions utility to set the customer
balance forward to zero.

5 After the utility generates the debit or credit memos, use the Invoice, Debit and Credit Memos
form to modify the transactions and then post using the Invoice Posting Utility.

A/R Payments

About Customer Payments
Use the A/R Payments form to process customer payments for invoiced amounts, finance charges,
and other amounts your customers owe you. You can enter and post non-customer payments to the
General Ledger as non-A/R cash.

You can also enter post-dated checks on the A/R Payments form. The payment type must be check.

Note:  You can apply open credits and payments from a customer only to the customer and any of its
subordinate customers. You cannot apply a subordinate customer's open credits or payments to another
customer that is a subordinate of the same corporate customer.

Before you post payments, you must apply or distribute the payment amount to invoices, finance
charges with balance due, non-A/R cash, or an open payment. You can do so manually through the
Distributions button, or you can select Actions > Generate Distributions to have the system
automatically distribute it.

When you generate distributions for invoices with multiple due dates, if you apply a payment towards
a due date, the system creates a partial payment record. If more than one payment for the same invoice
is applied, only one record will be created for that invoice.

You can also re-apply open credits or open payments against invoices. To re-apply an open credit,
enter a new payment against an existing check or draft number. The system fills in the G/L Reference
field with the description "Re-Application of Open Payment." The system does not post the transaction
to the General Ledger or to the customer's record. The transaction updates the corresponding Open
Item record.

See Example: Reapplication of an Open Payment on page 167.

For credit card payments (which are available only if the Credit Card Interface is used in your system),
you cannot change the payment amount and other components, in order to ensure that the payment
reconciles to the credit card charge. However, it is still possible to apply the payment to multiple invoices.

When you post A/R payments, the system prompts you to print a Payment Transaction Report, which
serves as an edit report.
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A/R Payments supports multiple invoices with different transactional currencies. The payment currency
does not have to be the same as that of the Bank Code. The payment amount is converted to the bank
amount, and the bank amount is converted to the domestic amount.

If you enter a payment amount in a part of euro currency, the system performs the triangulation
conversion method. See About the Euro Triangulation Conversion on page 173 for more information.

Caution:  If you enter an A/R payment for a customer, bank code, and check number combination
that already exists and Transfer VAT on the Tax Systems form is selected, an error message displays
and the system stops the transaction.

Accepting Customer Payments in the Euro Currency
If your domestic currency is the euro, or if a customer has converted to the euro, you can accept
customer payments in the euro currency.

You can accept payments in the customer's currency, the euro currency, or your domestic currency.

To accept payments in the euro, follow these steps:

1 Set up a bank reconciliation account for the euro currency on the Bank Reconciliations form. In
the Currency field, enter the currency code for the euro that you entered on the Currency Codes
form.

Note:  If none of your customers has converted to the euro currency, this step is optional. You use
this bank account to accept payments from those customers that use the euro as their domestic
currency.

2 When you are ready to process a customer payment (for example, after you have applied the
payment amount to invoices), access the A/R Payments form.

3 In the Customer field, select the customer ID of the customer that is making the payment.

4 In the Bank Code field, select the code for the bank into which you are receiving the payment.The
bank code must use the same currency code as either the customer currency or your domestic
currency.

5 In the Euro Amount field, enter the amount of the payment in the euro currency. The system
converts the amount to the customer's national currency and to your domestic currency.

Note:  The customer's balance is reduced by the amount in the Bank Amount field. The amount
in the Domestic Amount field is received into the specified bank code. The system does not use
the amount in the Euro Amount field; this field simply enables you to enter the euro payment
amount to be converted.

6 Enter any additional data in the remaining fields.

7 To save the record, select Actions > Save.

Infor SyteLine Financials User Guide | 133

 

Accounts Receivable (A/R)



Adjusting a Payment
To adjust a posted transaction, use the following payment adjustment process. The adjustment will
show up as a payment on the A/R Posted Transactions Detail form.

Note:  You can only adjust a draft that was manually entered and not one generated from an invoice.

1 To create the adjustment:

a Access the A/R Payments form.
b Select Actions > New.
c Select the customer.
d Select the payment type Adjust.
e Enter the check or draft number to apply the adjustment.

Note:  To find the check or draft number for the adjustment, you might need to review the A/R
Posted Transactions Detail form.

f Select the bank code, if necessary.
g Enter the amount you want to adjust.

To increase the payment amount, enter a positive number. To reduce the payment amount,
enter a negative number.

The G/L Reference field displays either ARPA or ARPR and the check or draft number. The
Description field displays either Payment Adj or Reapplication and the check or draft number.

h Save the transaction by selecting Actions > Save.

2 To distribute the adjustment:

a Access the A/R Payment Distributions form by clicking Distributions on the A/R Payments
form.

Note: When you distribute the adjustment, you can only distribute it to either an invoice or a
finance charge.

b Distribute the adjustment:

• To distribute the adjustment to an invoice, select Invoice in the Type field, and then
select the invoice number.

• To distribute the adjustment to a finance charge, select Finance Charge in the Type
field.

• If the customer is a corporate customer, you can assign the adjustment to a subordinate
customer.

c In the Amount field, enter the amount of the distribution.
d Save the transaction by selecting Actions > Save.

3 To post the adjustment:

a Access the A/R Adjustment Posting form.
b Enter the customer range.
c Click Process.
d Run the A/R Payment Transaction Report.

Use this report to verify that the payments and their related distributions are accurate. The
Payment Type field on the report displays adjustment to indicate an adjustment.
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Note:  The system does not post transactions containing errors. If a transaction contains errors,
correct the errors and perform the posting again.

Creating Open Payments for a Customer
To enter a payment that is applied to the customer's total account balance, use the following procedure.
This type of payment is the only payment type required for balance forward customers. For open item
customers, these open credits need to be reapplied against invoices or finance charges at a future
time.

1 On the A/R Payments form, select Actions > New.

2 Enter the appropriate information in the following fields:

• Customer: Select the number of the customer the payment is for.
• Type: This field displays the customer's default payment method, but you can select a different

method.
• Number: Enter the check or draft number of the payment.
• Receipt Date: Enter the date you received the payment, or accept the default, which is today's

date.
• Payment Due Date: (Available only if the payment type is Draft.) Enter the date the draft is

due.
• G/L Reference: Enter a description to appear in the distribution journal for this transaction, or

accept the default, which is ARP, followed by the check or draft number.
• Description: Enter a description to appear in the distribution journal for this transaction, or

accept the default description.
• Bank Code: The customer's default bank code displays, but you can select a different code

of the bank into which the payment will be deposited.
• Customer Amount: Enter the amount of the payment.

3 Select Actions > Save.

4 To distribute the payment, using the A/R Payment Distributions form, click Distributions.

5 Under the General tab, in the Type field, select Open Credit.

6 In the Order field, enter the number of the sales order to which the payment is to be applied.

7 In the Dist Amount field, enter the amount to apply against the customer's sales order or the
amount to post as an open payment.

8 In the Disc/Credit 1 and Allowance/Credit 2 fields, enter the discount and allowance, if applicable.

9 Select Actions > Save.

Entering Customer Payments
To enter and process payments from customers, use the A/R Payments form. On this form, enter
payments for invoiced amounts, finance charges, and other amounts your customers owe you.

Note:  You can enter and post non-customer payments to the General Ledger as non-A/R cash.
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To create a payment, on the A/R Payments form:

1 Select Actions > New.

2 Enter the appropriate information in the following fields:

• Customer: Select the customer ID of the customer the payment is for.
• Type: This field displays the customer's default payment method, but you can select a different

method.
• Number: Enter the check or draft number of the payment.
• Receipt Date: Enter the date you received the payment, or accept the default, which is today's

date.
• Payment Due Date: (Available only if the payment type is Draft.) Enter the date the draft is

due.
• Deposit Date: Enter the date you deposited the check. This field is available for entering

post-dated checks. It is enabled only if the payment type is Check, and no credit memo is
associated with the payment. Enter the date on the customer's check.

• G/L Reference: Enter a reference ID to appear in the distribution journal for this transaction,
or accept the default, which is ARP followed by the check or draft number.

• Description: Enter a description to appear in the distribution journal for this transaction, or
accept the default description.

• Bank Code: This field displays the customer's default bank code, but you can select a different
code for the bank into which the payment will be deposited.

• Customer Amount: Enter the amount of the payment.

3 Select Actions > Save.

You can then distribute and post the payment.

Distributing Customer Payments Automatically
You can use the A/R Payment Distributions form to apply or distribute payment amounts before
posting them. The distributions determine how a payment is applied to a customer's account, and how
it is distributed to the General Ledger (G/L).

Caution:  The system posts only balanced transactions, one side to the cash account for the payment
and the other to the accounts receivable (A/R) account for the distributions. Therefore, the applied
amount for any transaction must equal the check amount of the payment. If these amounts are not
equal, the system detects the error and cancels the posting.

To distribute payments automatically:

1 On the A/R Payments or A/R Payment Distributions form, select the customer for which you
want to create the distributions.

2 Select Actions > Generate Distribution.

To review the distributions that were automatically generated, if you are using the A/R Payments
form, you can click the Distributions button.
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Note:  Creating distributions automatically will use the G/L default account from the Accounts
Receivable Parameters form.

Distributing Customer Payments Manually
You can use the A/R Payment Distributions form to apply or distribute payment amounts before
posting them. The distributions determine how a payment is applied to a customer's account, and how
it is distributed to the General Ledger.

Caution:  The system posts only balanced transactions, one side to the cash account for the payment
and the other to the accounts receivable (A/R) account for the distributions. Therefore, the applied
amount for any transaction must equal the check amount of the payment. If these amounts are not
equal, the system detects the error and cancels the posting.

To distribute payments manually:

1 On the A/R Payment Distributions form, select Actions > New.

2 Specify this required information:

Customer
Specify the number of the customer whose payment you are distributing.

Payment Type
This field displays the customer's default payment method, but you can select a different method.

Number
Select the number of the customer's check or draft you are distributing.

Bank Code
This field displays the customer's default bank code, but you can select a different code for the
bank into which this distribution will be deposited.

Type
Select a desired distribution type.

3 Use this table to specify additional information according to the distribution type:
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Specify and view information in these fields:Distribution
Type

Invoice: Select the number of the customer's invoice to distribute the payment to.

Site: This field shows the site that owns the invoice to which the payment distribution
is being applied displays, but you can select a different site to which to apply the
payment.

Dist Amount: Specify the distribution amount.

Disc/Credit 1: If the payment receipt date is less than the discount date of the invoice,
this field shows the discount amount for the invoice, but you can change it to a different
amount.

Allowance/Credit 2: Specify the allowance amount or the second credit distribution
amount (in the customer's currency) given to the customer.

Invoice

Order: Select the customer order against which you are applying the distribution.

Site: This field shows the site that owns the invoice to which the payment distribution
is being applied, but you can select a different site to which to apply the payment.

Dist Amount: Specify the distribution amount.

Disc/Credit 1: If the payment receipt date is less than the discount date of the invoice,
this field shows the discount amount for the invoice, but you can change it to a different
amount.

Allowance/Credit 2: Specify the allowance amount or the second credit distribution
amount (in the customer's currency) given to the customer.

Open Credit

Site: This field shows the site that owns the invoice to which the payment distribution
is being applied, but you can select a different site to which to apply the payment.

Dist Amount: Specify the distribution amount.

Finance
Charge

Site: This field shows the site that owns the invoice to which the payment distribution
is being applied, but you can select a different site to which to apply the payment.

Disc/Credit 1: If the payment receipt date is less than the discount date of the invoice,
this field shows the discount amount for the invoice, but you can change it to a different
amount.

Allowance/Credit 2: Specify the allowance amount or the second credit distribution
amount (in the customer's currency) given to the customer.

Non-A/R

4 In the Accounts tab, use this table to specify information according to the distribution type:
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Specify information in these fields:Distribution Type

Disc/Credit 1 Acct: Select the G/L account number to post the discount/credit
1 amount to, or accept the default discount G/L account number that displays
from the Accounts Receivable Parameters form. Then, if any of theUnit
Code 1-4 fields are available, select the applicable unit codes.

Allowance/Credit 2: Select the G/L account number to post the allowance
or credit amount to, or accept the default G/L allowance account number that
displays from the Accounts Receivable Parameters form. Then, if any of
the Unit Code 1-4 fields are available, select the applicable unit codes.

Tax Adjustment1: If Tax Discount/Allowance is selected on the Tax Sys-
tems form, specify this amount.

Tax Adjustment2: If this field is displayed and if Tax Discount/Allowance
is selected on the Tax Systems form, specify this amount.

Invoice

and you entered
amounts in the
Disc/Credit1 and
Allowance/ Credit2
fields

Disc/Credit 1 Acct: Select the G/L account number to post the discount/credit
1 amount to, or accept the default discount G/L account number that displays
from the Accounts Receivable Parameters form. Then, if any of the Unit
Code 1-4 fields are available, select the applicable unit codes.

Deposit Acct: Select the G/L account number to post the open credit (deposit)
amount to, or accept the default deposit G/L account number that displays
from the Accounts Receivable Parameters form. Then, if any of the Unit
Code 1-4 fields are available, select the applicable unit codes.

Tax Adjustment1: If Tax Discount/Allowance is selected on the Tax Sys-
tems form, specify this amount.

Tax Adjustment2: If the field is displayed and if Tax Discount/Allowance
is selected on the Tax Systems form, specify this amount.

Open Credit

Disc/Credit 1 Acct: Select the G/L account number to post the discount/credit
1 amount to, or accept the default non-A/R cash account from the Currency
Codes form. Then, if any of the Unit Code 1-4 fields are available, select the
applicable unit codes.

Allowance/Credit2 Acct: Select the G/L account number to post the al-
lowance or credit amount to, or accept the default non-A/R cash account from
the Currency Codes form. Then, if any of the Unit Code 1-4 fields are
available, select the applicable unit codes.

Tax Adjustment1: If Tax Discount/Allowance is selected on the Tax Sys-
tems form, specify this amount.

Tax Adjustment 2: If Tax Discount/Allowance is selected on the Tax Sys-
tems form, enter this amount.

Non-A/R

and you entered
amounts in the
Disc/Credit1 and
Allowance/ Credit2
fields

5 Select Actions > Save.
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About Early Payment Discounts
If the Tax Discount/Allowance field is selected for Tax System 1 on the Tax Systems form, and an
early payment discount exists, then when a regular or landed cost voucher is created, the discount
and non-discount amounts must be calculated differently.

The early payment discount initially is based on the voucher total, including all charges and VAT on
the voucher. At the moment of payment, if the early payment discount is applied, the discount amount
is split into two parts:

• Net discount amount, calculated by applying the discount percent that is defined in the payment
terms to the voucher total, exclusive of the VAT.

• VAT adjustment, calculated by applying the discount percentage that is defined in the payment
terms to the total VAT amount.

This discount affects these areas of the system:

• A/P Check Printing/Posting
• A/P Payment Distributions
• A/P Payments
• A/P Posted Transactions Detail
• A/P Posted Transactions Summary
• A/P Quick Payment Application
• A/P Vouchers and Adjustments
• A/R Payment Distributions
• A/R Payments
• A/R Posted Transactions Detail
• A/R Posted Transactions Summary
• A/R Quick Payment Application
• EU VAT Report
• Generate A/P Transactions
• Generate Landed Cost Vouchers
• Purchase Order Receiving
• VAT Report

Example: A/P Voucher Distributions

The Discount Amount is calculated against the sum of the Purchase Amount and the VAT Amount, as
shown in this table:

VAT PercentTax BasisConcept

 400.00Purchase Amount

 400.00Tax Basis

19%76.00Plus VAT

 476.00Voucher Total

3%14.28Minus Discount
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VAT PercentTax BasisConcept

 461.72Net Voucher Amount

Tax Date for Early Payment Discounts

For Accounts Receivable and Accounts Payable payments made before the discount date and where
the tax discount has been applied, the EU VAT Report shows the payment date as the Tax Date. If
these dates fall outside the specified Tax Period Start and Tax Period End report options, these rows
are not included in the report.

Processing Returned Checks
When you run the Returned Checks utility, the processing that takes place depends on which option
is selected on the Accounts Receivable Parameters form.

The options are described here:

• If the Generate Debit Memo per Invoice check box is selected on the Accounts Receivable
Parameters form:
• One debit memo is created in the original transaction currency for each invoice to reverse the

payment amount for that invoice.
• Two distribution rows are created. The first is for the actual amount of the check, crediting the

cash account. The second is for the discount amount, crediting the early pay discount account.
• If the Generate Returned Check Fee check box is selected on the Bank Reconciliations

form and a Returned Check Fee Type of Amount is selected, a second debit memo is created
in the original transaction currency for the returned check fee amount.

• If the Generate Returned Check fee check box is selected on the Bank Reconciliations
form and a Returned Check Fee Type of Percent is selected, a debit memo is created in
the original transaction currency for the fee amount associated with each invoice paid off by
the check being returned. Each debit memo is for the amount of the invoice multiplied by the
fee percentage.

• You must run Invoice Posting to post the debit memo(s) generated by the Returned Checks
utility. This creates journal entries to book the offset of the returned check and discount amounts.
The fee amount is also booked.

• If the Generate Payment Adjustment for Returned Checks check box is selected on the Accounts
Receivable Parametersform:
• One negative amount adjustment is created in the bank currency, to show the invoice amount

as still being due.
• A payment adjustment distribution record is created in the bank currency to offset the payment

and any associated discount amount.
• If the Generate Returned Check Fee check box is selected on the Bank Reconciliations

form and a fee type of Amount is selected, a debit memo is created in the customer currency
for the returned check fee amount.

• If the Generate Returned Check Fee check box is selected on the Bank Reconciliations
form and a fee type of Percent is selected, a debit memo is created in the customer currency
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for the fee amount associated with each invoice paid off by the check being returned. Each
debit memo is for the amount of the invoice paid off by the check multiplied by the fee
percentage.

• A/R Adjustment Posting needs to be executed to post the negative check adjustment created
by the Returned Checks utility. This creates journal entries to book the offset of the returned
check and discount amounts.

• You must run Invoice Posting to post any debit memo(s) created for the returned check fee.
This creates journal entries to book the fee amount.

See the appropriate topic to handle returned checks:

• Returning a Single Check on page 142
• Returning Part of a Summarized Check Deposit on page 142
• Redepositing a Check on page 143

Returning a Single Check
1 Contact the customer and determine a course of action. A new check may be collected or the

returned checks re-deposited.

2 Open the Bank Reconciliations form.

3 Filter by the bank that failed to accept the check.

4 Using your bank records, search for the deposit date that matches the rejected check's deposit
date.

5 Select the Returned Check check box in the grid.

6 If applicable, select the Generate Returned Check Fee check box, and add information for the
Returned Check Fee Type and Returned Check Fee Value fields.

7 Open the Returned Checks form and process the appropriate bank code. A message will display
indicating that the utility was successful.

For more information about what happens on this form, see Processing Returned Checks on page
141.

Returning Part of a Summarized Check Deposit
To return a check that was part of a summarized check deposit:

1 Using your bank records, search the Bank Reconciliations form for the deposit date that matches
the rejected check's deposit date.

Note:  The Bank Reconciliations form includes summarized transaction records. Therefore, it
may not be possible to match the exact check amount on your bank record with the exact check
amount on the Bank Reconciliations form. If the Bank Reconciliations form displays multiple
deposits on the day in question, use your best judgment in determining the proper row to modify.
As long as you enter the correct amount, modifying the wrong row will not cause any problems.

2 Modify the number in the Bank Amount field to reflect the actual amount deposited in the bank.
The difference between the two numbers should equal the amount of the returned check.

Infor SyteLine Financials User Guide | 142

 

Accounts Receivable (A/R)



3 Add a new Bank Reconciliations record, with this information:

Type
Specify Deposit

Amount
Specify the [returned check amount.

Bank Amount
Specify 0.

Ref Number
Specify the customer number.

Customer Check Number
Specify the  check number.

Returned Check?
Specify Selected.

Returned Check Fee?
Accept the default from the A/R Parameters form  or clear the check box.

Returned Check Fee Type
Accept the default from the A/R Parameters form or select a type.

Returned Check Fee Amount
Accept the default from the A/R Parameters form or specify an amount.

4 Open the Returned Checks form and post invoices or payment adjustments.

For more information about what happens on this form, see Processing Returned Checks on page
141.

Redepositing a Check
1 On the Bank Reconciliations form, clear the Returned Check field for the check being redeposited,

and select the Bank Reconciled field.

2 On the Returned Checks utility form, select the Process Returned Check Deposit check box
for the appropriate bank code and click Process. A credit memo is created to show the check has
been redeposited.

3 On the Invoice Posting form, post the credit memo. Journal entries are created to book the
redeposited check.
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Finance Charges

Calculating A/R Finance Charges
For each customer whom the Finance Charge check box is selected on the Customers form, the
system looks at all open invoices, debits, credits, finance charges and payments.

If the system finds an invoice or debit, it performs the following:

TA * APR/365 * (BD - (LFCD or TDD)) = CFC

where:

• CFC = Calculated Finance Charge
• TA = Transaction Amount
• APR = Annual Percentage Rate (from the Accounts Receivable Parameters form)
• 365 = days in a year
• BD = Base Date (first choose Generate Charges)
• LFCD = Last Fin Chg Date (from the Customers form)
• TDD = Transaction Due Date

If the Last Fin Chg Date is more recent than the Transaction Due Date, the system uses the Last
Fin Chg Date; otherwise, it uses the Due Date. The calculated amount is a positive finance charge.
If a transaction is a credit or payment, the system calculates the transaction the same way, except the
amount is a negative finance charge.

If a transaction is a finance charge transaction, the system calculates the finance charge only on this
amount if the Compound Charges check box is selected on the Accounts Receivable Parameters
form. In this case, the system calculates the amount the same way as invoices and debits.

After the system calculates all finance charge amounts, it sums them to arrive at the final finance charge
amount for the customer.

Multi-Site A/R Finance Charge Calculations

Although the finance charge activity does run across sites, when run from the entity, they are not split
to see where all the charges came from. The site that generated the finance charge is the only one
with the finance charge transactions. See these examples:

• Example 1 on page 145
• Example 2 on page 145
• Example 3 on page 145

Given these three examples, you will need to determine whether you want to have "centralized" or
"decentralized" finance charge collections. the system automatically provides you with decentralized
finance charge generation and posting. If you want to have only one of your sites be the collection point
for finance charges, you must have defined customers in that one site for all customers that exist in all
sites (as shown in Example 3). Once that is done, finance charge generation and posting should not
be run at sites other than the collection site.
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Example 1: Multi-Site A/R Finance Charge Generation
In this example, if Site 1 generated the finance charges, nothing would happen for customer C-1 since
C-1 is not local.

Site 3Site 2Site 1

C-1C-1C-1 not local

$300.00 (past due balances)$400.00$0.00

3.00 (individual finance charges)4.00$0.00

Example 2: Multi-Site A/R Finance Charge Generation
In this example, Customer C-1 exists in all three sites and finance charges are run individually at each
site. When run individually, the finance charges stay in the site where they were run.

Site 3Site 2Site 1

C-1C-1C-1

$300.00 (past due balances)$400.00$0.00

3.00 (individual finance charges)4.00$0.00

Example 3: Multi-Site A/R Finance Charge Generation
In this example, Site 1 is responsible for accepting payments (which can be distributed to the proper
site) and running the finance charges. In this case, only Site 1 generates the finance charges and
becomes the actual location of the finance charge transactions before and after finance charge posting.

Site 3Site 2Site 1

C-1C-1C-1

$300.00 (past due balances)$400.00$0.00

0.00 (centralized finance charges)0.00$7.00

Entering Finance Charges Manually
On the Finance Charges form, you can enter the finance charges manually by entering the finance
charge for the selected customer in the Finance Charge field.
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Generating and Posting Finance Charges
To calculate finance charges for customers who have a past-due balance and for whom the Finance
Charge check box on the Customers form is selected, use the A/R Finance Charge Generation
utility.

To post the finance charges, use the Finance Charge Posting form.

1 On the A/R Finance Charge Generation form, enter information in these fields:

• Site Group: Enter the multi-site group ID for which you want to generate finance charges.
• Start and End Customer: Enter the range of customers you want to generate finance charges

for.
• Statement Cycle: Select from the drop-down list the statement cycles you want to generate

finance charges.
• Cutoff Date: Enter the cutoff date of the transactions you want to include in the calculation.
• Include Fully Paid Invoices: If you want to include invoices that are fully paid, but which are

late, select this check box.
• Delete All Records First: If you want to delete all finance charge records before generating the

new amounts, select this check box.
• Increment Date: If you want the system to automatically increment date ranges and re-run

reports and utilities, select this check box.

2 To generate finance charges for the selected customers, click Process.

After you generate the finance charges and review them for accuracy, you must post the charges. To
post the charges, use the Finance Charge Posting form and:

1 Select the range of customers whose finance charges you want to post, or, to post finance charges
for all customers, leave these fields blank.

2 To print the Finance Charge Transaction Report and verify that the finance charges are correct,
click Process.
Note:  You must print this report before you can post the charges. The Commit option is inactive
until you perform this step.

3 After verifying the report, to post the finance charges, select Commit and then click Process.

After the finance charges are posted, they display on the A/R Posted Transactions Detail form with
Finance Charge as the type and -1 as the invoice number. The posted finance charges display as
Finance Charge on this form.

The system does not post transactions that contain incorrect information. In this case, the system
displays an error message stating that the posting process is partially complete. You must correct the
errors, and then post the finance charges again.
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Importing Electronic A/R Payments

Importing A/R Payment and Distribution Data from Bank Files
You can import and process electronic customer payments from a bank or electronic lock box and
apply them to A/R invoices.  Different banks use different file formats. Set up a Map ID for each type
of file format  that will be imported.

To prepare for the import:

• The file to be imported into the A/R Payment Import Workbench must be based on Microsoft
Windows format, where end-of-line is indicated by Carriage Return (CR - CHAR(13) - \r - 0x0D)
and Line Feed (LF - CHAR(10) - \n - 0x0A) control characters. Using this format allows SyteLine
to import each line into a separate row in the table.

• Use these forms to set up mapping of the imported values to fields:

• A/R Payment Import Field Mappings: Use this form to define a map ID that, together with
the description, clearly defines the bank and the type of file to be used for an import. Also
specify the default logical folders where you will place the files to be imported. Archived files
are stored in the A/R Payment Import Archive Logical Folder that is defined on the Accounts
Receivable Parameters form after import.

• A/R Payment Import Conversions

Because it is a standard format already defined in SyteLine, you only need to specify a Map ID
and the Type when you set up mapping for the NACHA CCD bank file format. For other delimited
or non-delimited bank file formats, you must specify additional information about the file format
and how the contents are mapped to the import workbench tables.

1 After customers' payments are deposited in your bank, use the A/R Payment Import utility to
import electronic files from your bank that provide a record of the EFT payments:

a Select a map ID.
b Verify that the appropriate import and archive logical folders are defined. These values are

linked to the map ID definition on the A/R Payment Import Field Mappings form. The A/R
Payment Import Archive Logical Folder is defined on the Accounts Receivable Parameters
form.

c Click the Files button next to Import Logical Folder to display the contents of the logical
folder.

d In the A/R Payment Imports form, click Process to import the files that are in the logical folder.

2 Then process the data with the A/R Payment Import Workbench:

a To access the utility from the workbench form, click AR Payment Import. You can also open
the utility standalone.

b Select a valid import map ID.
c When the map ID is specified, the Import Logical Folder for that ID is displayed. You can

change the logical folder.
d Click Process.

The utility reads each file in the import path and imports each file based on the mappings
defined for the map ID. The data from successfully imported files are loaded into the workbench

Infor SyteLine Financials User Guide | 147

 

Accounts Receivable (A/R)



tables, and the files are moved to the A/R Payment Import Archive Logical Folder specified
in the Accounts Receivable Parameters form.

If an error occurs while importing a file, the error is captured and no more files are processed.
You can view the error in the Background Task History form.

3 Open the A/R Payment Import Workbench form to view and manipulate the values and then post
the data to the A/R payment tables.

See Processing Imported A/R Payment and Distribution Data on page 151.

Note:  Bank reconciliation records are not imported with this utility. Only A/R payments and distributions
are imported and processed using the import utility and workbench. Bank reconciliations are created
when the A/R payments are posted in SyteLine.

Mapping Bank Files to A/R Payments and Distributions
Use the information in this topic to set up the mapping between an electronic A/R payment file from a
bank and SyteLine tables, so that the import works for specific bank file formats.

Follow these steps:

1 Use the A/R Customer Bank Account to link customers with their bank routing and account
numbers.

2 Use the A/R Payment Import Conversions form to specify conversions of values from incoming
payment files into acceptable SyteLine values.

3 Use the A/R Payment Import Field Mappings form to set up the needed format types.

4 Use the A/R Payment Import Mappings form to define the import logical folder, contents, and
formatting of an incoming A/R payment file from a specific bank:

a Specify this information:

Map ID and Description
Specify an ID and description that clearly define the bank and the type of file to be used for
this import.

Import Logical Folder
Specify the import logical folder where files to be imported with this format are placed for
processing. The logical folder must already exist, and you must belong to the same
authorization group as the logical folder.

Type
Specify one of these options:
• Delimited: There is a delimiter character between each field in the imported file.
• Non-Delimited: There are no delimiters in the imported file.
• NACHA CCD: This Map ID is used when you import fixed format files that use the NACHA

format. In this case, you cannot further define the mapping. The Electronic File Transfer
Imports form will process incoming files based on the standard NACHA CCD fixed format.

b If Type is set to Delimited, specify the delimiter character and specify whether the fields are
enclosed in quotation marks. If so, the quotation marks are stripped off.
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c If amounts in the imported file do not contain an actual decimal point, but have an implied
decimal point, select Amounts Contain Implied Decimal and then specify the number of
digits that are included to the right of the decimal.

d Specify the Date Format used in the file.
e Specify whether Record Identifiers Are Used in the file. If yes, then specify this information:

Record Identifier Field Number
If Type is set to Delimited, specify the field position of the Record ID field.

Starting and Ending Position
If Type is set to Non-Delimited, specify the characters in the row that are the start and end of
the Record ID value.

f In the Mapping Groups section, specify this information:

Group
Specify the name of the mapping group, which identifies the purpose of field mappings in the
group. Currently the options are Payment or Distribution.

Sequence

Specify the sequence number.

5 Use the A/R Payment Import Field Mappings form to determine how imported data is viewed.

6 On the A/R Payment Import Form form, import a bank file:

a Specify the Map ID and the Import Logical Folder fields.
b Click Process.
c Ensure everything came in as expected.

Example: Bank Import File Mapping
This example shows the information you would specify in the various forms to import an A/R payment
file for a particular bank.

A/R Payment Import Mapping

ValueField

AR00000001Map ID

DelimitedType

|  (pipe)Delimiter

YesAmounts contain implied decimal

2Digits following implied decimals

YYMMDDDate format

YesRecord IDs are used
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ValueField

1Record ID field number

A/R Payment Import Mapping

First record ID of groupGroup name

PRPayment

IVDistribution

A/R Payment Import Conversions

Define this information in the A/R Payment Import Field Mappings form:

Converted valueSource valueValue conversion ID

CACHPaymentType

CBKWPaymentType

CFWTPaymentType

CLBXPaymentType

CSWTPaymentType

WWIRPaymentType

A/R Payment Import Field Mappings

Value
conver-
sion ID

Field
is
date

Field
is
amount

Record
ID

Field
num-
ber

Column nameTable nameTable group

PR8account_numarpmt_import_pay-
ment

Payment

YesPR4check_amtarpmt_import_pay-
ment

Payment

YesPR9deposit_datearpmt_import_pay-
ment

Payment

Pay-
ment-
Type

PR2payment_typearpmt_import_pay-
ment

Payment

PR7routing_numarpmt_import_pay-
ment

Payment

SP16check_numarpmt_import_pay-
ment

Payment
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YesIV5amt_paid_amtarpmt_import_distribu-
tion

Distribution

YesIV7disc_amtarpmt_import_distribu-
tion

Distribution

IV3inv_numarpmt_import_distribu-
tion

Distribution

Processing Imported A/R Payment and Distribution Data
Use the A/R Payment Import Workbench form to view, modify, and validate the payment and
distribution information so that it is ready to post. All batches that were successfully imported are listed
in this form.

Note:  For AR import files in NACHA CCD format, the import assumes that positions 40-54 (Company's
ID Number) of record type 6 in the AR import file contain the check number. The import places this
value in the Check Number field of the workbench form. If the import finds any non-numeric characters
in those positions of the file, it places a zero in this field. If this field is not populated with the check
number, please contact the bank to determine if the bank can place the check number in positions
40-54.

1 Select a batch ID to view its status:

• If the status is Processed, every payment record in the batch has been processed; you can
click Delete to remove the batch from the form. The original file is stored in the Archive folder
in case it needs to be reviewed later.

• If the status is Unprocessed, at least one payment is not processed; that record has a status
of Unprocessed, Error, or Hold.

2 Click Validate to validate all payments and distributions for batches where the payment status is
Unprocessed or Error. During validation, if the customer field is blank for a payment or distribution
record, the system:

• Tries to find the customer number based on the invoice number.
• If that fails, leaves the customer number blank.

Other validations are performed. Any resulting validation error messages are displayed in the grid.

3 Correct any validation errors and fill in any blank customer numbers.

4 In the Payment grid, select the payment records that you want to process. If you do not want to
process a record, you can change its status to Hold.

5 The Distribution grid lists all distributions associated with a selected payment in the Payment grid.
You cannot add or delete records in this grid. If you do not want a distribution to be processed, set
the Apply Amount and Discount Amount to zero. Distribution records are disabled for a payment
whose status is Processed or Hold.

6 Click Process.

All payments and distributions in the batch ID that have a payment status of Unprocessed or Error
are validated, even if they are not selected.

All selected payments that are unprocessed with no errors will be processed. A/R Payment and
A/R Payment Distribution records are created. When an A/R Payment record is created, the

Infor SyteLine Financials User Guide | 151

 

Accounts Receivable (A/R)



customer, routing number and bank account are checked against the A/R Customer Bank Account
records. If a matching customer bank account record is not found, one is created.

Note:  Discount amounts are not calculated on the distribution records. They are either included in the
values from the import file, or they must be manually updated.

Quick Payment Application

Using the A/R Quick Payment Application
Use the A/R Quick Payment Application form to:

• Enter full or partial payments.
• Distribute full or partial invoices.
• Create open payments.
• Pay finance charges.
• Distribute finance charges.
• Reapply open payments.
• Reapply open credits.

To use the A/R Quick Payment Application utility:

1 To access the A/R Quick Payment Application utility from the A/R Payments or A/R Payment
Distributions form, click Quick.

2 If you have not done so on a previous form, enter all the A/R payment information (customer, type,
number, receipt date, due date, and so on).

3 Enter the payment amount.

4 Specify a G/L Reference and a Description, or accept the default values that display.

5 Select Actions > Save.

When you save a payment, all the customer's open invoices, credit memos, finance charges, and
open payments display in the grid at the bottom of the form.

6 Select the invoice, payment, credit, or finance charge to which you want to distribute the payment.

• To select all displayed transactions, click Select All.
• To remove the selection flag from all displayed transactions, click Deselect All.

7 Click Apply.

Notes:

• Debit memos are not included on this form because you cannot enter the invoice number (required
with debit memos). You must apply debit memos through the A/R Posted Transactions form.

• You can apply open credits and payments from a customer only to the customer and any of its
subordinate customers. You cannot apply a subordinate customer's open credits or payments to
another customer that is a subordinate of the same corporate customer.

• Non-A/R payment distributions must be entered in the A/R Payment Distributions form.
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• You can enter post-dated checks on the A/R Quick Payment Application form. The payment
type must be check.

• You can enter full or partial payment amounts. When you close the form or the work with a different
payment, the system creates distributions for the selected invoices in the A/R Payment
Distributions form.

• If you delete a payment through the A/R Quick Payment Application form, the payment is also
deleted from the A/R Payments and A/R Payment Distributions forms.

• In a multi-site environment, if you are making a quick payment where the Type is Draft, the system
only displays invoices from the current site because you cannot select invoices from another site.
There is a one-to-one relationship (site specific) with an invoice and a draft.

The system does not support applying payments to invoices of sites where they do not have the
same domestic currency as the site entering the payment to apply.

• The system does not accept changes until you leave the form or work with a different payment.

Creating Open Payments Using A/R Quick Payment Application
To create an open payment using the A/R Quick Payment Application form:

1 Select Actions > New.

2 Specify information in these fields:

• Customer: Enter the customer ID of the customer for whom you are entering the payment.
• Type: This field displays the customer's payment method by default, but you can select a

different method.
• Number: Enter the check or draft number for this payment.
• Receipt Date: Enter the date you received the payment, or accept the default, which is today's

date.
• Payment Due Date: (Available only if the payment type is Draft.) Enter the date the draft is

due.
• G/L Reference: Enter a description to appear in the distribution journal for this transaction, or

accept the default, which is ARP followed by the check or draft number.
• Description: Enter a description to appear in the distribution journal for this transaction, or

accept the default description.
• Bank Code: Enter the bank code of the bank from which the payment will be made, or accept

the customer's default bank code.
• Amount: Enter the amount of the payment.

3 Do one of the following:

• To apply the entire payment to an open payment, select Actions > Save, and then select
Apply. The entire amount is then distributed to an open payment.

• To apply part of the payment to an open payment, select the Selected check box for each
invoice and/or finance charge you want to apply the payment to. Then select Apply. The
remaining amount is then distributed to an open payment.

Note:  If you select multiple invoices, open payments, and/or open credits, the oldest open transaction
is applied to the oldest invoice. You cannot enter the invoice number of the open payment to apply the
payment to.
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Entering Customer Payments Using A/R Quick Payment Application
To process payments from customers, you can use the A/R Quick Payment Application form. You
can select open invoices, finance charges, payments, and credit memos.

To process payments using the A/R Quick Payment Application form:

1 Select Actions > New.

2 Enter the appropriate information in the following fields:

• Customer: Enter the customer ID of the customer you're entering the payment for.
• Type: This field displays the customer's payment method by default, but you can select a

different method.
• Number: Enter the check or draft number for this payment.
• Receipt Date: Enter the date you received the payment, or accept the default, which is today's

date.
• Payment Due Date: (Available only if the payment type is Draft.) Enter the date the draft is

due.
• Deposit Date: Enter the date you deposited the check. This field is available for entering

post-dated checks. It is enabled only if the payment type is Check, and no credit memo is
associated with the payment. Enter the date on the customer's check.

• G/L Reference: Enter a description to appear in the distribution journal for this transaction, or
accept the default, which is ARP followed by the check or draft number.

• Description: Enter a description to appear in the distribution journal for this transaction, or
accept the default description.

• Bank Code: Enter the bank code of the bank from which the payment will be made, or accept
the customer's default bank code.

• Amount: Enter the amount of the payment.

3 Select Actions > Save.

Note:  You must perform this step before you can select any transactions in the grid.

All open invoices, finance charges, payments, and credit memos for this customer display in the
grid at the bottom of the form. If any of these transactions have been distributed, the Selected
check box is selected for each.

Note:  On the A/R Quick Payment Application form, non-A/R payment distributions display as
selected in the grid. The amounts display in the Discount and Allowance columns. In the Discount
column, you enter Credit Amount 1, and in the Allowance column you enter Credit Amount
2.

4 For each transaction you want to make a payment against, select the Selected check box, or, to
select all the displayed transactions, click Select All.

5 Select Apply. The system displays a message informing you of the actions that were taken.

Reapplying Open Payments and Credits Using A/R Quick Payment
Application
If you add a customer payment and also add a payment distribution type of Open Credit, and then post
the payment, you can reapply the posted payment using the A/R Quick Payment Application form.
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You can reapply an open payment and credit on this form using either of these methods:

• Entering an Open Payment to Reapply.

You do this without selecting transactions against which to apply the payment.

• Selecting an Open Payment to Reapply.

You do this in the grid at the bottom of the form.

Entering an Open Payment to Reapply

In this case, you enter and save a payment in the A/R Quick Payment Application form without
selecting transactions against which to apply the payment:

1 Open the A/R Quick Payment Application form.

2 Select Actions > New.

3 Select the customer number, and enter the check number that matches the open payment you
want to reapply.

The system fills the G/L Reference field with the description Re-Application of Open Payment/Credit.

4 Change the G/L Reference and Description fields, if necessary.

Note:  When reapplying open credits, do not change the Receipt Date. The journal entries created
will be a debit and credit to the A/R account. When reapplying open payment, and a separate A/R
Deposit account is used, change the Receipt Date to current date. The journal entries created will
be a debit to the A/R Deposit account and a credit to the A/R account. If the deposit account is the
same as the A/R account, then the receipt date should not be changed.

5 Select Actions > Save.

Note:  You must perform this step before you can select transactions in the grid at the bottom of
the form.

6 Select the Selected column of each transaction you want to apply the payment to.

7 Click Apply. The system updates the payment with the new invoice number, and journal entries
are posted for the reapplication. The journal entries will have a reference of ARPR (payment or
credit reapplication).

Selecting an Open Payment to Reapply

In this case, you use the grid at the bottom of the  A/R Quick Payment Application form to specify
the information.

1 Open the A/R Quick Payment Application form.

2 Make sure that you have entered all the payment information.

3 Select Actions > Save.

Note:  You must perform this step before you can select transactions in the grid at the bottom of
the form.

4 Select an invoice in the grid.
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5 Select an open credit or payment in the grid. The selection of both the invoice and the open
credit/payment triggers the reapplication process.

6 Click Apply. The system creates a payment distribution for the invoice for the value in the Bank
Amount field. To verify that the system has reapplied the open payment, you can view it in the
A/R Posted Transactions Detail form.

Note:  If you select multiple invoices, open payments and/or open credits, the oldest open transaction
is applied to the oldest invoice. You cannot enter the invoice number to apply the open payment
to.

Examples: Using A/R Quick Payment Application
Use these examples to understand the A/R Quick Payment Application.

Scenario 1

You enter a payment for $150, and select three $50 invoices in the grid against which to apply the
payment.

The grid shows:

DiscAmt
to ap-
ply

Due
Date

Inv
Date

Chk/
Ref

Deliv-
ery
Order

OrderSiteInvTypeCus-
tomer

0.0050.006/155/15C0000101101I1

0.0050.007/156/15C0000701150I1

0.0060.007/226/22C00001001156I1

When you select Apply, the system creates three distribution records for each one of these invoices.

Scenario 2

You enter a payment, and do not select any transactions in the grid.

You enter a payment for $100 on the A/R Quick Payment Application form with a payment date of
06/15/02, and save it. Then, you select Apply. A payment distribution is created as an Open credit for
$100.

The grid shows:

DiscAmt
to ap-
ply

Due
Date

Inv
Date

Chk/
Ref

Deliv-
ery
Order

OrderSiteInvTypeCus-
tomer

0.0050.006/156/1501OpenP1
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Scenario 3

You enter a payment, select an invoice, and some payment amount is left to be applied.

You enter a payment for $100 on the A/R Quick Payment Application form, and save it. Then you
select an invoice for $60, and click Apply. Two payment distributions are created, one as an invoice
for $60, and the other as an open credit for $40. Both the invoice and the open credit display as selected
in the grid.

DiscAmt
to ap-
ply

Due
Date

Inv
Date

Chk/
Ref

Deliv-
ery
Order

OrderSiteInvTypeCus-
tomer

0.0040.006/156/1501OpenC1

0.0060.006/155/15C0000101102I1

Scenario 4

You enter a payment for $0, and select an invoice and an open credit.

Dis-
count

Amt
To Ap-
ply

Due
Date

In-
voice
Date

Chk/RefDeliv-
ery
Order

OrderSiteIn-
voice

TypeCus-
tomer

0.0050.0006/15/1506/15/15  C00000101OpenC1

0.0050.0006/15/1505/15/15  C00000101101I1

The open credit is automatically when you click Apply. The invoice number in the A/R Transaction
table (artran) now shows 101. The A/R account in the original artran record for the open credit is 11000.
The A/R account in the parameters is 11000. The journal entries created will be:

Exchange
Rate

Ref/CurrencyAmountAcountDate/Account Descrip-
tion

Journal
Seq

1ARPR50.001100006/15/1529 *  

1.000USD50.00 Accounts Receivable 

1ARPR50.001100006/15/1530 *

1.000USD50.00 Accounts Receivable 

Scenario 5

You enter a payment for $50, and select multiple invoices, open payments, and credits: two invoices,
101 with a due date of 06/15/02 and 150 with a due date of 07/15/02 for $50 each; and the open credit
has a due date of 06/15/02. The payment is for $50 on 07/20/02.

When you click Apply, the open credit of $50 is applied to invoice 101 and then posted. A/R Posted
Transactions will show the credit with an invoice number of 101. The new payment of $50 is applied
to invoice 150, and a payment distribution is created.
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The grid shows the following:

DiscAmt
to ap-
ply

Due
Date

Inv
Date

Chk/
Ref

Deliv-
ery
Order

OrderSiteInvTypeCus-
tomer

0.0050.007/156/15C00000701150I1

Scenario 6

You enter a payment, and select a Finance Charge transaction.

Three finance charges exist in posted transactions: one for $20 with a due date of 05/15/02, one for
$20 with a due date of 06/15/02, and one for $20 with a due date of 07/15/02.

You enter a payment for $40. The finance charges display in the grid as follows:

DiscAmt
to ap-
ply

Due
Date

Inv
Date

Chk/
Ref

Deliv-
ery
Order

OrderSiteInvTypeCus-
tomer

0.0050.005/155/1501Fin
chg

F1

You must update the Amt To Apply (in the grid) to $40.00. When you click Apply, a distribution is
created for the finance charge. Upon posting the payment, the amount will automatically be applied to
the oldest finance charges.

Scenario 7

Reapplication of an Open payment/Open credit.

You enter an open payment/open credit to reapply for $1000. The grid shows an invoice selected for
$1000. When you click Apply, a payment distribution is created. The A/R account in the original A/R
transaction (artran) record for the open credit is 11000, and the A/R account in the original record for
the open payment is 26000 (Deposit account). The open credit journal entries are the same as in
scenario #4 above. When the open payment is applied, payment application occurs within the due
date, so a discount for $50 is automatically created by the system in the Discount column.

When the payments are posted, the open payment entries are:

Customer/Ex-
change Rate

Ref/CurrencyAmountAccountDate/Account De-
scription

Journal
Seq

656ARPR1,000.002600001/18/1555 *

1.000USD1,000.00 AR Deposit 

656ARPR50.004045001/18/1556 *

1.000USD50.00 Sales Discount 

656ARPR1,050.001100001/18/1557 *
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Customer/Ex-
change Rate

Ref/CurrencyAmountAccountDate/Account De-
scription

Journal
Seq

1.000USD1,050.00 Accounts Receivable 

Scenario 8

Reapply an Open payment to an invoice from another site.

An invoice is selected from Site 2. The open payment was entered in Site 1, and is being applied in
Site 1. When you click Apply, you are prompted to transfer cash. If you select Yes, journal entries in
Site 2 will transfer the amount from Accounts Receivable to cash. In Site 1, the amount will be transferred
from the deposit account to cash. The entries appear:

Site 2:

Customer/Ex-
change Rate

Ref/CurrencyAmountAccountDate/Account De-
scription

Journal
Seq

25ARPR100.001100001/17/1532 *  

1.000USD100.00 Accounts Receivable 

25ARPR100.001000001/17/1533 *  

1.000USD100.00 Cash 

Site 1:

Customer/Ex-
change Rate

Ref/CurrencyAmountAccountDate/Account De-
scription

Journal
Seq

25ARPR100.002600001/17/1543 *

1.000USD100.00 AR Deposit 

25ARPR100.001000001/17/1544 *

1.000USD100.00 Cash 

If transfer cash is not selected, the A/R Inter-Site Liability and Asset accounts will be used instead of
Cash. The entries are:

Site 2:

Customer/Ex-
change Rate

Ref/CurrencyAmountAccountDate/Account De-
scription

Journal
Seq

23ARPR100.001100001/17/1535 *

1.000USD100.00 Accounts Receivable 

23ARPR100.004902001/17/1536 *

1.000USD100.00 A/R Inter-Site Asset 
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Site 1

Customer/Ex-
change Rate

Ref/CurrencyAmountAccountDate/Account De-
scription

Journal
Seq

23ARPR100.002600001/17/1547 *

1.000USD100.00 AR Deposit 

23ARPR100.004900001/17/1548 *

1.000USD100.00 A/R Inter-Site Liability 

Scenario 9

Reapply an open payment to an invoice with a different exchange rate. An open payment for $310
Canadian Dollars (CND) at an exchange rate of 1.55 is applied to an invoice with an exchange rate of
1.60. The following entries happen in the journal when the Apply button is selected:

Customer/Ex-
change Rate

Ref/CurrencyAmountAccountDate/Account De-
scription

Journal
Seq

5651ARPR200.002600001/14/1566 *

1.550US$310.00 AR Deposit 

 ARX7.0340200300067 *

1.550CND10.90 Currency Gains 

 ARX7.031100001/14/1568 *

1.550CND10.90 Accounts Receivable 

5651ARPR200.001100001/14/1569 *

1.550CND310.00 Accounts Receivable 

Scenario 10

You enter a payment for $95. You also enter a non-A/R cash distribution for $5.00 in A/R Payment
Distributions. When you access the A/R Quick Payment Application form, the following transactions
display:

DiscAmt
to ap-
ply

Due
Date

Inv
Date

Chk/
Ref

Deliv-
ery
Order

OrderSiteInvTypeCus-
tomer

0.00100.0055/15-1C00000701Fin
chg

F1

5.005/1501Non
A/R

Non
A/R

0.0020.005/15-101OpenOpen
credit
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DiscAmt
to ap-
ply

Due
Date

Inv
Date

Chk/
Ref

Deliv-
ery
Order

OrderSiteInvTypeCus-
tomer

0.0010.006/155/1501100I1

When you click Apply, the $20 open credit is applied to the finance charge. It is automatically posted
and shows on the A/R Posted Transactions form.

The $95.00 payment is then applied. Distributions for an $80 finance charge, $5.00 non-A/R cash, and
$10.00 invoice will then be created. The non-A/R cash already exists in the distributions.

Posting A/R Draft Payments
Draft payments cannot be directly posted to a cash account like you would post a check or a wire
payment. When you first post the draft payment, the draft status is changed to Posted and the usual
journal transactions are created. However, the transaction does not yet impact the Cash account in
the General Ledger, but instead it impacts the Draft Receivable account found in the Accounts
Receivable Parameters form.

Next, based on the due date of the draft and when you wish to receive the cash (at due date or before
the due date), perform a draft remittance using the A/R Posting Draft Remittance form.

Note:  The bank charges an additional discount fee when you want to receive the cash before the due
date.

After the draft remittance, post the draft. Posting the draft changes the status of the draft to Remitted
and creates a journal entry from the Draft Receivable account to either the Draft Remitted account or
the Draft Discounted account identified in the Bank Address form.

Posting prepares entries for the AR DIST journal as shown here.

These journal entries are created with the A/R Posting Draft Remittance form:

• Debit: Drafts Remitted
• Credit: Drafts Receivable

For discounted drafts, these journal entries are created:

• Debit: Drafts Remitted
• Credit: Draft Discounted Receivable

When the bank tells you it has given you the money, use the Bank Reconciliations form to perform
a draft deposit. The deposit updates the draft status to its final value of Paid and creates the new journal
entry that finally impacts the Cash account.

These journal entries are created when you reconcile draft payment deposits in the Bank
Reconciliations form:

• Debit: Cash
• Credit: Drafts Remitted
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Posting Payments
Note:  The Accounts Receivable account must be assigned on the Accounts tab on the Accounts
Receivable Parameters form; otherwise, an error message displays and the posting process stops.

1 Open the A/R Payment Posting form.

2 (Optional) By default, payments for all customers will be posted, but you can further refine the
posting by selecting a range of customers, bank codes, receipt dates, and check numbers. You
also can select a single payment for posting.

The Print option is automatically selected. You must first print the A/R Payment Transaction
Report to review and verify the transactions that will be posted.

3 To produce the report, click Process. After reviewing the report, you can post the transaction(s)
and create Bank Reconciliation record(s). Notice that the Commit option is now enabled.

4 Select the Commit option.

5 To post the payment(s) and create the Bank Reconciliation record(s), click Process.

The system does not post transactions containing errors. If a transaction contains errors, correct
them, and then try again to post.

6 When you post an A/R open payment that is tied to a customer order,you are asked if you want to
apply it as a prepaid amount on the customer order. You have three options:

• To post the payment and not update the customer order, select No.
• To post the payment and update the customer order, select Yes.
• To cancel the action and not update the order or post payments, select Cancel.

Example: Multi-Site Payment Posting
Use this example to understand multi-site payment posting.

Three sites exist for Entity XYZ. Site A is designated as the centralized collection site where all customer
payments are collected. If Site A receives a $300 payment from a customer to pay 3 invoices, each
from a different site, these journal entries must occur:

• Invoice customer - $100 from each entity, as shown in this table:

CreditDebit  

 $100A/RSite A transactions:

$100 Sales 

 $100A/RSite B transactions:

$100 Sales 

 $100A/RSite C transactions:

$100 Sales 

• Post payment of $300 - distribute $100 to each entity, as shown in this table:

Infor SyteLine Financials User Guide | 162

 

Accounts Receivable (A/R)



CreditDebit  

 $300CashSite A Transactions:

$100 A/R 

$100 Inter-Site Liab (Entity B) 

$100 InterEntity Liab (Entity C) 

 $100InterEntity AssetSite B transactions:

$100 A/R 

 $100InterEntity AssetSite C transactions:

$100 A/R 

Note:  To reverse the inter-site transactions; each site will create a manual entry when corporate pays
cash to the sites.

Posting to the A/R Distribution Journal
The A/R Distribution Journal records invoice, credit memo, debit memo, finance charge, and payment
transactions. Eventually, you need to post this journal to the General Ledger.
Note:  After transactions are posted to the journal, you can no longer update them. You can add text
to the line entries, but to adjust them you must use the A/R Payments and A/R Payment Distributions
forms.

You can view a summary of the distributions on the Journal Account Summary form. Select the AR
Dist Journal in the grid to view the account totals.

You view posted transactions to the A/R Distribution journal on the A/R Posted Transaction Detail
form. Use the grid pane to select the transaction you want to view. The Type field identifies the type
of transaction you are viewing: invoice, credit memo, debit memo, finance charge, or payment.

To view summary information about the displayed transaction, select Summary. The A/R Posted
Transaction Summary form displays.

Reversing a Posted Payment
To reverse a posted A/R payment:

1 Enter a negative A/R payment for the customer with the same check number. You must add a one
or zero to the end of the original check number, as the system will see that this check has already
been used for this customer.

2 Distribute the negative amount to the invoices that were originally paid. If the original payment was
distributed as an open payment to the customer's A/R journal, then distribute the negative amount
the same way.
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3 Create a zero-amount invoice (for example, 0.00) and post it to the customer's A/R journal.

4 Reapply the open positive payment to the zero-amount invoice.

5 Reapply the open negative payment to the zero-amount invoice.

6 Post the payments to zero them out on the customer's A/R journal.

Posting A/R Direct Debit Payments
1 Open the A/R Direct Debit Posting form.

2 Select Display Report Header if you want to include a header on each page of the payment report.

3 Select the ranges of customers, bank codes, due dates, and direct debit numbers that you want
to include in the payment post.

4 To populate the grid and print the payment report, select Print and click Process.

5 In the grid, select Process for the records that you want to include.

6 To post the payments, select Commit and click Process.

After posting A/R direct debit payments, these actions are performed:

• The appropriate journals are posted to:
• Debit: Direct Debit Receivable
• Credit: Accounts Receivable

• The corresponding direct debit status is set to Generated.
• A DebitTransfer BOD is triggered containing the A/R payment data.
• The customer's mandate Last Used Date is updated to the current date.

Purging A/R Direct Debits
1 Open the A/R Direct Debit Purge form.

2 Select the range of direct debit records you want to purge.

3 Select the statuses of the direct debits that you want to purge:

• Canceled
• Paid
• Voided

4 To review the list of direct debits that will be purged before actually deleting them, select Preview
and then click Process. The grid at the bottom of the form is updated with the list of records that
match your selection criteria.

5 After reviewing the list and optionally making changes to the selection criteria, to purge the records,
select Commit and then click Process.
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Purging Drafts
The A/R Draft Purge utility deletes draft records, based on status. Only Canceled, Paid, and Voided
drafts can be purged. A register of the purged drafts is produced as an audit trail.

To purge A/R drafts:

1 Open the A/R Draft Purge form.

2 (Optional) By default, all drafts are purged, but you can select a range of drafts to purge instead.

3 Select the status check boxes for the drafts you want to purge: Canceled, Paid and/or Voided.

4 To review the list of drafts that will be purged before actually deleting them, select Preview and
then click Process. The grid at the bottom of the form is updated with the list of drafts that match
your selection criteria.

5 After reviewing the list and optionally making changes to the selection criteria, to purge the drafts,
select Commit and then click Process.

Purging Invoice History
To purge the invoice history:

1 Open the Purge Invoice History form.

2 In the Ending Invoice field, select the last invoice whose associated history information you want
to delete.

3 In the Ending Invoice Date field, select the date of the last invoice you want to delete.

4 To delete only transaction list items and not their associated header information, select the Delete
Line Items Only check box.

5 Select the source of the transactions you want to delete: Order Entry, A/R or Both.

6 Click Process.

Caution:  Running this utility may impact the use of invoice sequencing by adding gaps to invoice
series. Run this utility after deleting an invoice/credit memo/debit memo sequence. (Deleting a
sequence automatically voids any unused numbers in the sequence.)

Note: 
• You must use the Activate/Deactivate Posted Transactions - A/R utility to deactivate A/R posted

transactions before purging.
• Purging the invoice history does not remove the invoice and payment from the A/R Posted

Transactions Detail form. In order to do that, you must run the Delete A/R Posted Transactions
utility before purging the invoices.

Reapplying Open Payments and Credits for Customers
If you add a customer payment and a payment distribution type of Open Credit for it, and then post the
payment, you can reapply the posted payment.
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1 Open the A/R Payments form.

2 To add a payment, select Actions > New.

3 Select the customer number, and enter the check number that matches the open payment you
want to reapply. The system fills in the G/L Reference field with the description Re-Application of
Open Payment.

4 (Optional) Change the G/L Reference, Description, and Notes fields.

Note:  When reapplying open credits, do not change the Receipt Date. The journal entries created
will be a debit and credit to the A/R account. When reapplying an open payment, and a separate
A/R Deposit account is used, change the Receipt Date to current date. The journal entries created
will be a debit to the A/R Deposit account and a credit to the A/R account. If the deposit account
is the same as the A/R account, then the receipt date should not be changed.

5 Click Distributions.

6 To add the new distribution(s), select Actions > New.

7 Post the reapplication and distribution(s).

8 To verify that the system has reapplied the open payment, you can view it using the A/R Posted
Transactions Detail and A/R Posted Transactions Summary forms.

Reapplying Open Payments or Credits Against Multiple
Invoices
To reapply an open payment or credit against multiple invoices you will need to create a payment
distribution for each invoice.

1 On the A/R Payment form, add the customer.

2 If you are reapplying a payment, enter the check number. If you are reapplying an open credit, find
the chk/ref number on the A/R Posted Transaction form. Use this chk/ref number in the check
number field.

After the check number is populated, the date and the amount of open payment/credit will appear
on the form and the reference will identify this as a reapplication. If this does not happen, either
the check number is incorrect, or your chk/ref number is incorrect.

3 After the system recognizes this transaction as a reapplication, save the payment record and click
the Distribution button.

4 On the A/R Payment Distribution form, click New to create a new distribution. Usually the Type
will be Invoice and you will enter the invoice number. If the reapplication does not pay the invoice
in full, change the amount of the distribution to be the amount to be paid against this invoice.

5 If the open payment is for more than the total amount you are applying (for example, you have
check for 1=$100.00 and you want to only apply $75.00 at this time), create a distribution for the
remaining amount. Change the type from Invoice to Open and put in the remaining amount. If the
balance will be a non-A/R transaction, change the type from Invoice to Non-A/R Payment and enter
the amount and the account number.

6 After all distributions have been created and amount remaining equals zero, save the distributions.

7 Post the check.
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Example: Reapplication of an Open Payment
The example below shows the reapplication of an open payment.
• Post an open payment. This table shows sample amounts:

CreditDebitTransaction

 $100Cash

$100 Deposit

• Post an invoice. This table shows the amounts.

CreditDebitTransaction

 $100A/R

$100 Sales

• Reapply the open payment to the invoice. This table shows the amounts:

CreditDebitTransaction

 $100Deposit

$100 A/R

Running the A/R Aging Report
To view the current status of all customer account balances, use the Accounts Receivable Aging
Report form.

Normally, you print this report at the end of the period, before you print statements. This report is helpful
in identifying customers with past-due invoices.

To print the Accounts Receivable Aging Report:

1 Select the field values and check boxes to define the parameters of the report you want.

The default selections print a report for all customers.

2 (Optional) To view the report before printing the final version, click Preview.

3 To print the final report, click Print.

Running the AR Balance History Utility
To update the average balance outstanding, the largest balance outstanding, and the last amount
outstanding for selected customers, use the A/R Balance History utility.
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1 Specify the range of customers and the date through which this utility should update customer
balances.

2 To reset the selected customers' balance history information, select the Reset Period Count To
1 check box.

3 Click Process.
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Chapter 4: Bank Statements

About Bank Statement Reconciliations
The Bank Statement form displays information relating to one customer or vendor bank identifier code
(BIC) or to one employee account used for payment. Bank statement files are received in the proprietary
format of specific banks. The files are transformed by an ION workflow that uses Infor Local.ly GEMS
components with Infor standard BODs. The BODs are then sent by the workflow to SyteLine. For more
information, see the SyteLine Integration Guide for Infor Local.ly.

Automatic A/P Payments

When a BankStatement BOD is received into SyteLine, automatic payments are generated for any A/P
transactions in the statement that have a domain family code of Issued Direct Debits (IDDT) or Issued
Credit Transfers (ICDT). Use the A/P button on the Bank Statement form to view the A/P payment
transactions that were created automatically. The A/P button is enabled only for IDDT or ICDT
transactions.

An agreement could exist between the provider and the customer for automatic transfer of funds as
payment for a product or service. Control methods for this transfer of funds are considered separately;
there is a general tolerance on the voucher and the payment that results in a variance that must be
monitored.

Generally, you can expect that the bank statement is correct and can be reconciled with your general
ledger. If the billing is incorrect and must be adjusted, perform the adjustment as a reversal, because
it requires all parties to apply the adjustment. There is no reason to deny an automatic transaction that
may be in error, because the other parties will still show an incorrect transaction until all parties agree
on a resolution.

Note: This information about automatic payments does not apply if certain country packs (for example,
Sweden) are enabled. See the appropriate SyteLine country guide for more information.

A/R and A/P Transactions in the Bank Statement

In order to balance your books, you must be able to view all relevant bank statement transactions
(records and charges). Some records show transactions that require subsequent action; other records
indicate a completed and accepted transaction:

• A/R records usually require confirmation of an existing transaction that has already been initiated
and performed.

• A/P records usually require the execution of an A/P payment transaction. Ideally the payment is
associated with a Vouchers Payable transaction and can be reconciled. The final reconciliation of
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the voucher must be done manually, because the process is variable. Not all A/P transactions
require an A/P payment; for example, the transaction could be a result of a check, wire posting or
other transaction type that is only being reported in the bank statement.

All bank statement line records are available for review. You must determine which records require
manual action on your part.

Transaction Types

The bank statement can include many transaction types. The transaction type codes follow ISO
standards, and are divided into domain codes, domain family codes, and domain sub family codes.
 For example, the Account Management (ACMT) family code is subdivided into domain family codes
such as Miscellaneous Credit Operations (MCOP) and Miscellaneous Debit Operations (MDOP), which
are further subdivided into domain sub family codes, for example Commission (COMM), Fees (FEES),
Interest (INTR) and so on. These transaction codes are predefined on these forms:

• ISO Bank Transaction Domain Codes
• ISO Bank Transaction Domain Family Codes
• ISO Bank Transaction Domain Sub Family Codes

Currency Exchange

The source currency for the bank transactions is always the account owner's currency. A/P transactions
are converted to domestic currency using the specified exchange rate. Fluctuations in the exchange
rate are reflected in the currency gains and losses. For more information, see About Realized and
Unrealized Gains and Losses on page 175.

For example, a vendor bank account is established using the Philippine Peso (PHP). The bank statement
reports all transactions using PHP. To apply an A/P voucher, the target currency for the voucher must
also be PHP.

If a fixed exchange rate is applied (by agreement between all parties), no variance occurs due to
currency fluctuations.  If a variable exchange rate is used, all vouchers will have fluctuations based on
currency rate fluctuations. Thus, to have the vendor's currency in balance with your domestic currency,
there must be a redistribution if the exchange rate has changed since the voucher was created. This
causes offsetting transactions for currency gains and losses, because the change in exchange rate
changes the value of the PHP account in domestic currency. The voucher value would also be adjusted
up or  down in relation to domestic currency.

To protect against currency fluctuations, you can set up an account in the vendor's currency, and pay
the vendor from that account. That way, the currency is never actually exchanged into your company's
domestic currency, even though it is represented in SyteLine in the domestic currency amounts.
Offsetting gains and losses cancel each other out.

If your payment account is in a different currency from the vendor's currency, then the exchange rate
is determined at the time of payment, and you do not have offsetting currency adjustments. (If the
payment is not in the vendor's currency or your domestic currency, no provision is made in the system
for an exchange rate that requires manual translation.)
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For A/R accounts in SyteLine, the currency used in the account must be either the domestic currency
or the customer's currency. For A/P accounts, we recommend that you use either the vendor's currency
or the domestic currency.

Purging Bank Statements
Use the Bank Statement Purge Utility to purge bank statement records that are marked as Processed.
You can set up this utility to process individual statements or batches of records on a regular schedule.

To purge individual statements:

1 On the Bank Statement Purge Utility form, select the range of dates for which you want to delete
records.

2 If your selection criteria include dates and you are scheduling the process to run periodically, select
Increment Date.

3 Specify the range of reference types (Bank, Customer, Vendor, or Employee) for which you
want to delete records.

4 Specify the range of reference numbers. For example, if you specified Customer as the Reference
Type, specify the range of processed customer bank statement records to purge.

5 Click Process.

Alternaltively, to purge a batch of processed bank statements on a regular basis, specify your selections
in the Bank Statement Purge Utility form and select Actions > Background Queue.

Generating a Positive Pay File
A positive pay file is a file you send to your bank that provides a list of the checks issued, their dollar
amounts, and your bank account number in a text file.

To set this up:

1 Create the format:

a Open the Positive Pay Format Sections form.
b Select the desired bank code.
c Provide the format.

You must get this format from the bank.

d Select section 1, 2, or 3.
e Provide a description of the section if desired.
f Save.

2 Define the fields for the file:

a Open the Positive Pay Format Fields form.
b Select the bank code, format name, and section.
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The format name and section choices for each bank code were created on the Positive Pay
Format Sections form.

c Provide a sequence number.
d In the Type field, specify Constant, Database, or Function.

Other fields on this form are either active or inactive depending on the choice you choose here.

e Provide the length.
f Save.

3 Generate the file.

a Open the Positive Pay File Generator form.
b Select the bank code and the format name.
c Select a check date range.
d Specify the logical folder and file name where the data is stored after it has been processed.

This logical folder must already exist, and you must belong to the same authorization group
as the logical folder. You can use the Files button to delete old files or download them to save
in another area.

e Click Process.
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Chapter 5: Currency

About the Euro Triangulation Conversion
During a euro conversion interim period (when one or both of the currencies involved is a part-of-euro
currency and neither currency is the euro), euro regulations prohibit direct currency conversions between
participating countries.

Therefore, to convert a monetary amount from one national currency to another, the system currency
conversion process performs these tasks:

• Converts the amount from the national currency to the euro.
• Converts the resulting amount, which is expressed in euros, to the other national currency.

For example, to convert Deutsche marks to francs:

The same principle applies if your domestic currency is not part-of-euro, but you need to do business
with a vendor or customer situated in a participating country who will be using the euro, but has not
yet switched to it. The system conversion process

1 Converts the amount from your domestic currency to the euro.
2 Converts the resulting amounts, which are expressed in the euro currency, to the national currency

of the vendor or customer.

For example, to convert US dollars to francs:
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The exchange rate between each participating national currency and the euro is fixed. If the currency
is part-of-euro, this fixed exchange rate to the euro is stored in the system  (on the Currency Codes
form). There is only one exchange rate to the euro (1 euro =) for each part-of-euro currency there is
no buy and sell rate.

Note: 
• This conversion process applies only if one or both of the currencies involved is a part-of-euro

currency and neither currency is the euro. If one of the currencies is the euro, the system performs
the conversion normally. Also, if one of the currencies involved in a transaction is part-of-euro, and
the other currency uses the Rate is Divisor option, the triangulation is calculated differently.

• The system does not round any numbers during this conversion process. After the conversion is
complete, the system rounds the final value to match the display format of the end currency.
Conversion rates are always expressed as 1 euro to the other currency.

• The use of francs and Deutsche marks above is only for illustration purposes; in reality, both
currencies have already been converted to the euro.

Converting the Domestic Currency to the euro
To change your base domestic currency to the euro currency and convert all related records, use these
steps. Where applicable, refer to the linked help topics for more information.

1 Perform a complete database backup.

2 Set up a currency code for the euro.

3 On the Currency Codes form, select the Part of Euro check box for your base currency.

4 On the Currency Rates form, enter the correct Buying Exchange Rate and Selling Exchange
Rate for all currencies, including the euro.

5 Post all A/P and A/R transactions.

6 Process and post all records of the types listed in the Unconverted Records Help topic.

7 Open the Domestic Euro Currency Conversion utility.

8 To use the standard unit cost for the purchased item, select the Use Std Cost for Purchased
Item check box. To use the current unit cost from the Item Costs form to update the material cost
for purchased items, clear this check box.
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9 In the Account field, enter the number of the account to contain any rounding variances that may
occur during the conversion process.

10 To start the conversion, click Process.

Note:  If your system still contains unposted A/P or A/R transactions (such as payments, invoices,
vouchers, etc.), the conversion process does not proceed and the system generates an error
message stating the type of transactions that must be posted.

11 After the conversion is complete, to convert the period totals records, run the Rebalance Ledger
Period Totals utility.

12 Run the Recalculate Journal Balances utility for each journal.

13 To update the low level codes, run the Current Bill of Material Processor.
14 To correct any possible rounding errors from the conversion of cost values, run the Current BOM

Cost Rollup utility.

15 If you have a multi-site or hierarchical set of sites and entities, perform these additional steps:

• After running the conversion utility, review and manually reestablish the exchange rates for
your inter-site transactions (defined on the Inter-Site Parameters form). The conversion utility
does not convert these rates automatically.

• When you convert an individual site, you must also convert all sibling sites (the sites of the
same low-level entity) and the parent low-level entity at the same time.

• When you convert a low-level entity, the conversion utility does not convert any of its child
entities. To convert child entities, run the conversion utility for each entity.

Note:  If you are converting a low-level entity that has no direct child sites, you can convert the
entity without converting any other entities.

About Realized and Unrealized Gains and Losses
When a company headquartered in one (domestic) country executes a transaction with a company in
another (foreign) country using a currency other than the domestic currency, one currency needs to
be converted into another to settle the transaction. This conversion from one currency to another creates
gains and losses depending on the currency exchange rate.

This topic covers realized and unrealized currency exchange gains and losses.

Realized Currency Exchange Gains and Losses

Realized currency exchange gains and losses can occur when full or partial payments are applied to
voucher or invoice amounts.

Note:  Gains and losses are calculated on each payment amount instead of the outstanding voucher
or invoice amount.
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Balance Paid in Full

In the following examples, the transactions were completed by the receipt of the payment of cash.
Therefore, any exchange gain or loss was realized and, in an accounting sense, was recognized on
the date of the cash receipt or cash payment.

For example, a U.S. company purchasing items from a British company that requires payment in British
pounds must exchange dollars ($) for pounds (£) to settle the transaction. This exchange of one currency
into another involves the use of an exchange rate. If the U.S. company had purchased items for £1,000
from a British company on June 1, when the exchange rate was $1.40 per British pound, $1,400 would
need to be exchanged for £1,000 to make the purchase.

Note:  The foreign exchange rates used in this example do not reflect current rates.

Because the U.S. company maintains its accounts in dollars, the transaction would be recorded as
follows:

AmountDescription

1,400June 1 Purchases

1,400Cash

Payment of Invoice #1725 from Sterling Co.

£1,000; exchange rate: $1.40 per British pound

For example, assume that on July 10, when the exchange rate was $.004 per yen (¥), a purchase for
¥100,000 was made from a Japanese company. Since the U.S. company maintains its accounts in
dollars, the entry would be recorded at $400 (¥100,000 X $.004), as seen below:

AmountDescription

400July 10 Purchases

400Accounts Payable - M. Suzuki

Invoice #823

¥100,000, exchange rate: $.004 per yen

If on the date of payment, August 9, the exchange rate had increased to $.005 per yen, the ¥100,000
account payable must be settled by exchanging $500 (¥100,000 X $.005) for ¥100,000. In this case,
the U.S. company incurs an exchange rate loss of $100, because $500 was needed to settle a $400
debt (accounts payable). The cash payment would be recorded as follows:

AmountDescription

400August 9 Accounts Payable - M. Suzuki

100Exchange Loss

500Cash

Cash paid on Invoice #823
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¥100,000, or $400, current exchange rate: $.005 per yen

All transactions with foreign companies can be analyzed as in the examples above. For example,
assume that on May 1, when the exchange rate was $.25 per euro, a sale on account for $1,000 from
a U.S. company to a French company was billed in euros (€4,000). The transaction would be recorded
as follows:

AmountDescription

1,000May 1 Accounts Receivable - Crusoe Co

1,000Sales

Invoice #7782

€4,000, exchange rate: $.25 per euro

If the exchange rate had increased to $.30 per euro on May 31, the date of receipt of cash, the U.S.
company would realize an exchange gain of $200. The gain was realized because the ‚€4,000, which
had a value of $1,000 on the date of sale, had increased in value to $1200 (€4,000 * $.30) on May 31
when payment was received. The receipt of the cash would be recorded as follows:

AmountDescription

1,200May 31 Cash

1,000Accounts Receivable - Crusoe Co.

200Exchange Gain

Cash received on Invoice #7782

€4,000 or $1,000, exchange rate: $.30 per euro

Partial Payments

When the balance is not paid in full, however, the system calculates currency gains and losses on each
payment amount instead of the outstanding voucher or invoice amount. Currency translation gains or
losses are only recorded when payments are applied to posted invoices. The system uses the following
formula when performing the gain/loss calculation:

Gain/Loss Amount = (Payment / Applied Invoice Exchange Rate) - (Payment / Payment Exchange
Rate)

where:

Average Invoice Exchange Rate = Foreign Amount Outstanding Balance / Domestic Outstanding
Balance

For example, a German company purchasing items from an U.S. company pays in euros. The U.S.
company must then exchange euros for U.S. dollars to settle the transaction. In this case, the German
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company is making partial payments rather than paying the balance in full. The transaction would occur
as follows:

NotesDomestic
Amount (U.S
Dollar)

Exchange
Rate

Foreign
Amount (eu-
ro)

 

 550.002.0001100.00Invoice #101

50.004.000200.00Credit Memo 201

= (200.00/2.00) -
(200.00/4.00) = 50.00
LOSS

50.00 Currency Gain/Loss

 200.003.000600.00Payment 301

= (600.00/2.00) -
(600.00/3.00) = 100.00
LOSS

100.00  Currency Gain/Loss

100.00 3.000300.00Payment 302

= (300.00/2.00) -
(300.00/3.00) = 50.00
LOSS 

50.00Currency Gain/Loss

Unrealized Currency Exchange Gains and Losses

However, if financial statements are prepared between the date of the original transaction (sale or
purchase on account, for example) and the date of the cash receipt or cash payment, and the exchange
rate has changed since the original transaction, an unrealized gain or loss must be recognized in the
statements.

For example, assume that a sale on account for $1,000 had been made to a German company on
December 20, when the exchange rate was $.50 per euro (€), and that the transaction had been
recorded as follows:

AmountDescription

1,000Dec. 20 Accounts Receivable - Mueller Co.

1,000Sales

Invoice #22

€2,000; exchange rate: $.50 per euro

If the exchange rate had decreased to $.45 per euro on December 31, the date of the balance sheet,
the $1,000 account receivable would have a value of only $900 (€2,000 X $.45). This "unrealized" loss
would be recorded as follows:
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AmountDescription

100Dec. 31 Exchange Loss

100Accounts Receivable - Mueller Co.

Invoice #22

€2,000 X $.05 decrease in exchange rate

Assuming that €2,000 are received on January 19 in the following year, when the exchange rate is
$.42, the additional decline in the exchange rate from $.45 to $.42 per euro must be recognized. The
cash receipt would be recorded as follows:

AmountDescription

840Jan. 19 Cash

60Exchange Loss ($.03X‚€2,000)

900Accounts Receivable - Mueller Co.

Cash received on Invoice #22

€2,000, or $840, exchange rate: $.42 per euro

If the exchange rate had increased between December 31 and January 19, an exchange gain would
be recorded on January 19. For example, if the exchange rate had increased from $.45 to $.47 per
euro during this period, an exchange gain would be credited for $40 ($.02 X €2,000).

Consolidated Financial Statements with Foreign Subsidiaries

Before the financial statements of domestic and foreign companies are consolidated, the amounts
shown on the statements for the foreign companies must be converted to domestic currency. Asset
and liability amounts are normally converted to domestic currency by using the exchange rates as of
the balance sheet date. Revenues and expenses are normally converted by using the exchange rates
that were in effect when those transactions were executed. (For practical purposes, a weighted average
rate for the period is generally used.) The adjustments (gains or losses) resulting from the conversion
are reported as a separate item in the stockholders' equity section of the balance sheets of the foreign
companies.

After the foreign company statements have been converted to domestic currency, the financial
statements of domestic and foreign subsidiaries are consolidated in the normal manner. For more
information, see Consolidation Overview on page 18.

Revaluing Assets and Liabilities for the Euro
If you work with customers and/or vendors that use a Part of Euro currency, but you have not converted
your domestic currency to the euro, you must revalue your outstanding assets and liabilities. Perform
this procedure on or after 1/1/1999.
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Caution:  If your company is situated in a euro-participating country, euro regulations require you to
revalue asset and liability transactions using this exchange rate. If you are not situated in a
euro-participating country, this revaluation is optional.

To revalue assets and liabilities:

1 Run the Currency Revaluation Report for all Part of Euro currency codes.

2 Select the Realize Gain/Loss check box.

3 Run the Bank Account Revaluation utility for all bank codes that use a Part of Euro currency
code.

4 Open the Euro Exchange Rate Revaluation utility.

5 In the Starting and Ending Currency Code fields, select the range of all Part of Euro currency
codes in your system.

For each outstanding asset and liability transaction that contains a currency code in this range,
the system updates the exchange rate to the appropriate national currency-to-euro exchange rate
(which is fixed as of 1/1/1999). This exchange rate is used in all triangulation conversions between
Part of Euro currencies during the euro interim period.

See About the Euro Triangulation Conversion. on page 173

6 To review a list of the conversions, select Preview then click Process.

7 To start the conversion, select Commit and then click Process.

Running the Currency Revaluation Report
Use the Currency Revaluation Utility to generate realized and unrealized currency gains and losses
that occur because of currency rate changes.

You can run this utility with or without posting to the respective A/P, PO, or A/R distribution journals.
When generating realized gains and losses, the utility includes gain/loss amounts previously posted
to the A/P and A/R journals.

Posting realized gains and losses rewrites historical rates in the open transactions. Posting unrealized
gains and losses creates the journal entries as reversing entries.

To run the utility:

1 Select the accounts to process:

• Receivables
• Payables
• Vouchers Payable

2 Specify this information:

Starting/Ending Currency
Select the range of currency codes to include in the process.

Transaction Date
The current date is displayed. Optionally, select a different date as the transaction date.
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Increment Date
Select the check box to automatically re-run the report.

Realize Gain/Loss
Select this check box to use the Realized accounts that are tied to each currency and to update
the historical rates stored on each record.Clear this check box to use the Realized accounts that
are tied to each currency, but leave unchanged the historical rates stored on each record.

3 Select Preview and click Process to view the results without saving.

4 Select Commit and click Process to run the utility and save the results.

5 The Inventory Adjustment Offset field is enabled only if Use Analytical Ledger is selected on
the General Parameters form. Select the number of the Inventory Adjustment Offset account for
which entries will be made to the General Journal. This account must be a non-analytical account.

6 The results grid shows this information:

Customer
The customer number is displayed.

Customer Name
The name of the customer is displayed.

Invoice
The invoice number is displayed.

Vendor
The vendor number is displayed.

Vendor Name
The name of the vendor is displayed.

Currency
The currency code is displayed.

PO
The purchase order number is displayed.

Invoice/Voucher
The invoice/voucher number is displayed.

Detail Description
A description of the journal entry is displayed.

Exchange Rate
The exchange rate currently on the journal entry is displayed.

Foreign Total Amount
The total transaction amount is displayed in the foreign currency.

Old Amount
The domestic currency amount converted from the Foreign Total Amount is displayed using the
old exchange rate.
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New Amount
The domestic currency amount converted from the Foreign Total Amount is displayed using the
revalued exchange rate.

Cost of Revaluation
The gain or loss amount associated with the transaction is displayed.

Gain or Loss Amount
The currency gain/loss amount generated for the invoice or voucher is displayed.

Account number
The account number is displayed.

Account Unit 1-4 Reporting Units
The unit codes used for detailed reporting and analysis are displayed.

Domestic Total Amount Debit 1-2
If the journal entry is a debit, the amounts debited are displayed.

Domestic Total Amount Credit 1-2
If the journal entry is a credit, the amounts credited are displayed.

Net Loss
The amount lost due to the change in exchange rate is displayed.

Net Gain
The amount gained due to the change in exchange rate is displayed.

Variance Account number
The account number used when posting the gain or loss is displayed.

Variance Account 1-4
The unit codes associated with the variance account number for the posted gain or loss are
displayed.

Description
A description of the account number is displayed.
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Chapter 6: External Financial Interface

Setting Up an External Financial Interface
SyteLine provides an XML-based interface that can be used with an external financial system such as
Infor SunSystems or SAP.  Also, SyteLine provides a direct data access interface for Infor Global
Financials (IGF). You can choose which types of financial information to export or import between
SyteLine and the other system.

Note: 
• If you are setting up the Infor SyteLine Enterprise Financials (SunSystems interface) package, see

the  Infor SyteLine Enterprise Financials Installation and Implementation Guide instead of using
these steps.

• If you are setting up integration with IGF, see the  Infor SyteLine Integration Guide for Infor Global
Financials instead of using these steps.

• If you are using any other financial package, follow the steps below.

Use this topic in conjunction with Setting Up an Incoming Financial Interface on page 188.

To set up the interface from to SyteLine to an External Financial System:

1 Since the external financial interface uses non-transactional replication as its method of transferring
data, be sure you understand how replication works.

For more information, see the Replication Reference Guide, available from our support site.

2 Make sure you understand the distinction between data flow (transaction records being passed
from SyteLine to the external system) and data maintenance (the updating of "code" records such
as customer codes, terms codes, or exchange rates that might be passed from SyteLine to the
external system, or vice versa). Decide which system will be the "master" for accounts payable
and accounts receivable tasks.

3 Become familiar with both the SyteLine database structure and that of the external financial
application. Map the financial data that needs to flow between the systems, noting the system in
which the data should be maintained.

The SyteLine DataMap's Schema-Properties spreadsheet, which lists SyteLine database tables
and columns, could provide a good starting point for a mapping plan.

4 Become familiar with the syntax of the XML request documents used to pass data to and from
SyteLine.

For more information, see the document Integrating IDOs with External Applications (especially
the chapter on XML IDO request and response documents), which is available from our support
site.
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5 In the System Types form, create a new system type for the external financial application.

This system type is used when defining the target site for the external financial application in the
Sites/Entities form.

Make sure that an additional system type is defined for your SyteLine application.

The source and target system types are used in the names of XSL stylesheets that can be used
to transform the XML data.

6 In the Intranets form, define a separate intranet to be used only for data requests to and from the
external financial application. Name this intranet something unique, such as EXTFIN, and select
the External check box.

For this intranet, specify the URL to which the financial XML request/response documents will be
posted. This URL should be entered in the URL field on the Intranets form. This URL could be an
ASP page on the external financial system that receives and processes the XML from the SyteLine
message queue. The processing done at this URL is up to you. For example, an ASP page might
map the data into the proper format for the external system, or it might write the XML documents
to a location on its server for later processing.

7 On the Sites/Entities form, define a source site from which system data will be exported:

• On the System Info tab, select the SyteLine application's system type (defined earlier) and
time zone.

• Set the Intranet Name to the default intranet.
• In the Database Name field, specify the application database name.

8 On the Sites/Entities form, define a target site for the external financial interface.

Note:  This site must not be used for any other purpose. To avoid confusion, we suggest you name
the site EXTFIN.

• On the System Info tab:

• Select the external financial application's system type (defined earlier) and the time zone.
• Set the site's Intranet Name to the intranet created in the previous step.
• Set the Database Name field to the external financial application's database.

9 On the Site User Map tab:

• In the From Site field, specify the SyteLine site that will send data to EXTFIN.
• In the User Name field, specify a local user on that site.

For more information about setup requirements for this user, see the online help for this tab and
field.

10 Decide whether you want to export invoices, debit memos, and credit memos, and/or vouchers
and adjustments, to the external financial system. Use the fields on the External Financial Interface
Parameters form in SyteLine to specify this information:

• If you select Use External Financial Interface, SyteLine exports all posted General Ledger
(G/L) transactions to the external system. This assumes that all customer and vendor records
will be created and updated in SyteLine and that the records will be exported to the external
system. Choosing this option also enables the External Financial Interface Data Request
Utility.

• If you want to use an external financial system for A/P, also select Use External A/P System.
This tells SyteLine to export all posted A/P voucher and adjustment transactions to the external
system.
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• If you want to use an external financial system for A/R, also select Use External A/R System.
This tells SyteLine to export all posted A/R invoice, credit, and debit memo transactions to the
external system. Selecting this option also enables the Customer Posted Balance tab on the
External Financial Interface Data Request Utility.

• For both the A/P and A/R options, you can determine the maximum batch size to include in a
single XML document. Keep in mind that larger XML documents take longer to process.

• For the Site field, specify the site you defined in step 8.

11 Decide whether you want to modify the standard SyteLine processing for Due Date Calculation,
Tax Calculation, or Currency Conversion. On the External Financial Interface Parameters form,
you can choose to use external processing for any or all of these. If you select external processing,
you will need to modify one or more of these "stub" stored procedures to do what you want:

• ExtFinCurrCnvtCalcSp (Currency Conversion)
• ExtFinDueDateCalcSp (Due Date Calculation)
• ExtFinTaxCalcSp (Tax Calculation)

12 Decide how you want to handle customer credit checking.

When SyteLine performs a credit check for a customer, it needs the customer's current posted
balance. If SyteLine is used for A/R functions, it has all the information it needs to calculate and
store posted balance amounts. However, if the external financial system is used for A/R functions,
then SyteLine must get the posted balance from the external system. There are two ways to do
this:

• To request the posted balance at the time of the credit check (that is, synchronously), set up
the system to call a stub stored procedure that obtains the customer's posted balance from
the external system.

To set this up, select the Use External Customer Posted Balance for Credit Check field on
the External Financial Interface Parameters form. Then update the stub stored procedure
named ExtFinGetExternalPostedBalSp so that it returns the posted balance from the external
system.

• To use a posted balance that was retrieved previously (that is, asynchronously), set up the
request information on the Customer Posted Balance tab of the External Financial Interface
Data Request Utility.

Whenever that utility is run, SyteLine updates its posted balance information for all customers
in the range. A credit check then uses the latest stored data.

13 Look at the default external financial (EXTFIN) categories in the Replication Categories form,
and decide if you need to add any new categories.

For instance, is there data in other SyteLine tables that your external financial system will need?
We recommend that you leave the default categories as is, and create new ones as needed. The
default EXTFIN categories are listed here:

Note:  A table name can be represented by the name of a view over the table. This section uses view
names in place of table names, where appropriate.
• EXTFIN: Used for exporting SyteLine A/R, A/P, and G/L transactions to the external financial

system, and also for exporting requests for updates to SyteLine tables  by the external financial
system. This category includes the functions and XML documents required to export financial
information:
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• ExtFinAPVoucherPosting: Exports data from the SyteLine export_aptrx and export_aptrxd
tables, which are holding tables for data collected from various A/P tables.

• ExtFinARInvoicePosting: Exports data from the SyteLine export_arinv and export_arinvd tables,
which are holding tables for data collected from various A/R tables.

• ExtFinAnaLedgerPosting: Exports data from the SyteLine ana_ledger table.
• ExtFinLedgerPosting: Exports data from the SyteLine ledger table.
• ExtFinRequest: Exports a request to the external financial application for updates to a specific

SyteLine table. For more information, see the help for the External Financial Interface Data
Request Utility.

• EXTFIN Customer: Used for exporting SyteLine customer information. This category includes the
sibling database tables custaddr and customer.

• EXTFIN Vendor:- Used for exporting SyteLine vendor information. This category includes the sibling
database tables vendaddr and vendor.

Processing note for customer and vendor records: When a new customer or vendor record is added
in SyteLine, the information is sent to the external financial system as a single XML document combining
the information from the sibling tables, customer/custaddr or vendor/vendaddr, respectively. The
information for custaddr or vendaddr in the single XML just contains the specified key values and default
values for the table's columns. The user-specified values will be included as part of an update that
follows the insert. However, for updates to existing customer or vendor records, the XML document
pulls records only from the table that changed.

• Create one replication rule for each EXTFIN category, using the Replication Rules form.

This must be done for each SyteLine site where you will be exporting data to the EXTFIN site. If
you created additional categories for your external financial system in the previous step, set up
rules for the new categories, too.

A sample rule would include information such as the following:

Source Site: OH (the site from which data will be extracted)

Target Site: EXTFIN

Category: EXTFIN Vendor

Description: Pass vendor info to EXTFIN

Interval Type: Immediate (anything but Transactional will work here)

Interval: (Blank if Interval Type is Immediate; some interval value otherwise)

Start Interval at: (Blank if Interval Type is Immediate; a time value otherwise)

Disable Replication: (Cleared - EXTFIN uses replication)

Update All Columns: (Cleared)

• On the Replication Management form, click the Regenerate Replication Triggers button to
rebuild the database table triggers based on the rules you created in the previous step.

• Stop and start the replication services on the SyteLine utility server.
• Set up the URL (which was specified in Step 6) on your external financial system to retrieve and

process the XML documents mentioned in Step 12.

Again, in these examples, we use view names in place of actual table names.

• The EXTFIN XML "update collection" documents are used to specify information from SyteLine
that should be updated in the external financial system. They start with a set of tags similar to
the following:
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<IDORequest>

 <RequestHeader Type="UpdateCollection">

  <RequestData>

   <UpdateCollection Name="EXTFIN.xml_doc_name.table">

For example: <UpdateCollection Name="EXTFIN.ExtFinLedgerPosting.ledger">

The external financial system is expected to respond to "update collection" requests by updating
the data in the external financial application.

• The EXTFIN XML "load collection" documents are used to request information from the external
financial system that needs to be updated in SyteLine. They start with a set of tags similar to
the following: <IDORequest>

 <RequestHeader Type="LoadCollection">

  <RequestData>

   <LoadCollection Name="EXTFIN.xml_doc_name.table">

For example: <LoadCollection Name="EXTFIN.ExtFinRequestChart.chart">

The exception is the Customer Posted Balance request, which uses an "invoke method" request:

<Invoke="EXTFIN.ExtFinRequestCustomerPostedBalance">

The external financial application is expected to respond to "load collection" and "invoke method"
requests by returning to SyteLine an "update collection" response that includes the requested
data.

For more information, see Example: Requesting Data from an External Financial Application
on page 189.

• The EXTFIN Customer and EXTFIN Vendor XML documents contain a tag similar to the
following:

<UpdateCollectionName="Table!replication_category_to_object_name">

For example: <UpdateCollectionName="Table!Customer">

The external financial system is expected to respond to these "update collection" requests by
updating the data in the external financial application.

Your external financial system should use the information in these tags to determine how to process
and map the data in each XML document. The import process on the external system must also
handle the batch_seq information in the XML document.

For information about the syntax and tags used in the XML documents, see the document Integrating
IDOs with External Applications, especially the chapter on XML IDO request and response
documents.

Samples of the outbound XML documents that may be generated from SyteLine are available in
ZIP files from our support site.

• Set up the interface from the External System to SyteLine.

See Setting Up an Incoming Financial Interface on page 188.
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Setting Up an Incoming Financial Interface
Use this topic to set up an incoming financial interface.

Use this topic in conjunction with Setting Up an External Financial Interface on page 183.

To set up an interface that updates the SyteLine database with financial data from an external financial
system, create XML documents that access the SyteLine IDO collections. The process and syntax of
using XML documents for data transfer to SyteLine is described in the document Integrating IDOs with
External Applications, available from our support site.

Then set up your external system to post the XML documents to the SyteLine mailbox, using the HTTP
POST protocol.

The SyteLine External Financial Interface Data Request Utility can be set up to request updates to
specific SyteLine database tables from the external financial application. Depending on your external
financial application's requirements, you may be able to use this utility as a starting point for setting up
your application.

For more information, see Updating SyteLine Data from Data in an External Financial Application on
page 188.

Note:  For Infor Global Financials (IGF) integration, only Chart of Accounts, Currency Codes, and
Currency Rates can be selected on the Table tab. All fields are available for use on the Customer
Posted Balance tab. The IGF integration uses direct data access with this utility to retrieve data for
SyteLine.

Updating Data from Data in an External Financial
Application
Note: 
• This utility is not used when running the SyteLine Enterprise Financials package that works with

Infor SunSystems.
• For Infor Global Financials (IGF) integration, only Chart of Accounts, Currency Codes, and Currency

Rates can be selected on the Table tab. All fields are available for use on the Customer Posted
Balance tab. The IGF integration uses direct data access with this utility to retrieve data for SyteLine.

The External Financial Interface Data Request Utility can be set up to request updates to specific
SyteLine database tables from the external financial application. This utility works as follows:

1 When the utility's Process button is clicked, the system submits background tasks to TaskMan.
The number of tasks submitted is dependent upon the number of check boxes selected.

2 When the task is processed, it constructs an XML LoadCollection request (or XML Invoke method
request for the Customer Posted Balance check box).

3 The XML request is submitted to the replication tables to be picked up by the Infor Framework
Replicator service and placed within the appropriate queue (in this case, the Outbound Queue),
based upon the Replication Rules.

4 The Replication Listener then posts it to the designated URL for the external financial application.
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5 The external financial system translates the XML into a request that its financial application can
understand. The application responds to the request by returning a set of updated data.

Note: This step and the following step are not part of the SyteLine system and must be set up
according to the needs of the external financial system.

6 The external financial system translates the set of data into an XML "load collection" request and
places the request in the system mailbox.

7 SyteLine picks up the XML request and processes it, validating the request and updating the proper
table.

For more information, see Example: Requesting Data from an External Financial Application on page
189.

Example: Requesting Data from an External Financial
Application
Use this example when requesting data from an external financial application.

In the ERP

In the External Financial Interface Data Request Utility, if the Unit Code 1 field is selected, the
ExtFinRequestUnitCd1 task is submitted. This task builds an XML request document similar to this:

<IDORequest>

 <RequestHeader Type="LoadCollection">

  <RequestData>

   <LoadCollection Name= EXTFIN.ExtFinRequestUnitCd1.unitcd1>

style="clear: none;" />

    <Items>

     <Item ID="unitcd1">

     <Property>unit1</Property>

style="clear: none;" />

     <Property>description</Property>

style="clear: none;" />

     <Property>CreatedBy</Property>

style="clear: none;" />

     <Property>UpdatedBy</Property>

style="clear: none;" />
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     </Item>

    </Items>

   </LoadCollection>

  </RequestData>

 </RequestHeader>

</IDORequest>

The XML document is passed to the external financial system as described in Updating SyteLine Data
from Data in an External Financial Application on page 188.

In the External Financial System

An ASP page on that system should be set up to:

• Retrieve the XML request document that was sent by SyteLine.
• Know that the "LoadCollection" XML request it received wants to get data from the external financial

application and return it to SyteLine.
• Extract information about the table and columns requested from the XML (table (view) unitcd1;

table columns unit1, description, CreatedBy, and UpdatedBy).
• Map that data to the corresponding data in the external financial application:

ExtFin Table.ColumnTable.Column

ucode1.codeunitcd1.unit1

ucode1.descriptionunitcd1.description

(See the note at the end of this section about how to handle the columns CreatedBy and UpdatedBy.)
• Extract values from the external financial application's database for the requested columns in table

ucode1. This table currently contains two rows:

DescriptionCode

Dept 1000 - Packaging1000

Dept 2000 - Inspection2000

  

• Use the mapping information to build an "updatecollection" XML request (see below) to be sent
back to SyteLine.

• Place the XML request in SyteLine's mailbox.

The "UpdateCollection" XML request would be similar to this:

<IDORequest>

 <RequestHeader UserName="ExtFin User" Password=Password_Value PasswordEn
crypted="N" Type="UpdateCollection" New="1" SkipTriggers="0">

 <SourceName>EXTFIN</SourceName>
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 <TargetName>SyteLineSite</TargetName>

style="clear: none;" />

 <RequestData ObjectType="1">

 <UpdateCollection Name="TABLE!unitcd1">

  <Items>

   <Item ItemNo="0" Action="Insert">

style="clear: none;" />

    <Property Name="unit1" Modified="Y" xml:space="preserve">1000</Property>

    <Property Name="description" Modified="Y" xml:space="preserve">Dept 1000
- Packaging</Property>

style="clear: none;" />

    <Property Name="CreatedBy" Modified="Y" xml:space="preserve">ExtFin Us
er</Property>

    <Property Name="UpdatedBy" Modified="Y" xml:space="preserve">ExtFin Us
er</Property>

   </Item>

   <Item ItemNo="1" Action="Insert">

style="clear: none;" />

    <Property Name="unit1" Modified="Y" xml:space="preserve">2000</Property>

    <Property Name="description" Modified="Y" xml:space="preserve">Dept 2000
- Inspection</Property>

style="clear: none;" />

    <Property Name="CreatedBy" Modified="Y" xml:space="preserve">ExtFin Us
er</Property>

    <Property Name="UpdatedBy" Modified="Y" xml:space="preserve">ExtFin Us
er</Property>

   </Item>

  </Items>

 </UpdateCollection>

 </RequestData>

 </RequestHeader>

</IDORequest>

Note:  The values for the properties CreatedBy and UpdatedBy should be set to the value of
RequestHeader UserName. In the example above, the value is ExtFin User.
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Chapter 7: Financial Statements

Financial Statement Setup
You can define your own financial statements that best suit your reporting needs. To specify the content
and format of a statement, use the Financial Statement Definition form, along with the Financial
Statement Definition Columns form and the Financial Statement Line Definition form.

Note: You can now use Microsoft Excel to retrieve and format SyteLine GL data. You can create a
fully interactive and data-bound workbook to produce various reports such as Balance Sheet, Profit/Loss
Statement, chart, and dashboard or pivot table without requiring any development knowledge or knowing
the complexity of data access. For information on how to install and use this addition to Microsoft Excel,
see the  Infor SyteLine Microsoft Office Integration Guide.

Financial statements consists of two major sections:

• Report Columns
• Report Totals

To design the statements, you use four major functions:

• Copying sections of reports
• Resequencing lines
• Automatically generating accounts
• Automatically setting ratio and subtotal levels

You must enter information for the report, such as:

• Headers and titles
• The columns in which to calculate and/or print amounts
• The account numbers for which amounts will be printed
• Descriptive text

You also must decide:

• Whether to print ratios, and if so, where
• When to print totals

It is best to lay out the reports on paper before attempting to define them. Remember to leave enough
room to print all the desired amount and ratio columns, because the system does not perform this task
automatically.

To create the financial statement:
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1 Find one of the demo reports (.RDL) provided with SyteLine that is most like your current financial
statement.

2 Make a copy of the .RDL with a new name.

3 In Visual Studio 2008, modify the new report as needed.

Note: The financial statement templates included with SyteLine include several suppressed fields
and objects. Ensure that the data you wish to display is unsuppressed. For more information about
suppression, see the Visual Studio 2008 online Help.

4 In SyteLine, add a Background Task Definition to point to this new .RDL.

5 Open theFinancial Statement Definition form.

6 Specify information in these required fields:

• Report ID: Enter a unique name for your report. This value can be up to 10 characters.
• Analytical: Select this field if this report should be pulled from a separate analytical ledger.
• Task Name: Fill in the task name of the background task you defined in Step 4, above.

7 Click the Columns button.

8 Complete the header definition on the Financial Statement Definition Columns form.

9 After you have defined the header and columns, save and return to the Financial Statement
Definition form.

10 To open the Financial Statement Line Definition form, click Lines.

11 Define the statement lines.

12 After you have defined a statement, you can print it by specifying the Report ID in the Financial
Statement Output form.

About Dates in Financial Statements
This table describes how the period start date and period end date that are used when printing the
Financial Statement are determined.

ThenIf

That date is used.The report column definition has a date,

The dates from the Financial Statement Output
form are used.

The Year Start in the column definition is
blank,

The dates for the period from the Account Period
for the Fiscal Year corresponding to the column's
Year Start are used.

The period on the column definition is greater
than zero,

The dates for the period from the Account Period
for the Fiscal Year corresponding the column's Year
Start are used.

The period on the Financial Statement Out-
put form is greater than zero,

That date is used.The Financial Statement Output form has a
date,
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Printing a Financial Statement
Note:  Before you can print a financial statement, you must have first set up it up and defined its columns
and lines. For more information, see the Financial Statement Setup on page 192 Help topic.

1 Open the Financial Statement Output form.

2 Perform one of the following actions:

• To produce a single report, in the Report ID field, select the ID of the report you want to print.
• To produce a group of reports, select Actions > Get Group, select the group number of the

reports, and click OK.

The system updates the Financial Statement Output form with all the reports in that group, and
you can define each one's output parameters.

3 Select the check box for each type of detail you want to include in the financial statement.

4 In the Report Type drop-down list, select the type of report you want to run.

5 In the Currency drop-down list, select the currency to use. By default, the system produces the
report in your domestic currency, but you can change it to a different currency.

6 In the Current Date field, select the effective date for the report. By default, the system uses the
current system date, but you can change it to a different date.

7 In the Site Group field, select the site you want to produce the report for, or, to produce the report
for all sites, select All.

8 From the Line Summary Level drop-down list, select the desired level of output detail for the
report:

• Direct Reports: Displays one line for each account and for each site. If the direct report is
an entity, it reports to the current entity and then summarizes all sites for that entity into a single
line.

• Site: Displays one line for each account and for each site.
• Summary: Displays and summarizes all sites into a single line for each account. Your selection

in the Site Group field determines which sites to include. If this is an entity, the report displays
all sites that report to the entity.

9 You can overwrite the following report definition settings for the purpose of this print run:

• Year Start
• Period
• Period Start and Period End
• From Unit Code 1-4 and To Unit Code 1-4
• Sort Order

10 Click Print.

Troubleshooting Financial Statements
This topic describes problems that you may encounter with financial statements.
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Net Income Not Correct

Net Income appears on both the Balance Sheet and Income Statement. Make sure you know which
report the user is looking at.

• Net Income is not calculated in the same way on both statements. Net Income on the Income
Statement is a subtotal of all accounts on the Income Statement. Net Income on the Balance Sheet
is calculated by taking the difference between the total activity of all Revenue and Expense accounts
between the fiscal year start date and the period end date (when the range is "B").

• Check to make sure all the Revenue and Expense accounts defined in the Chart of Accounts are
on the Income Statement. If there was a revenue and expense account that had activity that was
not on the Income Statement, its value would not be included in the Income Statement net income,
but would be in the Balance Sheet net income figure.

• Net Income will also be off if there was a balance in a revenue and expense account from prior
years. Run the Trial Balance Report for each prior year using the year-end date as the As of Date.
If there is a balance found, the year-end procedure for G/L will have to be rerun for the year the
balance(s) is in.

Retained Earnings Not Correct

• Find out when the last year-end closing occurred.
• Verify the account the user is speaking about is defined as type "Owner's Equity" in the Chart of

Accounts.
• Verify the account used as the Income Summary account in the latest year-end closing is one of

these type "Owner's Equity" accounts on the statement.
• Verify the latest year-end closing left all revenue and expense accounts with a zero balance by

running the Trial Balance Report using the As of Date as the last date of the most recent year
closed. If the balances are not zero, run the Trial Balance Report for the prior year-end dates for
all revenue and expense accounts to see at the end of what year are the revenue and expense
accounts balances area zero. Perform a year-end closing for all years necessary.

• When a year-end closing procedure is run, the entries that are generated will be put in the General
journal with a transaction date of the fiscal year end date. The reference on the entries for revenue
and expense accounts will be Income Summary and the one account specified as the "Income
Summary" account (usually retained earnings) will have a reference of Year Closing. General
ledger reports will include entries with these references. Financial Statements only ignore Income
Summary entries. The reason for this is to make it possible to run statements for a year after the
year-end closing procedure has been performed and to roll the year's net income into retained
earnings.

• If a prior year statement shows the net income amount in both retained earnings and net income,
on the Financial Statement Definition Columns form, the Amount Type field needs to be set to
Start Bal on the sequence report line for the retained earnings account. This way, it prints the start
balance for the retained earnings for the year and shows the net income only on the net income
line.

Statements are Not Picking Up Correct Amounts

• Find out what kind of statement the user is working with.
• Verify the date ranges they are using and where they are controlling that from. The date entered

on the Financial Statement Output form does not override the dates on the financial statement
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header. If they have entered dates on the header and now want them blank, have them clear the
date fields.

• Verify the information on the statements header, type and most importantly the range. Make sure
the type will give them the type of statement they are looking for. Since a Balance Sheet contains
asset, liabilities, and owner's equity accounts, the range should usually be S or B. Income Statements
contain revenue and expense accounts and should be a range of P or Y.

• Check the information on the financial statements against the general ledger reports. Here are
some guidelines:
• If a balance sheet is out of balance, then generate the Trial Balance Report for all accounts

to see if the entire ledger is out of balance. If not, then compare the balances on this report
with what is on the Balance Sheet. If there are differences, run the Rebalance Ledger Period
Totals utility for those accounts. If the ledger is out of balance, run the Rebalance Ledger
Period Totals then re-run the Trial Balance Report. If the ledger is still out of balance, contact
Application Support for additional assistance.

• If income statement balances are wrong, then run the General Ledger Report for all Revenue
and Expense accounts. Compare the period totals on that report with the totals on the Income
Statement. If there are differences, run the Rebalance Ledger Period Totals utility for those
accounts.

• If it seems like accounts are missing on any report, go into sequence report lines then run the
Financial Report Account Check activity. This activity checks which accounts in the Chart
of Accounts are missing from the statement. Those accounts will then need to be added into
the statement.

Combined Financial Statements
In a Multi-Site environment there are times when you want to combine the data of two or more sites
regardless of the hierarchical financial structure or legal financial entities. To allow this, you can take
advantage of Multi-Site Groups used in other parts of the system (most often to run reports and utilities).

By creating a Multi-Site Group ID which contains a list of sites which you would like to combine, you
can specify this site group when running certain General Ledger reports. These reports are:

• General Ledger
• Journal Transaction Report
• User-Defined Financial Statements
• To ensure meaningful reports, the sites must share the same Chart of Accounts format.
Note: 
• Convert transaction amounts from the other site into its own domestic currency using the exchange

rate tables set up in the other site, and
• Have a transaction date that is equal to or later than the Effective Date of the exchange rate

Otherwise the conversion cannot be done. If either of the above two conditions is not met you will
receive an error message when attempting to output a combined financial statement.

When running combined financial statements where different sites have designated different base
currencies, you may specify the translation method to use on each line of the defined financial statement.

Infor SyteLine Financials User Guide | 196

 

Financial Statements



Chapter 8: Fixed Assets

Fixed Assets Overview
Fixed assets are items a company owns and uses in its operation. Fixed assets do not include assets
used for resale purposes, such as inventory, and those held on a temporary or short-term basis.

Examples of fixed assets include:

• Equipment
• Furniture and fixtures
• Buildings
• Leasehold improvements

Depreciation

You do not usually expense fixed assets during the year you acquire them. Rather, you record their
value as an asset on the balance sheet and depreciate the value over their useful life.

Fixed assets can accommodate many types of depreciation methods. SyteLine

Several factors influence the method selected for calculating fixed asset depreciation: provides seven
predefined depreciation methods and allows you to add additional, custom depreciation methods. You
can also maintain up to four separate depreciation schedules for each fixed asset. This feature allows
you to maintain both your book and tax records on one system.

• The expected useful life of the asset
• The expected salvage value at the end of its useful life
• Its original cost

provides seven After the system calculates depreciation for a particular accounting period, it records
the depreciation onto the General Ledger as a debit to the depreciation expense and as a credit to the
accumulated depreciation.

Fixed Assets and the General Ledger

Fixed assets operate with the General Ledger in the following ways:

• During Fixed Assets Disposal, the system credits the asset account and debits the Accumulated
Depreciation account. (You enter any remaining distributions manually.)

• During Fixed Assets Transfer, when transferring from one class code to another, the system
transfers the asset from the old asset account (and its accumulated depreciation account) to the
new asset account and its accumulated depreciation account.
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• During depreciation posting (for the BOOK schedule only), the system posts to the Depreciation
Expense account and to the Accumulated Depreciation account.

• When you enter a fixed assets purchase, you must enter an acquisition transaction into the General
Ledger to debit the Asset account and credit the Cash account.

• Fixed asset records are created when the fixed asset number is assigned on the purchase order
line.

• Any line received with a fixed asset number updates the fixed asset acquired date.

Reports

These reports are available for fixed assets:

• Fixed Asset Acquisition Report
• Fixed Asset Classification Report
• Fixed Asset Cost Report
• Fixed Asset Current Depreciation Report
• Fixed Asset Disposal Transaction Report
• Fixed Asset Disposition Report
• Fixed Asset Insurance Report
• Fixed Asset Quarterly Costs Incurred Report
• Fixed Asset Transfer Report

Fixed Assets Steps
Fixed assets are items a company owns that could not be easily sold (in contrast to liquid assets).
Because fixed assets are long-term investments, special accounting rules and some governmental
regulations allow you to treat expenses for fixed assets differently. Therefore, you can use calculations
for depreciation or, in other words, measures of the amount of value used up within specific accounting
periods.

Use these steps to maintain fixed assets in SyteLine.

1 Configure the application for fixed assets:

a Create General Ledger accounts that will be used for the costs associated with the fixed assets.

See Creating Fixed Assets General Ledger Accounts on page 207.

b Create class codes on the Fixed Asset Class Codes form.
c Set up depreciation schedules on the Fixed Asset Parameters form.

You can have up to four different ways of depreciating an asset, one for each of the defined
schedules.

d Create depreciation tables on the Fixed Asset Depreciation Tables form.
e Create bonus depreciation codes on the Bonus Depreciation Codes form.

2 As you acquire new assets, add them in the Fixed Assets form.

See Adding a Fixed Asset on page 206.
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3 Post depreciation.

See Posting Depreciation to the General Ledger on page 207.

4 Optionally, you can transfer assets using the Fixed Asset Transfer form.

Use this form to transfer an asset from one class code or department to another. You can transfer
only active assets. A Fixed Asset Distribution journal entry is generated to reclassify the asset on
the balance sheet. Future depreciation entries are charged to the expense account associated
with the new class code.

If you change any of the related cost or depreciation records, you must delete and re-add the
Transfer record so the correct amounts are written to the FA Distribution journal.

To post fixed asset transfer transactions, use the Fixed Asset Transfer Posting form.

5 Optionally, you can dispose of an asset using the Fixed Asset Disposal form.

Use this form to record that an asset has been sold or otherwise disposed. Only assets with a
status of Active are disposed. After you enter the disposal transaction, distributions are generated
for the asset account and the Accumulated Depreciation account. After disposing of the asset, the
system adjusts the Gain and Loss account (from the Fixed Asset Parameters form) in the General
Ledger.

To post the asset disposal, select Actions > Disposal Posting.

6 At year end, use the Fixed Asset Year End Procedure form to set to zero the YTD Depreciation
field for each fixed asset record that falls within the selected range of assets.

About Depreciation
The traditional approach to depreciation is based upon the fact that when a taxpayer buys a business
or an investment-related asset that wears out, he or she can spread the costs over the period of the
asset's useful life rather than entirely at the point at which the cost was incurred.

Older depreciation methods

Over the years, the Internal Revenue Service (IRS) in the United States prepared and disseminated
various guidelines to estimate useful lives of assets. The Asset Depreciation Range System (ADRS)
presented guidelines for the depreciable lives of specified classes of assets grouped by industrial
classifications and by certain broad general asset classifications.

A taxpayer electing to use the ADRS system could rely on the lives set forth therein as being safe from
challenge by the IRS. With regard to assets not covered by ADRS, the depreciation period (useful life)
was based upon actual facts and circumstances of each asset. However, this was subject to attack by
Internal Revenue in each specific case.

Depreciation methods were generally grouped into two categories:

• Straight Line: The taxpayer's depreciation deductions are spaced equally over an asset's useful
life.

• Accelerated Depreciation Method: Includes Declining Balance Method, Double Declining Balance
Method, Sum Of The year's digits, ACRS, MACRS, and other sophisticated methods.
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The purpose of providing for Accelerated Depreciation was twofold: 1) to stimulate capital investment,
and 2) to encourage risk-taking investment. The accelerated methods permitted taxpayers to allot
larger depreciation deductions to the earlier years of an asset's life and smaller deductions to later
years.

The purpose of accelerating deductions in early years is to allow the taxpayer to pay less in taxes
during the earlier years of an asset's useful life. The taxpayer thereby gains the benefit of deferring his
or her tax obligation to a later time. The taxpayer will be able to earn money on the amounts which
would otherwise have paid taxes in the early years of the asset depreciation schedule.

Accelerated Cost Recovery Systems

In general, the Accelerated Cost Recovery Systems provided for an accelerated recovery of the cost
of tangible, depreciable property used in a trade or business or held for the production of income and
placed in service after 1980, but prior to 1987. The cost is recovered over a period of 3, 5, 10 and 15
years. ACRS defined easily identifiable classes of assets and prescribed standard cost recovery periods
for these classes. It divorced the capital recovery period from the concept of "useful life." After ACRS,
the terms Asset Depreciation Range and "useful life" generally no longer apply.

For personal property, taxpayers have the option to use the Straight Line method over the regular
recovery. For real property, taxpayers have the option to use the Straight Line method over the recovery
methods described in Code Sections 167 and 168.

Modified ACRS (MACRS) provides recovery periods of 3--5--7--10--15--17.5--20 and 31.5 years.
Basically, MACRS took away some of the advantages to the taxpayer included in the more rapid ACRS
recovery. Technically, ACRS and MACRS are not depreciation methods because they are not based
upon a "useful life" of property. The deduction is based upon an allowed method of cost recovery to
the taxpayer. However, they are nevertheless referred to as depreciation methods.

ACRS was designed to spur capital investment and to help businesses to recover their costs faster
and thereby keep pace with the rate of inflation. This system was also designed to reduce disputes
between taxpayers and the IRS over the useful life of assets.

As property is depreciated and tax deductions permitted during the depreciation, the basis of the
property being depreciated changes. Upon a sale or other disposition of the property, the amount of
gain for which the taxpayer is taxed is the excess of the amount realized upon transfer over the adjusted
basis of the property disposed of whether by sales, exchanges, or involuntary conversions.

Deductions are allowed only for business property or property held for the purpose of producing income.
Such property does not include inventory nor unimproved real estate.

Goodwill cannot be depreciated, because no useful life can be attributed to it. Therefore, in business
transactions, what would be classified as goodwill is often treated as a covenant by the Seller not to
compete. Covenants not to compete can be depreciated on a Straight Line basis over the term of the
covenant.

Remember that without depreciation you would, for example, pay $1,000 for a piece of machinery and
not have any tax break whatsoever. If you held the property for five years and sold it for $800, there
would be no tax. If you sold it for $1,200, there would be a tax on the $200 gain. Depreciation allows
you a tax advantage in the years of depreciation, however, if you later sell or dispose of the property,
this tax advantage is recaptured as taxable income. For example, if the $1,000 piece of machinery is
depreciated under MACRS for three years, there would be an adjustment to basis for the amount
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allowed during each of those years as a deduction. Assuming the property is in the five year class, the
MACRS deductions would be $200 for the first year, $320 for the second year, and $192 for the third
year. The adjusted basis after the three years would be $288. If, at the end of the three years, the
taxpayer sold the item of equipment for $900, he would have a taxable gain on the difference between
the depreciated basis and the sale price.

Obviously, if the taxpayer is in a high tax bracket, he will derive greatest benefit by using the most rapid
recovery method possible. If, on the other hand, the taxpayer's marginal tax rate is low, the election of
a Straight Line method of depreciation and an extended recovery period could prove more advantageous,
particularly if income is expected to increase in later years.

The Treasury Department is constantly changing regulations relative to depreciation either to spur the
economy or increase revenue.

Calculations

See Depreciation Calculations on page 203.

Partial Depreciation

You can also schedule a partial year depreciation when an asset is placed in service at some time
during the calendar or fiscal year.

For more information, see About Partial Depreciation on page 201.

About Partial Depreciation
SyteLine provides seven standard and user-defined depreciation methods. The user-defined methods
have different depreciation rates based on year.

For example, if Number of Periods is set to 12 for a year and it has 36 units to depreciate, the custom
rate is:

Rate %Year

301

502

203

The asset detail is:

AS_1Asset Name

Apr 2012Start to Depr Date

7200Cost

36 (12 Periods * 3 Years)# Units to Depr

Infor SyteLine Financials User Guide | 201

 

Fixed Assets



It will depreciate for twelve periods for a single year from the start date.

Period DepreciationRate %Units to depreciateDate

180 = 7200 * 30% / 12301204/2012 - 03/2013

300 = 7200 * 50% / 12501204/2013 - 03/2014

120 = 7200 * 20% / 12201204/2014 - 03/2015

For partial depreciation, when an asset is placed in service at some time in the year, part of the full-year
depreciation is required in the first year, while the remaining balance is deducted in the final year of
the depreciation. The year for partial has three types:

1 Calendar Year: Period from January 1 to December 31. It depreciates starting on the date it is
placed in service to December 31.

2 Fiscal Year: Period used for calculating annual financial statements in businesses. It depreciates
from the date is placed in service date to the end of the fiscal year. The US fiscal year is October
1 to September 30.

3 None: No partial depreciation is taken.

For example, below is a three year property partial depreciation rate:

Rate %Year

301

402

203

104

For the calendar year, depreciation rates would be as follows:

Period DepreciationRate %Units to depreciateDate

240 = 7200 * 30% / 930904/2012 - 12/2012

240 = 7200 * 40% / 12401201/2013 - 12/2013

120 = 7200 *20% / 12201201/2014 - 12/2014

240 = 7200 * 10% / 310301/2015 - 03/2015

For the fiscal year, depreciation would be as follows:

Period DepreciationRate %Units to depreciateDate

360 = 7200 * 30% / 630604/2012 - 09/2012

240 = 7200 * 40% / 12401210/2012 - 09/2013

120 = 7200 * 20% / 12201210/2013 - 09/2014

120 = 7200 * 10% / 610610/2015 - 03/2016
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Follow the steps in Generating a Depreciation Schedule on page 207 to set up a fixed asset depreciation.

Using Dates in the Past

You can specify any date as the date to start depreciation. If you specify a date in the past, depreciation
will start from that month.

For posting to Fiscal Periods, you can specify a transaction date when posting. This date is used to
determine Fiscal Periods. If you specify a date in the past, depreciation is calculated for all previous
months.

Using a Date in the Middle of the Month

If you start depreciation in the middle of the month, depreciation will start from the first of that month.
There is no partial month depreciation.

Depreciation Calculations
This topic describes depreciation calculations.

Salvage Value

If you enter a salvage value on the Fixed Asset Depreciation form, all depreciation schedules (columns)
for that asset will use that value. This occurs when the system determines the amount of depreciation
necessary to reduce the carrying value of the asset to the estimated residual value (salvage value)
during the last year of its useful life.

After each depreciation method, the following equation occurs:

If c-amt > t-amt - s-amt - d-amt

Then c-amt = t-amt - s-amt - d-amt

where:

c-amt = Current depreciation

t-amt = Total value of the asset

s-amt = Salvage value

d-amt = Accumulated depreciation + bonus depreciation

The methods are correct, but you should have the option not to calculate salvage value into all of the
schedules for each asset.

Salvage Value - Bonus Depreciation

For Fixed Asset Depreciation Table methods, if you are considering salvage value, you must enter it
in the Bonus Depr field of the depreciation schedule (column) using that method. You only use the
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amount in the Salvage Value field for calculating the depreciation amount during the last year of the
asset's useful life.

The equation is:

c-amt = (t-amt - facepr.bonus-depr-$)*fadeptab.percent-yr[k]*.01

where:

c-amt = Current depreciation

t-amt = Total value of the asset

fadepr.bonus-depr-$ = Bonus depreciation amount

fadeptab.percent-yr[k] = The percent of the asset value to be depreciated in year 'k'

This equation had contained salvage value instead of bonus depreciation amount, but was changed
to use bonus depreciation correctly and to allow the user the option to include or exclude salvage value
on a particular schedule.

Bonus Depreciation

To use bonus depreciation correctly, you must use a Depreciation Table method. Most methods do
not consider bonus depreciation until the equation:

If c-amt > t-amt - s-amt - d-amt

Then c-amt = t-amt - s-amt - d-amt

where:

c-amt = Current depreciation

t-amt = Total value of the asset

s-amt = Salvage value

d-amt = Accumulated depreciation + bonus depreciation

You must subtract bonus depreciation from the total value of the asset before calculating the current
depreciation amount. As in this equation:

c-amt = (t-amt - fadepr.bonus-depr-$) * fadeptab.percent-yr[k] * .01.

where:

c-amt = Current depreciation

t-amt = Total value of the asset

fadepr.bonus-depr-$ = Bonus depreciation amount

fadeptab.percent-yr[k] = The percent of the asset value to be depreciated in year 'k'

Another problem for bonus depreciation is the equation:

If c-amt > t-amt - s-amt - d-amt

Then c-amt = t-amt - s-amt - d-amt
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where:

c-amt = Current depreciation

t-amt = Total value of the asset

s-amt = Salvage value

d-amt = Accumulated depreciation + bonus depreciation

By having d-amt = accumulated depreciation plus bonus depreciation, this equation assumes that you
have not incorporated the bonus depreciation into the accumulated depreciation amount.

To solve the above problems:

• Add a field to each depreciation schedule (column) for salvage value.
• For each depreciation method, include the following statement in the equation:

(t-amt - fadepr.xxx - fadepr.bonus-depr-$)

where:

t-amt = Total value of the asset

fadepr.xxx = The salvage value for a specific schedule

fadepr.bonus-depr-$ = The bonus depreciation for a specific schedule

• Remove bonus depreciation from the following:

d-amt = accumulated depreciation and bonus depreciation.

Sum of the Year's Digits

When using the Sum-of-the-Year's Digits depreciation method, the system uses the following equation:

c-amt = (t-amt - s-amt) * k / sum-of-yrs.

where:

c-amt = Current depreciation

t-amt = Total value of the asset

s-amt = Salvage value

sum-of-yrs = Sum of the year's digits

k = The current year's digit

SYD is not supposed to consider salvage value until the following equation:

If c-amt > t-amt - s-amt - d-amt

Then c-amt = t-amt - s-amt - d-amt

where:

c-amt = Current depreciation

t-amt = Total value of the asset

s-amt = Salvage value

Infor SyteLine Financials User Guide | 205

 

Fixed Assets



d-amt = Accumulated depreciation + bonus depreciation

Period Basis Using Declining Balance

When depreciating on a period basis using the Declining Balance methods, the system uses the
following equation:

c-amt = (t-amt - d-amt) * p-amt * (1 / (t-units / perds)) / perds

where:

c-amt = Current depreciation

t-amt = Total value of the asset

d-amt = Accumulated depreciation + bonus depreciation

p-amt = Percent amount (calculated)

t-units = Total life units

perds = Number of accounting periods

The depreciation amount for each period of a given year will not be equal.

Adding a Fixed Asset
The Fixed Assets form contains identifying and descriptive information about an asset.

To add a fixed asset:

1 On the Fixed Assets form, specify information about the asset. Set the Status to Active. Save
the record.

2 Click Fixed Asset Costs and specify costs for the asset.

Use the Fixed Asset Costs form to maintain a comprehensive history of all costs accumulated
for an asset. These costs include the initial purchase price as well as costs for enhancements and
repairs.

There is a one-to-many relationship between an asset and its cost records. Each time you add an
additional cost factor, a new record is created and assigned a sequence number. This helps you
track the cost history of the asset. For example, when you first enter the purchase price of an asset,
the sequence number for the cost record is 1. Later, if you add upgrade the asset and add the cost
of the upgrade, a new record is created with the sequence number of 2.

3 Use the Fixed Asset Depreciation form to establish a depreciation method and depreciation
schedule for the asset.

See Generating a Depreciation Schedule on page 207 for the steps to set up a depreciation schedule.
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Creating Fixed Assets General Ledger Accounts
Enter new Fixed Assets General Ledger accounts using the Chart of Accounts form.

These accounts should include all asset accounts, all accumulated depreciation accounts, and all
expense accounts.

Posting Depreciation to the General Ledger
1 When you open the Fixed Asset Depreciation Posting form, the grid displays the assets that

contain errors that will prevent them from posting. You should correct these errors before proceeding.
Assets appear in the error grid when either of these conditions is true:

• There is no depreciation record for the asset (you must create the depreciation record on the
Fixed Asset Depreciation form).

• The # Units to Depr value is greater than or equal to the Units Depreciated value AND the Curr
Period Depr value is 0 (these values are all defined on the Fixed Asset Depreciation form).

2 Click the Process button. The message "F/A Depreciation(s) will be printed before posting" displays.

3 Click OK. The Fixed Asset Current Depreciation Report (Modal) form displays.

4 Click the Print button. The report prints to the printer you specified on the Report Options form.
Use this report to verify that the depreciation information is correct prior to posting.

5 After you verify the information is correct, click the X button in the top-right corner of the report
window to close the report form. The message "Do you want to return an OK response to form
Fixed Asset Depreciation Posting?" displays.

6 Click Yes. The message "[Fixed Asset Depreciation Posting] will be performed" displays.

7 Click OK. The message "x F/A Depreciation(s) were posted" displays." This message also alerts
you about the number of assets that did not post because of errors.

Note:  Depreciation Schedules are user-defined in the Fixed Asset Parameters form. You can have
up to four different ways of depreciating an asset, one for each of the defined schedules.

Generating a Depreciation Schedule
The third step in creating a Fixed Asset file is to generate a depreciation schedule. To generate a
depreciation schedule:

1 On the Fixed Assets form, specify the Useful Life and Date to Start Depreciation for the asset.

2 Open the Fixed Asset Depreciation form.

3 Select Actions > New.

4 In the Asset Number field, select an asset.

5 The Class Code field is read-only and shows the class code for the asset.

6 Select the Depreciation Code:
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• BOOK
• TAX01
• TAX02
• VALUE

7 In the Depr Method field, select the desired method of depreciation:

• sl = Straight line
• syd = Sum-of-the-years' digits
• usage = Production or use method
• 125db = 125% declining balance
• 150db = 150% declining balance
• 175db = 175% declining balance
• 200db = Double declining balance

For details about calculations performed for these depreciation methods, see About Depreciation
on page 199.

Note:  To use a custom depreciation method that you defined, you must first define it using the
Fixed Asset Depreciation Tables form.

8 In the Depr Frequency field, select the frequency for calculating depreciation (Year or Period).

The system depreciates the asset when the Generate Depreciation activity is finished. There is
no special setting for depreciating an asset for part of a year or part of a month.

For example, if an asset was purchased in July, and you want to accumulate 1/2 year of depreciation,
run the Generate Depreciation utility for the months of July through December, assuming periods
equal calendar months. The number of times the utility has been run is the number of months the
asset is depreciated.

9 To switch to the straight-line method, when the straight-line method results in a greater depreciation
deduction than the user-defined or declining balance methods, select the Auto Crossover check
box.

During depreciation generation, if a switch to the straight-line method has occurred, the Auto
Crossover field is selected.

10 Enter appropriate information in the optional fields as desired, or accept the default values and
settings.

• Bonus Depr: Select for additional, special expensing, or depreciation of an asset less the
depreciable basis. You must enter it manually and post it to the General Ledger.

• Bonus Depr Code: Enter the code that explains the bonus you chose in Bonus Depr field.
Note:  For additional, special expensing or depreciation of an asset during its first year, enter
both the Bonus Depr and Bonus Depr Code.

• # Units to Depr: Enter the number of units to depreciate. You can enter this field in two ways:
• For assets that use the usage depreciation method, enter the number of units in the asset's

life.
• For assets that do not use the usage depreciation method and use a depreciation frequency

of Period, enter the number of accounting periods over which to depreciate the asset.

This field is linked to the Useful Life field on the Fixed Assets form.

The system calculates the default amount by accessing the useful life and the number of
accounting periods from the General Ledger. This value does not decrease.
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Note:  If ThailandCountryPack is enabled on the Optional Modules form, the number of units
to depreciate is incremented by one when the depreciation method is not USAGE and the
acquisition date falls between the start and end of the specified accounting period. For example,
if the depreciation frequency is set to Period (usually 12 in one year) and the acquisition date
is 10-Jan-2013, then for a "Useful Life" of 5 years the number of units to depreciate is about
61 (12*5 + 1) instead of 60 (12*5). Similarly, if the acquisition date is specified to the beginning
of the month (1-Jan-2013) then the number of units to depreciate is 60 (12*5).

• Units Depreciated: Enter the number of units that have already depreciated. This number
cannot exceed the number of units to be depreciated.

• Accum Depr: This field displays the accumulated amount of depreciation for this asset.
Note:  You must include the bonus amount in the Accum Depr and YTD Depreciation fields
before generating depreciation. You must post the bonus amount manually to the General
Ledger. You also must reduce the Bonus Depr field amount by bonus amount that you included
in the Accum Depr and YTD Depreciation fields.

• YTD Depreciation: This field displays the amount of depreciation year-to-date.
• Curr Period Depr: Enter the asset's depreciation amount for the current accounting period. It

is calculated when depreciation is generated. If this value is 0, the asset will not post.

This field is linked to the Date to Start Depreciation field on the Fixed Assets form.

• Last Post Date: This field displays the last date depreciation was posted for an asset.
Note:  If you want a salvage value, enter the estimated value of an asset at the end of its useful
life. The system does not depreciate an asset below its salvage value.

11 Select Actions > Save.
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Chapter 9: Journals

About Journal Entries

Entering Journal Transactions

Two or more transactions are typically entered to create a balanced entry, with one transaction entered
as a debit (such as receiving a cash payment), and the second entered as a credit (such as recording
miscellaneous income). The sum of the debit transactions equals the sum of the credit transactions.
If each group of transactions is assigned the same reference, it is easily recognizable later that these
transactions were entered at the same time.

Transactions must be entered into the journal as the first step in changing an account's balance. The
next step is to post the journal to the ledger, at which time the account balances are updated. After a
transaction has been posted to the ledger, you cannot change it. The only way to correct an incorrect
entry is by entering a reversing entry.

You cannot directly delete a ledger transaction; however, you can enter a journal transaction for an
opposite amount (and the same date as the original transaction), and then post that transaction to the
ledger to cancel out the previous transaction.

System Journals

SyteLine initially creates the following system journals, which you cannot delete:

• AP Dist: Accounts Payable Ledger Distribution
• AR Dist: Accounts Receivable Ledger Distribution
• BNK Dist: Banking Distribution
• CO Dist: Order Entry Ledger Distribution
• FA Dist: Fixed Assets Ledger Distribution
• FS Dist: Service Distribution
• General: General Journal
• IC Distribution: Inventory Control Ledger Distribution
• INV Dist: Inventory Ledger Distribution
• Multi-Site: Multi-Site Journal
• PC Dist: Project Control Ledger Distribution
• PO Dist: Purchasing Ledger Distribution
• PR Dist: Payroll Ledger Distribution
• SF Dist: Shop Floor Control Ledger Distribution

Infor SyteLine Financials User Guide | 210

 

Journals



• WC Dist: Work Center Ledger Distribution
Note: 
• The BNK Dist journal is created for all databases, although it is populated only by running the

Currency Revaluation Report.
• The INV Dist journal is available in SyteLine only for backward compatibility, and to support any

code modifications that post to the journal. This journal was replaced by the CO Distribution, IC
Distribution, PO Distribution, and SF Distribution journals. Infor has no plans for future use of this
journal.

• If you have deleted material transactions, any ledger or journal records that reference them will
have their references cleared. If you try to view detail on a ledger or journal and the specific material
transaction has been deleted, you will receive a message that the record is not available.

Read-Only Journals

Except for unit codes, the distribution journals are read-only. The General Journal and any user-defined
journals are considered "writeable". Transactions for the distribution journals are entered from the
appropriate SyteLine function.

For example, after a payment is entered and posted through Accounts Payable, the transaction appears
in the A/P Dist Journal. Transactions for the General Journal are entered through the General Ledger.

These functions are performed on read-only journals:

• Enter text (to be associated with each transaction)
• Compress journal by account & date
• Post to General Ledger
• Sequence reset (resequence transaction numbers)

You can also update unit codes for a journal transaction residing in a read-only journal.

These functions cannot be performed on read-only journals:

• Add transactions
• Delete transactions
• Update transactions
• Perform year end closing
• Update journal title

Standard Journals

A standard journal may be set up for recurring transactions (such as rent, mortgage, payroll, or loan
payments). When transactions are posted from the General or standard journals, there is an option
available to delete all entries in the journal.

Do not delete recurring entries in the standard journals. The transactions are needed for the next
period's posting. Recurring entries are usually the only entries in user-defined journals you would not
delete.

The entries in the General Journal change from period to period and need to be deleted.
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Accounting References and Distribution Journal Entries
Entries for distribution journals originate in the corresponding application (such as A/R for the A/R
Ledger Distribution journal, A/P for the A/P Ledger Distribution journal, and so on), as described in the
following topics.

Accounts Payable Ledger Distribution Journal

• AP Compresses AP Journal Transactions
• APA # Adjustment Transaction and Voucher Number
• APP # Payment Transaction and Voucher Report
• APPB Draft Reconciliation and Draft Number and Vendor Number
• APPD Draft Remittance Transaction and Vendor Number and Draft Number
• APPR
• APRV # Recurring Voucher Transaction and Voucher Number
• APV # Voucher Transaction and Voucher Number
• APVPC # Accounts Payable Voucher Pre-Registering Closed transactions
• APVPP # Accounts Payable Voucher Pre-Registering Posting transactions
• APX Multi-Currency Gain/Loss Transaction
• APX VAT Transfer Mexico VAT Transfer Gain/Loss and Voucher Number
• Bank Code FEE APP Japan Bank Fee and Vendor Number
• VAT Transfer Mexico VAT Transfer and Voucher Number

Accounts Receivable Ledger Distribution Journal

• AR Compressed AR Journal Transactions
• ARC # Credit Memo Transaction and Invoice Number
• ARC FIN CHG Credit Memo to Finance Charge Transaction
• ARC OPEN Open Credit Memo Transaction
• ARD # Debit Memo Transaction and Invoice Number
• ARD FIN CHG Debit Memo to Finance Charge Transaction
• ARD OPEN Open Debit Memo Transaction
• ARI # Invoice Transaction and Invoice Number
• ARF # Finance Charge Transaction and Customer Number3
• ARP # Payment Transaction and Check Number
• ARPB Direct Debit/Draft Reconciliation and Direct Debit/Draft Number
• ARPD Draft Remittance Transaction and Draft Number and Customer Number
• ARPR AR Payment Reapplication
• ARX Multi-Currency Gain/Loss Transaction
• ARX VAT Transfer Mexico VAT Transfer Gain/Loss and Invoice Number
• VAT Transfer Mexico VAT Transfer and Invoice Number

Banking Distribution Journal

• REVALUATION ADJUSTMENT Multi-currency Revaluation Transaction

Field Service Ledger Distribution Journal

• ACM ACM Posting
• APV Expense Reconciliation and Partner Reimbursement Voucher
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• SROINV SRO WIP Relief Due to Invoicing
• SROC SRO Credit Memo
• SROI SRO Invoicing
• SRO Labor Labor Transaction Posting
• SRO Matl Material Transaction Posting
• SRO Misc Miscellaneous Transaction Posting
• SRO CLOZ SRO Close Utility WIP Relief
• SRO OP M CL SRO Operation Manual Close WIP Relief
• SRO MANUAL CLOSE SRO Line Manual Close WIP Relief
• SRO Matl InvAdj Inventory Adjustment Due to Transaction Posting
• CONI Contract Invoice
• ARC Partner Reimbursement Credit Memo
• ARI Partner Reimbursement Invoice

Fixed Assets Ledger Distribution Journal

• FA Compressed FA Journal Transactions
• FADEP # Depreciation Transaction and Asset Number
• FADSP # Asset Disposal Transaction and Asset Number
• FAT # Asset Transfer Transaction and Asset Number

General Journal

• Income Summary GL Year End Closing Expense/Revenue Transaction
• Year Closing GL Year End Closing Income Summary Transaction
• Site Move To Change Reports To Entity beginning balance
• Site Move Away Change Reports To Entity closing balance
• Tax Journal Tax Transaction

General Ledger

• Date Summary Compressed GL Transactions by Date
• Period Summary Compressed GL Transactions by Period
• Allocation Summary Accounts used as Allocation Type

Inventory Control Ledger Distribution Journal

• IC Compressed IC Journal Transactions
• INV ACTC Inventory Update
• INV ADJ Inventory Adjustment
• INV CC-A Cycle Count Adjustment
• INV CHGM Change Item Cost Method
• INV DMOV Multi-Site Transfer Order (when posting method is Inter-Entity)
• INV MISU Inventory Miscellaneous Issue
• INV MOVE Inventory Move 
• INV MRCP Inventory Miscellaneous Receipt
• INV PI-A Physical Inventory Adjustment
• INV SADJ Stack Adjustment
• INV SMOV Multi-Site Transfer Order (when posting method is Intra-Entity)
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• INV STDC Inventory Roll Current to Standard Cost
• INV TADJ Multi-Warehouse Transfer Loss
• INV TMOV Multi-Warehouse Transfer between Warehouses

Multi-Site Journal

• MSJE + site Multi-site journal transactions from Journal Builder

Order Entry Ledger Distribution Journal

• CO Compressed CO Journal Transactions
• CGI Customer Order Shipment Approval Cost of Goods In Process
• INV CRT # Customer Order Return and Order/Line Number
• INV CSH # Customer Order Shipment and Order/Line Number
• POS CASH ADJ Cash Drawer Number
• RMX RTI RMA Item Disposition Return To Inventory
• RMX Return Vendor Return

Payroll Ledger Distribution Journal

• PR Compressed PR Journal Transactions
• PR # PR Number
• PR [DIST DATE] Payroll Transaction and Date

Shop Floor Control Ledger Distribution Journal

• SF Compressed SF Journal Transactions
• INV JADJ # Job BOM Cost Roll Up and Job Order Number
• INV JBF # Job Order Back Flush and Job Order Number
• INV JCLS # Job Order Other WIP Variance and Job Order Number
• INV JFIN # Job Order Finish and Job Order Number
• INV JFMO # Job Order Fixed Material Overhead and Job Order Number
• INV JMOV # Job Order Overhead Variance and Job Order Number
• INV JMUV # Job Order Material Usage Variance and Job Order Number
• INV JOB # Job Order Other Issue and Job Order Number
• INV JOC # Job Order Work Center and Job Order Number
• INV JOI # Job Order Material, Tool, Fixture, Issue and Job Order No.
• INV JOL # Job Order Labor and Job Order Number
• INV JRWK # Job Order Return for Rework and Job Order Number
• INV JVMO # Job Order Variable Material Overhead and Job Order No.
• INV JWIP # Job Order WIP Account Change and Job Order Number

Project Control Ledger Distribution Journal

• PRJ MTL Project Resource Transaction
• PRJ ADJ Project Adjustment Transaction
• PRJ LBR Project Labor Transaction
• PRJ WIP Project WIP Transaction
• JCLS PRJ Project's Job Order Other WIP Variances
• JFIN PRJ Project's Job Order Finish
• JOL PRJ Project's Job Order Labor
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• JOM PRJ Project's Job Order Material
• JMUV PRJ Project's Job Order Material Usage Variances
• JFMO PRJ Project's Job Order Fixed Material Overhead Variances
• JVMO PRJ Project's Job Order Variable Material Overhead Variances

Purchasing Ledger Distribution Journal

• PO Compressed PO Journal Transactions
• INV P-CL # Purchase Order Status Change and PO/Line Number
• INV PIV # Replaces INV P-CL #
• INV PNI # Purchase Order for Non-Inventory Item and PO/Line No.
• INV PRCV # Purchase Order Receipt and PO/Line Number
• INV PRTN # Purchase Order Return and PO/Line Number
• POX Purchase Order Gain/Loss

Work Center Ledger Distribution Journal

• INV WC # Work Center Cost
• INV WCM # Work Center Material
• INV WCL # Work Center Labor
• INV WCFO # Work Center Fixed Overhead
• INV WCVO # Work Center Variable Overhead
• INV WCO # Work Center Outside Labor
• INV WCI # Work Center Inventory
• INV WCSP # Work Center Scrap
• INV WFIN # Work Center Finished Goods

Multiple Journals

• XBAL Balance Recalculation
• EC VAT EU VAT Report
• EUR Domestic Euro Currency Conversion
• LOSS Currency Loss
• GAIN Currency Gain

Creating a User-Defined Journal
1 Access the Journals form.

2 Select Actions > New.

3 Enter a unique journal ID of up to 10 alphanumeric characters.

4 Enter a description of the journal. This description displays for the journal in selection lists.

5 To create a journal that will post to:

• The Analytical Ledger, select the Analytical Ledger check box.
• The General Ledger, clear the Analytical Ledger check box.
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Note:  The Analytical Ledger check box is available only if the Use Analytical Ledger check box
is selected on the General Parameters form.

6 Select Actions > Save.

After you have created a user-defined journal, you can enter transactions for it using the Journal
Entries form.

Creating and Posting Recurring Journal Entries
Note:  Recurring journal entries can be created in only standard or user-defined journals.

1 To create a recurring journal record:

a Open the Journals form and find or create a user-defined journal.
b Select Recurring Journal.
c Save the record.

2 To post recurring journal entries:

a Click Journal Entries. The Journal Entries form is displayed.

Note:  If you need to post entries for another recurring journal, open the Journal Entries form
and then find the recurring journal.

b Fill in the appropriate fields for your recurring transaction. For a new recurring journal, specify
all transaction entries. For an existing recurring journal, you might only need to change the
transaction dates.

Note:  Transaction dates can be changed one by one on the Journal Entries form, or you
can change them all at once using the Ledger Posting form, which is opened in the next step.
On the Ledger Posting form, select Single Date To All Entries and specify the date in Date
For All Transactions.

c Select Actions > Post Journal. The Ledger Posting form is displayed.
d Print and post the ledger.
e Review the Journal Transaction report to check for any inaccuracies.
f Post the journal.
g If the journal was posted before in the same period, you will be prompted to confirm. Click Yes

to post.

After successful completion of the post, a success message is displayed and the system returns to the
Ledger Posting form.

Creating Auto-Reversing Transactions
Auto-reversing transactions are transactions that are to be reversed in the next accounting period or
fiscal year. A reversing transaction is normally used when entering an accrual type of transaction.
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1 To create the transactions, follow the steps in Creating Journal Entries on page 217.

2 On the Journal Entries form, when creating the transactions, to indicate that this entry is a reversing
transaction, select the Reversing check box.

The system creates the reversing transactions when you post the journal.

The reversing transactions total is displayed at the bottom of the Journal Account Summary form
with the other totals.

Creating Journal Entries
To create journal entries only for the General Journal and for user-defined journals, use the Journal
Entries form. You cannot use this form to create journal entries for the distribution journals. Entries for
the distribution journals originate in the corresponding module (such as A/R for the A/R Dist journal,
A/P for the A/P Dist journal, and so on).

1 Open the Journal Entries form.

2 In the Journal field, select General Journal or the user-defined journal you want to add an
entry to.

3 Click the filter-in-place button.

4 Select Actions > New.

5 Specify information in these fields:

• Sequence: The system automatically assigns a sequential number to uniquely identify each
transaction, but you can change it.

• Date: This field displays today's date, but you can change it to the date that this transaction is
to be posted to the ledger. When you post journal entries, you do so for a range of dates.

• Account: Select the number of the account that the transaction amount will be posted to. The
account description automatically displays as reference.

• Control Number: You can update the control number prefix or the control number sequence.
• Ref Control Number: If you need to reference a control number or a transaction posted to

the ledger, enter the information in these fields.
• (Unit Code 1-4): For each segment that is available, you can select the unit code that the

transaction applies to.
• Currency: This field displays the domestic currency, but you can select a different currency

for the transaction. The currency must be the same as the currency of the bank that this
transaction affects. If a non-domestic currency is specified, you can enter debit or credit amounts
in either the Domestic or Foreign Debit/Credit fields. Note that if a bank code is specified,
that bank's currency is displayed in this field, and you cannot change it.

• Bank Code: Select the bank code of the bank account to which this transaction will be posted.
If you are posting to a cash account that is tied to a bank code, that bank code is specified by
default. The system automatically updates the Currency and Exchange Rate fields to reflect
the values associated with the selected bank code.

• Domestic Debit/Credit: Enter the debit or credit amount of the transaction in the domestic
currency. The Exchange Rate field is set to one by default and the Foreign Debit/Credit fields
cannot be used.
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• Foreign Debit/Credit: These fields are enabled if a non-domestic currency is specified in the
Currency field, so you can enter the debit or credit amount of the transaction in the foreign
currency, if you prefer. The system automatically calculates the corresponding domestic
debit/credit amount based on the default exchange rate.

If the domestic currency amount is specified, and the corresponding foreign debit/credit is 0.00,
then the system automatically calculates the foreign debit/credit amount based on the default
exchange rate between the two currencies. If the domestic currency amount is specified, and
the corresponding foreign debit/credit is not 0.00, then the system automatically recalculates
the exchange rate based on the domestic debit/credit amount and the corresponding foreign
debit/credit amount.

• Exchange Rate: This field displays today's exchange rate between the domestic and foreign
currencies. You can change it only if you selected a value in the Bank Code field.

• Reference: Enter a brief description of the transaction. The reference can be used to group
transactions. This field is part of the selection criteria for the Journal Transaction Report.
You can list all transactions with a particular reference. Note that all the debits and credits for
the same reference should equal 0 (zero).

• Cust/Vendor: The number of the customer or vendor associated with the transaction is
displayed.

• Name: The name associated with the customer or vendor number is displayed.
• Reversing: Select this check box if you are entering a reversing transaction.

6 Select Actions > Save.

7 To continue entering transactions until the debit balance equals the credit balance, repeat steps
2 - 6.

Deleting a User-Defined Journal
To delete a user-defined journal:

1 On the Journals form, in the grid, select the line for the journal you want to delete.

2 Select Actions > Delete.

The system presents a message informing you that the journal will be permanently deleted when
you save your changes.

3 Click OK.

The system presents another message informing you that all the journal's transactions will also be
deleted.

4 Click OK.

5 To permanently delete the journal and its transactions, select Actions > Save.
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Importing Bulk Journal Entries
This topic describes how to import journal entry files with the Import Journal Entries Bulk form, and
it is intended to be used if you need to import more than 100 records. If you want to import fewer than
100 records, you can use the Import Journal Entries form. The Import Journal Entries form allows
you to import XML and CSV files, but the Import Journal Entries Bulk form only allows the import of
CSV files.

1 Open the Import Journal Entries Bulk form.

2 Specify this information:

• Journal - Only the General Journal or user-defined journals can be selected.
• Date
• Reference - This field is optional.

3 Click Load Journal Entries.

4 Select the CSV file you wish to import.

5 Click Open.

Importing Journal Entries from External Sources
This topic describes how to import CSV or XML files with the Import Journal Entries form. If you need
to import more than 100 journal entry records, we recommend that you use the Import Journal Entries
Bulk form.

To import journal entries from CSV or XML files with the Import Journal Entries form, or to copy and
paste journal entry data for import:

1 Ensure that the files are formatted properly.

See Guidelines for Imported Journal Entry Files on page 220.

2 Open the Import Journal Entries form.

3 Perform one of these tasks:

• If you are importing data from a CSV or an XML file, select the file type and then click Load
Journal Entries.

• If you are importing data by copying and pasting it from a spreadsheet, open the spreadsheet
to work with and paste the needed data into the grid.

4 Select the journal in which to enter the grid data.

5 Perform one of these tasks:

• To edit the date, account, or reference information for individual grid entries, click in the grid
cells and make changes as necessary.

• To change the date and/or reference information and apply it to all grid entries, specify the
date and/or reference at the bottom of the form.

6 Click Process. The data is validated and, if accurate, saved to the selected journal. If errors are
found, the data remains in the grid so you can make necessary changes.
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Guidelines for Imported Journal Entry Files
To import journal entries from CSV or XML files, or to copy and paste journal entry data for import, use
the Import Journal Entries form.

Before you start the import, make sure you have formatted CSV and XML files according to these
guidelines:

CSV files must use this format: Date,Account,Unit Code 1,Unit Code 2,Unit Code 3,Unit Code
4,Debit,Credit,Reference,AnalysisAttribute01 ...AnalysisAttribute15

For XML files, each journal entry must start with a journal_entry tag and use date, account, unit codes,
debit, Credit, reference, and analysis attribute 01 - 15 tags for grid fields, as shown in the following
example.

Note: For this example, analysis attributes 1 - 5 were defined as Employee Name, Customer Number,
Hotel Name, Room Type, and City. Analysis attributes that are not defined can be left blank or removed
from the XML.

<?xml version="1.0" 
 encoding="UTF-8" ?> 
<Journal_Entries>
<Journal_Entry> 
<Date>05/15/2014</Date> 
<Account>10000</Account> 
<UnitCode1></UnitCode1> 
<UnitCode2></UnitCode2> 
<UnitCode3></UnitCode3> 
<UnitCode4></UnitCode4> 
<Debit>1000.00000000</Debit> 
<Credit>0.00000000</Credit> 
<Ref>CP  1330</Ref> 
<AnalysisAttribute01>Mark White</AnalysisAttribute01> 
<AnalysisAttribute02>00001</AnalysisAttribute02> 
<AnalysisAttribute03>Grand  Hyatt</AnalysisAttribute03> 
<AnalysisAttribute04>Grand 
 Room - King Bed</AnalysisAttribute04> 
<AnalysisAttribute05>New York</AnalysisAttribute05> 
<AnalysisAttribute06></AnalysisAttribute06> 
<AnalysisAttribute07></AnalysisAttribute07> 
<AnalysisAttribute08></AnalysisAttribute08> 
<AnalysisAttribute09></AnalysisAttribute09> 
<AnalysisAttribute10></AnalysisAttribute10> 
<AnalysisAttribute11></AnalysisAttribute11> 
<AnalysisAttribute12></AnalysisAttribute12> 
<AnalysisAttribute13></AnalysisAttribute13> 
<AnalysisAttribute14></AnalysisAttribute14> 
<AnalysisAttribute15></AnalysisAttribute15> 
</Journal_Entry> 
<Journal_Entry> 
<date>05/15/2014</date> 
<account>10000</account> 
<UnitCode1></UnitCode1> 
<UnitCode2>0007</UnitCode2> 
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<UnitCode3></UnitCode3> 
<UnitCode4>01</UnitCode4> 
<Debit>0.00000000</Debit> 
<Credit>1000.00000000</Credit> 
<Ref>CP  1330</Ref> 
<AnalysisAttribute01>Mark White</AnalysisAttribute01> 
<AnalysisAttribute02>00001</AnalysisAttribute02> 
<AnalysisAttribute03>Grand Hyatt</AnalysisAttribute03> 
<AnalysisAttribute04>Grand Room - King Bed</AnalysisAttribute04> 
<AnalysisAttribute05>New 
 York</AnalysisAttribute05>  
<AnalysisAttribute06></AnalysisAttribute06> 
<AnalysisAttribute07></AnalysisAttribute07> 
<AnalysisAttribute08></AnalysisAttribute08> 
<AnalysisAttribute09></AnalysisAttribute09> 
<AnalysisAttribute10></AnalysisAttribute10> 
<AnalysisAttribute11></AnalysisAttribute11> 
<AnalysisAttribute12></AnalysisAttribute12> 
<AnalysisAttribute13></AnalysisAttribute13> 
<AnalysisAttribute14></AnalysisAttribute14> 
<AnalysisAttribute15></AnalysisAttribute15> 
</Journal_Entry></Journal_Entries> 

Dates must use the standard format: mm/dd/yyyy.

Reference information can be up to 30 characters in length.

Identifying Missing Information in a Journal
The Journal Transaction Utility searches through the journal for missing information within the
transactions. This utility sets missing dates, accounts, and amounts.

Caution: 
• If you cancel or abort the posting, all changes are undone.
• If this is a read-only journal, you cannot update this information again using this utility.

1 Open the Journal Transaction Utility form.

2 In the Journal field, select a journal to process.

3 Click Process.

Posting a Journal
The posting process commits your transactions to the ledger. The ledger is not impacted by changes
that affect General Ledger (G/L) accounts until the transactions are posted.

Note: 
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• If you use a second, separate Analytical Ledger (as is traditional in some European countries), the
journal posting process is significantly different.

For more information, see About Analytical Accounting on page 233.

• You must define a fiscal year for each transaction that is posted to the journal.

1 Open the Journal Entries form.

2 Select the journal having transactions you want to post,

3 Select Actions > Filter > Execute in Place.

4 Select Actions > Post Journal.

The system displays the Ledger Posting for Journal form.

5 To compress the journal before posting it, select the Compress Journal Before Post check box,
and then select the Compression Level (Reporting Unit or Account).

Caution:  If you select this check box, the journal entries will be combined by account and then
totaled. The detail will be deleted prior to posting. You will also lose any journal control number
information.

6 To have the system delete the transactions from the journal after they have been posted, select
the Delete Transactions After Post check box.

Note:  If you are posting a distribution journal, you must select this check box.

7 In the Reversing Transaction Date field, select the date to assign to reversing transactions, or
accept the default value, which is the current date.

8 To assign the same date to all the posted transactions, select the Single Date To All Entries
check box. Then, in the Date For All Transactions field, enter the date to assign to them.

9 In the Post Through field, enter the date through which to post transactions.

10 To print the report, click Process.

The Print option is automatically selected. You must first print the posting report for auditing
purposes before you can actually post the transactions. This report provides a listing of the
transactions associated with the journal you are going to post.

11 You are prompted to print the report; click OK.

The system goes through every journal transaction and validates it. For each transaction, it verifies
that the transaction's account number exists in the Chart of Accounts. If the account number does
not exist, a message displays.

If this message occurs, go to the General Journal, and either delete the transaction or add the
missing account number. Then, try again to post the journal. Note that you cannot delete or update
transactions in the AP Dist, AR Dist, BNK Dist, CO Dist, FA Dist, FS Dist, IC Dist, Multi-Site, PC
Dist, PO Dist, PR Dist, SF Dist, and WC Dist journals.

After all the transactions are checked, warning messages may display about transaction balances
or missing accounts. If the only error received is a warning that the date was out of the current
period, you may proceed.

12 After you view and verify the report, select Commit and click Process to post the journal.

13 You are prompted to perform the ledger posting; click OK. These processing steps occur:

• Each transaction is copied to the ledger, along with its descriptive text. For a reversing journal
transaction, the reversing ledger transaction is posted.
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• Journal control numbers are converted to ledger control numbers.

Caution:  If you compress the journal, journal control numbers will be deleted.

• If you elected to delete journal transactions after posting them, the transactions are deleted at
this time.

• After posting is complete, a message displays if the system experienced problems finding
every journal transaction or creating the new ledger transactions.

• If you use the External Financial Interface, additional processing occurs during journal posting.

For more information, see Setting Up an External Financial Interface on page 183.

Performing Mass Journal Posting
Use the Mass Journal Posting form to post transactions from one or more journals to the ledger.

Optionally, you can choose to post system journals using the Background Queue by selecting the Post
In Background Queue check box on this form. The system activates the Background option on the
Actions menu when this check box is selected. You must select at least one system journal and then
specify the background task options. The journals are locked as part of the posting process run in the
background. After the selected system journals are posted, if there are any errors, a Mass Journal
Posting Background Message report shows the error messages.

Caution:  If you have transactions that are out of the current period but elect to post them, mass
journal posting does not prohibit you from doing so. Make sure that the Post Through date is correct.
The out of period warning displays only after all posting is complete.

For each journal you want to post, select the Post check box. You can select the Post check box for
journals with a status of To Print or To Post at any time. For journals with other statuses, you must first
select the Post In Background Queue check box.

Note:  When you select a journal to post, journal locking is activated. Clearing a journal's selection in
the Post column deactivates journal locking for it.
• To compress the journal before posting it, select the Compress Journal Before Post check box,

and then select the Compression Level (Reporting Unit or Account).

Caution:  If you select this check box, the journal entries will be combined by account and then
totaled. The detail will be deleted prior to posting. You will also lose any journal control number
information.

• To have the system delete the transactions from the journal after they have been posted, select
the Delete Transactions After Post check box.
Note:  If you are posting a distribution journal, you must select this check box.

• In the Reversing Transaction Date field, select the date to assign to reversing transactions, or
accept the default value, which is the current date.

• To assign the same date to all the posted transactions, select the Single Date To All Entries
check box. Then, in the Date For All Transactions field, enter the date to assign to them.

• In the Post Through field, enter the date through which to post transactions.
• To print the report, click Process.

Infor SyteLine Financials User Guide | 223

 

Journals



The Print option is automatically selected. You must first print the posting report for auditing
purposes before you can actually post the transactions. This report provides a listing of the
transactions associated with the journal you are going to post.

• You are prompted to print the report; click OK.
• After you view and verify the report, select Commit and click Process to post the journal.

Note:  The posting process will not stop if errors are encountered. All selected journals are posted
before the error messages display. Therefore, you do not have to sit and watch the posting process;
it will complete on its own. When finished, any errors display on a journal-by-journal basis.

Purging a Journal
To delete journal transaction records, use the Purge Journals utility.

1 Enter information in these fields:

• Journal: Select the journal you want to purge.
• Cutoff Date: Enter the last date of transactions you want to include in the purging action.

Note:  You can purge only one journal at a time.

2 Select Process.

Using the Journal Builder
Use the Journal Builder form to enter site-specific pending journal transactions, which are then
validated and created in the Multi-Site journal at the specified site.

1 Set up rules for the Journal Builder replication category on the Replication Rules form:

• Create rules from the Journal Builder site to all remote sites into which pending Multi-Site
journal transactions will be inserted.

• Create rules from those remote sites back to the Journal Builder site.

2 Log into the site where pending Multi-Site journal transactions will be entered and open the Journal
Builder form.

3 Enter a transaction date that is valid for the local site.

4 Enter site-specific journal transactions.

5 When all the transactions are entered and the amounts in the Debit and Credit total fields in the
header are balanced, click Process.

If validation is successful, a success message displays, which contains the control number generated
by the Journal Builder utility. The pending journal transactions are then inserted in the Multi-Site
Journal in the specified site(s) and a success message displays . The transactions have a batch
control number that includes the site ID of the Journal Builder site, for audit purposes.

If validation is not successful:
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• If the To Site is the local site, or if replication is transactional from the local site to the remote
site, the system returns an error and no transactions are processed.

• If the To Site is not the local site AND if replication is non-transactional, failures must be handled
at the remote site. The local site will be unaware that an error occurred. For more information,
see the note below about non-transactional replication.

Notes:

• Journal Builder use at an entity, or to enter transactions to be inserted at an entity, is not supported.
• Transactions can be entered only for sites that use the same domestic currency as the local Journal

Builder site.
• When you close the Journal Builder form, any unprocessed rows are removed.
• The control number is based on the site where the pending journal entries are entered through the

Journal Builder, so all the transactions in one batch have the same control number.
• Non-transactional replication: If processing is non-transactional and fails for some reason at a

remote site, the entire transaction will not be backed out. Successful journal entries will be inserted
and reside in the Multi-Site journal. Unsuccessful journal entries will be handled in the same way
as any other "failed" process for non-transactional setups. This could result in a Multi-Site journal
with transactions where the Total Debits do not equal the Total Credits until the error is resolved.

Recalculating Journal Balances
The Recalculate Journal Balances utility recalculates the accumulated debit and credit balances of
all transactions for a specific journal and date range. If an imbalance exists, the system generates a
new transaction to bring the journal back into balance.

Note: 
• After running this utility, you must run the Journal Transactions utility to complete the transactions

that were created to balance the journals.
• You can recalculate only one journal at a time.

1 Enter information in the following fields:

• Journal ID: Enter the journal ID you want to recalculate.
• Starting and Ending Transaction Date: Enter the range of dates for which you want to recalculate

transactions.
• Transaction Date: (Optional) Enter the date you want to use for any transactions that are

created by this utility. Note that if you do not enter a date, you will be prompted to enter one
when you use the Journal Transactions utility to update the transactions.

2 To process your selections, click Process.

At most, the system creates one transaction.
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Chapter 10: Invoice Builder

Invoice Builder Overview
Use the Invoice Builder form to create invoices and credit memos for the base site and other target
sites for customer order shipments and returns.

With the Invoice Builder form, you can:

• Generate invoices and credit memos across a multi-site intranet. Invoices and credit memos
generated by the Invoice Builder form are only from shipped and returned customer order
lines/releases. The invoices and credit memos are generated based on the target site configurations
such as invoice numbering, currency code, etc.

• Print and reprint invoices and credit memos across a multi-site intranet.

You can perform these tasks for both the base site (login site) and the target site (a different site within
the same multi-site intranet). For other sites, if the site domestic currency is different from the base
site, or if the customer currency code of this site is different from the customer currency code of the
base site, the customer order lines/releases are not displayed in Invoice Builder.

What Happens When You Use This Form

Using this form affects what you can do on other forms:

• Builder Invoice Originating Site field is available on these forms: AR Payment Distributions,
AR Posted Transactions Detail, Invoice, Debit and Credit Memos, and Invoices, Debit and
Credit Memos G/L Distribution.

• Builder Invoice field is available on these forms: AR Payment Distributions, AR Posted
Transactions Detail, Invoice, Debit and Credit Memos, Invoices, Debit and Credit Memos
G/L Distribution, Multi-Site Invoice Posting, and Invoice Transaction Report .

Using the Invoice Builder
The Invoice Builder is a form that allows you to generate and print invoices for CO shipments and
returns in multiple target sites from a base site crossing a multi-site intranet.

Prerequisite setup:

• If desired, specify a builder invoice prefix on the Order Entry Parameters form.
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• Set up rules on the Replication Rules form for the Invoice Builder category. The Invoice Builder
base site (login site) and the target sites must all be replicating the Invoice Builder replication
category to each other.

To generate and print an invoice or credit memo with the Invoice Builder:

1 On the Invoice Builder form, specify a customer in the Customer field. If you leave the field blank,
all customers are returned.

2 In the Type field, specify Invoice or Credit Memo. If you choose Invoice, shipped but not
invoiced customer order lines/releases are displayed. If you choose Credit Memo, returned but not
invoiced customer order lines/releases are displayed.

3 In the Invoice Type group box, select the options for the types of invoices you want to include.

4 You can use the grid to make selections, or use the Additional Selection tab to make selections
for a larger number of records. If you use the Additional Selection tab, click the Select Matching
CO button to see the desired selections in the grid.

5 Use thePrint tab to customize further. You can also set reprint criteria on this tab.

6 Click Process.
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Chapter 11: Ledgers

General Ledger Overview
The General Ledger tracks financial expenditures within the company and generates financial statements
and reports for management, auditors, and investors. The General Ledger is tied to other parts of the
system through the Chart of Accounts and the distribution journals.

Some European countries add a separate Analytical Accounting system to track revenue and expense
accounts.

The Chart of Accounts form defines account numbers used throughout the system to record, track,
and report costs. An account in the General Ledger tracks domestic currency spent or earned by
business activities, such as paying bills, receiving payments, cutting payroll checks, purchasing and
receiving supplies from vendors, paying rent, and material and job transactions.

Financial information collected during day-to-day operations is posted frequently to distribution journals.
Once their accuracy can be verified, the transactions are posted to the General Ledger at regular
intervals. These are the distribution journals:

• Accounts Receivable
• Accounts Payable
• Fixed Assets
• Inventory
• Multi-Site
• Payroll
• Purchasing
• Order Entry
• Shop Floor Control
• Work Center
• Currency Banking Journal
• Project Control.

In addition to the distribution journals, there is a General journal that you can use to hold closeout and
summary entries for year-end procedures.

You can also create user-defined journals - custom journals to store, retrieve, and track entries specific
to your business. Examples include Accruals, Reversing Entries, Adjusting Entries, Intercompany
Eliminations, Banking Transfers, Charges, and Credit.

Four unit codes on page 316 can be activated for each account in the Chart of Accounts, to collect key
management data. You can define unit codes to track those costs important to your business, such as
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sales territory, individual sales representative, product or product family, location of manufacture, work
center, cost center, and department.

Benefits of the General Ledger include:

• Provides detailed financial statements/reports.
• Maintains complete journal and ledger transaction details.
• Allows detailed or summarized account information.
• Provides a bank reconciliation feature.
• Maintains all journal transactions in edit list form prior to posting to General Ledger.
• Provides the ability to report prior or future years with budgeting and planning comparisons for

current year.
• Provides complete support for multi-site financial reporting, including financial consolidations.
• Distributes an expense among more than one account according to allocation rules. For example,

you can divide a monthly office lease payment among the departments sharing the building quarters.
For more information, see Setting up Account Allocations on page 275.

• Automates the process of storing and posting recurring entries by using recurring journals. Simply
create an entry once for each recurring expense, and the system automatically enters the transaction
into the general ledger each period.

• Provides flexibility so you can decide when and how to handle month-end closes. And you can
begin entering next month's business transactions even before the current month has completely
closed.

• Calculates retained earnings for the fiscal year at year-end closing.
• Provides statistical accounts in financial statements to compare important non-financial data to

related financial data for measuring such things as productivity and controlling costs.
• Offers a financial statement capability, which presents financial information from the General Ledger

in a variety of formats to meet requirements of auditors, investors, and managers.

General Ledger Setup
Before you can begin processing in the General Ledger (G/L), you must set up some basic accounting
 information.

See these topics for details:

• Setting Up Accounting Periods on page 229
• Setting Up the Chart of Accounts on page 230
• Setting Up Beginning Account Balances on page 231

Setting Up Accounting Periods
Set up the accounting periods that are used by General Ledger for a particular fiscal year using the
Accounting Periods form. Accounting periods are used only to visually group transactions.

Note: 
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• You must set up these accounting periods before transactions can be posted.
• You cannot delete an accounting period if ledger transactions exist for that period in the fiscal year.

To set up accounting periods:

1 Open the Accounting Periods form.

2 In the Fiscal Year field, enter the year for which you want to add or change periods.

3 Click the Filter-in-Place button.

4 Select the desired period in the fiscal year.

5 (Optional) Set the fiscal year start date.

Note:  By default, the Start Date field for the first period is set to the first day of the fiscal year, but
you can change it.

6 Do one of the following:

• To have the system create the accounting periods in monthly increments, select the Monthly
option and then click Generate Period. The system automatically updates the period starting
and ending dates.

• To have the system create the accounting periods in quarterly increments, select the Quarterly
option and then click Generate Period. The system automatically updates the period starting
and ending dates. Each period is three months long.

• To create custom periods, manually enter the starting and ending dates of each accounting
period in the fiscal year.

7 Select Actions > Save.

To generate the control number sequence by period or by year, use the Accounting Period Control
Number Sequences form.

Setting Up the Chart of Accounts
To set up and maintain all the accounts that are used throughout the system, use the Chart of Accounts
form.

Before setting up the Chart of Accounts, you need to define the structure of the accounts, grouped by
account type (asset, liability, expense, and so on), and assign logical account numbers to them.

For more information, see About Accounts on page 11.

To add an account:

1 Open the Chart of Accounts form.

2 Select Actions > New.

3 In the Account field, enter the account identifier for the account you are adding.

4 In the field to the right of the Account field, enter the description of the account for reference.

5 From the Account Type drop-down list, select the account type.

Note:  If you select Allocation, you must also enter an allocation for it on the Chart of Account
Allocations form.

6 In the Effective Date field, select the date you want the account to become active.
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7 If you no longer want to use the account after a particular date, select that date in the Obsolete
Date field. Otherwise, leave this field blank.

8 In the Unit Code 1-4 fields, select one of these options:

• No Access: The reporting unit field will not be accessible for this account. The system also
disables the corresponding Unit Code tab on the form.

• Accessible: The reporting unit field will be accessible for this account.
• Required: The reporting unit field is required for this account.

9 If the financial entity reports to another financial entity, select either Buying or Selling as the
Exchange Rate Type. Then, select the number of the account to which this account reports in the
other financial entity, and the currency translation method.

10 To save the account, select Actions > Save.

Setting Up Beginning Account Balances
When applicable, enter the beginning balances for your accounts. To enter beginning balances for
accounts:

1 Open the Journal Entries form.

2 In the Journal field, select General.

3 Click the filter-in-place button.

4 Select Actions > New.

5 Create an entry on page 217 for the first account's beginning balance. In the Reference field, enter
Beginning Balance.

6 Repeat steps 4 and 5 for each account for which you need to enter a beginning balance.

Note:  You cannot post unless the debit amount equals the credit amount for each period.

General Ledger Steps
Before any General Ledger processing can be performed, you must set up the Chart of Accounts, enter
beginning account balances, and define your accounting periods. For more information, see the General
Ledger Setup topic.

Closing the Year for General Ledger on page 236

Copying Ledger Balances into Budgets/Plans on page 237

Creating and Maintaining Budgets and Plans on page 16

Setting up Account Allocations on page 275

Creating and Posting Recurring Journal Entries on page 216

Creating a User-Defined Journal on page 215
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Creating Auto-Reversing Transactions on page 216

Creating Journal Entries for a User-Defined Journal on page 217

Deleting a User-Defined Journal on page 218

Identifying Missing Information in a Journal on page 221

Monitoring financial data on the Controller Home form

Posting a Journal on page 221

Preparing a Bank Reconciliation on page 75

Printing a Financial Statement on page 194

Creating Statistical Accounts on page 17

Note:  Before printing a financial statement, you must have already defined its header, columns and
lines, as applicable. For more information, see Financial Statement Setup on page 192.

Purging a Journal on page 224

Recalculating Journal Balances on page 225

Using the Journal Builder to Enter Site-Specific Journal Transactions on page 224

Note:  If you use a second, separate Analytical Ledger (as is traditional in some European countries),
see About Analytical Accounting on page 233 for more information.

About Accounting Periods
While General Ledger does not post summarized information to the financial period buckets, complete
detail of the transactions is maintained. Accounting periods are for visually grouping transactions only,
and must be set up on the Accounting Periods form before transaction posting is processed.

The accounting periods are used to group the following financial data by date:

• Budgets & Plans
• G/L Transactions
• Journal Transactions
• G/L Compression
• G/L Posting
• Financial Statement Reports
• Account Balances

Various General Ledger functions access the accounting period dates. In these functions, either the
system prompts for the dates or the system uses current period's dates. You are responsible for
maintaining the current period number.

Note:  The period record does not need to exist in the subordinate site for updates to take place in a
financial entity. This is because both sites and financial entities are allowed to delete periods, and the
financial entity may have a period record that one of its subordinate sites does not.
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Sites that report to financial entities cannot add or do the Monthly Update or Quarterly Update activities.
They can only update the current period, delete the period record, or do the Current Period Update
activity.

About Analytical Accounting
When you activate Analytical Accounting by selecting the Use Analytical Ledger check box on the
General Parameters form, the system changes its journal posting and reporting mechanisms in
important ways to support the second accounting system.

Posting

These read-only journals always post to the General Ledger:

• AP Dist - Accounts Payable Ledger Distribution
• AR Dist - Accounts Receivable Ledger Distribution
• BNK Dist - Banking Distribution
• FA Dist - Fixed Assets Ledger Distribution
• FS Dist - Service Distribution
• PR Dist - Payroll Ledger Distribution

These read-only journals always post to the Analytical Ledger:

• CO Dist - Order Entry Ledger Distribution
• IC Dist - Inventory Control Ledger Distribution
• PC Dist - Project Control Ledger Distribution
• PO Dist - Purchasing Ledger Distribution
• SF Dist - Shop Floor Control Ledger Distribution
• WC Dist - Work Center Ledger Distribution

User-defined journals post to the Analytical Ledger if the Analytical Ledger field is selected. If this
check box is cleared, they post to the General Ledger.

You can display transactions posted to the Analytical Ledger using the A/L Posted Transactions form.
You can obtain more detailed information by framing searches using the A/L Posted Transactions
Query utility.

Caution:  The system does not post an analytical account or journal to the General Ledger and does
not post a non-analytical account or journal to the Analytical Ledger. It is important that you carefully
define all default accounts so that analytical accounts do not post to journals that will later post to the
General Ledger, and non-analytical accounts do not post to journals that will later post to the Analytical
Ledger. For more information, see Analytical Ledger Setup on page 235.
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Reporting

Several General Ledger reports have been modified so that they can track information from the Analytical
Ledger when you select the Analytical Ledger field. They are:

• Trial Balance
• General Ledger
• General Ledger Check Information Report
• General Ledger Transaction Report

Printing Financial Statements

Use the Financial Statement Definition form to print all financial statements. If you want the statement
to reflect data in the Analytical Ledger, select the Analytical check box.

Multi-Site

You can use a separate Analytical Ledger in a multi-site environment, but the Analytical Ledger itself
is not consolidated.

The Chart of Accounts is created at the entity level and is automatically copied to all sites reporting to
the entity.

The General Ledger is created at the site level. A map allows the General Ledgers of several sites to
be consolidated to create a single financial statement at the entity level.

The Analytical Ledger may be created at either the entity or the site level, but is never consolidated.
Some sites may use Analytical Ledgers, while other sites do not. If the Analytical Ledger is created at
the entity level, the analytical accounts (Type Y) must be copied only to sites where the Use Analytical
Ledger check box is selected on the General Parameters form.

Budget consolidation transaction takes place at the site level and should not be consolidated for
analytical accounts.

Other

The following system functions support the Analytical Ledger:

• Compress General Ledger Transactions Utility
• Chart of Accounts - Budgets and Plan
• Copy Balances to Budgets
• Year-End Procedure Utility
• Rebalance Ledger Period Totals
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Analytical Ledger Setup
Some European countries traditionally use two accounting systems, one which posts to the General
Ledger and a second which posts to a separate Analytical Ledger. You can set up an analytical
accounting system to track expense and revenue accounts.

To set up an Analytical Ledger:

1 Open the General Parameters form and:

• Select the General tab.
• Select the Use Analytical Ledger check box.
• Save the form.

When you select this field, the system creates a separate Analytical Ledger and changes its
journal posting and reporting mechanisms in important ways to support the second accounting
system.

2 Open the Chart Of Accounts form.

Select Analytical in the Account Type field for each new account.

3 For each of the following forms and fields, enter an analytical account:

Note:  A labeled account field consists of a drop-down list that allows you to select the desired
account number. For example, on the Project Parameters form, Default tab, the first labeled
account field is Material.
• Project Parameters form, Default tab, all labeled account fields
• Purchasing Parameters form, Accounts tab, all labeled account fields
• Product Codes form, all tabs except the General tab, all labeled account fields
• Distribution Accounts form, all tabs, all labeled account fields
• End User Types form, Cost Of Goods Sold tab, all labeled account fields
• Employees form, General tab, Wage Acct field
• Departments form:

• Direct Labor Applied Acct field
• Fixed Ovhd Applied Acct field
• Var Ovhd Applied Acct field

• Indirect Labor Codes form, Wage Acct field
• Work Centers form, Costing tab:

• Fix Mach Ovhd Applied Acct field
• Var Mach Ovhd Applied Acct field

• Accounts Payable Parameters form, Misc tab:
• A/P Suspense field
• A/P Unmatched field
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Closing the Year for General Ledger
Caution:  This procedure creates debit and credit entries to close out all revenue and expense
accounts for the date range specified. These entries are placed in the General Journal. You must
then post the General Journal to the General Ledger.

Note: 
• This procedure should be run only after all entries made to the fiscal year are posted.
• To close the journal, it must be a writable journal.

To close the year for the General Ledger:

1 On the Year End Closing Journal Entries form, select the general journal to close.

2 In the Income Summary Account field, select the "Retained Earnings" account for the year end
closing transaction. The account's type must be set up in the Chart of Accounts as Owner's Equity.

3 (Optional) Change the Fiscal Year Start Date and Fiscal Year End Date.

4 To have the system first delete all journal entries for this journal before generating the year-end
transactions, select the Delete Current Journal Entries check box.

This refers to the existing entries in the General Journal only. Do not change any of the references
generated by the system on the entries in the General Journal. If this check box is selected, all
journal transactions along with any associated text are deleted when the transactions are generated,
prior to creating the closing transactions.

5 To have the system clear the unit code balances in the revenue and expense accounts as well,
select the Unit Code Detail check box.

Clearing this check box leaves the balances in the unit codes, and carries them forward.

6 Click Process.

Note:  You can close fiscal years an unlimited number of times. If you have closed the fiscal year and
need to enter transactions for that year, you can post the transactions and then run the year-end close
again.

Suppose the following entries were the financial activity for a company for the fiscal year of January 1
to December 31 using the following accounts:

DescriptionAccount

Assets10000

Liabilities20000

Owner's equity30000

Revenue40000

Expense50000

Example of Ending Balances on December 31:

BalanceAccount

100,000.0010000
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BalanceAccount

(64,500.00)20000

(20,000.00)30000

(23,500.00)40000

8,000.0050000

Example of Year End Entries:

BalanceAccount

15,500.0030000

23,500.0040000

(8,000.00)50000

Example of Ending Balance on December 31 after Year End Balance:

BalanceAccount

100,000.0010000

(64,500.00)20000

(35,500.00)30000

0040000

0050000

No entries were generated for Accounts Receivable of Cash, because they are asset accounts. Only
revenue and expense accounts are closed out.

Copying Ledger Balances into Budgets/Plans
You can copy ledger balances to account budget or plan amounts of another fiscal year, using the
Copy Balances to Budgets or Multi-FSB Copy Balances to Budgets activity. You can then view
the results with the Chart of Accounts Budget and Plan or Multi-FSB Chart of Accounts Budget
and Plan form.

1 Open the Copy Balances to Budgets form.

2 In the Account Types group box, select the check box of each type of account of the balances
you want to copy. Options include:

• Asset
• Liability
• Owner's Equity
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• Revenue
• Expense
• Analytical

Note:  The Analytical check box is available for standard GL ledger balances only if the Use
Analytical Ledger check box is selected on the General Parameters form. It is not available for
multi-FSB ledger balances.

3 In the Fiscal Year From field, the prior fiscal year displays by default, but you can select a different
year from which to copy the budget/plan information.

4 In the Fiscal Year To field, the current fiscal year displays by default, but you can select a different
year to which to copy the budget/plan information.

5 Select the type of information you want to copy to: Budget or Plan.

6 In the Starting and Ending Account fields, select the range of accounts for the budget/plan
information you want to copy, or leave both fields blank to copy the information of all accounts for
the selected account types.

7 In the Starting and Ending Unit 1-4 fields, select the range of reporting units you want to include
in the activity.

8 Click Process.

Deleting a Ledger Transaction
You cannot delete a ledger transaction directly. To delete a transaction:

1 Enter a journal transaction for the opposite amount and the same date as the transaction to delete.

2 Post that transaction to the ledger to cancel out the previous transaction.

3 Use the Compress General Ledger Transactions utility to compress the general ledger.

Note: 

If you have deleted material transactions, any Ledger or Journal records that reference them will have
their references cleared. If you try to view detail on a ledger or journal and the specific material
transaction has been deleted, you will be told the record is not available.

FASB 52 Overview
This topic describes the Financial Accounting Standards Board 52 (FASB 52) standards.
Note:  This adjustment is necessary only when all of these conditions are true:
• The ledger is consolidated in a multi-site setup with an entity's domestic currency different from

the parent entity's domestic currency.
• Different account types are posted with different translation methods.
• The exchange rates vary.
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This process automatically adjusts for the Financial Accounting Standards Board 52 (FASB 52)
requirement after the Ledger has been consolidated. Adjustments occur to:

• Asset and Liability accounts that use currency translation method of End.
• Owner's Equity accounts that use currency translation method of Spot.
• Revenue and Expense accounts that use currency translation method of Average.
• An out-of-balance ledger due to different account types having different currency translation

methods.

Throughout the year, asset and liability accounts are posted to the ledger based on the End currency
translation method, and owner's equity accounts are posted to the ledger based on the Spot currency
translation method. As the currency rates fluctuate, the totals for the balance sheet accounts should
also fluctuate. The system creates a new ledger entry to the balance sheet accounts to manage these
fluctuations. The system also creates a new ledger entry to the CTA account to ensure the ledger
balances.

Expense and revenue accounts use the Average currency translation method. Due to this, the same
amount in a balanced site journal can be rolled up to two different amounts. So, a new ledger entry is
created to balance out the "Corp" entity ledger.

On the Ledger Consolidation form, if the Year End check box is selected, the system posts expense
and revenue accounts to the ledger based on the Average currency translation method at the time of
the posting. As the currency rates fluctuate, these accounts' totals should also fluctuate. The system
creates new ledger entries to the following accounts:

• Asset and liability accounts, to adjust for the fluctuation.
• The CTA account, to ensure the ledger balances.

Order of Events:

1 Post the journal. See Posting the journal on page 221.
2 Run Ledger Consolidation.
3 Run Year-End Closing Journal Entries.
4 Post the journal.
5 Run Ledger Consolidation.

Posting to General Ledger - Actual Costing
This topic describes in detail the posting of inventory transactions to the General Ledger (GL) module.
All transactions processed in the Customer, Material, Vendor, and Production modules that affect the
value of inventory are posted to the appropriate inventory distribution journal (CO Dist, IC Dist, PO
Dist, and SF Dist, respectively) using account numbers that can be found in the Product Codes,
Departments, Purchasing Parameters, and Distribution Accounts forms.

See Actual Costing: Transactions Posting to Inventory Distribution Journals on page 242 for a list of the
transactions.
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Actual Costing - Post to Journals

The system uses the same GL account numbers when posting to the appropriate inventory distribution
journal, no matter which of the four actual cost flow methods is in use (Average, LIFO, FIFO, Specific).
For this reason, the transactions outlined below are for actual costing in general.

The phrase "issue cost" is used several times in this topic to refer to the cost at which an item is being
issued from inventory. The issue cost value varies depending on the cost flow method in use.

General Ledger Account Numbers Used

Before processing any transactions in the manufacturing modules, the GL account numbers which are
used for posting to the GL inventory distribution journals must be set up. The key accounts are stored
at the Product Code level, so that different account numbers may be assigned to different classifications
of items and also allow for the tracking of cost details of a unit cost.

Maintaining individual accounts for the various cost details allows visibility of these costs through work
in process, inventory and cost of goods sold and more accurately determines the exposure relating to
material, labor, fixed overhead, variable overhead and outside service costs. It is also possible to use
one account number for all the cost detail components of an item if this cost detail visibility is not desired.

Example - Maintaining Individual Account Numbers for Each Cost Detail Component

A finished goods inventory account number and a raw materials inventory account number may be
used rather than having all items posted to the same inventory account.

Account NumberFinished Goods Account

1001FG INV Material Cost

1002FG INV Labor Cost

1003FG INV Fixed Overhead Cost

1004FG INV Variable Overhead Cost

1005FG INV Outside Service Cost

Account NumberRaw Materials Account

2001RM INV Material Cost

2002RM INV Labor Cost

2003RM INV Fixed Overhead Cost

2004RM INV Variable Overhead Cost

2005RM INV Outside Service Cost

These accounts may be used rather than having all items posted to the same inventory account.
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Example - Maintaining One Account Number for All Cost Detail Components of Finished Goods
Inventory and Raw Materials Inventory

Account NumberFinished Goods Inventory Account

1001FG INV Material Cost

1001Labor Fixed Overhead Cost

1001Variable FG INV Outside Service Cost

Account NumberRaw Materials Inventory Account

2001RM INV Material Cost

2001Labor Cost

2001Fixed Overhead Cost

2001Variable RM INV Outside Service Cost

Accounts List

The following lists identify the accounts found in the Product Codes, Departments, Purchasing
Parameters, Work Centers, and Distribution Accounts forms.

Product Codes:

• Inventory Adjustment
• Material Fixed Overhead Applied
• Material Variable Overhead Applied
Note:  The Material Fixed Overhead Applied and the Material Variable Overhead Applied accounts
are required only when basing overhead on job material issues.

Purchasing Parameters:

• Vouchers Payable Account
• Department
• Direct Labor Applied Account
• Fixed Overhead Applied Account
• Variable Overhead Applied Account

Although these rates default from this location, they are also maintainable on the Current Operations,
Job Operations, and Estimate Operations forms.

Work Center - Costing:

• Fixed Machine Overhead Applied Account
• Variable Machine Overhead Applied Account

Although these rates default from this location, they are also maintainable at the Current Operations,
Job Operations, and Estimate Operation forms.

Distribution Accounts - Inventory:

• Inventory Material
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• Inventory Labor
• Inventory Fixed Overhead
• Inventory Variable Overhead
• Inventory Outside

Distribution Accounts - Sales/Cost of Goods Sold:

• COGS Material
• COGS Labor
• COGS Fixed Overhead
• COGS Variable Overhead
• COGS Outside

Distribution Accounts - In-Transit:

• In-Transit Material
• In-Transit Labor
• In-Transit Fixed Overhead
• In-Transit Variable Overhead
• In-Transit Outside
Note:  You can delete any distribution account record, including the default distribution account, with
a blank warehouse and blank product code.

The inventory account numbers used for journal transactions do not come directly from the Product
Codes form. Rather, the inventory accounts used come from the stock location being accessed when
the transaction is performed. (When a stock location is added for an item in the Inventory module,
inventory accounts are entered for the location, using the Item Stockroom Location form.) The default
for this field is the inventory account numbers in the Distribution Account file to which the item belongs.

These steps are taken in the system to locate the inventory account numbers:

• The system searches for an exact match for both the warehouse and the product code.
• If that fails, the system searches for a match for the product code and a blank warehouse.
• If that fails, the system searches for a match for the warehouse and a blank product code.

If any of the account numbers the system is attempting to use have not been set up, the system does
not post to the GL inventory distribution journals.

Actual Costing: Transactions Posting to Inventory
Distribution Journals
The following subsections outline every transaction that is posted to the inventory distribution journals
when some method of actual costing is being used.

Because the costs and account numbers used for the journal posting are quite different if using standard
costing or one of the four actual cost flow methods, the transactions generated are explained for both
standard and actual. If the system should not automatically generate these transactions, clear the
General Parameters form's Post to Journal check box.
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See Posting to General Ledger - Actual Costing on page 239 for more information.

Purchasing Transactions

The following transactions are posted to the inventory distribution journal named PO Dist.

• Purchase Order Receipt:

CreditDebitTransaction

 xxxxInventory Material

xxxx Vouchers Payable

Because this item is purchased, only one posting (Inventory Material Cost) is applicable. All accounts
for each cost details component would have the same account number, therefore only one posting
entry is made.

The cost used is the quantity received multiplied by the purchase order line item unit cost. (This is
the default cost. At the time of receipt, it is possible for you to update the receipt cost to anything.)

CU = (RQ * POUC)

where:

• CU = Cost Used
• RQ = Receipt Quantity
• POUC = PO Unit Cost

• Purchase Order Return:

CreditDebitTransaction

xxxx Vouchers Payable

xxxx Inventory

xxxxxxxx   orInventory Adjustment

The cost used is the quantity returned multiplied by the item's issue cost:

CU = (QR * IIC)

where:

• CU = Cost Used
• QR = Quantity Returned
• IIC = Item's Issue Cost

• Voucher Generation:

Transaction

a. If vouchered cost > receipt cost:

Vouchers Payable

Accounts Payable

b. If vouchered cost < receipt cost:

Vouchers Payable

Inventory Adjustment
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Accounts Payable

The previous transaction is created only if any line items were vouchered at a different cost than
the cost at which they were received into inventory. (The cost at which the items were received
into inventory is the line item unit cost field at the time of the receipt.)

xxxx = (quantity received * (vouchered cost - receipt cost))

xxxx = (cost of receipt - cost of voucher) - adjustment

POVC = QR * (VC - RC)

where:

• POVC = Purchase Order Variance Cost
• QR = Quantity Received
• VC = Voucher Cost
• RC = Receipt Cost

Production Transactions

The following transactions are posted to the inventory distribution journal named SF Dist.

• Job Material Issue:

CreditDebitTransaction

 xxxxWIP Material Costs

 xxxxWIP Labor Costs

 xxxxWIP Fixed Overhead Costs

 xxxxWIP Variable Overhead Costs

 xxxxWIP Outside Costs

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

xxxx Fixed Material Overhead Applied

xxxx Variable Material Overhead Applied

The inventory accounts used are those of the item being issued to the job, not the item being
manufactured. The inventory credit amount is the quantity issued from inventory multiplied by the
issue cost of the item.

ICA = QIFI * IC

where:'

• ICA = Inventory Credit Amount
• QIFI = Quantity Issued from Inventory
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• IC = Issue Cost

The credits to the overhead accounts are calculated by multiplying the actual material cost by the
fixed and variable overhead rates in the Product Codes form.

COA = MC * (FO + VOR)

where:

• COA = Credits to the Overhead Account
• MC = Material Cost
• FO = Fixed Overhead
• VOR = Variable Overhead Rate

The debit to WIP is the sum of the direct material, fixed overhead, and variable overhead amounts.

DTWIP = DM + FO + VOA

where:

• DTWIP = Debit to WIP
• DM = Direct Material
• FO = Fixed Overhead
• VOA = Variable Overhead Amounts

• Job Material Withdrawal:

CreditDebitTransaction

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx WIP Material Costs

xxxx WIP Labor Costs

xxxx WIP Fixed Overhead Costs

xxxx WIP Variable Overhead Costs

xxxx WIP Outside Costs

 xxxxFixed Material Overhead Applied

 xxxxVariable Material Overhead Applied

The debit to inventory is the quantity of the item withdrawn from the job multiplied by a unit cost
figure which varies depending on the costing method in use.

DTI = QIWJ * VUCF

where:

• DTI = Debit to Inventory
• QIWJ = Quantity of the Item Withdrawn from the Job
• UCF = Unit Cost Figure
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The debits to the overhead accounts are calculated by multiplying the average cost of all items
issued. The job material total actual cost/job material quantity issued.

DOA = MT / JI

where:

• DOA = Debits to the Overhead Account
• MT = Job Material Total actual cost
• JI = Job material quantity issued

The credit to WIP is the sum of direct material, fixed overhead, and variable overhead amounts.

CTWIP = DM + FO + VOA

where:

• CTWIP = Credit to WIP
• DM = Direct Material
• FO = Fixed Overhead
• VOA = Variable Overhead Amounts
• Post Job Transaction Labor:

CreditDebitTransaction

 xxxxWIP Labor Costs

 xxxxWIP Fixed Overhead Costs

 xxxxWIP Variable Overhead Costs

xxxx Direct Labor Applied

xxxx Fixed Labor Overhead Applied

xxxx Variable Labor Overhead Applied

The credit to labor is the actual hours in the transaction multiplied by the specified manufacturing
rate of the employee who reported the transaction.

CTL = AH * SMR

where:

• CTL = Credit To Labor
• AH = Actual Hours
• SMR = Specified Manufacturing Rate

The credits to the overhead accounts are calculated by multiplying the actual labor hours by the
fixed and variable overhead rates in the Departments form.

COA = LH * (FO + VOR)

where:

• COA = Credits to the Overhead Account
• LH = Labor Hours
• FO = Fixed Overhead
• VOR = Variable Overhead Rate

The debit amount to WIP is the sum of direct labor, fixed overhead, and variable overhead amounts.
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• WIP Amount = (actual hours * employee manufacturing rate) + (actual hours * department
fixed overhead rate) + (actual hours * department variable overhead rate)

• Direct Labor =(actual hours * employee manufacturing rate)
• Fixed Labor Overhead = (actual hours * department fixed overhead rate)
• Variable Labor Overhead = (actual hours * department variable overhead rate)
• Post Job Transactions: Machine transactions

Machine costs apply machine overhead charges to a job operation for the hours a machine was
run, along with the quantity of goods completed, scrapped, and moved to the next operation. If the
work center for the operation is machine scheduled, the remaining scheduling time for the operation
will be reduced by the total hours posted.

The additional posting described below for the "Move" transaction is also performed for all "Run"
transactions.

• Job Finish (Put to Stock):

CreditDebitTransaction

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx WIP Material Costs

xxxx WIP Labor Costs

xxxx WIP Fixed Overhead Costs

xxxx WIP Variable Overhead Costs

xxxx WIP Outside Costs

When inventory is received from a job, the receipt cost used is determined by:

• The Shop Floor Control Parameters form's Costs Based on Complete field.
• The status of the job.
• The Complete flag on the job's operations.

If the receipt is being performed using a labor transaction on the last operation, you have the option
of closing the job order. If the job is closed when the transaction is entered, the receipt cost used
is always the actual unit cost of the job. If the job is not closed and the Costs Based on Complete
parameter is set to Jobs, the receipt cost used is the planned unit cost of the job.

The planned unit cost is based on the setup, run-times, run rates, and labor overhead rates in the
Job Operations form as well as the unit costs and the material overhead rates in the Job Materials
form.

If the job is not closed and the Costs Based on Complete parameter is set to Operations, the
receipt cost used is determined by the Complete flag of the job's operations. Actual costs from
complete operations are accumulated while planned costs from incomplete operations are
accumulated to determine the final receipt cost.
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• Job Closed Manually:

CreditDebitTransaction

  a. If actual cost > planned cost:

 xxxxInventory Adjustment

xxxx WIP Material Costs

xxxx WIP Labor Costs

xxxx WIP Fixed Overhead Costs

xxxx WIP Variable Overhead Costs

xxxx WIP Outside Costs

  b. If actual cost < planned cost:

 xxxxWIP Material Costs

 xxxxWIP Labor Costs

 xxxxWIP Fixed Overhead Costs

 xxxxWIP Variable Overhead Costs

 xxxxWIP Outside Costs

xxxx Inventory Adjustment

If the job is being closed manually by changing the status from Released to Complete an adjustment
needs to be made since the job's planned cost would have been used for the transaction that put
the item to stock.

The amount used is the difference between the total planned and actual cost of the job:

AU = TPC - AC

where:

• AU = Amount Used
• TPC = Total Planned Cost
• AC = Actual Cost

Customer Order Transactions

The following transactions are posted to the inventory distribution journal named CO Dist.

• Customer Order Shipment:

CreditDebitTransaction

 xxxxCOGS Material

 xxxxCOGS Labor

 xxxxCOGS Fixed Overhead

 xxxxCOGS Variable Overhead
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CreditDebitTransaction

 xxxxCOGS Outside

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

The amount used is the quantity shipped multiplied by the issue cost of the item.

AU = QS * ICI

where:

• AU = Amount Used
• QS = Quantity Shipped
• ICI = Issue Cost of the Item

• Customer Order Return:

CreditDebitTransaction

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx COGS Material

xxxx COGS Labor

xxxx COGS Fixed Overhead

xxxx COGS Variable Overhead

xxxx COGS Outside

The amount used is the average value of all shipments.

AU = CST / IQS

where:

AU = Amount Used

CST = Item's Cost of Goods Sold Total

IQS = Item's Quantity Shipped
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Inventory Control Transactions

The following transactions (unless otherwise specified) are posted to the inventory distribution journal
named IC Dist.

• Inventory Adjustment:

CreditDebitTransaction

  a. Increase quantity:

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx Inventory Adjustment

  b. Decrease quantity:

 xxxxInventory Adjustment

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

The amount used for an inventory adjustment transaction varies depending on the cost flow method
in use. If you are using:

• Average costing, the system uses the Items form's unit cost.
• Specific, the system uses the cost tied to the location that is being adjusted.
• LIFO or FIFO and increasing the quantity, the cost used is the cost tied to the last item LIFO

record on file for the item.
• LIFO or FIFO and decreasing the quantity, the system consumes records from the item LIFO

stack until the adjustment quantity is satisfied.

Cycle counting and physical inventory posting create transactions like the ones described above.
Either transaction a or b is created, depending on whether the count quantity is greater than or
less than the original quantity.

• Inventory Move:

CreditDebitTransaction

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead
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CreditDebitTransaction

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

  Inventory Adjustment

This transaction is posted only if the From and To locations have different inventory accounts tied
to them or if specific costing is being used and the From and To locations have different unit costs
tied to them.

The inventory account debited is the account tied to the To location. The credited inventory account
is the account tied to the From location. The inventory adjustment account is used only for specific
costing when the From and To accounts have different costs assigned to them.

• Location Update:

A transaction is created if you change the inventory account tied to the location:

CreditDebitTransaction

  Inventory (New Accounts):

 xxxxInventory Material Cost

 xxxxInventory Labor Cost

 xxxxInventory Fixed Overhead Cost

 xxxxInventory Variable Overhead Cost

 xxxxInventory Outside Cost

  Inventory (Old Accounts):

xxxx Inventory Material Cost

xxxx Inventory Labor Cost

xxxx Inventory Fixed Overhead Cost

xxxx Inventory Variable Overhead Cost

xxxx Inventory Outside Cost

A transaction is also created if specific costing is in use and you change the unit cost tied to the
location.

(This example assumes that all cost detail values are changed.)
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CreditDebitTransaction

  a. Increase cost:

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx Inventory Adjustment

  b. Decrease cost:

 xxxxInventory Adjustment

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

• Location Insertion:

CreditDebitTransaction

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx Inventory Adjustment

This transaction is only posted if a quantity is entered for the location at the same time it is added.

• Miscellaneous Receipt:

CreditDebitTransaction

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

Infor SyteLine Financials User Guide | 252

 

Ledgers



CreditDebitTransaction

xxxx Inventory Adjustment

The debit amount used is the quantity received extended by the unit cost you entered.

DAU = QR * UCEBU

where:

• DAU = Debit Amount Used
• QR = Quantity Received
• UCEBU = Unit Cost Entered by you

The unit cost defaults to the value in the Items form's Unit Cost field at the time the transaction
is entered.

The credit account is the GL account number you entered. The account defaults to the item's
Inventory Adjustment account.

• Miscellaneous Issue:

CreditDebitTransaction

 xxxxAccount Entered

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

The debit account is the GL account number you entered. The account defaults to the item's
Inventory Adjustment account.

The credit amount used is the quantity issued multiplied by the issue cost of the item:

CA = QI * IC

where:

• CA = Credit Amount
• QI = Quantity Issued
• IC = Issue Cost

• Job Material Issue:

The following transactions are posted to the inventory distribution journal named SF Dist.

CreditDebitTransaction

 xxxxWIP Material Costs

 xxxxWIP Labor Costs

 xxxxWIP Fixed Overhead Costs

 xxxxWIP Variable Overhead Costs
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CreditDebitTransaction

 xxxxWIP Outside Costs

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

xxxx Fixed Material Overhead Applied

xxxx Variable Material Overhead Applied

• Job Receipt:

The following transaction(s) are posted to the inventory distribution journal named SF Dist.

CreditDebitTransaction

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

 xxxxFixed Material Overhead Applied

 xxxxVariable Material Overhead Applied

xxxx WIP Material Costs

xxxx WIP Labor Costs

xxxx WIP Fixed Overhead Costs

xxxx WIP Variable Overhead Costs

xxxx WIP Outside Costs

Posting to General Ledger - Standard Costing
The standard costing system posts all transactions that affect the value of inventory to the GL inventory
distribution journals. All transactions are processed using standard costs that have been established
with variances being posted to a series of variance account numbers.

See Standard Costing: Transactions Posting to the Inventory Distribution Journals on page 257.
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General Ledger Account Numbers Used

Before processing any transactions in the manufacturing modules you must set up the GL account
numbers to use for posting to the inventory distribution journals. These account numbers can be found
in the Product Codes, Departments, Purchasing Parameters, and Distribution Accounts forms.

The following list details the accounts you need to set up.

Product Codes - WIP:

• WIP Material
• WIP Labor
• WIP Fixed Overhead
• WIP Variable Overhead
• WIP Outside

Product Codes - Miscellaneous:

Inventory Adjustment

Product Codes - Applied Overhead:

• Material Fixed Overhead Applied
• Material Variable Overhead Applied
Note:  The Material Fixed Overhead Applied and the Material Variable Overhead Applied accounts
are required only when basing overhead on job material issues.

Product Codes - Variance:

• Purchase Cost
• Material Usage
• Routing

Product Codes - Labor Variance:

• Labor Rate
• Labor Usage

Product Codes - Overhead Variance:

• Labor Fixed Overhead Usage
• Labor Variable Overhead Usage
• Material Fixed Overhead Usage
• Material Variable Overhead Usage
• Machine Fixed Overhead Usage
• Machine Variable Overhead Usage
Note:  The Material Fixed Overhead Usage and the Material Variable Overhead Usage accounts are
required only when basing overhead on job material issues.
• Purchasing Parameters
• Vouchers Payable

Departments:

• Direct Labor Applied Account
• Fixed Overhead Applied Account
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• Variable Overhead Applied Account
Note:  The Fixed Overhead Applied and the Variable Overhead Applied accounts are required only
when basing overhead on job labor.

Although these rates default from this location, they are also maintainable at the Current Operations,
Job Operations, and Estimate Operations forms.

Work Centers - Costing:

• Fixed Machine Overhead Applied Account
• Variable Machine Overhead Applied Account

Although these rates default from this location, they are also maintainable at the Current Operations,
Job Operations, and Estimate Operationsforms.

Distribution Accounts - Inventory:

• Inventory
• Inventory Labor
• Inventory Fixed Overhead
• Inventory Variable Overhead
• Inventory Outside

Distribution Accounts - Sales/Cost of Goods Sold:

• COGS Material
• COGS Fixed Overhead
• COGS Variable Overhead
• COGS Outside

Distribution Accounts - In-Transit:

• In-Transit Material
• In-Transit Labor
• In-Transit Fixed Overhead
• In-Transit Variable Overhead
• In-Transit Outside
Note:  You are allowed to delete any distribution account record, including the default distribution
account with a blank warehouse and blank product code.

The inventory account number used for journal transactions does not come directly from the Distribution
Accounts form. Rather, the inventory accounts used comes from the stock location being accessed
when the transaction is performed.

When a stock location is added for an item in the Inventory module, an inventory account is entered
for the location, and an account number for each cost detail component is added.

The default for these fields are the inventory account numbers in the Distribution Accounts file to which
the item belongs.

To locate the inventory account numbers, the system searches, in the following order, for:

• An exact match for both the warehouse and the product code.
• A match for the product code and a blank warehouse.
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• A match for the warehouse and a blank product code.

The system does not post to the G/L inventory distribution journals if any of the account numbers it is
attempting to use are not set up.

Standard Costing: Transactions Posting to the
Inventory Distribution Journals
Outlined below is every transaction that is posted to the inventory distribution journals when standard
costing is being used.

See Posting to General Ledger - Standard Costing on page 254.

Purchasing Transactions

The following transactions are posted to the inventory distribution journal named PO Dist.

• Purchase Order Receipt:

CreditDebit 

 xxxxInventory

xxxx Vouchers Payable

xxxxxxxx   orPurchase Variance

Note:  Since this transaction is for a purchased item, only inventory material cost details component
is posted.
• Inventory = (quantity received * standard unit cost from the Items form)
• Vouchers Payable = (quantity received * po unit cost)
• Purchase Variance = (qty received *(std unit cost - po unit cost))

The amount that inventory is debited is the quantity received multiplied by the item's standard unit
cost:

AID = QR * ISUC

where:

• AID = Amount that Inventory is Debited
• QR = Quantity Received
• ISUC = Item's Standard Unit Cost

Vouchers Payable is credited with quantity received multiplied by the purchase order line item unit
cost. If there is a difference between the item's standard unit cost and the purchase order unit cost,
the purchase cost variance account is either debited or credited with the difference, which balances
the transaction.

If (ISUC - POUC) >> 0, then PCVA = DD or CD

where:

• ISUC = Item's Standard Unit Cost
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• POUC = Purchase Order Line Item Unit Cost
• PCVA = Purchase Cost Variance Amount
• DD = Debited with the Difference
• CD = Credited with the Difference

• Purchase Order Return:

CreditDebit 

 xxxxVouchers Payable

xxxx Inventory

xxxxxxxx orPurchase Variance

Note:  Since this transaction is for a purchased item, only inventory material cost details component
is posted.
• Vouchers Payable = (quantity returned * po unit cost)
• Inventory = (quantity returned * Items standard unit cost)
• Purchase Variance = (qty returned *(std unit cost - po unit cost))

The amount that vouchers payable is debited is the quantity returned multiplied by the purchase
order unit cost. Inventory is credited with quantity returned multiplied by the item's standard unit
cost. If there is a difference between the item's standard unit cost and the purchase order unit cost
the purchase cost variance account is either debited or credited with the difference, which balances
the transaction.

• Voucher Generation:

CreditDebit 

  a. If vouchered cost is greater than receipt cost:

 xxxxVouchers Payable

 xxxxPurchase Variance

xxxx Accounts Payable

  b. If vouchered cost is less than receipt cost:

 xxxxVouchers Payable

xxxx Purchase Variance

xxxx Accounts Payable

The previous transaction is created only if any line items were vouchered at a different cost than
the cost at which they were received into inventory. (The cost at which the items were received
into inventory is the line item unit cost field at the time of the receipt.)

Variance = (VP - AP)

where:

• VP = (qty vouchered * received cost)
• AP = (qty vouchered * vouchered cost)
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Production Transactions

The following transactions are posted to the inventory distribution journal named SF Dist.

• Job Material Issue:

CreditDebit 

 xxxxWIP Material

 xxxxWIP Labor

 xxxxWIP Fixed Overhead

 xxxxWIP Variable Overhead

 xxxxWIP Outside

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

xxxx Fixed Material Overhead Applied

xxxx Variable Material Overhead Applied

At the time of issue, the work in process account is debited with the total standard cost of the
material being issued plus the fixed and variable material overhead amounts:

WIPA = MC + (FMO * MC) + (VMO * MC)

where:

• WIPA = WIP Amount
• MC = Material Cost
• FMO = Fix Material Overhead
• VMO = Variable Material Overhead

MC = SUC * QI

where:

• MC = Material Cost
• SUC = Standard Unit Cost of Material
• QI = Quantity Issued

Inventory is credited with the material cost shown above. The Overhead accounts are credited with
the material cost multiplied by the material overhead rates.

• Job Material Withdrawal:

CreditDebit 

 xxxxInventory Material

 xxxxInventory Labor
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CreditDebit 

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx WIP Material

xxxx WIP Labor

xxxx WIP Fixed Overhead

xxxx WIP Variable Overhead

xxxx WIP Outside

The amount used is the quantity withdrawn multiplied by the item's standard unit cost.

• Post Job Transaction:

CreditDebit 

 xxxxWIP Material

 xxxxWIP Labor

 xxxxWIP Fixed Overhead

 xxxxWIP Variable Overhead

 xxxxWIP Outside

xxxx Direct Labor Applied

xxxx Fixed Overhead Applied

xxxx Variable Overhead Applied

xxxxxxxx orLabor Rate Variance

xxxxxxxx orLabor Usage Variance

xxxxxxxx orFixed Overhead Usage Variance

xxxxxxxx orVariable Overhead Usage Variance

Work in process (WIP) is debited (increased) by what the labor and overhead should be for the
transaction entered based on the standard run and setup times in the Job Operations record and
the standard setup and run rates in the Work Centers form. The calculation varies depending on
the type of job transaction being processed.

WIP amount for (S)etup transaction =

[(SSH * WCSSR) * EFFICIENCY FACTOR]+

[(SSH * DFOR) * EFFICIENCY FACTOR] +

[(SSH * DVOR) * EFFICIENCY FACTOR]

where:
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• SSH = Standard Setup Hours
• WCSSR = Work Center Standard Setup Rate
• DFOR = Department Fixed Overhead Rate
• DVOR = Department Variable Overhead Rate

WIP amount for (R)un Transaction =

[(AP * SRHU * WCSRR) * EFFICIENCY FACTOR] +

[(AP * SRHU * DFOR) * EFFICIENCY FACTOR] +

[(AP * SRHU * DVOR) * EFFICIENCY FACTOR]

where:

• AP = Actual Pieces
• SRHU = Standard Run Hours (Labor) per Unit
• WCSRR = Work Center Standard Run Rate
• DFOR = Department Fixed Overhead Rate
• DVOR = Department Variable Overhead Rate

Direct labor applied, fixed overhead applied, and variable overhead applied amounts are based
on the actual hours reported for the transaction:

WIP Amount for (C) Machine Transaction =

[(AP * SRHMU * WCFOR) * Efficiency Factor] +

[(AP * SRHMU * WCVOR) * Efficiency Factor]

where:

• AP = Actual Pieces
• SRHMU = Standard Run Hours (Machine) per Unit
• WCFOR = Work Center Fixed Overhead Rate (Machine)
• WCVOR = Work Center Variable Overhead Rate (Machine)

FO = (AH * DFOR) or (M * MFOR)

where:

• FO = Fixed Overhead
• AH = Actual Hours (Labor)
• DFOR = Department Fixed Overhead Rate
• M = Material
• MFOR = Material Fixed Overhead Rate

VO = (AH * DVOR) or (Material * MFOR)

where:

• VO = Variable Overhead
• AH = Actual Hours (Labor)
• DVOR = Department Variable Overhead Rate
• M = Material
• MFOR = Material Fixed Overhead Rate

An entry is made for labor rate variance if there is any difference between the actual employee
manufacturing rate and the work center standard pay rate:

LRV = (MR - SR) * AH

where:
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• LRV = Labor Rate Variance
• SR = Standard Rate
• MR = Manufacturing Rate
• AH = Actual Hours (Labor)

A labor usage variance, fixed overhead variance, and variable overhead variance are posted if the
actual hours are less than (<) or greater than (>) the time it should have taken to complete the
pieces that were reported:

LUV = ((((SRHU / EF) * PC) - AH) * SPR)

where:

• LUV = Labor Usage Variance
• SRHU = Standard Run Hours per Unit
• PC = Pieces Complete
• AH = Actual Hours (Labor)
• SPR = Standard Pay Rate
• EF = Efficiency Factor (100/ER)
• ER = Efficiency Rate
• WCSSR = Work Center Standard Setup Rate

SET-UP: LUV = ((SSHU - AH) * WCSSR) / ER

FOUV = (((SRHU / EF) * PC) - AH) * DFOR)

where:

• FOUV = Fixed Overhead Usage Variance
• SRHU = Standard Run Hours per Unit
• PC = Pieces Complete
• AH = Actual Hours (Labor)
• DFOR = Department Fixed Overhead Rate
• SSHU = Standard Setup Hours per unit
• EF = Efficiency Factor (100/ER)
• ER = Efficiency Rate

SET-UP: FOUV= ((SSHU - AH) * DFOR) / ER

VOUV = (((SRHU / ER)* PC) - AH) * DVOHR)

where:

• VOUV = Variable Overhead Usage Variance
• SRHU = Standard Run Hours per Unit
• PC = Pieces Complete
• AH = Actual Hours (Labor)
• DVOHR = Department Variable Overhead Rate
• SSHU = Standard Setup Hours per Unit
• ER = Efficiency Rate

SET-UP: ((SSHU) - AH) * DVOHR) / ER

FMOUV = (((SRHU / ER) * PC) - AH)) * WCFOR

where:

• FMOUV = Fixed Machine Overhead Usage Variance
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• SRHU = Standard Run Hours (Machine) Per Unit
• PC = Pieces Complete
• AH = Actual Hours (Machine)
• WCFOR = Work Center Fixed Overhead Rate (Machine)
• ER = Efficiency Rate

VMOUV = (((SRHU / ER) * PC)- AH)) * WCVOR

where:

• VMOUV = Variable Machine Overhead Usage Variance
• WCVOR = Work Center Variable Overhead Rate (Machine)
• ER = Efficiency Rate

• Job Finish (Put to Stock):

CreditDebit 

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx WIP Material

xxxx WIP Labor

xxxx WIP Fixed Overhead

xxxx WIP Variable Overhead

xxxx WIP Outside

Both inventory and WIP are posted with the quantity being put to stock multiplied by the Items
form's standard unit cost of the item being moved to inventory.

xxxx = (quantity completed * Items standard unit cost)

• Job Close:

If the quantity of any material issued is more or less than the standard quantity required, the following
accounts are adjusted:

• Material Usage Variance
• Fixed Material Overhead Usage Variance
• Variable Material Overhead Usage Variance
• WIP Material
• WIP Labor
• WIP Fixed Overhead
• WIP Variable Overhead
• WIP Outside
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The material usage variance amount is the difference between the standard quantity required and the
actual quantity issued, extended by the standard cost of the material.

The overhead variance amounts are material usage variance extended by the fixed and variable material
overhead rates.

If subsequent to this transaction there is any remaining WIP amount (+ or -), the following adjustment
is made.

CreditDebit 

  a. If remaining WIP amount is greater than (>) 0 then:

 xxxxRouting Variance

xxxx WIP Material

xxxx WIP Labor

xxxx WIP Fixed Overhead

xxxx WIP Variable Overhead

xxxx WIP Outside

  b. If remaining WIP amount is less than (<) 0 then:

xxxx WIP Material

 xxxxWIP Labor

 xxxxWIP Fixed Overhead

 xxxxWIP Variable Overhead

 xxxxWIP Outside

xxxx Routing Variance

This transaction may be necessary since the WIP account is increased with amounts that are based
on the standard times and rates that are established for the job. The decrease of the WIP in the job
finish transaction is based on the standard cost of the item being manufactured. If the total standards
for the job do not match the standard unit cost of the item, this adjustment to WIP needs to be made.

If the job is not closed at the time the job transaction is posted, the above transaction is posted at the
time the status of the job is manually changed from (R)eleased to (C)omplete.

Customer Order Transactions

The following transactions are posted to the inventory distribution journal named CO Dist.

• Customer Order Shipment:

CreditDebit 

 xxxxCOGS Material

 xxxxCOGS Labor
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CreditDebit 

 xxxxCOGS Fixed Overhead

 xxxxCOGS Variable Overhead

 xxxxCOGS Outside

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

 xxxxInventory Outside

This transaction is processed using the quantity shipped and the item's standard unit cost:

xxxx = (quantity shipped * Items form's standard unit cost)

• Customer Order Return:

CreditDebit 

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx COGS Material

xxxx COGS Labor

xxxx COGS Fixed Overhead

xxxx COGS Variable Overhead

xxxx COGS Outside

This transaction is processed using the quantity returned and the item's standard unit cost:

xxxx = (quantity returned * Items form's standard unit cost)

Inventory Control Transactions

The following transactions (unless otherwise specified) are posted to the inventory distribution journal
named IC Dist.

• Inventory Adjustment Transaction:

CreditDebit 

  a. Increase quantity:
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CreditDebit 

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx Inventory Adjustment

  b. Decrease quantity:

 xxxxInventory Adjustment

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

The amount used for an inventory adjustment transaction is the adjustment quantity multiplied by
the standard unit cost of the item.

Cycle counting and physical inventory posting create transactions like the transactions depicted
previously. Either transaction a or b is created, depending on whether the count quantity is greater
than (>) or less than (<) the original quantity.

• Inventory Move:

CreditDebit 

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside
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This transaction is only posted if the From and To locations specified on the form have different
inventory accounts tied to them. The amount used is the move quantity times the standard unit
cost.

• Location Update:

A transaction is created if you change the inventory account tied to the location. (The example
assumes that all cost details accounts are changed.)

CreditDebit 

  Inventory (New accounts)

 xxxxInventory Material Cost  1101

 xxxxInventory Labor Cost 1102

 xxxxInventory Fixed Overhead Cost  1103

 xxxxInventory Variable Overhead Cost 1104

 xxxxInventory Outside Cost 1105

  Inventory (Old accounts)

xxxx Inventory Material Cost  1001 

xxxx Inventory Labor Cost  1002

xxxx Inventory Fixed Overhead Cost  1003

xxxx Inventory Variable Overhead Cost 1004

xxxx Inventory Outside Cost 1005

The amount used is the quantity at the location multiplied by the standard unit cost of the item.

• Location Insertion:

CreditDebit 

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx Inventory Adjustment

This transaction is only posted if a quantity is entered for the location at the same time it is added.
The amount is the quantity entered multiplied by the item's standard unit cost.

• Roll Current Cost to Std Cost utility:

CreditDebit 

  a. If the new standard is greater than (>) old standard:
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CreditDebit 

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx Inventory Adjustment

  b. If the new standard is less than (<) old standard:

 xxxxInventory Adjustment

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

• Miscellaneous Receipt:

CreditDebit 

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx Account Entered

xxxxxxxxPurchase Cost

The amount used is the quantity entered multiplied by the item's standard unit cost.

The credit account is the GL account number entered by you. The account defaults to the item's
Inventory Adjustment account.

All variances are posted to the account found in the Purchase Cost field on the item's Product
Codes form.

• Miscellaneous Issue:

CreditDebit 

 xxxxAccount Entered

xxxx Inventory Material
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CreditDebit 

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

The amount used is the quantity entered multiplied by the item's standard unit cost.

The debit account is the GL account number you entered. The account defaults to the item's
Inventory Adjustment account.

• Job Issue:

The following transactions are posted to the inventory distribution journal named SF Dist.

CreditDebit 

 xxxxWIP Material

 xxxxWIP Labor

 xxxxWIP Fixed Overhead

 xxxxWIP Variable Overhead

 xxxxWIP Outside

xxxx Inventory Material

xxxx Inventory Labor

xxxx Inventory Fixed Overhead

xxxx Inventory Variable Overhead

xxxx Inventory Outside

xxxx Fixed Material Overhead Applied

xxxx Variable Material Overhead Applied

At the time of issue, the work in process account is debited and the inventory account is credited
with the standard unit cost of the item issued multiplied by the quantity issued plus overhead. At
the time of job close, the material quantity variance is calculated, the work in process account
debited, and the material usage variance account credited.

CreditDebit 

xxxx Material Usage Variance

 xxxxWIP Material

 xxxxWIP Labor

 xxxxWIP Fixed Overhead

 xxxxWIP Variable Overhead
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CreditDebit 

 xxxxWIP Outside

• Job Receipt:

The following transactions are posted to the inventory distribution journal named SF Dist.

CreditDebit 

 xxxxInventory Material

 xxxxInventory Labor

 xxxxInventory Fixed Overhead

 xxxxInventory Variable Overhead

 xxxxInventory Outside

xxxx WIP Material

xxxx WIP Labor

xxxx WIP Fixed Overhead

xxxx WIP Variable Overhead

xxxx WIP Outside

Both inventory and WIP are posted with the quantity being put to stock multiplied by the Item
Maintenance standard unit cost of the item being moved to inventory.

xxx = (quantity completed * item standard unit cost)

If, subsequent to this transaction, there is any remaining WIP amount (+ or -) the following adjustment
is made.

CreditDebit 

  a. If remaining WIP amount is greater than (>) 0:

 xxxxOther WIP Variance (Routing Variance)

xxxx WIP Material

xxxx WIP Labor

xxxx WIP Fixed Overhead

xxxx WIP Variable Overhead

xxxx WIP Outside

  b. If remaining WIP amount is less than (<) 0:

 xxxxWIP Material

 xxxxWIP Labor

 xxxxWIP Fixed Overhead
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CreditDebit 

 xxxxWIP Variable Overhead

 xxxxWIP Outside

xxxx Other WIP Variance (Routing Variance)

Reversing a Set of Related Journal or Ledger Entries
To reverse a set of related journal or ledger entries all at one time, use the Reverse Transaction form.
You can reverse entries from the General Journal or a user-defined journal, and the entries must have
a shared control number. They must all be part of the same business transaction.

1 Open the appropriate form and search for the entries to reverse. You can use the Journal Entries,
G/L Posted Transactions, or A/L Posted Transactions forms.

2 Select an entry from the business transaction and then click Reverse Transaction. The Reverse
Transaction form is displayed.

3 Click Process. A set of reversing entries is automatically created in the originating journal, but the
entries are not posted.

4 Post the reversing entries. If necessary, you must also create and post corrected entries to replace
the reversed entries.

Creating and Rebalancing Ledger Period Totals
Use the Rebalance Ledger Period Totals utility to create period total records that contain the sum of
the transactions for a particular period.

Creating period totals improves the speed with which reports can run, because the system calculates
account balances at the time the report is printed. It does not store totals. To get a total, it must sum
up ledger transactions for an account up through the required date.

When calculating a balance, the system first sums up the period total records that apply, and then adds
in the ledger transactions that close the gap between the end of an accounting period and the requested
date.

For example, you may request an account balance on 4/15, but the accounting periods end on 3/31
and 4/30. The system sums up period total records through 3/31 and ledger transactions from 4/1
through 4/15 to arrive at the total.

This utility processes all ledger transactions and creates balance totals per period, for each account.
This information is then used for General Ledger reporting.

Run this utility if you suspect that the period totals are not correct, because it takes some time if there
are a lot of ledger transactions.
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You may also want to run this utility when you have sort methods that need to be maintained only for
a short period of time.

For example, suppose you have defined a sort method for a financial report that is needed for year
end closing. Maintaining this report throughout the year would be an unwanted performance hit for
eleven months. You would leave the index inactive for eleven months and when the time came to run
your report, you would run this utility for this one sort method and select the Active Only check box.
Once you are done with your year end reporting, you would go to the Period Sorting Methods form
and deactivate the sort method until next year.

When you run this utility, the Index Active check box for each sort method in the specified range is
not selected, preventing other programs that are run by other users from looking at these period total
records and retrieving a potentially incorrect or partial amount. When the utility completes successfully,
the Index Active check box is then selected.

Note: If the utility does not run to completion (because, for example, of a power outage or system
failure), theIndex Active check box will not be selected, and the account balance calculation will be
slow because the system cannot reliably look at period totals. Re-run this utility, and do not select the
Active Only check box.

Separate Debit and Credit Totals

If you have selected Separate Debit and Credit Totals on applicable activities and reports,
theRebalance Ledger Period Totals utility manages the calculation of these totals. If cancellation
posting is also enabled, this utility includes negative-signed debits and credits in its calculations. When
cancellation posting is not enabled, separate debit and credit totals are determined using only the
positive or negative state of the original transactions. For more information, see About Cancellation
Posting for Single-Entry Accounting on page 13.

Note: Transaction compression, such as theMass Journal Posting activity or the Compress General
Ledger Transactions utility, eliminates the detail necessary for tracking separate debit and credit
amounts and for providing the treatment for cancellation notation. The Rebalance Ledger Period
Totals utility records only a single debit amount or credit amount when the ledger uses transaction
compression.

Setting Up a Consolidation Reporting Structure
The system allows you to set up or modify the hierarchical structure of your entities and sites. We
recommend that you carefully plan the relationship between entities and sites before using the system.
We suggest that you contact our Consulting Services group to help with your implementation.

If you modify an existing consolidation reporting structure, historic data will not change.

For additional information, see the Consolidation Overview on page 18.

Prerequisites:

• Appropriate replication rules must be set up between the sites and entities.
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• Sites must have the same base (domestic) currency as the entity they will report to. If a chart of
accounts or accounting periods have been set up at the site, they must match those established
for the entity.

Following is the typical process:

1 Log in to each site whose Reports To entity will be set or changed.

2 If general ledger activity has been performed at the site, do the following. (If this is a new site with
no activity, skip to the next step.)

• Post all journals and consolidate the ledger for transactions in the current site. Run the Ledger
Consolidation activity at each site to calculate the ending balances for every account number
at the site and consolidate them up through the old entity hierarchy.

• Since the full account balances will be closed out and moved, any balances that are to remain
in the old structure must be manually transferred to other sites by journal entries in both sites.
Those journal entries must be posted and consolidated.

3 Run the Change Reports To Entity utility at each site that you are changing to report to a new
entity.

• If this utility is run at a site, you can only change Reports To Entity to a financial entity that
has the same base (domestic) currency, chart of accounts and accounting periods. Also, the
system verifies that all accounts defined at the site already exist at the financial entity. If this
validation fails, the change is not allowed and a report is created detailing the failures.

• If chart records exist at the site that do not exist at the entity, you can use the Multi-Site Chart
Copy Utility to copy the site's Chart of Accounts to the financial entity.

If no chart of accounts or accounting periods have been set up yet at the site, this Change Reports
To Entity utility will copy them from the entity to the site.

4 If this utility is being run at a financial entity at any level, the closing balances for each account at
every site beneath the financial entity are calculated and consolidated all the way up the hierarchy.
Then the Reports-To value is changed. All the Reports To account mappings for the entity's Chart
of Accounts must be corrected to map to the chart of accounts of the new Reports-To financial
entity.

5 Run Ledger Consolidation (again) at each site/entity in the new structure. This consolidates the
beginning balances for each account up through the new financial entity hierarchy.

6 The G/L Ledger references created when the process is complete are:

• SITE MOVE AWAY, which holds the closing balance.
• SITE MOVE TO, which is the beginning balance for the new Reports-To entity.

Note:  No financial reporting should be run between steps 3 and 4, because the books will be
temporarily out of balance.

Notes about Consolidation:

• If the Change Reports To Entity utility is performed at a site (not an entity), and that site includes
a replication rule for shared currency to and from the entity that it was previously reporting to, that
replication rule should be deleted. Then a new replication rule for shared currency should be set
up between that site and the new entity. Regenerate replication triggers and run the Manual
Replication Utility for the Shared Currency category.

This ensures that users at the site will be viewing the currency records of their new financial entity
instead of their old one.
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• The Change Reports To Entity utility can also be run if a site is sold and needs to be removed
from the financial consolidation structure. In this case you would run the utility with the Reports To
field blank.

• The Set Ledger Consolidated Flag utility rebuilds an entity. Use it to reconsolidate entities whose
data was lost, corrupted or discarded due to a complete change in corporate structure.

After running this utility, you should then run the Change Reports To Entity utility to correct the
current site structure, using the option to not post the closing balances. You can then run the
Ledger Consolidation activity to consolidate into the new structure. In this case, it is assumed
that the entities into which you are consolidating are new and thus empty of ledger records.

Using the Cash Impact Report
This report shows your expected cash flow over a specified period of time for a selected range of
currencies in summary or detail format. The information is organized in six user-defined pay range
periods (or buckets).

You can include this information on the report:

• A/R transactions, A/P transactions, and early payment discounts
• Transactions for customers and vendors that are on hold
• Customer orders and vendor purchase orders. For customer orders, you can elect to include blanket

releases and progressive billings. For vendor orders, you can elect to include blanket releases and
PO requisitions.

• Estimated. If you include estimates, you can select the types to include (Working, Quoted, Planned),
and specify the estimate order offset days.

Note: If you are using advanced terms, the European algorithm is used to calculate the due date
buckets for purchase orders and customer orders.

Landed Costs

Landed cost records are accessed to determine the outstanding, unvouchered, landed cost amounts.
The landed costs are not quantity-based; therefore, it is not possible to simply multiply the costs by the
difference between the quantities ordered and vouchered.

The report finds all landed cost PO receipt records for the PO line record, and subtracts the vouchered
amount from the total estimated cost for the landed cost on the PO line.

When no landed cost PO receipts exist for a PO line (because, for example, no receipts have been
posted against the line), the full estimated cost is still payable.

Also, landed cost PO receipt records with a vouchered amount of zero may exist (that is, the line was
received but not vouchered). In such cases, the full estimated cost is also still payable.

The calculation for the material portion uses the PO line material cost, multiplying it by the difference
of the quantity ordered minus the quantity vouchered.

At the point of vouchering, the landed cost estimate amount will reduce the cash outflow commitment
from the PO, and show separately as an A/P transaction under the voucher number that's created.
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Allocating and Distributing Expenses

Setting up Account Allocations
You can routinely distribute an expense among more than one account, according to rules that you
define. First, you set up an Allocation Account. Any charges you enter to that account trickle down to
the other accounts that you specify on the Chart of Account Allocations form. Each of these other
accounts is charged with an amount or percentage of the total. This process occurs during posting to
the General Ledger.

1 In the Chart of Accounts form, set up an account with a description that explains how the allocation
account is used, for example, Supplies Expense Distribution. Specify this information:

Account Type
Specify Allocation.

Unit Code 1-4
Set the appropriate unit code fields to Accessible.

2 In the Chart of Account Allocations form, only accounts of type Allocation are displayed.
Select the allocation account and specify this information:

Sequence
This field determines the order in which the allocation is made. For example, you might have 4
allocation sequences in a rule, and the first sequence allocates a fixed amount of $75 to a
distribution account. If the current expense is $75 or less, the other allocation sequences are
ignored.

Allocation Basis Type
Specify the basis used to create the distribution journal entries for this sequence. Different sequence
numbers in the same allocation rule can use different basis types.
• If the sequence distributes a percentage of the total amount, specify Percentage.
• If the sequence distributes an exact amount to this account, specify Amount.
• If the sequence distributes whatever is remaining after the other sequences are completed,

specify Remainder. This option can only be used for the last sequence number in the rule.
Note:  If you add at least one sequence with an Allocation Basis Type of Percentage, the last
sequence must have an Allocation Basis Type of Remainder, to avoid rounding errors.

Allocation Basis Rate

Specify the decimal percentage or the  amount used to create the distribution journal entries for
this sequence For example, specify 25.000 for 25%.  If Allocation Basis Type is Remainder,
this value is zero and the field is disabled.

Distribution Account, Description and Account Type
Select the account to which you want to distribute the expense. The account description and type
are displayed..
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Unit Codes
The unit code fields are enabled for any accessible unit codes. Select the appropriate codes. For
example, if Unit Code 1 is accessible, select a department to which the expense will be allocated.

Allocate by Statistical Account
If this sequence allocates expenses using variable percentages that are based on the information
in a statistical account, select this field.

For more information, see Example: Allocating Expenses with Variable Percentages based on
YTD Amounts from Statistical Accounts on page 280.

Statistical Account

If you selected Allocate by Statistical Account, specify the statistical account number.

3 Repeat step 2 to add sequences until the rule is complete and the expense amount is completely
allocated.

Example: Allocating Expenses with Percentages
This example shows how percentages can be used to distribute an expense to different accounts.

Chart of Accounts

You could set up an allocation account 99870 where unit code 1 is accessible and holds the department
numbers for your company.

Chart of Account Allocations

You can then use the Chart of Account Allocations form to allocate the expense to different
departments, based on percentages that you define. You would set up the Chart of Account Allocations
form to contain these sequences and values for account 99870, unit code 1:

Allocation Account 99870

Unit
Code 1

Distribu-
tion Ac-
count

Basis RateBasis TypeSequence

1005155125.000Percentage1

3005155150.000Percentage2

500515510Remainder3

In this rule, sequence 1 distributes 25% of the expense to department 100, using the distribution account
51551. Sequence 2 distributes 50% to department 300, and sequence 3 distributes the remainder
(25%, but because you specified Remainder, it also includes any amount incurred from rounding) to
department 500.
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Journal Entries

This is the original journal entry for the expense:

CommentCreditDebitAccount

Initial entry to allocation
account

 10,000.0099870

 10,000.00 2000

This is the allocation entry that is generated during ledger posting:

CommentCreditDebitUnit Code 1Account

Offset to initial en-
try

10,000  99870

  2,500.0010051551

  5,000.0030051551

  2,500.0050051551

Example: Multi-level Allocations
On the Chart of Account Allocations form, you set up a multi-level allocation when you specify an
account number with an Allocation account type in the Distribution Account field.
Note: Do not structure an allocation to itself, that is, specify the same allocation account in the header
and in the Distribution Account field. An allocation cannot be infinitely recursive. If you try to allocate
a portion of an account to itself, an error message is displayed when you post the journals.

First Level

For example, your company divides rent between manufacturing and operations. You can set up a rent
allocation account 99000 to distribute the expense.

In the Chart of Accounts form, set account 99000 as an allocation account.

On the Chart of Account Allocations form, divide rent between operations and manufacturing as
shown in this table:

Allocation Account 99000:

Account TypeDescriptionAccountAllocation Basis
Amount

Allocation Basis
Type

RegularRent - Operations6000060Percent

AllocationRent - Manufactur-
ing

9800040Percent
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Second Level

However, the manufacturing area also wants to divide the rent charged to account 98000 among its
four departments, based on the percentage of floor space each uses in the manufacturing area.

To allow for this, in the Chart of Accounts form, set up account 98000 as an allocation account type.
Then on the Chart of Account Allocations form, you can divide rent among the manufacturing
departments as follows:

Allocation Account 98000:

Account TypeDescriptionAccountAllocation Basis
Amount

Allocation Basis
Type

RegularRent - Grinding6100020Percent

RegularRent - Manufactur-
ing

6200010Percent

RegularRent - Painting6300025Percent

RegularRent - Assembly6400045Percent

The rent initially charged to account 99000 then trickles down as shown in this diagram:

Journal Entries

If rent is $10,000.00, then these amounts would be posted for the rent expense:

• 60% Operations $6000.00
• 40% Manufacturing $4000.00
• 20% Grinding $800.00
• 10% Plating $400.00
• 25% Painting $1000.00
• 45% Assembly $1800.00
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Example: Allocating Expenses Using Fixed Amounts and
Remainders
This example shows how fixed amounts and remainders can be used to distribute an expense to
different accounts.

Chart of Accounts

You could set up an allocation account 99870 where unit code 1 is accessible and holds the department
numbers for your company.

Chart of Account Allocations

You can then use the Chart of Account Allocations form to allocate the expense of the electric bill
by department, based on amounts that you define. You would set up the Chart of Account Allocations
form to contain these sequences and values for account 99870, unit code 1:

Allocation Account 99870

Unit
Code 1

Distribu-
tion Ac-
count

Basis RateBasis TypeSequence

10051551100.00Amount1

30051551200.00Amount2

500515510Remainder3

In this rule, sequence 1 distributes the first $100 of the expense to department 100, using the distribution
account 51551. Sequence 2 distributes the next $200 to department 300, and sequence 3 distributes
whatever remains of the expense to department 500. I

Journal Entries

This is the original journal entry for the expense:

CommentCreditDebitAccount

Initial entry to allocation
account

 600.0099870

 600.00 2000

This is the allocation entry that is generated during ledger posting:

CommentCreditDebitUnit Code 1Account

Offset to initial en-
try

600.00  99870

  100.0010051551
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CommentCreditDebitUnit Code 1Account

  200.0030051551

  300.0050051551

If the original journal entry was for $500, the first two distributions would be the same, but Department
500 would be allocated the remainder of $200.

If the original journal entry was for $50, Department 100 would be allocated all of the $50 expense.

Example: Allocating Expenses with Variable Percentages
based on YTD Amounts from Statistical Accounts
This topic includes an example for allocating expenses with variable percentages based on year-to-date
amounts from statistical accounts.

Prerequisites

• The appropriate allocation and statistical accounts must exist in the Chart of Accounts form.
• Unit code combinations that are assigned to a statistical account must also be assigned to any

distribution accounts that are associated with the statistical account through a Chart of Accounts
Allocation sequence.

Chart of Accounts

You could set up a statistical account 7777777 in the Chart of Accounts form, where unit code 1 holds
the department numbers for your company.

You could also set up an allocation account 99870 that has the unit codes assigned the same way
they are assigned in account 7777777.

Chart of Accounts Budget and Plan

In the Chart of Accounts Budget and Plan form, for account 777777, specify a department number
in the Unit Code 1 field, and then specify a starting number of employees for that department in the
Actual Change field. Add the same information for the rest of your departments.

Then use the Actual Change field to keep track of the growth or reduction of people in each department
from month to month. As the department YTD personnel change each month, the department's
percentage of the whole company's YTD personnel also varies, as shown in this chart:

Statistical Account 777777

Percentage of all
depts

YTD totalActual changePeriodUnit code (de-
partment)

50/100=50%50501100
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Percentage of all
depts

YTD totalActual changePeriodUnit code (de-
partment)

54/124 = 44%5442100

54/129 = 42%5403100

52/149 = 35%52-24100

52/149 = 35%5205100

42/159 = 26%42-106100

Percentage of all
depts

YTD totalActual changePeriodUnit code (de-
partment)

30/100 = 30%30301200

50/124 = 40%50202200

50/129 = 39%5003200

72/149 = 48%72224200

72/149 = 48%7205200

52/159 = 33%52-206200

Percentage of all
depts

YTD totalActual changePeriodUnit code (de-
partment)

20/100 = 20%20201300

20/124 = 16%2002300

25/129 = 19%2553300

25/149 = 17%2504300

25/149 = 17%2505300

65/159 = 41%65406300

Chart of Account Allocations

You can then, for example, use the Chart of Account Allocations form to allocate the monthly cost
of protective clothing, based on the variable percentage of people in each department every month.
You would set up the Chart of Account Allocations form using values like these:

Allocation Account 99870

Statistical Ac-
count

Allocate by Statistical
Account

Unit 1Basis RateBasis TypeSe-
quence

7777777Yes 100Percentage1
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In this case, the allocation account would use the current YTD percentages from the statistical account
to distribute the expense across the departments. In Period 2, the allocation would be like this:

• Dept 100 44%
• Dept 200 40%
• Dept 300 16%

But with some movement of personnel every month, the allocations are automatically changed without
you having to create new rules. By Period 6, the allocations have changed quite a bit:

• Dept 100 26%
• Dept 200 33%
• Dept 300 41%

You could use the statistical account values as only part of the allocation rule. For example, you might
want to allocate the first $75 of each month's bill to department 400, but divide the rest among the other
departments. In that case, your Chart of Account Allocations rule would look like this:

Statistical Ac-
count

Allocate by Statistical
Account

Unit 1Basis RateBasis TypeSe-
quence

 No400$75Amount1

7777777Yes 100Percentage2

Extended Analysis with Dimensions and Attributes

Chart of Accounts Object

Specifying Dimensions and Attributes for G/L Accounts
If you assign dimensions to accounts, your G/L data becomes multi-dimensional. For example, not
only can you drill down to detail about an account, but you can also drill across to details about the
customer or the item involved in a particular A/R transaction posted to that account.

To support this functionality, predefined dimensions related to Customer, Item and Vendor information
are included in the SyteLine initialized data and can be attached to an account. Each dimension has
a predefined set of attributes. Your system administrator can modify or add dimensions and attributes,
and set up additional joins between database tables, to meet your company's needs.

Typically, the process includes these steps:
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1 You tell the system administrator how you want to analyze the Chart of Accounts and posted ledger
transactions. Be specific about the information you need to see, including any functions or
calculations.

For example, for an account related to employees, you might want to see employee-specific
information. The system administrator can join the employee database table in the dimension, so
that employee-related fields are made available for your reports. You do not need to see all of the
fields in the employee table, so unwanted fields can be hidden. You might also want to see some
fields from other tables. The number of possible joins and dimensions that are applicable to an
account is unlimited; the predefined data only includes a small sample.

2 The system administrator finds the appropriate information in the database and builds any additional
calculations based on that data, creating dimension attributes.

The system administrator then makes the attributes available to you through the Chart of Accounts
Dimensions and Ledger Dimensions forms.

3 Use the Dimensions tab on the Chart of Accounts form to assign one or more dimensions to an
account. The same dimension can be added to any or all G/L Accounts. Do one of the following:

• For Ledger object analysis, select a dimension in the Ledger Dimension drop-down list to
assign it to the account.

• For Chart of Accounts object analysis, select one or more dimensions in the grid to assign
them to the account. You can then click the Dimensions button to open the Chart of Accounts
Dimensions form, where you can perform these actions on the listed dimension attributes:
• View the name and description of the attribute.
• View the underlying database schema and/or calculation used to produce the output data.
• See if the attribute is hidden in the output and if a mask is used to display the data (for

example, display a date as MM/DD/YY or DD/MM/YYYY). If you have the appropriate
permissions, you can modify these options for an attribute.

• Re-sequence the attribute display order. To do this, change the numbers in the Sequence
column and click Resequence.

You can then click the Details button to open the Chart of Accounts Dimension Details form, where
you can view the actual output data for the dimension and export the grid to Excel for further analysis
and reporting.

Example: Dimensions and Attributes
This diagram shows an example of how the Chart of Accounts object can have multiple dimensions
and attributes.
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Object
Chart of Accounts

Dimension
Customer

Dimension
Item

Dimension
Vendor

Attribute (Value)
Customer Number

P(customer.custnum)

Attribute (Database User-Defined Function)
Ledger Transaction Date Period

Dbo.GetPeriod(V(Ledger Transaction Date))

Attribute (Calculation)
Value Added Tax

V(Ledger Domestic Amount) * 0.10

Attribute
...

Attribute

Attribute

Attribute

Attribute

In the diagram, the example shows the predefined object Chart, which is used for Chart of Accounts
analysis.  The Chart object has three predefined dimensions. Each of the dimensions have predefined
attributes that can include fields (properties), or calculated values. For more information about how to
use dimensions and attributes with the Chart of Accounts, see Specifying Dimensions and Attributes
for G/L Accounts on page 282.

The system administrator can create additional dimensions. The number of dimensions for an object
is unlimited.  The administrator also can create additional attributes. .

Note:  A maximum of 100 attributes of any data type per dimension can be displayed on certain forms.
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Ledger Object

About Dimension Analysis Attributes
Dimension analysis attributes for the Ledger dimension object are 15 pre-defined attributes that
administrators can configure for use on the Journal Entries,Import Journal Entries, and G/L Posted
Transactions forms. SyteLine users can then specify values in these analysis attributes fields as they
enter transactions. The fields may or may not be required, depending on how the administrator sets
them up. The attributes store values for a specific journal transaction based on the transaction account.
The values are then transferred to the posted ledger transaction and stored in association with the
ledger transaction similar to the way documents or notes are stored.

Setup

There are two methods for configuring the analysis attributes: quick setup using the Ledger Dimension
Analysis Attributes form and regular setup using the Dimension Attributes and Ledger Dimensions
forms. Quick setup is best when you do not need to build new tables, create table joins, or assign IDO
information for the analysis attributes. Regular setup allows for the more complex configurations.

These are the general steps for quick setup:

• Administrators gather analysis requirements from the finance department.
• Based on requirements, administrators use the Ledger Dimension Analysis Attributes form to

configure one or more of the 15 available analysis attributes. For each analysis attribute,
administrators can set properties, specify the attribute value, create a hard-coded values list, and
assign the attribute to selected Ledger dimensions.

See Quick Configuration - Dimension Analysis Attributes on page 289.

• Administrators use the Chart of Accounts form to assign a Ledger dimension to specific accounts.
The assigned dimension determines which analysis attributes are displayed for use on theJournal
Entries, Import Journal Entries, and G/L Posted Transactions forms, for related journal/ledger
transactions. It also determines what dimension attributes are associated with ledger transactions.
(Both dimension attributes and dimension analysis attributes can be assigned to a Ledger
dimension.)

See Specifying Dimensions and Attributes for G/L Accounts on page 282.

These are the general steps for regular setup:

• Administrators gather analysis requirements from the finance department.
• If new tables are needed to meet requirements, administrators use the Dimension Table Joins

form to define the base table for the Ledger object and to link the appropriate primary and secondary
tables to the base table.

• Administrators use the Dimension Attributes form to configure one or more of the 15 analysis
attributes. For each analysis attribute, administrators can set properties, specify the attribute value
or build a value expression, and add domain IDO information or create a hard-coded values list.

See Regular Configuration - Dimension Analysis Attributes on page 290 for more information.

• If new Ledger dimensions are needed before assigning the analysis attributes, administrators can
use the Ledger Dimensions form to create them.
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• Administrators use the Ledger Dimensions form to assign attributes, including analysis attributes,
to selected dimensions.

• Administrators use the Chart of Accounts form to assign a Ledger dimension to specific accounts.

Maintenance

To use and maintain the dimension analysis attributes, these are the general steps:

• With analysis attributes already configured, users can enter values for analysis on journal
transactions:
• If transactions are to be imported, users must prepare the XML or CSV file and then use

theImport Journal Entries form. On this form, users can import or copy and paste values for
the 15 dimension analysis attributes, as defined by the Ledger dimension specified for each
account. If corrections are needed after values are loaded, users can also modify values on
this form.

For requirements, see Importing Journal Entries from External Sources on page 219.

• On the Journal Entries form, users can specify values for one or more of the analysis attributes
for journal transactions within system journals, the General journal, and user-defined journals.
Some analysis attributes may be required for the General journal and user-defined journals
before a transaction can be saved, depending on how the administrator has configured them.

Note: Dimension analysis attributes are not populated when system journal rows are generated,
because the system journal rows are generated by SyteLine core functions. Analysis attributes
cannot be populated at that time.

• Users post journal transactions to the ledger. When a journal is posted to the ledger, all analysis
attribute values are carried forward, unless the user selects Compress Journal Before Post on
theLedger Posting for Journal form. In that case, related dimension analysis attribute values are
lost.

• Users update ledger attribute values using theGeneral Ledger Attributes Update utility. If journals
are compressed before posting, attributes of related ledger transactions cannot be populated by
running this utility.

See Updating Ledger Dimension Attribute Values on page 292.

• On the G/L Posted Transactions form, users can view and modify one or more of the analysis
attribute values in the ledger transactions.  

Analysis

The Ledger Dimension Details form is used to view and export the dimension attribute values of
ledger rows for a specified Ledger dimension. Users can filter ledger rows by transaction date and
account. Also, users can display the details of a ledger row in addition to just the ledger dimension
attributes/analysis attributes.

For more powerful data analysis, you have these options:

• If Infor BI is installed, you can export ledger transactions to BI, along with all dimension analysis
attributes. BI users can use cubes to perform their own analysis of this data.

• If Infor Query & Analysis is installed, you can extract ledger transactions, along with all dimension
analysis attributes. Data analysis can then be done with Infor Q & A or Microsoft Excel.
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Example: Ledger Dimensions and Attributes
This diagram shows an example of how the Ledger object can have multiple dimensions and attributes.
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Object
Ledger

Dimension
Customer

Dimension
Item

Dimension
Vendor

Attribute (Value)
Customer Number

P(customer.custnum)

Attribute (Database User-Defined Function)
Ledger Transaction Date Period

Dbo.GetPeriod(V(Ledger Transaction Date))

Attribute (Calculation)
Value Added Tax

V(Ledger Domestic Amount) * 0.10

Attribute
...

Attribute

Attribute

Attribute

Attribute
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In the diagram, the example shows the predefined object Ledger, which is used for Ledger transaction
analysis. The Ledger object has three predefined dimensions. Each of the dimensions have predefined
attributes that can include fields (properties) or calculated values, and predefined analysis attributes
that can be configured for use on journal transaction forms.

For more information, see About Dimension Analysis Attributes on page 285.

The system administrator can create additional dimensions. The number of dimensions for an object
is unlimited. The administrator also can create additional attributes (but not analysis attributes).

Note: A maximum of 100 attributes of any data type per dimension can be displayed on certain forms.

Quick Configuration - Dimension Analysis Attributes
Quick configuration can be used to set up a simple Ledger dimension analysis attribute -which does
not need table joins, domain IDOs, or a complex value expression- and assign it to a new or an existing
Ledger dimension.

1 Gather analysis requirements from the finance department.

2 Based on the requirements, use the Ledger Dimension Analysis Attributes form to configure
one or more of the pre-defined analysis attributes. Click Filter-In-Place and select a pre-defined
analysis attribute to configure.

3 Specify this information:

Value
Specify the attribute value.

Description
Specify a description for the attribute. This description is displayed as the field label on the Journal
Entries, Import Journal Entries, and G/L Posted Transactions forms. If no description is
specified here, then the attribute name (AnalysisAttribute01) is displayed on the forms.

Required
Indicate whether the attribute is required when transactions for the associated account are entered.
If it is required, then users cannot save a transaction until a value is entered. This setting is
applicable for entries in the General or user-defined journals.

Inline List
To provide a drop-down list of hard-coded values from which the user can select a value, click
Add Row and then enter the first value in the list. Repeat for all values to include in the list.

Apply to Dimensions
Specify the dimension(s) to which to apply this analysis attribute. Dimensions created on theLedger
Dimensions form are listed.

4 Save the record.

5 On the Chart of Accounts form, select an account and then on the Dimensions tab, select a
Ledger dimension with the configured analysis attribute. This assigns the dimension to the account.
When transactions are entered for this account, the analysis attributes will be included for data
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entry on the journal transaction forms. You can add one Ledger dimension for an account. You
can also add multiple Chart of Account dimensions for the account if needed.

Regular Configuration - Dimension Analysis Attributes
Regular configuration must be used to set up a Ledger dimension analysis attribute that needs table
joins or domain IDOs or for which you must build a value expression.

1 Optionally, use the Dimension Table Joins form to prepare tables for the Ledger object.

2 On the Dimension Attributes form, specify Ledger in the Object Name field and then click
Filter-In-Place. Select a pre-defined analysis attribute to configure.

3 Specify this information:

Description
Next to the attribute name, specify a description for the attribute. This description is displayed as
the field label on the Journal Entries, Import Journal Entries, and G/L Posted Transactions forms.
If no description is specified here, the attribute name (AnalysisAttribute01) is displayed on the
forms.

Value
Specify the attribute value. You can type directly in the Value text box or use the right pane to
build the value expression.

Masking
For numeric or date fields, you can specify an appropriate mask here. For example, a date field
might be masked as ##/##/##.

Hidden
Optionally, to hide the selected attribute in the analysis results, select this option.

Required
Indicate whether the attribute is required when transactions for the associated account are entered.
If it is required, then users cannot save a transaction until a value is entered. This setting is
applicable for entries in the General or user-defined journals.

Domain IDO
If the property to be used for the attribute is a foreign key, you can specify the domain IDO of the
property; that is, the other IDO where the property is defined.   

Domain Property
Specify the domain IDO property to be used for the attribute.

Domain List Property

Specify the property that will contain a value to display along with the Domain Property value. For
example, Description with Item.

Inline List
To provide a drop-down list of hard-coded values from which the user can select a value, clickAdd
Row and then enter the first value in the list. Repeat for all values to include in the list. See Example:

Infor SyteLine Financials User Guide | 290

 

Ledgers



Configuring and Applying an Analysis Attribute on page 291. This option can be used only if you
do not specify domain IDO information.

4 Save the record.

5 On the Ledger Dimensions form, create a new dimension or select an existing dimension and
then in the grid, add the configured analysis attribute. You can modify Masking, Hidden, and
Required settings for the attribute if necessary. You can add up to 15 analysis attributes for the
dimension. You can also add other Ledger attributes if needed. If you add more than one attribute,
you can update the sequence. Change the sequence numbers and then click Resequence.

6 On theChart of Accounts form, select an account and then on the Dimensions tab, select a Ledger
dimension with the configured analysis attribute. This assigns the dimension to the account, so
when transactions are entered for this account, the analysis attribute fields are included for data
entry on the journal transaction forms. You can add one Ledger dimension for an account. You
can also add multiple Chart of Account dimensions for the account if needed.  

Example: Configuring and Applying an Analysis Attribute
This example shows creation of the Cash dimension and the Expense Type dimension attribute for the
Ledger object, with initialized dimension attributes for Customer Number and Vendor Number. The
Cash dimension is bound to Account 10000.

1 On the Ledger Dimension Analysis Attributes form, filter and select AnalysisAttribute01. In the
Value list, select Customer Number.

2 In the Apply to Dimensions grid, specify Cash in the Dimension Name and Description columns
and click the Select field. Click Save.

3 Select AnalysisAttribute02. In the Value list, select Vendor Number. In the Apply to Dimensions
grid, click the Select field for Cash. Click Save.

4 Select AnalysisAttribute04. Leave the Value field empty. In the Description field, specify Expense
Type. In the Inline List grid, specify three Value/Description entries: Traffic Fee/Traffic Fee
Expense, Meal Fee/Meal Fee Expense, and Lodging Fee/Lodging Fee Expense. In theApply to
Dimensions grid, click the Select field for Cash. Click Save.

5 On the Chart of Accounts form, filter and select Account 10000. On the Dimensions tab, in the
Ledger Dimension field, select Cash. Click Save.

6 On the Journal Entries form:

a Filter on the General journal.
b In the grid, add a new row.
c In Account, select 10000 and in Credit, specify 10.00.
d On the Dimensions tab, see that the three defined analysis attributes are enabled. In Expense

Type, select Meal Fee.
e Add another new row to balance the journal and then click Save.
f Add another new row.
g In Account, select 10000 and in Credit, specify 1000.00.
h On the Dimensions tab, in Customer Number, specify 1.
i Add another new transaction row to make an advanced payment to balance the journal and

then click Save.
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Updating Ledger Dimension Attribute Values
After journal transactions are posted to the ledger, the General Ledger Attributes Update form is
used to update dimension attribute values for ledger transactions. You can choose to include analysis
attribute values in the update. You can also choose to overwrite existing data, so stored attribute values
are updated, if necessary.

Normally, the General Ledger Attributes Updateutility is run as a background task; however, if you
make an attribute change, for example to a company name, you can run the utility manually.

Also, the G/L Posted Transactions form can be used to update just dimension analysis attribute
values.  

Modifying Dimension Analysis Attributes
After dimension analysis attributes have been configured, administrators can modify them on the
Ledger Dimension Analysis Attributes, Dimension Attributes, or Ledger Dimensions forms. If
there are existing journal or ledger transactions with associated analysis attribute values, this data is
not removed or changed when dimension analysis attributes are reconfigured.

Also, when you delete a value from the Inline List of an analysis attribute, and if the value has been
used by a ledger transaction row, you are prompted to confirm your action.

In either case, stored data is changed only if you run the General Ledger Attributes Update utility
with Update Analysis Attributes and Overwrite Existing Data selected.
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Chapter 12: Multiple Financial Sets of Books
(Multi-FSB)

Multiple Financial Sets of Books Overview
SyteLine provides Multi-Financial Sets of Books (FSB) functionality for businesses that require reporting
for one or more ledgers in addition to the General Ledger. Each new ledger can contain any combination
of a fiscal calendar, chart of accounts, and currency that are different from those used for the standard
General Ledger. Each combination creates a separate financial set of books, and you can set up as
many as you need.

A setting on the General Parameters form is used to enable multi-FSB functionality. With this option
selected, you can define and activate multiple financial sets of books using the SyteLine multi-FSB
forms. Many of the forms function similarly to the standard General Ledger forms.

This table lists all Multi-FSB forms and the related standard GL forms, if applicable:

Related Standard General Ledger FormsMulti-FSB Forms

Accounting PeriodsMulti-FSB Accounting Periods

N/AMulti-FSB Charts

Chart of AccountsMulti-FSB Chart of Accounts

N/AMulti-Financial Sets of Books

Chart of Accounts Budget and PlanMulti-FSB Chart of Accounts Budget and Plan

Journal EntriesMulti-FSB Journal Entries

Ledger Posting for JournalMulti-FSB Ledger Posting for Journal

Copy Balances to BudgetsMulti-FSB Copy Balances to Budgets

N/AMulti-FSB Copy Chart of Accounts

N/AMulti-FSB Chart of Accounts Mapping Report

General LedgerMulti-FSB General Ledger

General Ledger Check Information ReportMulti-FSB General Ledger Check Information
Report

General Ledger Transaction ReportMulti-FSB General Ledger Transaction Report

General Ledger Worksheet ReportMulti-FSB General Ledger Worksheet Report
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Related Standard General Ledger FormsMulti-FSB Forms

Journal Account SummaryMulti-FSB Journal Account Summary

Journal Transaction ReportMulti-FSB Journal Transaction Report

Trial BalanceMulti-FSB Trial Balance

Compress General Ledger TransactionsCompress Multi-FSB Ledger Transactions

Rebalance Ledger Period TotalsMulti-FSB Rebalance Ledger Period Totals

Refresh Account/Unit CombinationsMulti-FSB Refresh Account/Unit Combina-
tions

Year End Closing Journal EntriesMulti-FSB Year End Closing Journal Entries

Accounting Periods QueryMulti-FSB Accounting Periods Query

N/AMulti-FSB Charts Query

Chart of Accounts QueryMulti-FSB Chart of Accounts Query

N/AMulti-Financial Sets of Books Query

Chart of Accounts Budget and Plan QueryMulti-FSB Chart of Accounts Budget and Plan
Query

Journal Entries QueryMulti-FSB Journal Entries Query

Multi-FSB Accounting Periods

Multi-FSB accounting periods for each new fiscal calendar must be created using the Multi-FSB
Accounting Periods form and given a name that differentiates them from all other accounting periods.
They must be maintained manually, because period changes and closing are not performed by the
system, even if the settings match the standard GL accounting periods.

Multi-FSB Chart of Accounts

After creating a unique multi-FSB chart of accounts record using the Multi-FSB Charts form, accounts
typically are added automatically using the Multi-FSB Copy Chart of Accounts form. The accounts
also can be added manually using the Multi-FSB Chart of Accounts form.

Accounts added to a multi-FSB chart of accounts can exist only on that chart; they cannot be used on
other multi-FSB charts. However, the same account numbers can be used on other charts of accounts.
They are treated as different accounts for each chart.

Each multi-FSB account can be mapped to one or more accounts in the standard GL Chart of Accounts,
but they are not required to be mapped. All GL accounts must be mapped to a multi-FSB account,
except for analytical accounts, which are not mapped. Also, a GL account can be mapped to only one
account per multi-FSB chart of accounts. You can specify unit codes for multi-FSB accounts or inherit
them from the mapped GL accounts. A utility can be run to verify that all GL accounts are mapped
correctly for a selected multi-FSB chart of accounts. The Multi-FSB Chart of Accounts Mapping
Report is provided for reviewing this mapping.
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This example shows how different accounts can be mapped for multi-FSB charts of accounts:
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1000010000

1100011000

3000030000

5000050000

FSB 1
Account numbers
used are the same
as GL account
numbers.

FSB 1
Account numbers
used are the same
as GL account
numbers.

General LedgerGeneral Ledger

1000010000

1100011000

3000030000

5000050000

5500055000

5600056000

FSB 2
Domestic currency

FSB 2
Domestic currency

1000010000

2500025000

3500035000

FSB 3
Non-domestic

currency

FSB 3
Non-domestic

currency

Example of account mapping invoked
during ledger posting

Example of account mapping invoked
during ledger posting
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The Multi-FSB Chart of Accounts Budget and Plan form also is provided so you can enter budget,
plan, and actual amounts for each individual account, accounting period, and fiscal year.

Multi-FSB Ledger

The Multi-Financial Sets of Books form is used to name, set up, and activate the combination of a
multi-FSB fiscal calendar, multi-FSB chart of accounts, and a new or selected currency. If you want to
use the same chart of accounts or fiscal calendar as that in the standard General Ledger for one of
your multi-FSBs, you must create that COA or fiscal calendar a second time using the multi-FSB forms.

After activation, the multi-FSB ledger is ready to receive transactions. As records are posted to the
General Ledger, they are also posted to all active multi-FSB ledgers. Multi-FSB ledgers also can receive
records that you post using the Multi-FSB Journal Entries form.

Multi-FSB ledger records use the multi-FSB currency and are recorded to multi-FSB accounts based
on the mapping of the standard GL accounts.

Journal entries can be created for any active multi-FSB, but transactions can be entered only into the
General Journal. No multi-FSB transactions are posted to the General Ledger or to other multi-FSB
ledgers.

Year-End Journal Entries

When the General Ledger set of books is closed for the year, it gets posted to all active multi-FSBs
based on account mappings. However, these transactions are not shown on the multi-FSB ledger
reports. Also, multi-FSBs are not closed when the GL set of books is closed, even if they have the
same fiscal calendar. Each active multi-FSB must be closed separately using the Multi-FSB Year End
Closing Journal Entries utility. The transactions must be posted to complete the year-end procedures.
Year-end transactions or adjustments made in a multi-FSB are not recorded in any other financial set
of books.

Different Fiscal Year Ends

All year-end transactions are recorded into the accounting period based on the date of the transaction.
Therefore, as transactions are copied from the GL financial set of books to all active multi-FSBs, each
transaction is recorded in the accounting period as assigned to its financial set of books. This way, a
transaction can be recorded into different periods, and even different fiscal years, based on the
accounting periods of each financial set of books.

Reporting

You can run reports on the multi-FSB ledgers to show transactions:

• In the multi-FSB accounts
• In the multi-FSB currency
• In the multi-FSB accounting period

General Ledger and Trial Balance reports are available, but multi-FSB transactions are not available
on the financial statements. Ledger entries with the reference of Income Summary or Year Closing can
be reviewed on the multi-FSB GL reports.
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Limitations

SyteLine multi-FSB functionality does not include the following:

• Mapping of transactions from a multi-FSB with the standard GL FSB, including year-end transactions.
• Mapping of a single GL account to multiple accounts in the same multi-FSB chart of accounts.
• Multi-FSB support in multi-site/entity configurations.
• Period sorting for multi-FSBs. Standard GL sorting is used.
• Ability to copy multi-FSB chart budgets and plans from the standard GL. They must be entered

manually for the multi-FSB.
• Ability to create different multi-FSB unit codes. Multi-FSB accounts receive the same unit codes

as the standard GL accounts they are mapped to. If a multi-FSB account is not mapped to a GL
account, then unit codes can be specified for the multi-FSB. The unit codes values that can be
selected for a multi-FSB account come from the Unit Code (number) forms.

Setting Up Multiple Financial Sets of Books
To set up a multi-FSB, follow these steps:

1 On the General Parameters form, select Multiple Financial Sets of Books.

2 If this set of books will use a currency that is not already set up in SyteLine, use the Currency
Codes form to add the new currency.

3 On theMulti-FSB Accounting Periods form, create a fiscal calendar for the new set of books.

4 On the Multi-FSB Charts form, specify a name and description for the chart of accounts for this
set of books.

5 Save the record.

6 Add accounts to the new chart of accounts, either automatically or manually.

a To add accounts automatically, click Copy COA on the Multi-FSB Charts form. This opens
the Multi-FSB Copy Chart of Accounts form so you can copy the standard GL chart of
accounts for the new set of books.

b To add accounts manually, use the Multi-FSB Chart of Accounts form. See Maintaining the
Multi-FSB Chart of Accounts on page 299.

7 On the Multi-FSB Charts form, click Confirm Mapping to run a check on account mapping. A
message is displayed to let you know if there are any problems. If successful, the Accounts
Mapped option is selected automatically.

8 On the Multi-Financial Sets of Books form, define the new set of books with this information:

• FSB: Specify a name and description for the new set of books.
• FSB COA: Select the chart of accounts created above.
• Fiscal Calendar: Select the fiscal calendar created above.
• Currency: Specify the currency to use for this set of books.
• CTA Account: Select the account to use for recording debits and credits that may occur to

rebalance the Multi-FSB ledger due to currency conversion during general ledger posting. This
is necessary only if the selected Currency is not Domestic.
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9 Save the record.

10 If you need beginning balances for the multi-FSB ledger, use the Multi-FSB Journal Entries form
to enter them manually and then post them.

11 To activate the new financial set of books for use, select Active on the Multi-Financial Sets of
Books form. Once active, the multi-FSB receives all posted GL ledger transactions, regardless of
the date.

If you select Compress Ledger, ledger records for this set of books are compressed automatically
by date, account, and unit code. For additional flexibility, you can use the Compress Multi-FSB
Ledger Transactions utility to set different compression options and process the compression.

Maintaining the Multi-FSB Chart of Accounts
Use the Multi-FSB Chart of Accounts form to manually set up and maintain mapping of multi-FSB
accounts with accounts from the standard GL Chart of Accounts.
Note: You can initially map multi-FSB accounts automatically by copying the standard GL Chart of
Accounts using the Copy COA button on the Multi-FSB Charts form. Then use this form to add,
remove, or change account mapping.

To map an account:

1 Open the Multi-FSB Chart of Accounts form.

2 Select Actions > New.

3 In the FSB COA field, select a multi-FSB chart of accounts to work with.

4 In the FSB Account field, specify an identifier for the multi-FSB account.

5 In the field to the right of the FSB Account field, specify a description of the account for reference.

6 In the FSB Account Type field, select the account type.

7 Optionally, you can specify a FSB Account Class for financial reporting.

8 Do one of the following:

• To map to an existing account from the standard GL Chart of Accounts, select the account on
the GL Accounts tab.

• For an unmapped account, specify unit code requirements for the account. In each of the Unit
Code 1-4 fields, select one of these options:
• No Access: The reporting unit field will not be accessible for this account. The system also

disables the corresponding Unit Code tab on the form.
• Accessible: The reporting unit field will be accessible for this account.
• Required: The reporting unit field is required for this account.

9 On the associated Unit Code tabs, you can add or remove unit codes.
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Deleting Multi-FSB Records
You can use the Delete button on the toolbar to delete a selected multi-FSB record on theMulti-Financial
Sets of Books form.

When a multi-FSB record is deleted, all FSB ledger records and associated data are deleted as well.

About the Multi-FSB Year-End Closing Process
The Multi-FSB Year-End Closing Journal Entries form generates multi-FSB fiscal year-end journal
transactions to close out all revenue and expense accounts into an income summary account. A journal
transaction that shows the net income, or sum of all year-end transactions, is also created. The
transactions are generated to the journal only and not posted to the ledger. The transactions may be
further modified and must be posted to complete the year-end procedures.

Generally you perform the multi-FSB year-end closing at the end of the company's FSB fiscal year,
but it can be performed at any time by specifying the fiscal start and end date without regard to the
defined accounting periods. The fiscal calendar and subsequent periods are defined on the Multi-FSB
Accounting Periods form.

Before running the multi-FSB year-end closing function, you should verify that all outstanding journal
transactions for the fiscal calendar are entered and posted to the ledger. This function generates journal
transactions that set all revenue and expense account balances to zero. If all journal transactions are
not posted to the ledger, the transactions created may not actually set all revenue and expense account
balances to zero.

Only one user at a time can have the ledger open. Therefore, if someone is running a financial report
or performing year-end closing, this function cannot be performed until the original process is complete.

Closing the Year for Multi-FSB General Ledger
Caution:  This procedure creates debit and credit entries to close out all revenue and expense
accounts for the date range specified. These entries are placed in the Multi-FSB General Journal.
You must then post the Multi-FSB General Journal to the Multi-FSB General Ledger.

Note: This procedure should be run only after all entries made to the fiscal year are posted. Also, to
close the journal, it must be writable.

To close the year for the Multi-FSB General Ledger:

1 Open the Multi-FSB Year End Closing Journal Entries form.

2 Specify this information:

Fiscal Year
Select the fiscal year for which to close a financial set of books. The default value is the current
fiscal year from General Parameters.
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FSB
Select the financial set of books to close. Only those FSBs active for the specified fiscal year are
shown.

Fiscal Year Start Date
The default value for this field is the specified fiscal year start date, taken from the Multi-FSB
Accounting Periods form. Optionally, you can change this date. This generates year-end
transactions for transactions occurring on or after this date.

Fiscal Year End Date
The default value for this field is the specified Fiscal Year end date, taken from the Multi-FSB
Accounting Periods form. Optionally, you can change this date. This generates year end
transactions for transactions occurring up to this date.

Income Summary Account
Select the "Retained Earnings" account for the year-end closing transaction. The account's type
must be set up in the Multi-FSB Chart of Accounts as Owner's Equity.

Delete Current Journal Entries
To delete all journal entries for this journal before generating the year-end transactions, select this
check box. This refers to the existing entries in the Multi-FSB General Journal only. Do not change
any of the references generated by the system on the entries in the Multi-FSB General Journal.
If this check box is selected, all journal transactions along with any associated text are deleted
when the transactions are generated, prior to creating the closing transactions.

Unit Code Detail

To clear unit code balances in the revenue and expense accounts, leave the Unit Code Detail
check box selected. If this check box is cleared, balances are left in the unit codes and carried
forward.

3 Click Process.

Note: You can close multi-FSB fiscal years an unlimited number of times. If you have closed the fiscal
year and need to enter transactions for that year, you can post the transactions and then run the
year-end close again.

See the example in Closing the Year for General Ledger on page 236.
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Chapter 13: Taxes

Automatically Create Tax Transactions
The system automatically creates tax transactions for you after you perform this setup.

1 On the Account Tax Code Defaults form, assign an account with the proper Tax Code, Exempt
Code, and Tax Account set. You cannot leave the Tax Code field blank. See the example to
determine when the tax entries or references are created.

2 On the Journal Entries form, select or clear the Taxable check box. If you select this check box,
the taxable tax code populates the Tax Code field. This is the tax code you set up on the Account
Tax Code Defaults form. If you clear the Taxable check box, the exempt tax code is displayed in
the Tax Code field. This code also comes from the Account Tax Code Defaults form.

3 On the Journal Entries form, adjust the tax code in the Tax Code field if necessary.

4 On the Journal Entries form, adjust the total amount in the Total Amount field if necessary.

5 Post the journal transactions. If no journal compression takes places, the records are updated and
are eligible to display on the Consumption Tax Report. If journals are compressed, the record is
deleted.

For example, this table shows when tax entries or references are created.

Tax Journal Entry
Created

Journal Reference Created=Tax CodeTaxable

YesYes=Rate CodeYes

NoYes=Exempt or 0 Rate
Code

No

NoNo=BlankNo

Recording Tax for Manually Created Journal
Transactions
The Journal Entries form allows you to define a journal entry transaction as a tax amount. These tax
amounts can then be reported on the EU VAT Report or VAT Report.

1 Specify the accounts for which tax transactions can be created from manual journal entries.
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See Defining the Accounts that Can Have Tax Records Created on page 303.

2 Specify the tax amounts in journal entries.

To specify a journal entry that includes tax:

a On the Journal Entries form, create a manual journal entry transaction into the General journal,
or another user-defined journal.

b Select Taxable. This indicates that the transaction uses the Tax Code or the Exempt Code
from the Account Tax Code Defaults form that is specified for the account. When this field
is selected, the Tax Amount and Total Amount fields are disabled and any values in them
are deleted.

Or, to specify a tax amount as a separate journal entry transaction:

a On the Journal Entries form, create a manual journal entry transaction into the General journal,
or another user-defined journal.

Note: The account you specify for this type of transaction must be set up on the Account
Code Tax Defaults form.

b Select Taxable. This indicates that the transaction uses the Tax Code or the Exempt Code
from the Account Tax Code Defaults form that is specified for the account.

c Select Entry is Tax. to indicate that the journal entry you are creating is an entry for the actual
tax amount. When this field is selected, the Tax Amount and Total Amount fields are disabled
and any values in them are deleted.

d Specify the Tax Code. (The Tax Account is not used.)

If the tax amount is automatically calculated, the amount is calculated as the debit or credit
amount, multiplied by the tax rate of the tax code. The journal transaction created for the tax
record is for this amount. If a debit amount is entered, this value is a debit amount. If a credit
amount is entered, this value is a credit.

3 Save your changes.

Defining the Accounts that Can Have Tax Records
Created
Use the Account Tax Code Defaults form to specify the accounts for which tax transactions can be
created from manual journal entries. This is similar to the A/P and A/R Tax Accounts that are defined
to temporarily hold VAT tax amounts for invoices and vouchers, but the accounts you specify here are
used for transactions that are not based on invoices or vouchers.

1 On the Account Tax Code Defaults form, select an account for which you want to allow tax records
in the journal entries. The account description is displayed.

2 Select the appropriate tax code to use.

3 In the Exempt field, select a tax code with a tax code type of Exemption.

4 Select the tax account and unit codes to use. In the case of tax journal entry transactions, you
would use the same account number in the Account and Tax Account fields.

5 Save your changes.
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Setting up Value-Added Tax Information
Use these general steps to set up value-added (VAT) tax code information in the system for use with
the EU VAT Report.

If you plan to use the VAT Report instead, see Setting Up Tax Information for the VAT Report on page
304.

1 In the Tax Systems form:

• Set up a Tax System 1 with Tax Mode set to Item.
• Specify the Transfer A/R VAT Tax Code and Transfer A/P VAT Tax Code.

2 On the Tax Codes form:

• Select the Transfer VAT check box.
• Specify the A/R Account and A/P Account.
• Specify the VAT A/R Received Account field and VAT A/P Paid Account.

Setting Up Tax Information for the VAT Report
Use these general steps to set up value-added (VAT) tax code information in the product so you can
later run the VAT Report:

1 On the General Parameters form, select Activate EU Reporting. Also, specify the EU Weight
Conv Factor, which is used to convert item weights to kilograms on the EU SSD Report.

2 On the Workflow Event Handler Activation form, select Active for this Site for the Validate EU
VATIN event handler. This enables the application to call a web service to validate the VAT ID on
the Customers, Vendors, or Customer Ship-Tos forms

3 If you plan to send EU SSD reports as ASCII or XML files, specify the SSD File Logical Folder
and the dispatch and arrival interchange IDs in the Tax Parameters form. You can get the IDs
from the appropriate federal statistical office in countries where this is required, for example,
Germany. The user who runs the report must have authorization to create files in the logical folder.

4 If a state tax office value is required for use with intrastat SSD data files, specify the value in the
Prov/States form. You can get the state tax office IDs from the appropriate federal statistical office
in countries where this is required, for example, Germany.

5 Use the EU VAT Reporting Categories form to view and further define the available VAT tax
categories, and to determine whether each category requires offsetting tax entries. The categories
that are listed cannot be changed; however, you can specify a category description that is displayed
in the VAT Report.

6 On the Tax Systems form, set up a Tax System 1 with Tax Mode set to Item. An item-based tax
system allows sales taxes to be charged at the line item level and tax codes to be specified in the
Items form. The system looks at the tax rate of the order line item and overrides the tax code on
the order header.

On the General tab, select the Tax Discount/Allowance field for Tax System 1. This allows the
system to calculate tax adjustments in payments due to discounts and allowances. It also disables
the Next Level Tax Code field on the Tax Codes form.
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Caution:  The fields on the General tab should not be changed after there are valid transactions
in the system. This can invalidate your data and compromise integrity. For example, if the Active
For Purchasing field is set to Yes after purchase orders have already been entered into the
system, the current purchase orders will not contain the proper tax codes, and the tax records
on the PO side will be nonexistent.

7 On theTax Codes form, set up codes:

• Allocate each tax code to a category.
• Select the Transfer VAT check box.
• Specify the A/R Account and A/P Account.
• Specify the VAT A/R Received Account field and VAT A/P Paid Account.

8 Return to the Tax Systems form. On the Tax Codes tab, define the default tax code information
for Tax System 1. Specify the Transfer A/R VAT Tax Code and Transfer A/P VAT Tax Code.

Use the Labels tab to customize labels for tax codes, tax amounts, and tax IDs.

9 On the Account Tax Code Defaults form, set up tax codes to use as the default tax account when
creating manual journal entry transactions that are not based on invoices or vouchers.

10 Use the Tax Parameters form to set your company's specific reporting and functionality
requirements, including SSD information.

11 Set up the Tax Line Numbers form to allocate tax codes to the appropriate lines of the fiscal
authority report. The line numbers in this form refer to the lines in the fiscal department tax formula.
If line numbers are assigned, you can later sort the VAT Report by line number, which allows you
to more easily fill in the required fiscal authority report.

Calculating Value-Added Tax Information
After VAT information is set up in the system, VAT is recognized at the time of payment for service
invoices, and at the time of invoicing for merchandise invoices. For PO vouchers, VAT is recognized
when the voucher is submitted for payment. VAT for manual journal entries is also recognized.

VAT amounts paid are placed into the appropriate A/P or A/R tax account at the rate specified by the
assigned tax code. Upon bank reconciliation of the payment or deposit, the system determines the
VAT amount to transfer after bank reconciliation. The VAT amount is then transferred to either the VAT
A/R Received Account or VAT A/P Paid Account. The VAT is paid to the taxing authority from this
account.

Setup

See Setting Up Tax Information for the VAT Report on page 304.

Processing VAT

For A/R, after you reconcile a deposit on the Bank Reconciliations form, the system:

• Calculates the VAT amount to be transferred.
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• Creates journal entries by debiting the A/R tax account with the calculated VAT amount and crediting
the VAT A/R Received Account.

• Transfers the VAT amount from the A/R tax account to the VAT A/R Received Account.

For A/P, after you reconcile a payment on the Bank Reconciliations form, the system:

• Calculates the VAT amount to be transferred.
• Creates journal entries by crediting A/P  tax account with the VAT amount and debiting the VAT

A/P Paid Account.
• Transfers the VAT amount from the A/P tax account to the VAT A/P Paid Account.

The system automatically updates A/P payments during bank reconciliation. However, the system does
not automatically update A/R deposits during bank reconciliation. Customer A/R deposits must be
manually entered on the Bank Reconciliations form.

Organizing VAT Information for Reporting to Tax Authorities

EU VAT reporting information is generated through these forms:

• VAT Report, which is used to sort and display accounts, categories, and VAT amount information
that must be included on EU VAT tax return documents

• EU VAT Report, which is an alternative to the VAT Report
• EU Sales List Report, also known as the EC Sales List Report
• EU Supplementary Statistical Declaration (SSD) Report, also known as the Intrastat Report

These reports detail intra-EU trade only.

Verifying Customer and Vendor VAT Numbers

For customers or vendors in European Union countries, you can enter the customer or vendor VAT
number in the [Tax ID Label 1] field on the Customers, Customer Ship-Tos, or Vendors form. The
EU mandates that all VAT numbers must be verified yearly.

Click the validation button next to the [Tax ID Label 1] field to pass the specified VAT number to the
VAT Information Exchange System, which verifies that the number is valid for each EU member. A
success or failure message is returned, and the date when the verification expires is stored in the
customer table. When the validation is successful and you save the record, all customer ship-to records
with the same VAT number, EU code and tax code are also updated with the new date.

The icon next to the button indicates whether the VAT number has been verified within the last year
(green check mark) or needs to be verified (red X).

These forms determine if a customer's VAT number is valid at the time of an order due date or shipment
date:

• Customer Order Lines
• Customer Order Blanket Releases
• Customer Orders Quick Entry
• EDI Customer Order Lines
• EDI Customer Order Blanket Releases
• Order Shipping
• Shipment Master
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If the number is not valid at the ship date/due date, a warning message is displayed. However, you
are still allowed to ship the order.

Purging VAT Transactions

Run the Bank Reconciliation - Compression utility occasionally to purge transactions related to
deposits.

Setting up VAT Tax Line Numbers
Each year, companies in some countries, for example, Germany, must submit a VAT advance tax
return to the fiscal authority. The format of this return changes from year to year.

Use the Tax Line Numbers form to define the line numbers on the tax return for a specific year. Map
each line number to the tax system and tax code that are used to derive the amount that goes in that
line of the report.

The VAT Report output can then be sorted by Line Number, and you can use the subtotals for each
line number as the amounts to enter for those lines on the VAT advance tax return.

To set up the VAT tax line numbers:

1 On the Tax Line Numbers form, specify this information:

Line Number
Specify the line number from the VAT advance tax return document. These are the numbered
lines on the left side of the tax document. Specify only line numbers where an amount must be
entered.

Description
Specify the description for that line from the tax document.

Effect Year
Specify the effective year for the tax document that uses these line numbers.

Tax Type
Specify the tax type for the line number: S (Sales) or P (Purchase).

Number for Tax Basis
If this line number includes an amount entry box in the first column on the tax document, specify
the box number here.

Number for Tax
If this line number displays an amount entry box in the second column on the tax document, specify
the box number here.

Tax System
Specify the tax system associated with the line number. If there is only one tax system, this field
is disabled.
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Tax Code

Specify the tax code associated with the line number. For example, if the Tax Type is set to P,
specify the tax code that is defined for purchasing transactions.

If the same tax code is used for both Tax Type S and P tax lines, the tax type for a particular
transaction is determined by the tax account that was used for the transaction. (The tax account
is defined in the Tax Code.) For example, if a transaction uses the tax account defined as the A/R
Tax Account for the tax code, the transaction is included in a tax line with Tax Type S. If the
transaction uses the tax account defined as the A/P Tax Account, the transaction is included in a
tax line with Tax Type P. This situation occurs in the EU.

2 Save your changes.

About EU VAT Reporting Categories
The categories that are described in this topic are defined on the EU VAT Reporting Categories form.

If Activate EU Reporting is selected on the General Parameters form and the Germany Country
Pack is licensed and enabled, you can use the categories in these forms:

• Tax Codes form: You can specify a category for each tax code.
• VAT Report form: You can choose to sort the report by tax code categories, and have subtotals

for the categories.

Category Descriptions

These predefined categories are included:

Create offset-
ting tax entries?

DescriptionCategory

NoCan be both sales tax and purchase tax, but only for domestic
transactions.

Tax

NoDomestic sales tax.Sales Tax

NoDomestic purchase tax.Purchase Tax

NoEU sales tax for goods. The base amounts must also be re-
ported in the EU Sales List Report with a blank Process In-
dicator.

EU Sales

YesTax must be calculated with the populated percentage for
each posting. One tax account is posted in the debit and
another tax account in the credit.

EU Purchase

NoEU sales tax for triangular transactions, where three different
EU countries are affected by one order. The base amounts
must also be reported in the EU Sales List Report with a
Process Indicator of 2.

EU Triangular
Sales
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Create offset-
ting tax entries?

DescriptionCategory

NoEU tax on a purchase from outside the EU countries. There
is only an invoice from Customs with the tax, and nothing
else. When you post this invoice in the application, the tax
amount goes directly to the tax line and thus into the tax re-
port.

Tax on Import

NoTax where only part of the invoice net amount is valid for the
tax calculation.

Old Part Tax

NoSame as the Tax on Import, but for a domestic purchase tax.Manual Tax

YesTax on special domestic transactions such as import of ser-
vices. The tax must be calculated with the populated percent-
age for each posting. One tax account is posted as a debit,
and another tax account is posted as a credit. This charge
is used to create offsetting entries for goods between coun-
tries, when you want to record the transaction but not make
a payment.

Reverse Charge

NoEU sales tax for services.  The base amounts must also be
reported in the EU Sales List Report with a Process Indi-
cator of 1.

EU Services

Offsetting Tax Entries

For some categories of VAT tax, the system must create offsetting debit and credit entries.

When tax codes that are assigned these categories are used in some areas of the system, special
processing occurs:

• When generating a voucher on the Generate A/P Transactions form, the system generates two
distributions against the tax code at the same time, on the Taxes tab and in the aptrxd table.

• When generating a voucher in the Voucher Builder, the system generates two distributions against
the tax code at the same time, in the aptrxd table.

• When automatically generating a voucher during Purchase Order Receiving, the system generates
two distributions against the tax code at the same time, in the aptrxd table.

• Offsetting tax entries are triggered by using a VAT exempt tax code on the PO header and VAT
rate code on lines. In this case, the offsetting entries create the values based on the lines, but then
offset each other to ensure that the total VAT on the voucher is still zero.

In all of these cases, one tax distribution is calculated as (tax basis * tax rate) payable, and the other
is calculated as (tax basis * tax rate) deductible. No matter what tax rate is defined, the calculated sales
is zero.

This functionality is used with the Exempt Tax Code on the purchase order header.
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Generating the VAT Report
On invoicing, a company in the EU must charge VAT when your customer is domestic or located in
another member state, and when the customer is not registered and arranges for the transport of goods
from another location. These cases are identified by a blank tax code on the customer order and for
the customer. Otherwise, enter a zero-rated tax code in the customer order and for the customer. If
you can define the transaction as distance selling, you must know the threshold of the customer, and
fill in the tax codes when appropriate.

Use the VAT Report form to extract information from invoice and voucher sales tax information, from
the Invoice Register and A/P Voucher Register line items, and from the manual journal entries tax
table. The information can be grouped in various ways to provide subtotal amounts that can be used
to fill in the VAT reports that are required by tax authorities.

Note:  If the Process Indicator is set to 3 for a transaction, then that amount is not included in the total
of invoice register and A/P voucher register line items.

To set up the report:

1 On the VAT Report form, specify the tax system, if there is more than one. Otherwise the tax
system defaults to 1.

2 Specify a tax jurisdiction.

3 Specify the way in which the report is sorted and subtotaled:

• Category: Sort by category and then by tax code. Categories are defined on the EU VAT
Reporting Categories form and are assigned to tax codes on the Tax Codes form.

• Tax Code: Sort by the codes that are defined on the Tax Codes form.
• Tax Account: Sort by the actual tax account numbers.
• Tax Base Account: Sort by the account that is being taxed, for example the sales order

account.
• Line Number: Sort by the line numbers and boxes on certain tax documents, as defined on

the Tax Line Numbers form.

4 Specify the date range of the tax period to include on the report.

5 Select Increment Date to have the system automatically increment date ranges and re-run the
report.

6 Click Preview to preview the report output or Print to print the report.

In the report output, each VAT amount is broken down to show the relevant transactions, including
voucher or invoice number and the tax breakdown.

About Consumption Tax Reporting
Use the Consumption Tax Report to report consumption tax data according to posted activity during
a specified fiscal period. You can then use information from the report to fill out your Consumption Tax
(CT) returns.
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With the Consumption Tax, companies are taxed on the supplies they purchase, and taxes are withheld
on goods the companies sell. Companies must periodically pay the difference between the CT paid
on supplies and the CT charged on goods or services.

The frequency of filing Consumption Tax returns depends on your turnover. The tax return lists all of
your company's transactions related to the supply of relevant goods or services. Any tax due must be
paid simultaneously with the filing of the tax return. In the case of a tax credit, where the CT incurred
by the company exceeds the CT charged on its sales and services in the reporting period, documentary
proof related to the transactions is often requested.

Consumption Tax is recognized upon invoicing for both goods and services.

If the Japan Country Pack is licensed and enabled, the amount can be computed on either the invoice
header or on the invoice lines. In large companies, where the unit prices tend to be large, they may
prefer line-level tax calculations. In smaller companies, where the unit prices tend to be smaller, they
may prefer header-level tax calculations. You set this preference on the Customers form.

If the Japan Country Pack is licensed and enabled, the calculated tax amount can be rounded off (for
example, 4.4 becomes 4.0 and 4.5 becomes 5.0) or it can be rounded up (for example, 4.4 becomes
5.0). The rounding rule must be agreed upon by the customers and vendors and is also set on the
Customers form.

The Consumption Tax has three components:

• Input tax on vendor vouchered amounts
• Output tax on customer invoiced amounts
• Automatic tax entries

You must set up separate A/R and A/P tax accounts to record the amounts for these components.

Example ledger transactions created for sales, purchasing, and the manual journal entries could look
as follows:

AmountAccountLedger Transaction

100030000Manual Entry

5015000Manual Entry

50030000Manual Entry

200040000Invoice

10020200Invoice

35040000Invoice

50050000Voucher

5050100Voucher

250050000Voucher

The tax records in the various tables that correspond to these ledger records would be:
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Tax RateTax CodeTax BasisTaxTax AccountTable

5OH10005015000Japan Journal
Tax Table

0NT500015000Japan Journal
Tax Table

5OH200010020200Invoice Sales
Tax Table

0NT350020200Invoice Sales
Tax Table

10US5005050100Voucher Sales
Tax Table

0NT2500050100Voucher Sales
Tax Table

For the Consumption Tax Report, you create records in the Consumption Tax Report Account Setup
form for accounts 30000, 40000, and 50000, and give them a description to describe what kind of
transactions they represent. The report generated would show:

Tax AmountTaxable
Amount

Non-Taxable
Amount

Total AmountDescriptionAccount

5010005001550Travel30000

10020003502450Sales40000

5050025003050Purchases50000

If the Japan Country Pack is licensed and enabled, then for these same transactions, the Tax Control
Report would show:

Rate: 5Type: Rate Description:
Ohio

Tax Code: OH

Tax AmountTax Basis>DateDescriptionAccount

50100011/12/13Travel Tax15000

100200011/5/13Sales Tax
Payable

20200

Rate: 10Type: Rate Description:Unit-
ed States

Tax Code: US

Tax AmountTax BasisDateDescriptionAccount

100200011/13/13Sales Tax Ex-
pense

50100
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Rate: 0Type: Exempt Description:Non-
Taxable

Tax Code: NT

Tax AmountTax BasisDateDescriptionAccount

050011/12/13Travel Tax15000

035011/1/13Sales Tax
Payable

20200

0250011/4/13Sales Tax Ex-
pense

50100

Using the Consumption Tax Report
Use the Consumption Tax Report form to report consumption tax data according to posted activity
during a specified fiscal period. You can then use information from the report to fill out your consumption
tax (CT) returns.

1 Specify this information:

Translate to Domestic Currency
Select this check box to translate amounts in the report to the domestic currency. Clear this check
box to leave amounts in the transaction currency.

Display Report Header
Select this check box to display report headers in the report. Report headers display on the first
page of the report and list the parameters by which you generated the report.

Fiscal Year
Specify the fiscal year for which tax information is to be included on the report.

Period

Specify the accounting period, within the specified fiscal year, for which tax information is to be
included on the report.

Display
Specify the level of data to include in the report: summary or detail.

2 To preview and print a report:

• Click Preview to preview the report.
• Click Print to print the report.
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Filing Forms 1095C and 1094C
To prepare IRS forms 1095C and 1094C:

1 Ensure that the Offer of Coverage Codes and Safe Harbor Codes forms list the correct codes.

2 On the Employee Insurance form, specify this information on the ACA tab:

• Plan Year
• Offer Date
• Type of Coverage
• The Offer of Coverage Code for each month, if the Type of Coverage is Monthly, or for the

entire year, if Type of Coverage is Annual
• The Share of Coverage for each month, if the Type of Coverage is Monthly, or for the entire

year, if Type of Coverage is Annual
• The Safe Harbor Code for each month, if the Type of Coverage is Monthly, or for the entire

year, if Type of Coverage is Annual

Note: The Offer of Coverage Code and Safe Harbor Code must be specified, even if the employee
is ineligible for coverage.

3 On the Self Insurance tab, specify this information:

• Name
• Social Security Number
• Date of Birth
• Which months the employee was self-insured

4 On the 1095 Form Printing Report form, specify this information:

• Employee range
• Fiscal Year
• Site
• Date range
• Employer identification and contact information
• Whether or not the filer is a designated governmental entity

5 In the 1094 group box, Specify the checkboxes that apply to your company to enable the
corresponding fields and tabs at the bottom of the form.

Note: Selecting the Authoritative Transmittal checkbox enables the remaining checkboxes in
the 1094 group box.

6 Specify the Filing Method. If you are filing 250 returns or more, you must file electronically.

7 If you are filing electronically, click Files and specify a logical folder where the returns will be stored.

8 If you selected ALE Member Group in the 1094 group box, specify the appropriate information
on the ALE Member Information and Other ALE Members of Aggregated ALE Group tabs.

9 If you selected Section 49890H Transition Relief in the 1094 group box, specify the
appropriate information on the ALE Member Information tab.

10 If you are filing electronically, specify the manifest information on the Manifest tab.

11 If the Designated Government Entity field is selected, specify your identification and contact
information on the Designated Government Entity tab.

12 If the Filing Method is Paper, perform these steps:
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a Select Print 1095C Paper Form, then click Preview.
b When you are satisfied with the preview, click Print to print the paper forms.
c Select Print 1094C Paper Form.
d Specify the number of 1095-C forms that were printed.
e Click Preview.
f When you are satisfied with the preview, click Print to print the paper forms.

13 If you are filing electronically, perform these steps:

a Select Generate 1094-1095C XML.
b Click Generate.
c Click Files to open the File Maintenance form.
d Select the filing documents and click Download; then select the local drive and folder where

you want to place the documents.
e Submit your filings via any IRS-approved product.
f Note the Receipt ID on your transmission confirmation. For example, 1095C-16-00001234. If

errors are returned by the IRS, match this ID with the Current Record ID field, on the Employee
Insurance form, to locate the erroneous record.

g If errors are returned, use the error report descriptions to identify, and correct, any errors on
the Employee Insurance form. After correcting each record, select the Corrected field and
save the record. When each record is saved, its Receipt ID automatically moves from the
Current Record ID field to the Previous Record ID field. This provides historical visibility if
an additional error report is returned after submitting your corrections.

h Open the 1095 Form Printing Report form.
i Specify the appropriate identification information.
j Locate the Submission ID and Record ID on your IRS error report. These IDs are located at

the end of the Receipt ID. For example, 1095C-16-00001234|01|03. In this example, the
Submission ID is 01 and the Report ID is 03.

k Select the ACA tab.
l Specify the Submission ID and Record ID
m If a tax filing was accepted, but contained errors, after correcting the errors, select 1094C

Corrections Only, 1095C Corrections Only, or both, depending on the nature of the
corrections.

n If a tax filing was rejected, and contained the error code AIREX, AIRBR, AIRTN, or BIRTH,
after making the appropriate corrections, specify the type of replacement. If the entire
transmission must be replaced, specify Transmission. If only specific submissions withing a
transmission must be replaced, specify Submission.

o Select Generate 1094-1095C XML.
p Click Generate.
q Submit your corrected filings via any IRS-approved product.
r If additional errors are reported, click Reset Corrected Employees on the 1095 Form Printing

Report form before attempting to correct the errors.
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Chapter 14: Unit Codes

About Unit Code Reporting
These are the basic assumptions of unit code reporting throughout the system.

Account Structure

The account structure in the system is:

• Account - Main account
• Unit Code 1 is predefined as tied to the department code. Payroll and Shop Floor Control use this

field when reporting hours. If Unit Code 1 is defined, it must be tied to a valid department number.
To make this connection on the Departments form, fill in the Unit Code 1 value for each department
you want.

• Unit Code 2 represents the product code, and, if defined, must be tied to a valid product code. As
inventory related transactions are produced, the transactions are automatically updated with the
value that appears in Unit Code 2 on the Product Codes form for that item.

• Unit Code 3 and Unit Code 4 are user-defined. They can carry any valid unit code that has been
defined on the appropriate Unit Code form. For example, you could use them for work centers or
for a cost center that is grouped differently than what is defined as Department in Unit Code 1.
You could use these for reporting on different currency codes, vendor statistics or customer statistics.

Account is part of the account template, unit codes are not. Any unit code can be tied to a main account,
provided the Chart of Accounts setup allows that chart record access to that unit code.

You can use the same unit code for more than one reporting unit, although the codes would not
necessarily mean the same thing. For example, a unit code value of ABCD could be set up for both
Unit Code 3 and Unit Code 4, because each unit code is a separate table.

Chart of Accounts

On the Chart of Accounts, you can set each unit code with one of these attributes:

• Not Accessible: The reporting unit field is not accessible for this account in the application. If
this option is selected, the unit code will not be posted. The corresponding Unit Code tab on the
Chart of Accounts form is disabled.

• Accessible: The reporting unit field is accessible for this account everywhere in the application
If this option is selected, you can specify that unit code for the associated account, but it is not
mandatory.

• Required: The reporting unit field is required for this account everywhere in the system. If this
option is selected, you are required to enter the unit code for the associated account. An error
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occurs if you leave the unit code blank when one is required. If no unit code is entered, posting
will fail.

Areas of the system that provide default account numbers also allow the entry of reporting units to be
used as defaults. In places where the default account numbers can be overwritten, so can the reporting
units.

Inventory Transactions

For transactions involving inventory distribution accounts, the system pulls unit codes from Item
Stockroom Locations.

Job Transactions

WIP transactions pull Acct, Unit Code 1, Unit Code 3, and Unit Code 4 from the Product Codes - WIP
tab. Unit Code 2 comes from the Product Codes - General tab.

For example, a job is created for Item A. Item B is the material issued to that job. Unit Codes 1, 3 and
4 are defined on the Product Codes - WIP tab. For a job material issue, the following accounts and
unit codes are used.

UC 4UC 3UC 2UC 1Acct 

     (Debits) from
Job Header
WIP Accounts
(Cost Detail

XXXXXXXXXXXXXXXXWIP Material

XXXXXXXXXXXXXXXXWIP Labor

XXXXXXXXXXXXXXXXWIP Fixed
Overhead

XXXXXXXXXXXXXXXXWIP Variable
Overhead

XXXXXXXXXXXXXXXXWIP Outside
Services

     Credits (from
Item Stock-
room Loca-
tions)

  XXX XXXXInventory Ma-
terial

  XXX XXXXInventory La-
bor

  XXX XXXXInventory
Fixed Over-
head
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UC 4UC 3UC 2UC 1Acct 

  XXX XXXXInventory Vari-
able Overhead

  XXX XXXXInventory Out-
side Services

Labor Posting

UC4UC3UC2UC1Acct 

     (Debits) From Job Header WIP
Accounts (Cost Detail)

XXXXXXXXXXXXXXXXWIP Material

XXXXXXXXXXXXXXXXWIP Labor

XXXXXXXXXXXXXXXXWIP Fixed Overhead

XXXXXXXXXXXXXXXXWIP Variable Overhead

XXXXXXXXXXXXXXXXWIP Outside Services

     (Credits) From Work Center of
Operation (Dept. of WC) Depart-
ments record

XXXXXXXXXXXXXXXXDirect Labor Expense

XXXXXXXXXXXXXXXXFixed Labor Overhead Applied

XXXXXXXXXXXXXXXXVariable Labor Applied

In standard costing, variance transactions use Unit Code 2 from the Product Codes - General tab.
For labor rate variance, it also uses Unit Code 1 from the Departments form. Other unit codes are
pulled from the Product Codes - Variance tab.

CO Shipping Transactions

Customer order unit codes can be handled in one of two ways. On the Customers form there is anEnd
User Type field. End User Type accounts can then be set up on the End User Types form. The
accounts defined here are Sales, Sales Discount, Accounts Receivable, Cost of Goods Sold Material,
Cost of Goods Sold Labor, Cost of Goods Sold Fixed Overhead, Cost of Goods Sold Variable Overhead,
and Cost of Goods Sold Outside. If End User Type is defined on the Customers form, that type is
pulled into the order and the default values for Acct, Unit Code 1, Unit Code 2, Unit Code 3, and Unit
Code 4 are used from the End User Types form. If there is no Unit Code 2 on the End User Type
form, it is pulled from the Product Codes - General tab.

If End User Type is not used, the system pulls the Acct, Unit Code 1, Unit Code 2, Unit Code 3, and
Unit Code 4 from the Sales/COGS tab on the Distribution Accounts form for all accounts listed above
except Accounts Receivable. If there is no Unit Code 2 on the Sales/COGS tab of the Distribution
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Accounts form, it is pulled from the Product Codes - General tab. Accounts Receivable is pulled from
the Accounts Receivable Parameters form and uses all Acct, and all Unit Codes.

See Where Unit Codes Come From on page 319 for more information.

Where Unit Codes Come From
Use this table to see where unit codes come from when performing certain activities. For example, in
the table you see that when performing an RMA Return Transaction with No End User Type, the Credit
Cost Of Goods Sold unit codes come from Product Code Distribution Accounts.

Where unit codes come fromAccountActivity

Bank Rec of Bank CodeDR CashCustomer Payments

Unit Code designated on artran
record for type "Invoice"

CR Accounts Receivable 

Unit Code designated on A/R
Payment Distributions form
for type "Open Credit", "Finance
Charge" and "Non-A/R". The
Unit Code defaults from Ac-
counts Receivable Parame-
ters form, but can be overwrit-
ten at A/R Payment Distribution
level.

CR 

Item Stockroom LocationsCR Inv.Customer Shipment - No End
User Type

Product Code Distribution Ac-
counts

DR COGS 

Item Stockroom LocationsCR Inv.Customer Shipment - With End
User Type

End User Type, then Product
Codes (Unit Code 2 only)

DR COGS 

Item Stockroom LocationsDR or CR Inv.Cycle Count and Physical Inven-
tory

Product Codes Misc, tab then
Product Codes General Tab
(Unit Code 2 only)

DR or CR Inv. Adj. 

Unit Code 1,3,4 from End User
Type, Unit Code 2 from Product
Code General

DR Accounts PayableInvoicing (with End User Type)
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Where unit codes come fromAccountActivity

Unit Code 1,3,4 from End User
Types form, and Unit Code 2
from General tab on Product
Codes form

CR Sales 

Unit Code from Accounts Re-
ceivable Parameters form, and
Unit Code 2 from Product
Codes form

DR Accounts ReceivableInvoicing (without End User
Type)

Unit Code from Product Code
Distribution Account, then Gen-
eral tab on Product Codes
form

CR Sales 

Item Stockroom LocationsDR Inv.JIT Transactions

Work Center WIP Accts, then
Product Codes (Unit Code 2
only)

CR WIP 

Job OrdersDR or CR WIPJob Close

Product Codes Variance tab
for Standard Cost item or
Product Codes Misc tab for
Actual Cost item, then Product
Codes General tab (Unit Code
2 only)

DR or CR Inv. Adj. Or Routing
Variance

 

Job Orders Cost Detail tabDR WIPJob Labor Transactions

Unit Code 1 from Dept. UC field,
all other codes from Dept. DL &
OH applied defaults, then Prod-
uct Codes (Unit Code 2 only)

CR Exp. 

Job OrdersDR WIPJob Material Issues

Item Stockroom LocationsCR Inv. 

Item Stockroom LocationsDR Inv.Job Move to Inventory (includes
Job Receipt

Job OrdersCR WIP 

Item Stockroom LocationsDR or CR Inv.Manual LIFO/FIFO Adjustment
Utility

Product Codes Misc, tab then
Product Codes General Tab
(Unit Code 2 only)

DR or CR Inv. Adj. 

Item Stockroom LocationsCR Inv.Miscellaneous Issue
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Where unit codes come fromAccountActivity

Product Code Misc. tab Invento-
ry Adjustment account

DR Misc. 

Item Stockroom Locations for
existing locations; Inventory
Distribution Accounts for new
locations

DR Inv.Miscellaneous Receipt

Product Code Misc. tab Invento-
ry Adjustment account

CR Misc. 

Wage account on Employee
General, then Departments
(Unit Code 1 only), then Payroll
Parameters for Unit Codes 2, 3,
and 4

DR Labor Exp.Payroll Transactions

Unit Code 1 from Employee
Dept. UC Field, all other codes
from Payroll Parameters and PR
Tax Tables

DR All Other Exp. 

Unit Code 1 from Employee
Dept. UC Field, all other codes
from Payroll Parameters and PR
Tax Tables

CR Tax Payable 

Unit Code 1 from Employee
Dept. UC Field, all other codes
from Payroll Parameters and PR
Tax Tables

CR Cash 

All unit codes from Product
Codes form, Project tab

DR Proj LaborProject Labor Transactions

All unit codes from Product
Codes form, Project tab

DR Proj Overhead 

All unit codes from Product
Codes form, Project tab

DR Proj G & A 

Unit Code 1 from Employee
Dept, all other codes from the
Accounts on the Employee Dept

CR Labor Exp. 

Unit Code 1 from Employee
Dept, all other codes from the
Accounts on the Employee Dept

CR Applied Ovhd 

Unit Code 1 from Employee
Dept, all other codes from the
Accounts on the Employee
Dept.

CR Applied G & A 
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Where unit codes come fromAccountActivity

Unit Code on Project Header
(Defaults from Product Code
associated with Project)

DR WIPProject Resource Transactions

Unit Code from Stockroom Loca-
tion of item being issued

CR Inv. 

Unit Code entered during Re-
source Transaction for "Non-
Item Master" issues

CR 

Item Stockroom LocationsDR Inv.PS Complete Transactions

Work Center WIP Accts, then
Product Codes (Unit Code 2
only)

CR WIP 

Product Codes Misc tab, then
Product Codes General Tab
(Unit Code 2 only)

DR Scrap Exp.PS Scrap Transactions

Work Center WIP Accts, then
Product Codes (Unit Code 2
only)

CR WIP 

Item Stockroom LocationsDR Inv.Purchase Order Receiving

Purchasing Parameters, then
Product Codes (Unit Code 2
only)

CR Vouchers Payable 

Purchasing Parameters, then
Product Codes (Unit Code 2
only)

DR or CR Vouchers PayablePurchase Order Variance

Product Codes Variance tab for
Standard Cost item or Product
Codes Misc tab for Actual Cost
item, then Product Codes Gen-
eral tab (Unit Code 2 only)

DR or CR Inv. Adj. or PPV 

Item Stockroom LocationsDR or CR Inv.Quantity Adjustment Transac-
tions

Product Codes Misc, tab then
Product Codes General Tab
(Unit Code 2 only)

DR or CR Inv Adj 

Item Stockroom LocationsDR Inv.RMA Return Transaction - No
End User Type

Product Code Distribution Ac-
counts

CR COGS 
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Where unit codes come fromAccountActivity

Item Stockroom LocationsDR Inv.RMA Return Transaction - With
End User Type

End User Type, then Product
Codes (Unit Code 2 only)

CR COGS 

Transit account, then Item
Stockroom Locations for exist-
ing locations; Inventory Distribu-
tion Accounts for new locations,
then Product Codes (Unit Code
2 only)

DR To LocTransfer Orders (Single Site)
Quantity Move

Transit account, then Item
Stockroom Locations for exist-
ing locations; Inventory Distribu-
tion Accounts for new locations,
then Product Codes (Unit Code
2 only)

CR From Loc 

Item Stockroom Locations(From Site) CR Inv.Transfer Orders (Multi-Site, In-
ter-Entity), MS Quantity Move

Intersite Parameters, then
Product Codes (Unit Code 2
only)

(From Site) DR I/E A/R 

Intersite Parameters, then
Product Codes (Unit Code 2
only)

(From Site) DR I/E COGS 

Intersite Parameters, then
Product Codes (Unit Code 2
only)

(From Site) CR I/E Sales 

Intersite Parameters, then
Product Codes (Unit Code 2
only)

(From Site) CR I/E Profit 

Item Stockroom Locations(To Site) DR Inv. 

Intersite Parameters, then
Product Codes (Unit Code 2
only)

(To Site) CR I/E A/P 

Item Stockroom Locations(From Site) CR Inv.Transfer Orders (Multi-Site, Intra
Entity

Intersite Parameters, then
Product Codes (Unit Code 2
only)

(From Site) DR I/E Clear Ship 

Item Stockroom Locations(To Site) DR Inv. 
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Where unit codes come fromAccountActivity

Intersite Parameters, then
Product Codes (Unit Code 2
only)

(To Site) CR I/E A/P 

Bank Rec of Bank CodeCR CashVendor Payments

Unit Code designated on aptrxp
record for type "Voucher"

DR Accounts Payable 

Unit Code designated on A/P
Payment Distributions form for
type "Open Payment", "Commis-
sion" and "Non-A/P". The Unit
Code defaults from Accounts
Payable Parmeters form, but
can be overwriteen at A/P Pay-
ment Distribution level.

DR 

Purchasing Parameters form,
then Unit Code 2 from General
tab on Product Codes form

DR Vouchers PayableVoucher (with Vendor Category)

Vendor Categories formCR Accounts Payable 

Purchasing Parameters form,
then Unit Code 2 from General
tab on Product Codes form

DR Vouchers PayableVoucher (without Vendor Cate-
gory)

Purchasing Parameters formCR Accounts Payable 

Work Center WIP AcctsDR WIPWC Labor Transactions

Unit Code 1 from Dept. UC field,
all other codes from Dept. DL &
OH applied defaults

CR Labor Exp. 

Item Stockroom LocationsCR Inv.WC Material Transactions

Work Center WIP Accts, then
Product Codes (Unit Code 2
only)

DR WIP 

Using Unit Code 1-4 Detail on Financial Statements
These examples show how to use the Unit Code 1-4 Detail field on the Financial Statements forms.
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Example 1

This example applies to the Year End Closing Journal Entries and Multi-FSB Year End Closing
Journal Entries forms and the Financial Statement Output form.

For a given account you could have these transactions for Unit Codes 1, 2, and 3:

AmountUC3UC2UC1

50.00 50100

55.00 50100

35.00 50200

65.00 30300

15.00 30300

Example 2

This example applies only to the Financial Statement Output form.

Using the amounts from the previous example, if all the Unit Code Detail check boxes on the form
have been cleared, the report shows one line for a total of 220.00. If the Unit Code 1 Detail check box
is selected, you see three lines:

100, 105.00

200, 35.00

300, 80.00

If the Unit Code 1 Detail and Unit Code 3 Detail check boxes are selected, you see four lines:

100, 105.00

200, 35.00

300, 65.00

300, 15.00
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